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SECTION 1 - INTRODUCTION

OVERVIEW

Once you have installed the system hardware, it is time to specify how you want the system to operate, using the
programmable DX-120 features. You need to set up the following:

e system settings such as system date and time, day/evening modes, and the numbering plan needed to meet your

customers' needs (“Section 4 - Programming System Resources” on page 39)

the interface to the CO lines coming into the system (“Section 5 - Programming C.O. Lines” on page 115)
how you want the system to handle and process calls (“Section 6 - Programming Call Handling” on page 187)
any restrictions you want in place for toll calls (see “Section 7 - Programming Toll Restrictions” on page 329)
Uniform Call Distribution - if applicable (see “Section 8 - Programming ucd groups” on page 341)

internal or external voice mail - if applicable (see “Section 9 - Programming Voice Mail” on page 361)
privileges for all extensions (see “Section 10 - Programming Extensions” on page 385)

feature buttons on individual DET phones and DSS consoles (see “Section 10 - Programming Extensions” on
page 385)

PROGRAMMING OPTIONS

There are three approaches you can take when programming a DX-120 system. Each approach has its advantages
and disadvantages. You may prefer one approach and use it often, but you may occasionally need to use an
alternative approach. You can:

Program the system on site using any Digital Extension Terminal (DET) phone.
Program the system on site using PC-DBA, this Windows-based software program.

Program the database using PC-DBA on a laptop prior to arriving at your customer’s site. Then when you arrive
on site, you can download the pre-programmed database into the DX-120 system in a minimal amount of time.
Advantages and Disadvantages of the Various Programming Methods

PROGRAMMING METHODS

Programming Interface Advantages Disadvantages
* You do not need a laptop PC to * You have a limited visual interface
program the database. (the phone display) vs. a menu
« The phone is a direct interface to the screen.
CPU, so there is no chance of  You have to do all programming on
database corruption during site.
transmission. If you are having a + DET phone programming can take
unidentifiable or persistent problem, longer to perform than PC-DBA
DET phone use DET phone programming to programming.
eliminate the possibility of a corrupt

* You cannot save the current switch
database. If you lose this database
because of battery failure or
because you have to perform a
Master Clear, you will have to
completely reprogram the database.

database.

Advantages and Disadvantages of the Various Programming Methods (continued on next page)
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PROGRAMMING METHODS (continued)

Programming Interface

PC-DBA laptop on site

Advantages

 You can save the existing database
residing on the switch via a
RECEIVE ALL command. When
you need to modify the database,
you can use the switch version as a
basis so you will not have to
reprogram all its custom settings.

If you lose the switch database
because of battery failure or
because you must perform a Master
Clear, you will NOT have to
completely reprogram the database
(provided you have previously saved
a copy of the custom switch
database onto your laptop).

Disadvantages

* You need a laptop with a serial port.
« You do all programming on site.

« PC-DBA is not a direct interface to
the CPU. Therefore, the possibility
exists that a corruption can occur
when transmitting the laptop
database to the switch.

You must be diligent in performing a
RECEIVE ALL when first arriving on
the customer site, and prior to
modifying their database. If you
neglect to do so, you may
inadvertently perform a SEND ALL
first, thus writing over their custom
programmed database with
whatever database you last used on
the laptop.

PC-DBA laptop remotely

You can program the customer’s
database while off site, and simply
download it to the switch when you
arrive on site. This reduces the
amount of time you have to spend
on site.

You can save the existing database
residing on the switch via a
RECEIVE ALL command. When
you need to modify the database,
you can use the switch version as a
basis so you will not have to
reprogram all its custom settings.

If you lose the switch database
because of battery failure or
because you must perform a Master
Clear, you will NOT have to
completely reprogram the database
(provided you have previously saved
a copy of the switch database on
your laptop).

You need a laptop with a serial port.

PC-DBA is not a direct interface to
the CPU. Therefore, the possibility
exists that a corruption can occur
when transmitting the database to
the switch.

You must be diligent in performing a
RECEIVE ALL prior to modifying
their database. If you neglect to do
S0, you may inadvertently perform a
SEND ALL first, thus writing over
their custom programmed database
with whatever database you last
used on the laptop.
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UPGRADING AN EXISTING SYSTEM

Occasionally you may need to perform maintenance programming or install an upgrade to an existing system. The
information provides you with some of the issues you need to consider when maintenance or upgrading needs to be
performed on the current system:

e When you are upgrading an existing system, the database is already in place and functional.

e You may want to program your changes off-line using PC-DBA on a laptop, and then download the newly modified
database to the system.

= When you use this method, be sure to perform a RECEIVE ALL command first to overwrite the database currently
on your laptop with the database the switch is using.

e After receiving the database from the switch (see above item) make your programming changes to the laptop
database, and when you are finished perform a SEND ALL to upload the new modified version onto the DX-120
switch.

A CAUTION

« If you fail to perform a RECEIVE ALL before you make your programming changes
and you then perform a SEND ALL, the system writes over the switch database
with whatever DX-120 database resides on your laptop.

e Use care that you do not overwrite the current site’s database with a database
residing on your laptop from your previous customer site.

* Itis a good practice to always perform a RECEIVE ALL when first arriving at a new
customer site or prior to modifying your customer’s database.

e During a hardware upgrade, you need to add the new hardware and then program the corresponding feature set
in the existing database.

e There are specific procedures to follow when adding new hardware to an existing system. See the Vertical DX-
120 Installation and Maintenance Manual available on the Vertical CCC web site (www.vertical.com/ccc).
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Converting a DX-80 Database to a DX-120 Database

A tool has been created that allows you to convert an existing DX-80 database for use in the DX-120DX-80 DB
Converter is a tool that allows you to convert DX-80 database files to DX-120 database files. This process MUST be
performed using PC-DBA only (i.e., you cannot convert the database using the DET).

There are two modules in this tool:

* Receive Data from the DX-80
* Convert F39 DB File to FO3 DB File

RECEIVING DATA FROM THE DX-80

This module supports the following DX-80 versions F24 to F39 (including intermediate versions). It allows you to
transfer data from the DX-80 to a F39 DB file.

From the PC-DBA main screen:
1) Go to File»New Database to create a new database in the F39 format.
2) Go to Control»Connect to open the connect screen.
3) Connect to the DX-80.

4) Go to Control»Receive to start receiving data from DX-80.

After transfer of the data is complete:

5) Go to File>Save as to save the database file in the appropriate location.

NOTE

In step 3, since some items do not exist in the database of old version KSU, some
messages, such as “CO Line Guard Time has not been received”, will be prompted
after data received from KSU. This may be due to missing items of some sort.

MISSING ITEMS IN DX-80 EARLIER THAN F39

e F24, F25 missing following items compared to F39:
- SMDR call Output is not completely received.
- CO Line Guard Time has not been received.
- Daylight Savings Time has not been received.
- CID Ring Time has not been received.
- OHVA Accept has not been received.
- OHVA Reject has not been received.
e F26 to F32 missing following items compared to F39:
- SMDR call Output is not completely received.
- CO Line Guard Time has not been received.
- Daylight Savings Time has not been received.
- CID Ring Time has not been received.
= F33to F39 missing following items compared to F39:
- SMDR call Output is not completely received.
- CO Line Guard Time has not been received.

Converting A DX-80 Database to a DX-120 Database (continued on next page)
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Converting A DX-80 Database to a DX-120 Database (continue)

CONVERTING AN F39 DB FILE TO AN FO3 DB FILE

With the help of this module, users can convert a DB file in F39 format (e.g., a file created by using the module

“Receive Data from KSU”) to a DB file in FO3 format.

From the PC-DBA main screen:

1) Go to Control»Convert to open the DX-80 Converter screen.

2) Click "Select a DB file in F39 format".

3) Specify a path for the newly converted DB file.

4) Click "Convert” to begin the conversion.

—3 NOTE

.é Please pay careful attention to any information that is displayed during the

conversion. Such information may be useful later on.

DIFFERENCES BETWEEN F39 AND FO03

Version FO3 contains the following items which should be set manually.

SW/HW Revision

Extension - ECF CO Group

Extension -Force LCR

Extension —Alternate Line ID Index

Call Handing — LCR Timeout

System Resource - Remote Ext Table

System Resource - SPD NO.-C.O. Group
System Resource - CID Transfer Table
Restriction-Account Code Table - C.O Group
Restriction-Account Code Table — LCR Enable
Restriction - LCR-DGT Modification Table
Restriction - LCR-DGT Comparison Table
C.O.Line Application - T1 Card

C.O.Line Application - Translation Table
C.O.Line Application - ISDN

C.O.Line Application — Alternate Line ID Table

System Application —Numbering Plan- LCR Directory Number
System Application—Numbering Plan - Remote Extension

Converting an F39 DB file to an FO3 DB file (continued on next page)
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Converting an F39 DB file to an FO3 DB file (continued)

OTHER DIFFERENCES WHICH MAY AFFECT CONVERTING
e F39 has 60 Extensions while FO3 has 120
= Only 60 Extensions settings will be copied to FO3 database file. You should set others manually.

e F39 has 16 C.O.Line while FO3 has 40 C.O. lines

= Only 16 C.O.Line settings will be copied to FO3 database file. In the category Extension, only first 16 records
about “Receive Assign” and “Line Access Assign” will be copied. You should set others manually.

[ NOTE
C.0O. lines for DX-120 are 800-839 (C.O. lines 840 through 843 are reserved for future
“ use).
e System Resource - SPD NO.

e Since the assignment of SPD NO. in F39 may causes conflict, some setting may be ignored. You'd better double
check it after converting

SOME ITEMS ARE NOT COPIED IN ORDER TO AVOID CONFLICT
These items should be set manually.

e C.O.Line - C.0.Group
e System Application — Numbering Plan
e C.O.Line - C.0.Group
e System Application — Numbering Plan

PoOssIBLE ERRORS DURING CONVERSION

The following is a list of possible errors that may occur during the conversion of the DX-80 database. If any of these
occur, you will need to set the specified information manually.

INDEX DESCRIPTION

C001 This item exists in FO3, but not in F39.

C002 This item has probably been converted, but some conflict may generate because of the differ-
ences between F39 and F03. Double check it after converting, and set manually as needed.

C003 This item was not be converted because of the data conflict.

C004 Exception occurred during conversion.
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Programming a New System
This manual provides information for completely programming a new DX-120 system from scratch. Vertical also
provides you with some tools you can use to reduce your programming time. These tools include:

« a series of worksheets for you to plan your system structure, and record the programming for future reference if
necessary. For more details, see Appendix A, Worksheets.

= copying a base CO line or extension’s setups to several other CO line or extensions thereby eliminating the need
to program them individually, and

e using one of four standard database programming templates provided with the DX-120 on CD part number DX-
120UTILCD. You can choose the template that most closely matches your new customer’s site needs, and then
add whatever custom changes you need to make. This approach saves you the time of programming the entire

system from scratch.
HINT

For more information on these and other aids the DX-120 provides to allow you to
program a system efficiently, see see “Shortcuts that Help You Work Faster” .

L)

BASIC PROGRAMMING TASKS
When you are programming a new system from scratch, perform the following basic tasks:
A) Set up the system features (see “Section 4 - Programming System Resources” on page 39)
B) Set up the CO lines (see “Section 5 - Programming C.O. Lines” on page 115)
C) Set up call handling (see “Section 6 - Programming Call Handling” on page 187)
D) Set up the toll restrictions (see “Section 7 - Programming Toll Restrictions” on page 329)
E) Set up the UCD groups (see “Section 8 - Programming ucd groups” on page 341)
F) Set up Voice Malil - if applicable (see “Section 9 - Programming Voice Mail” on page 361)

G) Set up the extensions and program the feature buttons on the individual DET phones and DSS consoles (see
“Section 10 - Programming Extensions” on page 385)

USING SHORTCUTS
The DX-120 provides some shortcuts to help you perform these tasks efficiently.

EXAMPLE

When you are setting up the individual extensions, you can first set up a “base”
extension that is typical of how you will set up the majority of extensions. After you
have set up this base extension, you can copy its programming to all of the other
extensions in the system. Then, you can modify the few specific extensions that
require different programming.

The DX-120 provides a similar shortcut for setting up CO lines with a CO Line Copy command. For more details on
helpful shortcuts provided with your system, see see “Shortcuts that Help You Work Faster” .

Programming a New System (continued on next page)
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Programming a New System (continued)

SETTING UP THE SYSTEM FEATURES FOR SYSTEM ADMINISTRATION AND RESOURCES

The system features allow you to control system administration and to assign system resources. Perform the following
tasks.

HINT
Details on how to perform these tasks are included in see “Overview” . The DX-120
provides programmable features that allow you to establish these various settings.

L

e Establish the database administrator password - see page 16

* Assign the attendant extension for each tenant group - see page40

= Assign the system reminder for each tenant group - see page45

e Set up the system time, date, and hour mode - see page49

e Set up the ring scheme - see page55

= Name each CO line - see page58

e Set up the pre-programmed incoming and outbound messages - see page60

e Program speed dial numbers - see page64

= Set the number of items in the Caller ID table - see page72

e Establish the music source for the each tenant group - see page83

* Assign the external pager ID to a tenant group - see page77

= Program ancillary devices - loud bell, external page, music on hold source - see page87
e Allocate the DSS - see page89

e Set up the optional internal modem - see page93

e Select the PC-DBA transmit rate - see page95

e Select the SMDR transmit rate - see page97

e Set up the numbering plan you want to use Set the user passwords and names for extensions - see pagel03
= Specify the letter type - see page476

e Set the user passwords and names for extensions - see page387




SECTION 2 - PROGRAMMING OPTIONS

OVERVIEW

There are two programming interfaces you can use to program the DX-120:

e PC-DBA
= Digital Extension Telephone (DET) - see page 26.

PROGRAMMING VIA PC-DATABASE ADMINISTRATION
(PC-DBA)

The DX-120 system allows you to administer system database parameters using any IBM® compatible Personal
Computer (PC).

The use of a PC has distinct advantages over programming the system using the digital telephone, including:
* specific database archiving (via save function),

e remote programming, and

e outboard programming (programming the system template in the PC memory, then downloading it to the DX-120
switch memory when ready).
The PC program that interfaces with the DX-120 system is called PC-Database Administration (PC-DBA).

PC-DBA Requirements

PC-DBA requires the following resources in the PC environment:
PC running Microsoft® Windows 98, 2000, ME, or XP

RAM: 64MB or greater.
Processor Speed: 350 MHz or greater.

Hard Disk Space: 4GB or greater.

IMPORTANT

You must have a well-rounded understanding of the Windows PC environment and
file structure to use this DX-120 utility. Vertical Communications, Inc. cannot support
users who are unfamiliar with these basic requirements. If any of these issues
concern you, program the DX-120 instead by using any DET phone.

Loading PC-DBA Software
When you download PC-DBA from the Vertical web site it is contained in an archived format to expedite the download.
Vertical recommends that you perform the following steps when downloading PC-DBA.

1) Create a separate directory on the PC where you can load PC-DBA (typically “DX-120").
e This becomes the working directory.

2) Copy the archive file into that directory.
< An icon for the software will automatically be placed on your desktop. When you are ready to use PC-
DBA, you just need to double click on that icon to start the program.
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Programming Using PC-DBA
CAUTION!

The changes you make using PC-DBA are stored in a temporary working
directory. They are not uploaded to the DX-120 system memory until you

perform a SEND function. Do not forget this crucial step, or you may lose the
programming changes you just made.

1) Double click on the icon (see previous page) to display the main screen of PC-DBA.

DX120 PC DBA - Default.mdb B
Flle Control Programming Maintenance  Help

Dl =% % 2

\“ ‘ Comdial DX

11:41 AM Aug 18, 2006 [Disconnzcte
Ready

[Dire [comi [oson [RD [sD [ep lers
FC-DBA Ver. [WABUMI.T14  KSU Ver. [ |

2) Use the items in each of the menus to program the database (and switch) as needed.

Programming Using PC-DBA (continued on next page)

- 10 -
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Programming Using PC-DBA (continued)

PC-DBA MAIN MENUS

Review the following menus to become more familiar with where the various options are for using, programming, and
maintaining PC-DBA.

File The File menu provides you with all the
Mew Database. ., CErl+M basic functions of handling the DB file.
Open Database. ., ChElHO
Save s, Conktrol The Control menu provides you with the
W capability to connect PD-DBA to the switch
Database Information A for sending a receiving information.
1 Default, mdb LBedrinizet 7 The Send and Receive options will not be
—end it available until successful connection has
Exit Al+F4 Recelve  FJ been made between the PC-DBA and the
switch.
The Programming menu provides you Programming
with a variety of programming options for Etarin
customizing the DB/system to work C.00 Line
efficiently and cohesively in the current Fir _
environment. Zall Handling 3
Swskem Resource k
Restriction k
Extension Application r
.0, Line Application r
Syskem Application r
Feature Key Programming  #
kSl DB Password
i The Maintenance menu monitor and test
Maintenance .
- : several aspects of the operation and use of
Canfiguration the database and system usage.
Diagnostics 4
Skakus
W [ HW Renision Help The Help menu gives you access to the online
Event k help system that contains detailed
Logon Craka S programming information (much like this
Remote Contral — # el P EE document). There is also an option that allows
Tl Mainkenance you to view specific information about the PC-

DBA software (e.g., version, etc.).

- 11 -
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Database Save and Restore

The working directory is the location allocated in the PC for all changes while the PC-DBA programming session is in
progress. You may want to save the data in this directory for later retrieval since you may be working on many various
databases.

CAUTION!
Always perform a database SAVE prior to database RESTORE if you intend to
preserve the current contents of the working directory.

SAVING THE DATABASE

From the PC-DBA main screen:

1) Go to Filep>Save As... to display the Save As dialog box.
¢ This dialog box allows you to enter a name for the database.

Save in: I@DXQD j . = B
@Default.mdb

File: name: Save
Save as type; IMS Access Files [*.mdb) j Cancel

v

2) Enter the desired database name.
* You can also change the directory if necessary.

3) Click Save to store the database with that name.
¢ This dialog box allows you to select the desired database file.

4) Select (or enter the name of) the database you wish to restore.

5) Click Open to open the specified database.
« The system will use this database file until you specify a different name or close the application.

Database Save and Restore (continued on next page)

- 12 -
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Database Save and Restore (continued)

RESTORING (OPENING) A STORED DATABASE

From the PC-DBA main screen:

1) Go to Filep>Open Database... to display the Open dialog box.
¢ This dialog box allows you to select the desired database file.

O T
Lackin: | =2 D120 Il « @k E-
I
FIF BACKLP DE.mdb 3
[#] | Defaulk.mdb
A tempdatebass, mdb
test.mdb
File name:  |BACKUP DB.mdb Open |
Files of type:  |MS Aiccess Files [“mdb) =] Cancel |
™ Open as ead-only
' C! Pl

2) Select (or enter the name of) the database you wish to restore.

3) Click Open to open the specified database.
« The system will use this database file until you specify a different name or close the application.

Connecting PC-DBA to the Switch

When using the programming options of PC-DBA, there are times when you need to send and receive information
between PC-DBA and the switch. However, before data can be exchanged between the PC and the DX-120 system,

you must make a connection between the two devices. This connection is a serial (RS-232 — COM port or modem)
link.

There are specific tasks that can only be performed after a successful connection between PC-DBA and the switch has
been made:

* Receiving (data from the switch) - see pagel8

e Sending (data to the switch) - see pagel9

« |nitializing the System (cold and warm starts) - see page21l
e Diagnostics and T1 Maintenance - see page480

HINT
@ Also see...For specific information about making a physical connection between
PC-DBA and the switch, be sure to review the Vertical DX-120 Installation and

Maintenance Manual available on the Vertical CCC web site (www.vertical.com/ccc).

Connecting PC-DBA to the Switch (continued on next page)

- 13 -
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Connecting PC-DBA to the Switch (continued)

Once you make this connection, you can connect to the DX-120 system processor and download (receive) the DX-120
database memory to the PC-DBA laptop working directory.

A connection can be made either on-site or remotely:

ON-SITE (CABLE) CONNECTION

While on-site, you can connect the PC to the DX-120 via a standard RS-232C “straight-through” cable. You can
connect the DX-120 system on site via the PC serial port (COM port). Use a straight-through 9-pin to 9-pin cable from
the PC serial port to the DX-120 CPM — PC-DBA port.

REMOTE (MODEM) CONNECTION
When you are accessing the system remotely you can make this connection via a modem.

1) Make the physical connection (cable or modem) between the PC and the DX-120 system.

From the PC-DBA main screen:

2) Go to Control® Connect on the to display the password screen.

Comec:

PLEASE ENTER PASSWORD

[
ok I Cancel

OR
Press F5 to display the password screen.

HINT
@ If the password screen does not appear, make sure that the physical connection is in
tact.

3) Enter the Database Administration password.
« At default, this password is eight spaces (i.e., press the space bar eight times).
¢ For information about changing the password, see “Changing Database Administrator Password” on
page 16.

- 14 -
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4) Click the OK button to display the next Connect screen that provides the current (local and remote)
settings for the connections.

=

Local  Remote

[t EURAE R |t el [ 537EP WS DF PCI Modem

Dizctiption Phone Mumber Blaud Rate Init String
150 2400 ATEFEDGOV8C157=255
150 2400 ATEFEDGOYY AC1510=12059=3057=255
3 | 150 9600 | ATEFENGOY&C1S7=255
4 | 150 9800 | ATEFEDGOYT&C1S10=12059=3057=255
Desciiption —~ [{ Baud Rate [2400 = Init Stiing. [ATSFEDOOVTECTS7=255

Phare Number. [150

Mediy | Delete | Connect | Addtolist |
Cancel |

5) Make any necessary changes to the connection settings (as described on next page):

IMPORTANT!
A e For local settings, make sure that you have the appropriate Baud rate and COM
Port settings.

* For remote settings, make sure you have all the necessary modem settings
entered (including the init string, modem name, baud rate, and phone number).

HINT
@ Refer to the following pages:

« Setting Up Optional Internal Modem - page 93
e Specifying PC-DBA Transmit Rate - page 95
* Selecting SMDR Transmit Rate - page 97

AND/OR

Remote (modem) Connection (continued on next page)
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Remote (modem) Connection (continued)

Click Connect to being the connection process.
« Several brief messages will be displayed to let you know what's happening during this process (e.qg.,
sending the password, connection request, successful connection).

» Once connection is successfully established, a red dot will appear in the lower left corner of the
screen...

Pl o S ey Flaimas sl
D@ « =3¢ ¥

N\ comdial DX-12

L

A red dot appears here when
there is an active connection
between the PC-DBA and the
switch.

6) You can now perform any of the tasks listed above (e.g, Receive, Send, Diagnostics, Initialize, T1
Maintenance).

Changing Database Administrator Password

The DX-120 system allows you to set up and maintain the system database using any DX-120 DET telephone, once
you have entered the database administrator password. This password also allows you to program the system using
PC-DBA. It's a good idea to change this password after the installation of the system.

Before changing the database administrator password, you must first connect to the DX-120 switch.

From the PC-DBA main screen:
1) Connect to PC-DBA to the switch (see 13).

2) Go to ProgrammingP®KSU DB Password to display the password change screen.

[Cranoe Pessmord T
old Password: ||

3) Enter the existing (old) password.
« When you enter text in this field, a new field will appear (i.e., New Password).

Changing Database Administrator Password (continued on next page)
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Changing Database Administrator Password (continued)

4) Enter the new password.

Change Password } x|

0Old Password: |
New Password: |

Cancel

* When you enter text in this field, a new field will appear (i.e., Confirm Password).

5) Enter the new password again to confirm it.

Change Password I _X_]
0ld Password: |
New Passwaord:

Confirm Passward:

« When you enter text in this field, an OK button will appear.

6) Click OK to change the password as designated in the previous steps.

Change Password 5'

el

Old Passwaord:

s el

Mew Passwaord:

TERRAEEE

Confirm Password:

o |

* A message will appear to ask you to confirm that you want to make the change.

H X
e a—

Save New DB Pswd TO KSU?(Y/N)

7) Click Yes to change the password and display a confirmation as the password is successfully changed.

HINT
@ Also see “Changing Database Administrator Password” on page 16.

- 17 -
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Receiving Data from the Switch

Before data can be exchanged between PC-DBA and the DX-120 system, you must Connect (F5) to the switch. After
you establish a successful connection between the DX-120 processor and the PC-DBA software, the system displays
the word Connect at the bottom of the screen, next to the time and date.

CAUTION!

« When you receive programming from the switch, the system overwrites the
corresponding programming on your PC with the settings from the switch.
Make sure you want to do this before proceeding.

e Always perform a Database Save (All) before a Database Receive (All)
operation if you want to preserve the current contents of the working
directory on the laptop.

e Itisrecommended that if you are making database changes to a system that
has been in operation for an extended period of time, that you perform a
Receive All operation prior to making any database changes on the laptop.

e Since some database fields (including Speed Dial and Service Mode) are
user adjustable, these fields will be overwritten if you perform a Send All
operation using an outdated PC-DBA laptop database.

From the PC-DBA main screen:
1) Connect PC-DBA to the switch.
2) Go to ControlPReceive to display a list of categories that represent the information that can be received.
OR

Press F3 to display a list of categories that represent the information that can be received.

x|
TP EERBNSION, e sacassniassiss st s asas s st fems |
| G R E  eme e e e e e e e Rame |
[vicCalltandling: o iamin i e s s R i, Harris |
¥ Sy atam RESOUMTE. . eveeeeeriieiesiesniesrenseesseteesesansas % ama |
7)) RESHAGHION. .. ...oooviesresnsiassneeensanns s onsssnsensnssnscnsnsnans . |
¥ Estension Spplcation. ... Reirio |
1% .00 Line Applieation....coecee et seenessssinas erne |
¥ System Appleation............ocoooreemeoiis i ienias e |
¥ Famtume KawWs. .o ftems |
Select Al | Unzelect A | ak I Canel | Help |

3) Locate the category that represents the information you want to receive.

4) Click the Items button to display the list of various options for that category.

Receiving Data from the Switch (continued on next page)
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Receiving Data from the Switch (continued)

5) Click on the specific items you want to receive to select them.
OR
Click Select All to select all the items on that screen.

* Use the Unselect All button to deselect all items on the page. You can then reselect any specific items
as needed.

6. Click OK when all your selections have been made to begin the receiving process and download the
data from the switch to your PC/laptop.

HINT
@ Refer to the following pages:

e Connecting PC-DBA and the Switch - page 13
* Sending Data to the Switch - page 19
¢ Disconnecting PC-DBA from the Switch - page 21

Sending Data to the Switch

Before data can be exchanged between PC-DBA and the DX-120 system, you must Connect (F5) to the switch. After
you establish a successful connection between the DX-120 processor and the PC-DBA software, the system displays
the word Connect at the bottom of the screen, next to the time and date.

CAUTION!

« When you receive programming from the switch, the system overwrites the
corresponding programming on your PC with the settings from the switch.
Make sure this is what you want to do before proceeding.

e Always perform a Database Save (All) before a Database Receive (All)
operation if you want to preserve the current contents of the working
directory on the laptop.

e Itis recommended that if you are making database changes to a system that
has been in operation for an extended period of time, that you perform a
Receive All operation prior to making any database changes on the laptop.

e Since some database fields (including Speed Dial and Service Mode) are
user adjustable, these fields will be overwritten if you perform a Send All
operation using an outdated PC-DBA laptop database.

From the PC-DBA main screen:
1) Connect PC-DBA to the switch.

2) Go to Control»Send to display a list of categories that represent the information that can be sent.
OR

Sending Data to the Switch (continued on next page)
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Sending Data to the Switch (continued)

3) Press F4 to display a list of categories that represent the information that can be sent.

send Items i x| /Click on these buttons to
. display the list of options for
2 = LT TP OP P fems ‘ p y p

the corresponding category.

4) Locate the category that represents the information you want to receive.
5) Click the Items button to display the list of various options for that category.

6) Click on the specific items you want to receive to select them.
OR

7) Click Select All to select all the items on that screen.
» Use the Unselect All button to deselect all items on the page. You can then reselect any specific items

as needed.

8) Click OK when all your selections have been made to begin the receiving process and download the data
from the switch to your PC/laptop.

HINT
@ Refer to the following pages:

e Connecting PC-DBA and the Switch - page 13
¢ Receiving Data from the Switch - page 18
e Disconnecting PC-DBA from the Switch - page 21
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Disconnecting PC-DBA from the Switch
After you have finished using the link between the DX-120 and PC-DBA, you should disconnect this link. The system
can be disconnected either automatically or manually:

AUTOMATIC DISCONNECTION

The system disconnects automatically if:

« the physical connection path (cable or modem connection) is interrupted (not recommended)
e you exit PC-DBA while the link is active (not recommended)

= after several minutes it senses that someone has not been using the associated tools that require connection (i.e.,
it automatically times itself out).

MANUAL DISCONNECTION

From the PC-DBA main screen:

1) Go to ControlP> Disconnect to disconnect the system from the switch.
OR

2) Press F7 to disconnect the system from the switch.

Once this disconnection is complete:

3) Disconnect any physical connection (cable or modem) between the PC and the switch system as
appropriate.

Initializing (F8) The System

In the programming process it is often desirable to revert to factory defaults (cold start). The Initialize function allows
you to revert the database settings to the factory defaults. While using the various database programming menus, you
can click the Initialize button or press F8 to initialize the current category.

Keep in mind that when you use Initialize, the system saves the restored data only when you exit the screen you are
on. The system then only sends it to the DX-120 switch database when you perform the F4-Send operation.

You can also initialize (i.e., reset) the system without reverting back to factory defaults and reloading the database
(warm start).

Qh-\'- NOTE

.é You can initialize all of the PC-DBA parameters when you install a new system. After
you perform a cold start, connect to the DX-120 processor by clicking Connect or
pressing F5. Then click Receive or press F3 to perform a Receive All and download
all factory settings to a new database file on the PC.

HINT
@ Also refer to the Vertical DX-120 Installation and Maintenance Manual which can be
found on the Vertical CCC website (www.vertical.com/service-login.html).

Initializing the System (continued on next page)
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Initializing the System (continued)

PERFORMING A COLD START
Use Software COLD Start to cause the system to restart operations and reload default customer database data.

CAUTION
A USE THIS FEATURE WITH CARE!

This operation requires confirmation since all calls in progress will be
disconnected and the current database will be erased!

g NOTE

] Once you run this operation, connection between the switch and PC-DBA will be lost.
Therefore, you will have to re-connect to the switch.

After vou connect the PC-DBA to the switch:

From the main PC-DBA Screen:
1) Go to Maintenance®Remote ControlP>Software Cold Start to display a prompt warning you about what
will happen if you continue with this process (i.e. programming operations will be lost, then returned to
default settings).

| Software Cold Start x|

Software Cold Start

Programming operations in KSU will be lost!
Programming status in KSU will return to default
setting.

(Please select "Yes" or "No”)

Yes M

2) Click Yes to execute the Cold Start.
« A message will appear to confirm that a cold start was successfully completed.

EE—— X

Cold start Succeed

Pro
sett

OR
Click No to cancel the Cold Start and close the warning prompt.

3) Click OK to close the window.

HINT
@ Also refer to the Vertical DX-120 Installation and Maintenance Manual which can be
found on the Vertical CCC website (www.vertical.com/service-login.html).
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PERFORMING A WARM START
Use the Warm Start process to cause the system to restart its operations without reloading or affecting the stored

database (e.g., if some how one or more ports lock up, etc.).

CAUTION
A USE THIS FEATURE WITH CARE!

This operation requires confirmation since all calls in progress will be
disconnected.

=g NOTE
.é Once you run this operation, connection between the switch and PC-DBA will be lost.
® Therefore, you will have to re-connect to the switch.

After vou connect the PC-DBA to the switch:

From the main PC-DBA Screen:
1) Go to Maintenance®Remote ControlP Software Warm Start to display a prompt warning you about what
will happen if you continue with this process. (i.e., all system process will be discontinued and any calls in
progress will be disconnected).

RM : Software Warm Start i x|

-~ Warning !

Al system processes will cease!
All calls in progress will be disconnected!

2) Click Yes to execute the Warm Start.
« At the end of the process a message will appear to confirm that a warm start was successfully

completed.
I x|
WWarm start Succeed
OR

Click No to cancel the Warm Start and close the warning prompt.
3) Click OK to close the window.

HINT
44 Also refer to the Vertical DX-120 Installation and Maintenance Manual which can be

found on the Vertical CCC website (www.vertical.com/service-login.html).
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Getting Help (F1)

You can access Help via the main menu bar or from any screen within the program.

From the PC-DBA main screen:

DX120 PC DBA
File Contrel Programming  Maintenance

DM & =367

Click here to display a list of options.

Help

OR

Click here to display the first page of the online help.

1) Click on the Help option on the main menu bar.

| Help

Abouk PC-DBA a

:B HINT
' You can also click on to display the first page of the online help (then, skip to step 3).

2) Selecting Contents to display the main Help screen.
« If you select About PC-DBA you will get information about the version of PC-DBA currently running on
your system.

E? D¥-120 PC-DBA ONLINE HELP =1of={
e o

Hide  Back Fomward  Frint.

| ¥

LCantents: | Index I §earch|

&
o @ Getting Started
@ Frogramming System Resources
@ Programming CO Lines

@ Pragramming Call Handling

@ Programming Toll Restrictions

0 Pragramming niform Call Distribution [| USI NG WI N DOWS PC DATABASE

@ Programming the Yoice Mail Spstem

\ f ‘ Comdial DX-120

@ Programming Estensiors ADMINISTRATION (PC-DBA) |
il @ Programming Feature Buttaris e
5@ Programming for T1 The OX-120 system allows you to administer system database
-0 Programming for ISDM (T1/PRI) parameters using any (=T compatible Personal Computer (PC)
- Multiple Call Harding running Yindows.
For general information abiout this program, please click on the links
helow:
PC-DBA Advantages
< | * ||| Pc-DBA Requirements =

3) Use the tabs (Contents, Search, Index) to find a specific topic for which you need help.
OR

Getting Help (continued on next page)
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Getting Help (continued)

From a specific screen within the program:

1) Press F1 for any individual screen within the program to display the corresponding page from Help for that

screen.
OR

2) Click on any individual screen within the program to display Help for that screen.

EXAMPLE

E? DX-120 PC-DBA ONLINE HELP

oo = &

Hide  Back Foward  Frint

Contents | index | Search |

Frogramming Call Handling d
Q Programming Toll Restictions
1 @ Programming Unifarm Call Distr
0 Pragramiming the Voice Mail Sy:
=) Prograrmiing Estensions
- [7] Reminder Tares
Pragramming Extensicons fo
! Azzigning a Ulser Mame to t
- [2] hssigning Estensions o Ter
- [2] hssigning Estensions to Pic
g @ Aizgigning Extensions to Pa
- [2] hssigning Extensions toa C
: @ Setting up Manitoring Privile

o

Lo I Rt s et
q I :

Setting Up Extensions for
Automatic Recording

When this feature is enabled for an
extension, the system will record all
conversations at that extensian
automatically whenever the user is on an
internal/external call. The record function
is deleted automatically after the call is
released or placed on hold unfess the
user presses the Voice Recorder button
(FEATURE B 7) to save the recorded
conversation before ending ar holding the
call When saved, the conversation is
stored in the extension user's mailbox =

Click on the Help button
from any screen...

pplication - Auto Recording Me

[ Memberd: |—_|-~ Mfe_.vr"r'rbgr‘a"._r _;|
...to display the corresponding page in online help. \ e | El MEmRasi] E
Memberd: I—;| Me_rrrber?-.’-l_ _:|
MEimE'efﬂzl_ < Memberd: |' L_LI
Update | lnil_ialize:FB” Tiose™ -;' Help I |
HINT
ol If you are unable to find the information you need in the Help system, contact Vertical

Technical Support for assistance.
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USING ANY DIGITAL EXTENSION TELEPHONE (DET)

The DX-120 system allows you to program system database parameters using any DX-120 DET. It is possible to
program the DX-120 system while the telephone is in use; however, certain button operations are used during
programming and cannot be used for telephone call processing. Therefore, Vertical suggests not using these features
simultaneously unless you have been directed to do so by the servicing technician.

The Database Administration password is set by default to ######## (eight #s). You can use any combination of
alphanumeric characters using the conventions of extension/CO line name.

Entering the Database Administration Mode

1) Press Feature, then # * to enter Database Administration.
* The system then prompts for the system Database Administration password.

e The default set at the factory is ######HE.

2) Enter the password and press show (show is an LCD interactive button).
« After you have correctly entered the password, the system gives you access to Database
Administration.
¢ You can also change the password at any time - see “Changing Database Administration Password” on
page 27.

LCD Interactive Buttons
The LCD interactive buttons are essential to completing database programming tasks. These buttons take on many
functions while in the database administration mode. LCD interactive buttons include the following.

next —moves the cursor to the next item or parameter

back—moves the cursor back one item or parameter

show—shows the contents of the current item or parameter

chg—changes the contents of the current item or parameter

bksp—when you are entering data, backspaces over what you entered so you can correct it

save—saves entered data
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Database Item Select Screen

After you enter the correct password and press show, the system opens DX-80 Database Administration and displays
the Database Item Select screen. This screen allows you to skip to the necessary database item for immediate
programming of that item. The coding instructions you enter for each database item correspond to the following list:

To Program Enter

EXTENSION 01-
CO LINE 02-
CALL HANDLING 03-
SYSTEM RESOURCE 04-
RESTRICTION 05-
EXTENSION APPLICATION 06-
CO LINE APPLICATION 07-
SYSTEM APPLICATION 08-

EXAMPLE

To skip to the extension application section of database administration, enter 06 at
the DB Item Select screen and press save. If you want instead to go to system
resources, enter 04 at the DB Item Select screen and press save.

Exiting Database Administration

To exit the Database Administration when you are finished programming or need to perform another task (e.g., make a
phone call):

Press the SPK button twice.
OR
Lift and replace the handset in the hook-switch cradle.

Changing Database Administration Password

1) Press Feature, then # * to enter Database Administration.
¢ The system then prompts for the system Database Administration password.

e The default set at the factory is #####HHHE.
2) Press show to display the DB Item Select screen.
3) Enter 04-01.
4) Press save to display to the System Resources — DB PSWD screen with the current password.
5) Press chg to change the password.
6) Enter a new eight-character, alphanumeric password.

IMPORTANT!
A Press # after entering each character that makes up the password.

7) Press save.
8) Exit the programming mode.
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SECTION 3 - GETTING STARTED

OVERVIEW

Before beginning to program a new system, it is important that you determine what configuration will best meet your
customer’s needs.

The DX-120 Numbering Plan contains all of the configuration defaults provided with the system. If you need settings
other than those provided, you will need to customize the Numbering Plan. Since you will be programming aspects
that can be affected by the Numbering Plan, it is best to customize the plan before programming the remainder of the
system. For details on modifying the default Numbering Plan see “Customizing the Numbering Plan” on page 103.

SHORTCUTS THAT HELP YOU WORK FASTER

Vertical also provides you with some tools you can use to reduce your programming time. These tools include:

= a series of worksheets for you to plan your system structure, and to record the programming for future reference if
necessary. These worksheets are provided in Appendix A, Worksheets.

e using one of four standard database programming templates provided with the DX-120 product CD. You can
choose the template that most closely matches your new customer’s site needs, and then add whatever custom
changes you need to make. This approach saves you the time of programming the entire system from scratch.

e copying a baseline CO line or extension’s setups to several other CO line or extensions, thereby eliminating the
need to program them individually.

= using the directory number/feature number lookup when you need to know a specific directory number or feature
code you need to enter at the DET speakerphone, and

e resetting an extension to its default settings during troubleshooting and fault isolation procedures.

< In addition, button label templates for customizing individual DET button definitions are provided in Appendix B,
Button Labeling.

Using a Database Programming Template

Six programming templates have been provided that you may use as a shortcut when setting up your customer’s
database; one template with no voice mail and five templates with voice mail options.

= You can copy the template that is closest to your customer’s requirements, and then customize it further if
necessary to further meet their needs.

e These six database templates are provided on the DX-120 product CD.

« While you are not allowed to modify the templates on the CD, you can download them to your laptop and then
customize them further as needed.

E CAUTION

e These templates are provided to reduce your programming time when
setting up a new system. You can use them for existing systems, but you will
lose whatever custom settings are currently in place on that system.

e Be aware of this when downloading a template from PC-DBA to an existing
system with a lot of customized features, as you will have to reprogram
those features.

HINT
@ For further details on using the database templates, refer to the Read Me file on the
DX-120 product CD.
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Copying Baseline CO Line Setups

This is a programming aid feature. Once you have programmed one CO line for the baseline configuration settings,
you can copy those setting to other CO lines using this utility. Copying these setups requires two separate procedures
whether you program via PC-DBA or by DET:

You must:
A) Program the CO Line Setup to be copied
B) Copy the programmed CO Line Setup - Setups can be copied one line at a time or several lines at a time

COPYING BASELINE CO LINE SETUPS VIA PC-DBA

PROGRAM THE CO LINE SETUP TO BE COPIED
See “Section 5 - Programming C.O. Lines” for additional information about programming C.O. lines

COPY THE PROGRAMMED CO LINE SETUP

From the PC-DBA main screen:
1) Go to ProgrammingP>System Application® Configuration Copy to display the Configuration Copy screen.
Copy the line(s) as needed:

Copy CO Lines One at a Time
2) Locate the Individual area under CO Line Copy.

3) Select the CO line directory number you want to use as a baseline from the dropdown list in the Source
DIR No. field.
« Valid directory numbers are 800 through 839.

* There is no default.

4) Select the CO line directory number into which you want to copy the baseline’s programming (800-839) in
the Destination DIR No. field.

5) Click Copy to make the specified copy.
« Enter any other CO line numbers as needed using the steps above.

« If needed, you can enter another source CO line directory number to copy from, and continue the
process for other CO lines.
Now... continue on to step 6 on the following page.

OR

Copy the Programmed CO Line Setup via PC-DBA (continued on next page)
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Copy the Programmed CO Line Setup via PC-DBA (continued)

Copy a CO Line Setup to All the Lines in a Line Group
2) Locate the Group area under CO Line Copy.

3) Select the CO line directory number you want to use as a baseline from the dropdown list in the Source
DIR No. field.
« Valid directory numbers are 800 through 839.

¢ There is no default.

4) Select the CO group number into which you want to copy the baseline’s programming (9 and 740 through
746) in the CO Group field.

5) Click Copy to make the specified copy.
< Enter any other CO group numbers as needed using the steps above.

Now... continue on to step 6 below.

When all copies have been made:
6) Click the Update button to enter and save your settings into the database on your local disk.

7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

8) Perform a SEND to copy the database changes to the DX-120 switch system memory.

CoOPYING BASELINE CO LINE SETUPS VIA THE DET

PROGRAM THE CO LINE SETUP TO BE COPIED
See “Section 5 - Programming C.O. Lines” for additional information about programming C.O. lines

COPY THE PROGRAMMED CO LINE SETUP

Qh-\'- NOTE
.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display a prompt for
the password.

2) Enter the DB Admin password.

Copy the Programmed CO Line Setup via the DET (continued on next page)
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Copy the Programmed CO Line Setup via the DET (continued)

Copy CO Lines One at a Time
3) Enter 08-11-01.
4) Press save to display the Individual CO Line Copy screen.
5) Press show to display the prompt: “COPY FROM".
6) Enter the CO line directory number you want to use as a baseline.
7) Press save to display the prompt “COPY TO".
8) Enter the CO line directory number you want to copy the baseline’s programming into (800-839).

9) Press save to store the copy and again display the prompt “COPY TO".
e Continue entering CO line directory numbers CO lines to which you want to copy the baseline setups.

* Press save each time you enter a directory number.
10) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Copy a CO Line Setup to All the Lines in a Line Group
3) Enter 08-11-02.
4) Press save to displays the Group CO Line Copy screen.
5) Press show to display the prompt: “COPY FROM".
6) Enter the CO line directory number you want to use as a baseline.
7) Press save to display the prompts “COPY TO".

8) Enter the CO line group directory number into which you want to copy the baseline’s programming (9,
740-746).

9) Press save to store the setups to all of the CO lines that are part of that CO line group.
¢ The system prompts “COPY TO” again so that you can save the setups to another line group if desired.

¢ Continue entering CO line group directory numbers where you want to save the baseline setup.
« Press save each time you enter a CO line group directory number.

10) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Copy the Baseline Setups (continued on next page)
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Copy Baseline Setups (continued)

COPYING BASELINE EXTENSION SETUPS

You can use this database feature to quickly copy the various programming and settings for one extension to other
extensions. Copying these setups requires two separate procedures whether you program via PC-DBA or by DET:

You must:

A) Program the Baseline Extension Setup to be copied

B) Copy the programmed Baseline Extension Setup - Setups can be copied one line at a time or several lines at a
time

COPYING BASELINE EXTENSION SETUPS VIA PC-DBA

PROGRAM THE BASELINE EXTENSION SETUP TO BE COPIED
See page “Section 10 - Programming Extensions” on page 385 for information about programming baseline
extensions.

T NOTE
When using group copy, all extensions you want to receive the programming must be
programmed for the same pickup group.

From the PC-DBA main screen:
1) Go to ProgrammingP>System Application® Configuration Copy to display the Configuration Copy screen.
Copy the line(s) as needed.

Copy Individual Extension Settings
2) Locate the Individual area under Extension Copy.

3) Select the extension directory number you want to use as a baseline from the dropdown list in the Ext DIR
No. field.
« You can enter any valid extension number in the system.

¢ There is no default.

4) Select the extension directory number (from the Ext DIR No. field to the right of the arrow) into which you
want to copy the baseline’s programming (i.e., any valid extension).

5) Click on Copy to copy the specified settings.
< Enter any other extension numbers as needed using the steps above.

« If needed, you can enter another source extension number to copy from, and continue the process for
other extensions.

Now... continue on to step 6 on the next page.

OR

Copy the Programmed CO Line Setup via PC-DBA (continued on next page)
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Copy the Programmed CO Line Setup via PC-DBA (continued)

Copy All Lines in a Pickup Group
2) Locate the Group area under Extension Copy.

3) Select the extension number you want to use as a baseline from the dropdown listin the Ext DIR No. field.
« You can enter any valid extension number in the system.

¢ There is no default.

4) Select the pickup group number (from the Pickup Group field) into which you want to copy the baseline
programming (i.e., any valid pickup directory number).

5) Click on Copy to make the specified copy.
< Enter any other pickup group numbers as needed using the steps above.

« If needed, you can enter another source extension directory number to copy from, and continue the
process for other pickup groups.

Now... continue on to step 6 on the next page.

When all extensions or pickup group settings are copied:
6) Click the Update button to enter your settings into the database on your local disk.
7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
8) Perform a SEND to copy the database changes to the DX-120 switch system memory.

COPYING BASELINE EXTENSION SETUPS VIA THE DET

PROGRAM THE CO LINE SETUP TO BE COPIED
“Section 5 - Programming C.O. Lines” for detailed information about programming C.O. lines

COPY THE PROGRAMMED CO LINE SETUP

Qh-\'- NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display a prompt for
the password.

2) Enter the DB Admin password.

Copy the Programmed Baseline Extension Setups via the DET (continued on next page)
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Copy the Programmed Baseline Extension Setups via the DET (continued)

Copy Individual Extension Settings
3) Enter 08-12-01.
4) Press save to display the “INDIVIDUAL COPY” programming screen.
5) Press show to display the prompt: “COPY FROM".
6) Enter the extension directory number you want to use as a baseline.
7) Press save to display the prompt: “COPY TO".
8) Enter the extension number into which you want to copy the baseline setups into.

9) Press save to store the copy and again display the prompt “COPY TO".
« Use the steps above to copy other extensions as needed.

* Press save each time you copy an extension.
10) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Copy All Lines in a Pickup Group
1) Enter 08-12-02.
2) Press save to display the “GROUP COPY” programming screen.
3) Press show to display the prompt: “COPY FROM".
4) Enter the extension directory number you want to use as a baseline.
5) Press save to display the prompt: “COPY TO".
6) Enter the pickup group number into which you want to copy the baseline setups into.

7) Press save to copy the programming of the baseline extension into all the extensions in the specified
pickup group and again display the prompt: “COPY TO".
« Use the steps above to copy programming to other pickup groups.

8) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Feature / Directory Number Lookup

The DX-120 system has many features and codes, and at times it may be difficult to remember the code for the
necessary feature. The DX-120 has a built-in feature code directory to allow you to look up the codes from a DET
phone.

While the telephone is idle (no call activity):
1) Press Feature # 5 to display the following screen:

DIR#-CODE LOOKUP
dir  fitr suffix

2) Use the corresponding method shown below and on the following pages to find the needed number or
code.

When you want to exit Feature/Directory Number Lookup:
3) Go off-hook, then on-hook (or press the ON/OFF button twice) to exit.

FIND A SYSTEM DIRECTORY NUMBER

1) Press dir to display the first screen of directory number listings (see 471 for a listing of the default
directory numbers).

2) Press next (and/or back) to move through the list until you see the item you want to select.
AND/OR
Press Hold to go back to a previous screen level.

When you find the item you want to use:
3) Press the button that corresponds to the item you want to display the appropriate number for that item.

EXAMPLE
To show the directory number assigned to CO line groups, press the button that
corresponds to co gp.

4) Make a note of that number for future reference.

FIND A FEATURE AcCCESS CODE
1) Press ftr to display the available features listed alphabetically and abbreviated (see 472 for a listing of the
default feature access codes).

2) Press next (and/or back) to move through the list until you see the feature you want to select.
AND/OR
Press Hold to go back to a previous screen level.

Once you find the code you want:
3) Make a note of the code for future reference.

Feature / Directory Number Lookup (continued on next page)
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Feature / Directory Number Lookup (continued)

FIND A SUFFIX CODE

1) Press suffix to display a list of digits dialed after system resource directory numbers displays (see page
474 for a listing of the default suffix codes).

2) Press next (and/or back) to move through the list until you see the suffix you want to select.
AND/OR

Press Hold to go back to a previous screen level.

When you find the number you want to use:

3) Press the button that corresponds to the suffix you want to select.

Resetting an Extension to the Default Set
When extension users have invoked several features on their extensions, it may be necessary to clear all settings and
return the telephone set to the factory condition. The Default Set code is used to perform this operation.

The following extension parameters are reset to the value shown:
e LNR = empty
= SNR = No Saved Number
e Memo = No Saved Number
e Telephone Lock = No
= Auto Hold = No
e Page Receive = Yes
e Busy Ring = Yes
= Hotline to = NULL (none)

To return an extension’s settings to the default settings:.

1) Press Feature 6 9 to display the prompt:

2) Press go to load the default set into the phone.
< You will hear the confirmation tone when the operation is complete.
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SECTION 4 - PROGRAMMING SYSTEM RESOURCES

OVERVIEW

The system features allow you to control system administration and to assign system resources. The DX-120 provides
programmable features that allow you to establish these various settings.

BASIC SYSTEM PROGRAMMING TASKS

CAUTION

Database changes reside only on your computer. When you have finished making all
changes to the database, perform a SEND operation to download the new database to
the DX-120 switch.

e Assign the attendant extension for each tenant group - see page 40
* Assign the system reminder for each tenant group - see page 45

= Set up the system time, date, and hour mode - see page 49

e Set up the ring scheme - see page 55

< Name each CO line - see page 58

= Set up the pre-programmed incoming and outbound messages - see page 60
e Program speed dial numbers - see page 64

e Set Caller ID in the CID Names and Assignments table - see page 72
= Establish the music source for the each tenant group - see page 83

e Assign the external pager a tenant group - see page 77

e Establish Loud Bell Setting - see page 80

= Assign the DSS port owner - see page 89

e Set up the optional internal modem - see page 93

e Select the PC-DBA transmit rate - see page 95

e Select the SMDR transmit rate - see page 97

e Set up/modify the numbering plan you want to use - see page 103

e Set the daylight savings time feature - see page 287

= Set the user passwords and names for extensions - see page 387

e Specify the letter type - see 476
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Assigning Attendants

You assign a primary attendant to each of the DX-120 system'’s three tenant groups. The standard Digital
Speakerphone serves as the attendant telephone. When assigned as attendant, this extension supports general
system functions like line recall, forced incoming ICM call forward, and manual evening or alternate service mode
operation. The attendant receives all intercom calls directed to the attendant directory number (“0” at default). The
attendant extension has an internal call queue that allows multiple intercom calls to be directed to the attendant at the
same time.

You can designate an alternate attendant position in each tenant group for common sharing of incoming CO line calls
or load sharing during peak traffic periods.

e The attendant’s extension has (with a password) control of:
- System Service Mode (day/evening/alternate/time)
- Time of Day Settings
- System Speed Dial Number Programming
- Recording of the Optional Auto Attendant Greetings

e You can connect the attendant extension to any system station port, and you can assign it any intercom extension
number in your numbering plan (see “Customizing the Numbering Plan” on page 103).

e The following conditions apply to the attendant extension:
- Any extension in the tenant group can dial 0 to reach the attendant extension.

- The system routes all unanswered transferred calls and all calls from any extension that invokes forced
intercom call forward to the attendant extension. When multiple internal calls are waiting in queue for the
attendant extension, the display indicates on the second line the number of calls waiting in the queue.

LINE 3 (145
-2

- The extension password for the attendant extension is required for entry into attendant administration, caller
ID table and ring mode. The default extension password is 9999.

- Only the designated attendant extension can manually change the system ring mode or the extension room
status (hotel mode).

Attendant Extension (continued on next page)
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Attendant Extension (continued)

e Features settings that can affect the attendant extension include the following.
- Do Not Disturb (i.e., forced DND)

- Hotel Mode
- Room Status (F7#)

- Attendant Administration (F#0)

- Service Mode Change

- Auto Attendant Message Record/Review

- Temporary Service Mode
- System Speed Dial

- Call Forward Auxiliary Lamp

- Extension User Password (F97)
- Caller ID Table (review) (F6#)

- Ring Mode (F63)

e Once you have programmed the attendant extension (see page 40), program the user password for that

extension.

ASSIGNING ATTENDANTS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance: Help

Extension

b
»
‘Restriction ]
Extension Application *
.0, Line Application b
Syskam Application 3
Feature Key Programiming  »
K5 DB Passward

System Reminder g

User Mames and Passwords

0 Line Mames

Preprogrammed Message

SPD.Ma, Assignment and Programmming
CID Wame Table &ssignment and Programming
External Pager

Loud Bell

D55 Allocation

Maden &nd Serial Part
Remote Ext Table

CID Transfer Table

Assigning Attendants via PC-DBA (continued on next page)
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Assigning Attendants via PC-DBA (continued)

1) Go to ProgrammingP>System Resource>Attendant to display the Attendant screen.

¢ This screen has two parts: a table at the top that summarizes the current settings, and some entry
fields at the bottom that are used to change the information in the table.

RP:Resource- Attendant |
Tenant| Attendant | At D551 | Att D552 | At D553 | A0S5S4 | Alternate | ALDSS1 | AltDSS2 | At D553 | Al D554
1:101
2
3
A
Attendant [1:101 - Alternate | 'vl
AttDSS1 | AltDast |
Tenant
AttDSS2 |
1 Alt D552 |
AttDS53 | [E—| AltDEs3 |
Att DS54 | Alt DS54 |
Update | Initialize(FE) | Close | Help |

2) Click on the line that corresponds to the tenant group you want to program
e "1"is highlighted initially.

IMPORTANT!
A If you are not using a tenant group, leave the Attendant and Alternate fields blank.

3)Click the down arrow to the right of the Attendant field.

Attendant [1:101 j

MA
Att.DSS1 (2102
3103 J
Att.DSS2 4104
5105
6106
’ : 707
Att.DSE4 o905
9:109
10:110
—{11:111
121112
13:113 B

Att.DSE3

4) Scroll to the extension/directory number you want to use for the primary attendant

5) Click on that extension.

« Valid numbers are any extension within the tenant group you have not already assigned as an alternate
attendant.

¢ The default is 101.

6) Click m in the middle of the screen to move the number you have selected into the table.
« Your selections are now entered for the tenant group you selected in Step 2.

Assigning Attendants via PC-DBA (continued on next page)
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Assigning Attendants via PC-DBA (continued)

Assign the Alternate Attendant Extension
If you do not wish to assign an alternate attendant extension, leave the field blank and skip to step 8.

7) Click the down arrow next to the Alternate field to display the list of available extensions.

Alternate =

-

AltDEST {1107
2:102 —
AltDES2 31103

AltDEEF 5105

. |B:108
AltDEE4 (7907

£108
J 5109
1110
11111
12112
13113 &

« Follow steps 4 through 6 as shown above to set the Alternate Attendant extension.

« Follow steps 2 through 6 to assign primary and alternate attendant extension numbers to other tenant
groups

When you have completed all entries:

8) Click the Update button to enter and save your settings into the database on your local disk.

9) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

10) Perform a SEND to copy your new database to the DX-120 switch system memory.

Attendant Extension (continued on next page)
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Attendant Extension (continued)

ASSIGNING ATTENDANTS VIA THE DET

=5 NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display a prompt for
the password.

2) Enter the DB Admin password.

3) Press show to display the DB Item Select screen displays.

Program the attendant extension
4) Enter 04-02-x-01, where x is the tenant group number., then press save.

5) To change the designated attendant extension press chg. Enter the extension number you want to assign
as the attendant extension.

=y NOTE
You can only assign valid extension directory numbers as tenant group attendants.
® You cannot use extensions that are programmed as attendants for other tenant
groups or as alternate attendants.

6) Press save.

Program the alternate attendant extension
7) Return to the Database Item Select screen by pressing the Volume button (up or down).
8) Enter 04-02-x-06, where x is the tenant group number.

9) Press save to save the setting.

To change the designated attendant extension
10) Press chg (change) to display the extension number prompt.
11) Enter the extension number you want to assign as the alternate attendant extension.

=y NOTE
You can only assign valid extension directory numbers as tenant group attendants.
® You cannot use extensions that are programmed as attendants for other tenant
groups or as alternate attendants.

12) Press save to save the setting.

13) Program the user passwords (see “Assigning a User Password, Password Length, and/or Name to
Extensions” on page 387) for each attendant extension and alternate attendant extension you have
programmed.
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Assigning System Reminders
You can set the DX-120 system to alert all phones at predetermined intervals during the day; you can choose up to
eight reminders. You specify the play time, which tells the system how long (from 1 to 10 minutes) to play the music.

The system uses the music source connected to the MC1 connector for the system reminder (unless the internal music
source is selected by an option strap on the CPM-- refer to the Vertical DX-120 Installation and Maintenance Manual
which can be found on the Vertical CCC website (www.vertical.com/service-login.html).

When the system reaches the time a reminder is to start, it plays the output from the internal or MC1 music source over
all digital extensions. The system plays this music for the length of time you specify: from one to ten minutes.
e The following conditions apply to system reminders.

- The music alarm will not play at an extension that is busy on a call (handset or speakerphone), or in the Do
Not Disturb (DND) mode.

- The system cancels any system reminder in progress when another function is invoked.
- The system uses the music source connected to the MC1 music input for the system reminder.
- Extensions monitoring background music channel MC1 will not recognize the system reminder.
IMPORTANT!
Before programming a system reminder, make sure the system time is accurate to

the current local time by downloading the switch time (especially if you are not
currently on site to check the accuracy).

HINT

5 A related feature that can affect system reminders is the Music Source field under Numbering Plan 2.
See “Establishing Music Sources” on page 83.

Assigning System Resources (continued on next page)
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Assigning System Resources (continued)

ASSIGNING SYSTEM REMINDERS VIA PC-DBA

From the PC-DBA main screen:

Programming. Maintenance: Help
»
»
»
Extension Application »
C.0, Line Application 4 00 Lire Mames:
Syskem Application b Preprogrammed Message
Feature Key Programming » SPD.Mo. Assignment and Programming.
K50 OB Passward CID Name Ta:h]_e'.Assigr_ln;lqnt.and Frogramming
External Pager
Loud Bell
055 Allocation
Madern And Serial Port

Remote Ext Table
CID Transfer Table

1) Go to ProgrammingP> System ResourcesP>System Reminders to display the System Reminder screen.

Y

Tenant 1 TerantZ  Tenant3 |
(HEMMY  (HHMMY (HH:bM)

Rerindar

Remiﬁder?.

Rernindar 3.

Reminder 4

Reminders

Reminder &

Reminder 7

Reminder 8

FlayTime | [1rin | [tmin =] [1min =]

Update | Initiallzs(FS)l Close | Help |

2) Enter the time at which you want the system to play into the Tenant 1 -Reminder 1 field.

RP: Resource - System Reminder il

Tenant 1 Tenant 2 Tenant 3 |
(HH:MM) {HH MM {HH: Mt
Rerminder 1 |1D:DEl | |

¢ This must be entered, in 24 hour (military) format.
¢ Valid times are from 00:00 to 23:59.
e The default is blank (no reminder).

Assigning System Reminders via PC-DBA (continued on next page)
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Assigning System Reminders via PC-DBA (continued)

3) Select a maximum duration in minutes from the Play Time field for the system to play the reminder.

1 min
2min k

3min

* Valid entries are even numbers of minutes, from 1 to 10.
¢ The default is 1 minute.
e Program other reminders (1-8) as needed using the steps above.

Repeat steps 2 and 3 for each reminder you want to set.

Tenant1 Tenant2  Tenantd |
(HEMM) (HHMM)  (HH:biM)
Reminderq | [ 1000 [ 0g:00 10:30
Refninder2 | |13:00 12:00
Reminder 3 16:00

When all reminders have been set:
4) Click the Update button to enter and save your settings into the database on your local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy your new database to the DX-120 switch system memory.

Assigning System Reminders (continued on next page)
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Assigning System Reminders (continued)

ASSIGNING SYSTEM REMINDERS VIA THE DET

=3 NOTE
.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 03-19.
5) Press save to display “ALARM PLAY”.
6) Press chg until the alarm play time (in seconds) you want to use displays.
7) Press back or next to continue programming.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting System Time, Date, and/or Hour Mode

The DX-120 system provides a built-in time clock to track system time for certain features.

=y NOTE
If you check this in PC-DBA, what you are seeing is the current time on your PC, not
* the current time on the switch.

SYSTEM TIME CLOCK DETAILS
Features that can use the built-in system clock include system night service mode change, SMDR, alarm clock —
system, automatic CO line ringing, extension, and time and date display at executive speakerphones.

e This clock is battery-protected from power failure.
* You can change the system time at any DET, using the attendant password.

= You can also choose what time format (standard 12-hour time or 24-hour time) the system uses to display the time
at DETs.

e The following conditions apply to the hour mode.
- The system does not display “AM” and “PM” indications.
- When programming time-related features, use 24-hour format.
- SMDR output is in 24-hour format regardless of the settings of hour mode.

SETTING SYSTEM TIME, DATE, AND/OR HOUR MODE VIA PC-DBA
SETTING THE HOUR MODE

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling
Syskem Resource
Restriction

‘DX-120

General Settings I

Extension Application

)
C.0, Line Application

System Application

.3
3
3
13
L3
L3
13

Feature Key Programming

Mumbering Plan

K5 DE Password Time Switching

DIR# and Port Map »
Configuration Copy
Syskem Time

Setting theHour Mode via PC-DBA (continued on next page)

- 49 -



BASIC SYSTEM PROGRAMMING TASKS DX-120 Programming Manual

Setting the Hour Mode via PC-DBA (continued)

1) Go to ProgrammingP> System Application® General Settings to display the System Application—General
Settings screen.

RP: System Application - General Settings I ll

Ring Scherme: I_ vI Letter Type: lD vl
‘Hour Mode: & 12 24 ‘ Self-Test Time: |

~PC-DBA Connection

Auto Log Off: IZD 'I Min.  Log On Again: |30 'I hin.
~Suffix Code
ICM Ring /Woice: |* =) Intrusion: 8 =
DMND Override: 3 | MSG Waiting: |3 ¥
Camp On: 4 - 1Chd OHWA: IU vl
Call Back: # | Manitor: |1 vl
Call Pickup: |6 'I
Update | Initialize(Fa) | Claze | Help |

2) Click to select the hour mode you want to use (i.e., 12 or 24).
e The default is 12.

3) Click the Update button to enter your setting into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

SETTING THE TIME AND DATE

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling 13

System Resource » P o

Restriction » Dx-1 2 o ]

Extension Application 3

C.0, Line Application »

n Application 3 General Settings

Feature Key Programming ¥ Mumbering Plan

K5 DB Password Time Switching
DIR# and Port Map  #
Configuration Copy

Setting the Time and Date via PC-DBA (continued on next page)
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Setting the Hour Mode via PC-DBA (continued)

5) Go to ProgrammingP System Application® System Time to display the System Application—System

Time screen.
System Time L |
Year: 2006
hdonth: SEP b
Drary: 13 -
veekday: hWED -

Hour: l

| 4 - l
hinLte: I 36

6) Enter the current year.

7) Select the current month.
e The default is JAN.

8) Select the day of the month.
e The default is 1.

=y NOTE
As you select the day, the system automatically changes the Weekday field to reflect
the day of the week for the year, month, and day you entered.

9) Select the current hour.
* Remember that time on the DX-120 is entered and shown in military format (i.e., 00:00 to 24:00).

Therefore, valid choices are 1 to 23.
¢ The default is 0.

10) Enter the current minute.
e The default is 0.

11) Click the OK button to exit the System Time screen and return to the PC-DBA main screen.

When You have Finished All Programming Changes

12) Perform a SEND to copy the database changes to the DX-120 switch system memory.
« Be sure to check the System Time option.

Setting System Time, Date, and/or Hour Mode (continued on next page)
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Setting System Time, Date, and/or Hour Mode (continued)

SET SYSTEM TIME, DATE, AND/OR HOUR MODE VIA THE DET

—x NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Change the Year

From the DB Item Select screen:
4) Enter 08-14-01 to display the current year (e.g., "YEAR :06").
5) Press chg.
6) Enter 2 digits for the new year setting.

7) Press save.

8) Pressing next to go to the month setting (now go to step 5 under “Change the Month:” below).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Change the Month:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 08-14-02 to display the current month.
5) Press the chg until the month you want is displayed.

6) Press next to go to the month setting (now go to step 5 “Change the Date:” below).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting System Time, Date, and/or Hour Mode (continued on next page)
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Setting System Time, Date, and/or Hour Mode (continued)

Change the Date:

From the Select screen (see steps 1 through 3 above):
4) Enter 08-14-03 to display the current date.
5) Press chg.
6) Enter 2 digits for the new date setting.

HINT
@ You must always use a two-digit format: if you want to set the date for the 9th, you
would need to enter it as 09.
7) Press save.

8) Press next to go to the month setting (now go to step 5 “Change the Day of the Week:” below).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Change the Day of the Week:
You can continue from step 8 above or:

From the Select screen (see steps 1 through 3 on page 52):
4) Enter 08-14-04 to display the day of the week.
5) Press chg until the day of the week you want is displayed.

6) Press next to go to the month setting (now go to step 5 “Change the Hour:” below).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting System Time, Date, and/or Hour Mode (continued on next page)
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Setting System Time, Date, and/or Hour Mode (continued)

Change the Hour:
You can continue from step 6 above or:

From the Select screen (see steps 1 through 3 on page 52):
4) Enter 08-14-05 to display the hour.
5) Press chg.
6) Enter 2 digits for the hour.

HINT
@ Hours must be entered using the military format and must always be entered as 2
digits: 1pm must be entered as 13, 2pm would be entered as 14, etc.
7) Press save to store the setting.
8) Press next to go to the month setting (now go to step 5 “Change the Minutes” below).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Change the Minutes
You can continue from step 8 above or:

From the Select screen (see steps 1 through 3 on page 52):
9) Enter 08-14-06 to display the minutes.
10) Press chg.
11) Enter 2 digits for the minutes.

HINT
You must always use a two-digit format: if you want to set the minutes at 5 after the
hour, you would need to enter it as 05.

12) Press to store the setting.

When you are finished:
13) Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Ring Scheme

Discriminating Ringing is provided to denote ringing patterns specific to system resources. Ringing at an extension for
intercom calls is different than ringing for CO line calls; this difference is referred to as discriminating ringing. There are
10 ringing options from which to choose.

Ring External Internal Callback Bee Double Door-phone
Scheme Ring Ring Ring P Beep Ring
300ms on
400msoff 1sec. on 300ms on 250ms on 250ms on gggm: g?f 2sec. on
300ms on 4sec. off 400ms off 250ms on 1sec. off
then off 500ms on
4sec.off repeat repeat then off then off repeat
repeat
350ms on
300ms off 1sec. on 300ms on 250ms on 500ms on 2sec. on
250ms on 250ms off 500ms off
350ms on 5sec. off 400ms off then off 250ms on 500ms on 1sec. off
5sec.off repeat repeat then off then off repeat
repeat
300ms on 250ms on
1sec.on 400ms off 300ms on 250ms on 250ms off gggm: S?f ﬁ:g g?f
4sec. off 300ms on 400ms off then off 250ms on 500ms on repeét
repeat 4sec. off repeat then off
repeat then off .off repeat
300ms on
1sec. on 400ms off 300ms on 250ms on 500ms on 2sec. on
2sec. off 300ms on 400ms off 250ms on 250ms off 500ms off 1sec. off
repeét 2sec. off repeat then off 250ms on =00ms on repeét
repeat then off then off
250ms on 500ms on
2sec. on 1sec. on 300ms on 250ms on 250ms off 500ms off 2sec. on
4sec off 2sec. off 400ms off then off 250ms on 500ms on 1sec. off
repeat repeat repeat then off then off repeat
250ms on 500ms on
1sec. on 1sec. on 300ms on 2sec. on
250ms on 250ms off 500ms off
?jegéf i rl.:egéf it f'gog; off then off 250ms on 500ms on rleseé:éto Ul
p P p then off then off p
200ms on
600ms on 200ms off
250ms on 500ms on
1sec. on 200ms off 200mson 250ms on 250ms off 500ms off 2sec. on
4sec. off 200ms on 200ms off then off 250ms on 500ms on 1sec. off
repeat 4sec.off 200ms then off then off repeat
repeat on4sec.off
repeat
Zggmz gpf 1sec. on 300mson40 250ms on 250ms on 500mson50 2sec.onlsec
300ms on 3sec of Omsoff then off 250ms off Omsoff off
250 ms on 500 ms on
1 sec. on 1 sec. on 300 ms on 2 sec. on
3 sec. off 3 sec. off 400 ms off 250 ms on 250 ms off 500 ms off 1 sec. off
repeat repeat repeat then off 250 ms on 500 ms on repeated
P P P then off then off p
300 ms on
1 sec. on 400 msoff | 300mson | oo o | SogMSOR | 200MSOR 2 sec on
3 sec. off 300 ms on 400 ms off then off 250 ms on 500 ms on 1 sec. off
repeat 4 sec. off repeat repeat
repeat then off then off

Setting Up Ring Scheme (continued on next page)
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Setting Up Ring Scheme (continued)

SETTING UP RING SCHEME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance
Extension
C.0, Line
Call Handling 3
Syskem Resource 3
Restriction 3
Extension Application 3
C.0, Line Application 3
System Application 3
13

Help

Feature Key Programming
K5U DE Password

‘DX-120

General Settings
Mumbering Plan

Time Switching

DIR# and Port Map »
Configuration Copy
Syskem Time

1) Go to ProgrammingP System Application® General Settings to display the Application—General Settings

screen.

RP: System Application - General Settings '_ ll

Ring Scheme: _ -

‘Hour Mode: & 12 24 ‘

Letter Type: lD vI
Self-Test Time: |

~PC-DBA Connection

Auto Log Off: IZD 'I Min.  Log On Again: |30 'I hin.

~Suffix Code

ICh Ring / Woice:
DMND Override:
Camp On:

Call Back:

Call Pickup:

Ll ]«

i

Update |

Initialize(Fa) |

Intrusion: 8 =
MSG Waiting: |3 ¥
ICht OHWA: ID vl
Manitor: |1 vl
Claze | Help |

In the Ring Scheme field:

Ring Scheme: |3

o —

Hour Mode: 3]

FC-DBA Connegl
Auto Log Off: I

Suffix Code—

Lobd O L

LUu I Bt B p I

|

il [KN

2) Select the desired ring number that corresponds to the ring schemes you want to use.
¢ Valid entries are 0 through 9 (see table on page 54).

¢ The default is 3.

Setting Up Ring Scheme (continued on next page)
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Setting Up Ring Scheme (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

PROGRAMMING RING SCHEME VIA THE DET

Qh-\'- NOTE

.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 08-01.

5) Press save to display the Ring Scheme programming screen.

6) Press chg until you see the ring scheme setting you want to use.
« Valid options are O - 9 (see table on page 54).
e The default is 3.

7) Press chg until the alarm play time (in seconds) you want to use displays.

8) Press back or next to continue programming.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Naming CO Lines

The DX-120 allows you to name (or label) CO lines so you can customize the appearance of the line identifier in the
telephone display when the CO line is in use. This labeling can assist users when handling CO line calls by displaying

the intended purpose of that CO line.
=3 NOTE

.é » Valid names can have up to 7 alphanumeric characters.

e The default names are "Line 1" through "Line 40," corresponding to directory

numbers 800 through 839.

» Directory Numbers 840 through 843 are reserved for future use.

NAMING CO LINES vIA PC-DBA

From the PC-DBA main screen:

Extension
G0, Line
Call Handling

Festrickion

C.0, Line Application
Syskem Application

Feature Key Programming -
K50 OB Passward

¥
»
»
Extension Application »
3
3
3

| Pragramming  Maintenance Help

[T

Attendant
System Remindsr

CO L
Preprogrammed Mge
SPD. Mo, Assignment and Programming.

CID Name Table Assignment and Prograriming
External Pager

Loud Bell

055 Allocation

Madern And Serial Port

Remote Ext Table

CID Transfer Table

1) Go to ProgrammingP>System ResourceP>CO Line Names to display the CO Line Names screen.

Line 1 -
2801 Line 2 :I
2|02 Line 2
4803 Line 4
5:804 Line s
6205 Line &
7:806° Line 7
8207 Line &
9:208 Line @
10:809 Line 10 e
1
Dirdt CO Line Name
1:800 | Line 1
Update | nitialize(Fe Close | Halp |

In the table at the top of the screen

1) Click on (to select) the line to which you wish to assign a name.

RP:Resource- €0 Line Names |

Line 1 -
2:801 Line 2
3:802 | Line 3

Naming CO Lines via PC-DBA (continued on next page)
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Naming CO Lines via PC-DBA (continued)

2) Highlight the current entry in the CO Line Name field at the bottom or the CO Line names screen.

Dir L0 Line Name

1:600 i

3) Enter the name you want to assign to the specified line.

4) Click III above the entry line to move the newly entered name next to the specified line number.
¢ Use the steps shown above to assign names to other CO lines as needed.

When you are finished:
5) Click the Update button to store the settings into the database on the local disk.

6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

7) Perform a SEND to copy your new database to the DX-120 switch system memory.

NAMING CO LINES THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 04-06-XXX (where XXX is the number of the CO line directory you want to name).
 Valid CO line numbers range from 800 to 839.

5) Press save to display the selected CO Line Name/Label field and current name for the line you specified.
6) Press chg to enter a new name/label.

7) Enter the name/label for the CO line (Use the dial pad keys and reference the lettering scheme tables).
< For additional information, see “Appendix E - Setting Up Letter Type for Using Special Characters” .

* Valid names can have up to 7 alphanumeric characters.
e The default is LINE 1 through LINE 40, corresponding to directory numbers 800 through 839.

8) Press save when you have finished the label to save the new name/label name.

9) Press next to enter another CO line directory name.

When finished programming CO line name/labels:
10) Press the Volume button (up or down) to return to the DB Item Select screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Pre-Programmed Messages

The DX-120 can notify a busy or unattended DET of a call attempt via one of the DX-120 system messaging features.
At the DET display, the system shows messages waiting and provides prompts to assist the extension user in
responding to the messages.

= A message may be sent and received in several forms:

A call me message

A customized text message

A pre-programmed text message (Six total available)
A voice mail message.

e The following conditions apply to messaging.

Custom text messages can contain 16 letters/symbols maximum.
When you enter a custom message, the system saves it for future use.
The system allows a total of forty-eight message wait indications in the system at any one time.

At DETSs, the system does not remove the message waiting indication until extension user presses reply or
delete.

When the system leaves a message wait indication at an extension, it flashes a slow green lamp.
Each extension may receive more than one message waiting from various extensions.

Multiple messages are retrieved in the order that they were left.

Each extension can leave only one message waiting at any one extension.

SETTING UP PRE-PROGRAMMED MESSAGES VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

.0, Line

Attendant:

Restriction Syskem Reminder

3
3
3
Extension Application 3 User Mames and Passwords
3
13
3

0 Line Mames

.0, Line Application
System Application

Preprogrammed Message k
i

Feature Key Programming SPD.Mo. Assignment and P

gramming
K5 DB Password CID Mame Table Assignment and Programming

External Pager

Loud Eell

D55 Allocation

Modem And Serial Pork
Remote Ext Table

CID Transfer Table

Setting Up Pre-Programmed Messages via PC-DBA (continued on next page)
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Setting Up Pre-Programmed Messages via PC-DBA (continued)

1) Go to ProgrammingP> System ResourceP Preprogrammed Message to display the Preprogrammed
Message screen.

RrResource Preprogrammed Message 0 i
— Qutgaing M e

1. | CEIETE 4. |visitor Waiting

2. |Ca|l Haome a, |Urgent

3. |Ca|l Schoal B. |Come SEE me

—Premises M e

il |Outt0 lunch 4. |Inameeting

2 |Wi|l return soon i |Out0f0fﬂce

3. |Gonef0rthe day B. |Onvacati0n

(0-9, A-Z, a-z, Space)

Update | Initialize(FS)l Close | Help |

2) Enter information in the fields as described below:

In this field... enter...

* The first standard message you want to have available for
extension users when sending a message to another

Outgoing Message 1 extension.
« Specify the contents of outgoing messages 2 through 6 as
needed

* The first standard message you want to have available for
extension users to leave on their extensions when they must

Premises Message 1 leave the company premise.

* Specify the contents of premises messages 2 through 6 as
needed.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy your new database to the DX-120 switch system memory.

Setting Up Pre-Programmed Messages (continued on next page)
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Setting Up Pre-Programmed Messages (continued)

SETTING UP PRE-PROGRAMMED MESSAGES VIA THE DET
You can set up both Outgoing and Premise Preprogrammed messages (see field descriptions under step 2 on previous
page):

=3 NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen..

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see 27).

3) Press show to display the DB Item Select screen.

Setting Up Outgoing Messages

From the DB Item Select screen (using steps 1 to 3 above):
4) Enter 04-07-01-01.

5) Press save to display Preprogrammed Messages — Outgoing (Text)
Message — 1.

6) Press next (if necessary) to advance to the next preprogrammed message.
7) Press chg to enter a new message for the selected preprogrammed message.
8) Use the chart and the dial pad keys to enter the new message. When finished:
9) Press save to store the settings.
Repeat steps above for additional messages.
10) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Pre-Programmed Messages via the DET (continued on next page)
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Setting Up Pre-Programmed Messages via the DET (continued)

Setting Up Premise Messages

From the DB Item Select screen (using steps 1 to 3 on page 62):
4) Enter 04-07-02-01.

5) Press save to display Preprogrammed Messages — Premise (Text)
Message — 1.

6) Press next (if necessary) to advance to the next preprogrammed message.
7) Press chg to enter a new message for the selected preprogrammed message.
8) Use the chart and the dial pad keys to enter the new message. When finished:
9) Press save to store the settings.
Repeat steps above for additional messages.
10)Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Speed Dial Numbers

Speed dialing allows you to store frequently dialed numbers. The system accesses these numbers for dialing by the
associated speed dial directory number (speed number location). You can store the directory number on any feature
button for instant, one-button operation.

There are 3 basic tasks involved in this process:
- Assign the maximum number of speed dial numbers for each tenant
- Enter all of the speed dial numbers available for each tenant group
- Allocate the number of speed dials allowed for each extension

- Enter all of the speed dial numbers for each extension
There are 200 speed dial bins allocated for system-wide use (locations 500-699).

Extensions may also store up to 50 personal speed numbers in memory.
You can program the DX-120 system to allow system speed dial numbers to override toll restriction settings (both
CO line and extension COS).

EXAMPLE

Suppose your customer has a branch office out of state where they want to allow the
corporate extension users to call, while still prohibiting all other toll calls. In this case,
you can set up a system speed dial to allow calls to the branch office.

= NOTE

.é It must be a system speed dial, as the system checks the toll restrictions for individual
speed dial numbers and abides by them. System speed dial numbers override toll
restrictions as long as you have System Speed Toll Check enabled - see “Enabling/
Disabling System Speed Toll Check” on page 252.

The default.... is...

Length c_)f both individual and system 3 digits

speed dial numbers

Range for System speed dials directory numbers 500 to 699
Range for individual speed dials directory numbers 470 to 489

=3 NOTE
You can change any of these default settings by customizing the numbering plan -
see “Customizing the Numbering Plan” on page 103.

Programming Speed Dial Numbers (continued on next page)
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Programming Speed Dial Numbers (continued)

e The following conditions apply to assigning system speed dial numbers:

- The DX-120 system has 1000 speed dial number memory locations that are dynamically allocated to the
system use (extensions individually via extension speed dial locations, or all extensions via system speed dial
locations).

- You can program system speed dial bins, using Attendant Administration on a DET.
- You can chain speed bins.

- You can store pauses and flashes within the speed dial number. Chaining, pauses, and flashes each occupy
one character position.

- If you access an empty bin the system displays a message that reads: "SPEED NO. EMPTY."
s NOTE
.é You can program individual speed dial numbers at the individual extension, or across
* several extensions using PC-DBA. If you use the DET to set up your speed dials, you

will have to program the speed dials at each extension; you cannot program individual
speed dial numbers globally using the DET.

PROGRAMMING SPEED DIAL NUMBERS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line
Call Handling o —

Attendant

3
Sy esource 3
Restriction 3 Syskem Reminder
Extension Application 3 User Mames and Passwords
C.0, Line Application L3 CO Line Mames
Syskem Application 3
Feature Key Programming  # SPD,Mo. Assignment and Programming
K5 DE Password CID Mame Table Assignment and Progr i
External Pager
Loud Bell
D35 Allocation
Modem And Serial Pork
Remote Ext Table
CID Transfer Table

Preprogrammed Message

Programming Speed Dial Numbers via PC-DBA (continued on next page)
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Programming

Speed Dial Numbers via PC-DBA (continued)

1) Go to ProgrammingP> System ResourceP SPD.No.Assignment and Programming to display the

SPD.No.Assignment and Programming screen.

RP: Resource -SPD. No. Assignment And Programming ﬂ
—3ystemn SPD.
| IncreaseiDecrease
Tenant: |_ 'I Mumber of SPD. {for Tenants) Iggg vl
Ma. DIR# SPD. Mo CO Group
500 1 -
2 501 1
3 502 1
4 503 1 ﬂ
Mo DIR# SPD. Mo, CO Group
1 [s00 =l I1 - 4

—Extension SPD.

Mo, DIR#

IncreasefDecrease
| E)den5|0n:|1:101 :I' | Murmber of SPD. (for Extension) Igg vl

SPD. Mo, CO Group
470 1 =
2 471 1
3 472 1
4 473 1 LI
Mo, DIR# SFPD. Mo. CO Group
1 [a70 = l1 R
Update | inffalizerey | Close | Hem |
In the System SPD area:
[ e Increase/Decrease
Tenant: m Nurmber of SPD. (for Tenants) m
Mo, DIR# SPD. Mo, CO Group
500 1 a
2 501 1
3 502 1
4 503 1 LI
Mo, DIR# SPD. Mo, CO Group
N T =

2) Select the Tenant group you wish to program.

3) Select the number of speed dial numbers you want to assign to the currently selected tenant group from
the Number of SPD (for Tenants) field.
When you first select a tenant group (see step 2 above), the field displays the number of speed dial
numbers currently assigned to each tenant group. You can decrease or increase (if there is sufficient
room) the number of speed dials available to the tenant group.

The valid range is 0 through 1000, in multiples of 50.
The defaults are 200 for tenant group 1, and O for tenant groups 2 and 3.

Assign the number of speed dials for each tenant group as necessary by following the steps above.

NOTE

There is a maximum number of speed dials available for the system as a whole. If

you cannot assign any to tenant groups 2 and 3, decrease the number available to

tenant group 1, then try again.

Programming Speed Dial Numbers via PC-DBA (continued on next page)
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Programming Speed Dial Numbers via PC-DBA (continued)

Once you have assigned a maximum number of system speed dials to each tenant group:

4) Click on the desired speed dial the in the System SPD scroll list.

« The appropriate line will also be highlighted in the scroll list above) from the DIR # field.

Mo,

2
3
4

DIR#

SPD. Mo

CO Group

500
501
502
503

1

1
i)
1

i

<]

5) Click in the SPD. No. field and type the number you wish to associate with this speed dial.
» Use special characters as required.

- Pause=P
- Flash =/ (forward slash)
- Speed Numbering Chaining = @ + next speed number (500-699).

6) Enter the group number you want associated with this speed dial number.
« Valid choices are from 1 to 8.

¢ The default is 1.

7) Click III to move the number into the scroll list.
e The default for all system speed dials is blank.

¢ Use this same procedure to program as many system speed dial numbers as needed (up to the limit
you assigned to each tenant group).

Once you have programmed all of the speed dial numbers, go to the Extension SPD area:

—Extension SPD.

Mo,

DIR#

SPD. Mo

IncreasefDecrease
| E)den5|0n:|1:101 :I' | Mumber of SPD. (for Extension) |gg vl

CO Group

2
3
4

MNo.

470
471
2
473

DIRz#

SPD. Mo

1

1
1
1

CO Group

&

.|

1 470

] |

1

= 4

8) Select the Extension you wish to program.

9) Select the number of speed dial numbers you want to allow for the currently selected extension from the
Number of SPD. (for Extension) field.

« The range of allowable speed dials per extension is 0 to 50, in increments of 10. The default for

extensions 101-140 is 20.

¢ The default for all others is 0.
« Use this same procedure to program to allocate the appropriate number of speed dials for each

Extension.

NOTE

If the system will not allow you to assign speed dials to an extension, decrease the

number assigned to one or more of the other extensions, then try again.

Programming Speed Dial Numbers via PC-DBA (continued on next page)
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Programming Speed Dial Numbers via PC-DBA (continued)

Once you have assigned a maximum number of system speed dials to each extension:

10) Click on the desired speed dial the in the System SPD scroll list.
* The appropriate line will also be highlighted in the scroll list above) from the DIR # field.

11) Click in the SPD. No. field and type the number you wish to associate with this speed dial.
* Use special characters as required.

- Pause =P
- Flash =/ (forward slash)
- Speed Numbering Chaining = @ + next speed number (500-699).

12) Enter the group number you want associated with this speed dial number.
« Valid choices are from 1 to 8.

¢ The default is 1.

13) Click III to move the number into the scroll list.
« The default for all system speed dials is blank.

» Use this same procedure to program as many system speed dial numbers as needed (up to the limit
you assigned for each extension).

When you are finished:
14) Click the Update button to store the settings into the database on the local disk.
15) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
16) Perform a SEND to copy your new database to the DX-120 switch system memory.

Programming Speed Dial Numbers (continued on next page)
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Programming Speed Dial Numbers (continued)

PROGRAMMING SPEED DIAL NUMBERS VIA THE DET

= NOTE
.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You cannot program individual speed dial numbers globally using the DET. If you
wish to do this, you must use PC-DBA.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Programming the Number of Speed Dial Numbers Allowed on an Extension:

This process allows you to program the number of speed dial numbers allowed on an individual extension.
4) Enter 04-08.

5) Press save to display the SPD No. Assignment screen.

6) Press show to advance to the Assignment for Individual Speed Dial numbers screen.
7) Press show to change an extension’s speed numbers assignment.

8) Enter the extension number you want to set.

9) Press show to advance to the Increase screen for this extension.

10) Press chg to increase the assigned speed dial numbers for this extension.
e The range of allowable speed dials is 0 to 50.

* The default for extensions 101-140 is 20.
* The default for all others is 0.

OR
Press next to advance to the Decrease screen for this extension.
11) Press chg to decrease the assigned speed dial numbers for this extension.

12) Press next if you want to change another extension number in the same tenant group.
* Repeat above steps if you want to change another extension number in the same manner.

OR

Press the Hold button twice to display the Individual Speed Dial Number screen (see step 6 above).
¢ You can then press next to display the system speed dial list, then go to step 6 in “Programming the
Number of System Speed Dial Numbers Allowed per Tenant:” on page 70.

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Speed Dial Numbers via the DET (continued on next page)
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Programming Speed Dial Numbers via the DET (continued)

Programming the Number of System Speed Dial Numbers Allowed per Tenant:
Use this process to program speed dial numbers for use by any extension user on the DX-120 system.

From the DB Item Select screen (see steps 1 through 3 on page 69):
4) Enter 04-08-02.
5) Press save to display the Assignment for System Speed Dial numbers screen.
6) Press show.
7) Enter the tenant group number you want to change (usually tenant group 1).
8) Press show to advance to the Increase screen for this Tenant Group System Speed List.

9) Press chg to increase the number of allocated speed dial numbers (in increments of 50).
e The range of allowable speed dials is 0 to 1000.

* The default is 200.
OR
Press next to advance to the Decrease screen for this Tenant Group System Speed List.
10) Press chg to decrease the number of allocated speed dial numbers (in increments of 50).
11) Press next to enter a new tenant group and continue programming.
12) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Program the System Speed Numbers:

From the DB Item Select screen (see steps 1 through 3 on page 69):
4) Enter 04-09-X (where X represents the tenant group: 1~3).
5) Press save to display the the system speed dial entry point for the tenant group you specified.
6) Enter the speed dial number to program (500-699).
7) Press show to display the current stored number.
8) Press chg to change this stored number.

9) Enter the new telephone number (using special characters as required).
- Pause = Feature 70
- Flash = Feature 3
- Pulse-To-Tone Conversion = *
- Speed Numbering Chaining = Feature # + next speed number (500~699).

Programming Speed Dial Numbers via the DET (continued on next page)
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Programming Speed Dial Numbers via the DET (continued)

10) Press save to display the speed dial number and the new contents.
11) Press next.

12) Press chg to select the C.O. Group you want to associate with this speed dial.
e The default is 1.

« Use the steps above to program other system speed dials as needed.

13) Press next to complete the setting.
« Repeat the steps above for each tenant group for which you want to program speed dial numbers.

When you are finished programming the system speed dials numbers:
14) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Programming CID Names and Assignments Table

This table stores information used by the DX-120 when dialing outgoing calls. Such information includes any special
entries used when dialing (e.g., local area codes, country and international country codes), as well as any names
displayed during those calls. The system stores caller identification information for 100 calls in this call table. While
reviewing the calls, you will have the option to dial the number, obtain more information for the particular call, or delete

the call.

e The following conditions apply when programming the caller ID table:

You must properly program the local area code and long distance prefix so the system can accurately re-dial
the CID number from the caller ID table.

If no name is delivered from the telephone company, the system displays the number only.

Any digital speaker phone user can review the caller ID table if the attendant password is known, but the table
can be reviewed by only one telephone at a time.

You can exit the caller ID call table mode at any time.

* When programming the caller ID table, enter the following:

International prefix (typically not required in the USA or Canada).

Country code (typically not required in the USA or Canada).

Long distance prefix (usually 1).

Local area codes (enter them as the prefix if the local phone company uses 10 digit dialing).
HINT

See “Programming Caller ID Codes and Local Calling Areas” on page 264.

PROGRAMMING CID NAMES AND ASSIGNMENTS TABLE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0. Line

Attendant:

.3
Syskem Resource 3
Restriction .3 Syskem Reminder

Extension Application 3 User Mames and Passwords

C.0, Line Application 13 O Line Names

System Application 3 Preprogrammed Message

Feature Key Programming  # SPD.Mo, Assignment and Programming

K5 DB Password CID Name Table Assignment and Programming
External Pager
Loud Bell

D355 Allocation
Moderm And Serial Pork
Remote Ext Table

CID Transfer Table

Programming CID Names and Assignments Table via PC-DBA (continued on next page)
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Programming CID Names and Assignments Table via PC-DBA (continued)

1) Go to ProgrammingP>System ResourceP>CID Name Table Assignment and Programming to display the
CID Name Table Assignment and Programming screen.

RP: Resource -CID Name Table Assignment And Programming |
Tenart: |_v| Increase/Decrease |1DD vl ‘

| Mo, Mare Phaone Number |

-

=R - - S R

=

Ma. MName Phone Mumber

1 | 1

Update | Initialize(FB)l Clase | Help |

2) Select the tenant for which you want to program CID information.

Tenant: |1 vl

3) Decrease or increase (if there is sufficient room) the number of caller ID names in the table as needed

(and if there is sufficient room).
* The range is 0 to 100, selectable in increments of 10.

¢ The default is 100 for tenant group 1, and O for tenant groups 2 and 3.

Increase/Decrease |100 j

30 -
Phone MU 45

a0
60
70
g0
a0

I 00K

—3 NOTE
¢ 100 is the maximum number of caller ID entries available for the system as a
* whole.

¢ To assign some of them to tenant groups 2 and 3, you must decrease the number
available to tenant group 1.

Programming CID Names and Assignments Table via PC-DBA (continued on next page)
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Programming CID Names and Assignments Table via PC-DBA (continued)

4) Select a line in the scroll list just below the Tenant and Increase/Decrease fields.

2
3
4
5
=]
7
8
9

5) Enter the name you wish to associate with a CID entry.

6) Enter the corresponding telephone number in Phone Number field for the name you entered in the
previous step.

Mo, Marme Phone Number
1 [ Inside Sales | 3415550001] ﬁ

7) Click |1| to move the number into the scroll list.
e Program other caller IDs as needed using the steps above.

When all assignments have been made:
8) Click the Update button to enter and save your settings into the database on your local disk.

9) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

10)Perform a SEND to copy your new database to the DX-120 switch system memory.

HINT
@ Also see“Programming CID Names and Assignments Table” on page 72.

Programming CID Names and Assignments Table (continued on next page)
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Programming CID Names and Assignments Table (continued)

PROGRAMMING CID NAMES AND ASSIGNMENTS TABLE VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-10 to enter CID Names and Assignments Table programming.
5) Press save.

6) Press show to advance to the Assignment for CID Name Table screen.

7) Select the tenant number.
 Valid entries are 1 to 3.

e The default is 1.
8) Press show.
9) Decrease or increase (if there is sufficient room) the number of caller ID names in the table.
10) Enter 04-10-1-01.

11) Press chg if you want to increase the number of Caller ID numbers allowed for tenant group 1.
e The system then automatically increases the amount of caller ID names allowed, counting by 10.

« The range of allowable speed dials is 0 to 100.
* The default is 100.

OR

Press next to display the Decrease screen (now go to step 12).
OR

Enter 04-10-1-02 (now go to step 12).

12) Press chg to decrease the number of Caller ID numbers allowed for tenant group 1.
« The system then automatically decreases the amount of caller ID names allowed, in increments of 10.

13) Press next to display the Tenant screen.
14) Press chg until the next tenant number you want to program appears: 1~3.
15) Press show to display the current Caller ID number setting for that tenant.
OR
Enter 04-10-2-01.
16) Press save if you want to increase the number of Caller ID numbers allowed for tenant group 2.
OR
Enter 04-10-2-02.
17) Press save if you want to decrease the number of Caller ID numbers allowed for tenant group 2.

Programming CID Names and Assignments Table via the DET (continued on next page)
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Programming CID Names and Assignments Table via the DET (continued)

18) Enter 04-10-3-01.

19) Press save if you want to increase the number of Caller ID numbers allowed for tenant group 3.
OR

Enter 04-10-3-02.

20) Press save if you want to decrease the number of Caller ID numbers allowed for tenant group 3.

21) Press the Hold button to return to the previous menu level.
OR

22) Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning External Page

The system provides external one-way, dedicated paging access to a paging amplifier or multi-zone one-
way page controller. The external paging zone may be accessed individually, or with all eight internal paging
zones as an all-call page.

HINT
To set up individual extensions for pager use, see “Assigning Extensions to Paging
Groups” on page 397.

2

ASSIGNING EXTERNAL PAGING VvIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance Help

Extension
C.0, Line
Call Handling 3 i
System Resource » Attendant:
» Syskem Reminder
Extension Application » User Mames and Passwords
.0, Line Application 3 O Line Names
System Application 13 Preprogrammed Message
Feature Key Programming  » SPD.Mo, Assignment and Programming

KSL DB Password CID Mame Table Assignment and Programming

Loud Bell k

D355 Allocation

Modem And Serial Pork
Remote Ext Table

CID Transfer Table

1) Go to Programming® System ResourcePExternal Page to display the External Page screen.

zl
Fage Port
Tenant |u'|
—Paging Group
Group Fort1
1, v
2. [ |
3 | |
4. o
&, N
6. |
W | |
8. i |
Update |Initia|ize(F8)| Close | Help |

2) Select the Page Port to which you want to assign groups.

Fage Port

[Tenant |1 'l

1

Group |3 1

Assigning External Page ID via PC-DBA (continued on next page)
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Assigning External Page ID via PC-DBA (continued)

3) Select the groups you want to assign to the selected port.

—Paging Group

Group F
i,

o o o =

« A checked box indicates that the group is assigned to the currently selected port. If a box is unchecked,
that group is unassigned.

When all assighnments have been made to the current port:

4) Click the Update button to enter and save your settings into the database on your local disk.
« Repeat the above steps for other page ports.

When all assignments have been made to all ports (as needed):
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy your new database to the DX-120 switch system memory.

ASSIGNING EXTERNAL PAGING VIA THE DET

Qh-\'- NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Specify the Paging Group
You need to select the paging group to be Used by the tenant group for the external paging port

From the DB Item Select screen (follow steps 1 through 3 above)
4) Enter 04-12.
5) Press save to display the External Pager.

6) Press show to display the Pager ID.
e The only valid choice is 1.

7) Press 1 to confirm.

Assigning External Page ID via the DET (continued on next page)
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Assigning External Page ID via the DET (continued)

8) Press show to display the tenant group.
9) Press next to display the first paging group.
10) Press chg to select (and apply) the currently displayed paging group.

11) Press next to display the next paging group.
* Repeat steps 9 and 10 until all paging groups are selected as necessary.

12) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Specify the Number of Digits for the Extension
You need to specify the number of digits for the extension you will use to access the external pager:

From the DB Item Select screen (follow steps 1 through 3 on page 78)
4) Enter 08-09-11-01.
5) Press save.
6) Press chg to select 1 - 4.

7) Press save.
e The default is 3.

8) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Program the External Page Directory Number Leading 1, 2 or 3
9) Enter 08-09-11-02.
10) Press save.
11) Press chg.

12) Enter the directory number you want to use to access the external pager, and then press save.
« Valid directory numbers include any available, non-conflicting directory number.
e The default is 777.

13) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Establishing Loud Bell Settings

If the system is installed in high noise environments (e.g., where machinery is being used, shipping/receiving areas,
etc.), there is often a requirement to equip a loud (high-gain) ringing device.

ESTABLISHING LOUD BELL SETTINGS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help
Extension
C.0. Line
Call Handling 3 _h
Sy e 4 Attendant
Restriction .3 Syskem Reminder
Extension Application 3 User Mames and Passwords
C.0, Line Application 13 O Line Names
System Application 3 Preprogrammed Message
Feature Key Programming  # SPD.Mo, Assignment and Programming
K5 DB Password CID Name Table Assignment and Programming

External Pager

D355 Allocation

Moderm And Serial Pork
Remote Ext Table

CID Transfer Table

1) Go to Programming® System Resource®Loud Bell to display the Loud Bell screen.
|

~Loud Bell
Applicaton: -
[ COGROURP 1 M COGROURS
M COGROUR 2 [T COGROURB

[T COGROUP3 [T COGROURP?
[” CO GROUF 4 [T COGROUF B

Update [Initialize(FE| Close | Help |

Establishing Loud Bell Settings via PC-DBA (continued on next page)
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Establishing Loud Bell Settings via PC-DBA (continued)

2) Click the down arrow to the right of the Application field and select one of the following:
- L.B. (loud bell) - this is the default setting
- M.S.1 (music source 1)
- M.S.2 (music source 2)
- E.P. (external page)
- DIR (loud bell control -- users can dial loud bell number to close relay until they hang up)

Application: ||__E|_ -

I CO GROUAK.S1

M.5.2
[~ COGROURE

3) Click the boxes below the Application field to put a check mark next to each CO line group for which you
wish to enable the loud bell.

|
~Loud Bell

Application:  |LB. -

. CO GROUR 1 [ COGROURS

[T CO GROUR 2 [T CO GROUFB
[T COGROUF3 [T COGROUPY
[T CO GROUP 4 [ COGROUFPS

Update [Initialize(FE| Close | Help |

« A checked box indicates that the CO line group is assigned to the currently selected application. If a
box is unchecked, that group is unassigned.

When all assignments have been made:
4) Click the Update button to enter and save your settings into the database on your local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy your new database to the DX-120 switch system memory.

Establishing Loud Bell Settings via PC-DBA (continued on next page)
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Establishing Loud Bell Settings (continued)

ESTABLISHING LOUD BELL SETTINGS VIA THE DET

—3 NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-13-1.

5) Press save to advance to you to the Loud Bell — Application programming field.

6) Press chg to select L.B., M.S.1, M.S.2, or E.P.

- L.B. (loud bell) - this is the default setting

- M.S.1 (music source 1)

- M.S.2 (music source 2)

- E.P. (external page)

- DIR (loud bell control -- users can dial loud bell number to close relay until they hang up)
7) Press next to specify which CO line groups you want to use the ancillary device.
8) Press chg to activate/deactivate the device for each CO line group.

9) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Establishing Music Sources

CAUTION!
A It is the your responsibility to adhere to all applicable copyiright laws and any
other music source restrictions.

e The system provides two dedicated 3.5 millimeter phono-jack type inputs so you can connect two external music
sources. The external music source may be a radio tuner, tape deck, CD player, message on hold, or other
source.

= You must connect an external music source to the KSU1-CPM Musicl or KSU1-CPM Music?2 ports for the music
on hold and background music features to operate.

e Users can listen to these music sources at digital speakerphone extensions by using the background music codes
(771/772). Also, any caller placed on hold will hear the music source you program for that CO line (sources are
programmable on a per-CO line basis). You will assign music sources when you program the CO lines (see
“Section 5 - Programming C.O. Lines” on page 115). At that time, you will specify either MC1 or MC2 as the music
source for each CO line.

HINT
@ Also see “Setting the Day and Evening Class of Services (COS) and Music On Hold
(MOH) Source” on page 121

ESTABLISHING MuUSIC SOURCES VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling
Syskem Resource

Restriction
Extension Application

'DX-120

Syskem Application General Settings “

Feature Key Prograrmming m
K5 DB Password Time Switching

DIR# and Port Map  »
Configuration Copy
Syskem Time

td ~ B2 AR 2

Establishing Music Sources via PC-DBA (continued on next page)
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Establishing Music Sources via PC-DBA (continued)

1) Go to ProgrammingP>System Application® Numbering Plan to display the Numbering Plan (Part 1)
screen.

Ext. Pickup Group

x|

~Extension———— ~Ext. Page Group ——

Length: m Length: m Length: m
Leading 1:|1 Leading 1;'40— Leading 1:|=1=1—
Leading 2.2 Leading2[ || Leading 2
Leading 3 I_ Leading 3:|— Leading 3 I_
Leading 43|_ ~Ext. Hunt Group ——

Leading 5:|_ Length:m

Leading b Leading 1: 41 | e |
Leading ?:I— Leading 2:| 42

Leading S:I— Leading 3:'43_ Update

—Indiv. SPD. Mo, —System SPD. Mo, —— Initialize(F3) |
Length: |3 'I Length: |3 'I
Leading 1:| 47 Leading 1: |5 4|C|DSE
Leading 2:| 43 Leading 2: | [ Help |
Leading 33| 49 Leading 3:|

RP: System Application - Numbering Plan (Part 2)

2) Click More... to display the Numbering Plan (Part 2) screen.

C0 Line DIR Ma. — External Pager —Wirtual Mumber

Lenath: Im Lenath; m Lenath: m
Leading 1: | & Leading 1: | 777 Leading 1: | 7q
Leading 2; Leading 2; [ | Leading 2: |71
Leading 3; Leading 3; Leading 3: |72

~Music Source —Loud Bell —Meet Me Conference

Length: ﬁ Length: |3 'l Length: ﬁ
Leading 1: [779 Leading 1. |77g Leading 1: [ag
Leading 2: | 772 Leading 2: l_ Leading 2:
Leading 3: I_ Leading 3: l_ Leading 3: I_

—CO Group Operator Code Account Code
tengt 1 =fjs  =lls  =lls  =lls ]| ceng [t =]|| tenat 2 4]
Leading: | 9 [74 ] [ | Leading: | 0 Leading: 75

~ Remote Extension

Leading 4: | a3
Leading 8: | a7

Leading 2: |31
Leading 6: |35

InitializedF &) |

Leading 3: |32
Leading 7: |35

Help |

Length: |3 vlLeading1: |30 S
Leading 5: |34

Update |

Close |

Establishing Music Sources via PC-DBA (continued on next page)
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Establishing Music Sources via PC-DBA (continued)

In the Music Source fields in the center left area of the screen:

—Music Source
Length:
Leading 1: | 771

J

Leading 2: | 772

Leading 3: I

3) Specify the appropriate information in the fields as described below:

For this field... Specify...

the number of digits in the extension you will use to access the
music sources.

Length « To do this, you can click the down arrow to the right of the
Length field and select 1 - 4.

e The default is 3.

the directory number of the extension you want to use for the first
music source in the Leading 1 field.

Leading 1 « Valid directory numbers include any available, non-conflicting
directory number.

e The default is 771.

the directory number you want to use for the second music
source in the Leading 2 field.

Leading 2 « Valid directory numbers include any available, non-conflicting
directory number.

e The default is 772.

Leading 3 » This field is not used and is always blank.

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy your new database to the DX-120 switch system memory.

Establishing Music Sources (continued on next page)
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Establishing Music Sources (continued)

ESTABLISHING MUSIC SOURCES VIA THE DET

—3 NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Program the Music Directory Number Length
(the number of digits in the extension you will use to access the music sources)

4) Enter 08-09-09-01.
5) Press save.

6) Press chg to select the number of digits in the extension you will use to access the music sources.
» Valid selections are 1, 2, 3, or 4.

e The default is 3.
7) Press save to store the setting.
8) Press the Volume button (up or down) to return to the DB Item Selection screen.

Program the directory number of the extension you want to use for the first music source
9) Enter 08-09-09-02.
10) Press save.
11) Press chg.

12) Enter the appropriate directory number.
« Valid directory numbers include any available, non-conflicting directory number.

e The defaultis 771.
13) Press next.

« Repeat steps 10 through 13 for each of the remaining music sources (i.e., Leading 2 and 3) you want to
program.
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Assigning Ancillary Devices -

Loud Bell, External Page. or Music on Hold

There is often a requirement to control ancillary devices via the telephone system. The DX-120 system provides one
dry contact closure (standard) for interface of the various devices.

CAUTION
It is important to adhere to the electrical requirements of this contact. The
contact closure is rated at 24vdc, 1Amp.

You can assign the contact closure to one of the following four uses.

e Loud Bell Control

Loud bell is used to activate the Loud Bell Feature, then specify which CO Groups to which the loud bell should
be applied.

EXAMPLE

When the phone rings in the warehouse, we want the loud bell set up to ring so that if
someone is standing just outside or in the back of the warehouse, they will hear the
phone ringing.

- If the system is installed in high noise environments, there is often a requirement to equip a loud (high-gain)
ringing device.

- Using the contact in this way provides for control of an optional, ancillary loud ringing device. The device is
connected to the contact as a trigger.

- When ringing occurs on CO lines in CO line groups designated for loud bell, the contact closure operates and
controls the connected device.

e External Page Control
This feature is used in conjunction with loud speaker so that announcements can be made over a P.A. system.

- The contact may also be programmed to control external paging apparatus.

- When programmed in this manner, the contact closure operates whenever the external paging port is
activated.

= Music Source Control

MS1 or MS2 is used if you want to use the BELL CONTACT (hardware set up) as an off/on switch (i.e., this
setting will also need the Loud Bell contact to be used).

EXAMPLE:

We have a Classical Music CD loaded in the CD player which is being used as Music
Source 1. But... we don't want the CD to be played constantly (as that would wear
out the CD quickly). Instead, we only want the CD to play when the system detects a
call on hold.

- The contact may also be programmed to control Message On Hold devices.
- In this mode of operation the contact closure operates whenever CO lines are placed on hold.
- This function can reduce wear on electromechanical devices that provide the message on hold function.

Assigning Ancillary Devices (continued on next page)
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Assigning Ancillary Devices (continued)

= DIR

This feature is used in conjunction with a bell or buzzer and acts as a gate/door control.

EXAMPLE
You might want to set this feature up in a warehouse so that when a truck pulls up to
the gate to make a delivery, he calls the warehouse manager who can then dial 779

to open the gate for the truck to drive through to get back to the loading dock of the
warehouse.

OR

When there is no receptionist, a phone is left in the lobby. When a visitor arrives, they
use the lobby phone to dial the extension of the employee they are visiting. That
employee can then dial 779 (or other specified number) to open the locked door,
allowing the visitor to enter beyond the lobby.

HARDWARE SETUP (I.E., USING THE CONTACTS ON THE CPM AS MENTIONED ABOVE)

e Music Sources 1 and 2 Contacts allow for music (or something else) to be played while calls are on hold - but
must also be set up in PC-DBA or by DET.

= External Pager Contact provides the ability to dial a number from an extension so that a page can be sent to
selected paging zones (aka an announcement over a speaker).

e Loud Bell Contact provides the ability to set the system up so that in certain (perhaps noisy) areas in a building,
when the phone rings, it will activate a loud bell and can also be used as an on/off switch for Music On Hold and

External Page.
IMPORTANT!

In addition to making the correct contact setting, you must also program the
features above in the system software - see below.

SOFTWARE SETUP

Once you make the hardware (contact) setup, you must program the features in the program software. The settings
are made in the Loud Bell feature - see “Establishing Loud Bell Settings” on page 80.
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Assigning the DSS Port/Owner

The Attendant/Extension DSS console is a self-contained digital terminal that interacts with a predetermined DET. The
console has 64 programmable buttons that can be used for easy access to the DX-120 system’s many CO lines,
extensions, and features.

All sixty-four (64) buttons on the DSS console have dual colored LEDs that allow status monitoring of system resources
such as CO lines and extensions.

Although usually considered to be an attendant feature benefit, the DSS console can be assigned to any DX-120 DET.
You can add a maximum of 12 sixty-four-button Attendant/Extension consoles to the system. Each requires its own
dedicated digital port, and therefore reduces the number of DETs that you can connect to the system on a one-to-one
basis.

= The following conditions apply when assigning DSS port owners.
- Each DSS console has 64 dual-color LED buttons
- Each DSS console requires its own dedicated cable pair from the KSU.
- You can assign up to 12 DSS consoles in the DX-120 system.
- You can assign to any DET a maximum of four Attendant/extension DSS consoles.

=S NOTE
.é Each DSS is “mapped” with a default button arrangement.

ASSIGNING THE DSS PoORT/OWNER VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance Help

Extension

C.0, Line

Attendant

.3
Sy ESOUrCe »
Restriction 3 Syskem Reminder
Extension Application 3 User Mames and Passwords
.0, Line Application 13 O Line Names
Syskem Application L3 Preprogrammed Message

Feature Key Programming  # SPD.Mo, Assignment and Programming

K5 DB Password CID Mame Table Assignment and Programming
External Pager

Loud Eell

Modern And Seriagrt

Remote Ext Table
CID Transfer Table

Assigning the DSS Port/Owner via PC-DBA (continued on next page)
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Assigning the DSS Port/Owner via PC-DBA (continued)

1) Go to ProgrammingP>System ResourceP>DSS Allocation display the DSS Allocation screen.

|

D35 Unit DIR Mo. D355 Owner

; 3

3

4

5

° =
0SS Unit DIR NO. 0SS Owner

1 | ]| [
Update | InitializedF &) | Close | Help |

2) Select a line in the scroll list at the top of the screen.

D33 Unit DIR Mo. D35 Owner

@ B WM

|

3) Select the directory number of the digital port to which the DSS Console is connected from the DIR NO
field.

 Valid port directory numbers include any available, non-conflicting port directory number.
e The default is blank.

DIR MO,

[

-

2102 u_

3103
4:104
5:105
6:106
7107
a:108
9:108
10:110
1111
121112
13113
14:114 il

Assigning the DSS Port/Owner via PC-DBA (continued on next page)
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Assigning the DSS Port/Owner via PC-DBA (continued)

4) Select the number of the extension with which this DSS will operate from DSS Owner field.
« Valid extension numbers include any available, non-conflicting extension number.

* The default is blank.

D55 Owner

|
2102 k—

3103

4:104

5:105

6:106

7107

a:108

9:108

10:110

1111

12:112 i

5) Click III to the right of the entry line to place your entries in the scroll list.
* Program other ports as needed using the steps above.

6) Click the Update button to enter and save your settings into the database on your local disk.

When all assignments have been made:

7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

8) Perform a SEND to copy your new database to the DX-120 switch system memory.
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PROGRAMMING USING THE DET

=3 NOTE
.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-14-01-01 to program the owner of DSS Console #1.

5) Press save to display the current programming of the DSS Console #1 owner.

To change the designated DSS console owner press chg
6) Enter the extension number to be assigned as the DSS Console owner.

=y NOTE
.é Only valid (equipment installed) extension directory numbers can be assigned as
DSS Console Owners.

7) Press save to store the settings.

8) Press next to display the current directory of the DSS Console (e.g., “NULL” if empty).

9) Press chg to enter the new DSS Console directory number (the extension number of the digital port to
which the DSS Console is connected).

10) Press save to store the settings.

11) Press next to display a prompt for the next DSS Console # to be programmed.
 Valid entries are 1-12.

12) Enter the number of the next DSS Console to program.
OR
Press the Hold button to return to the previous programming menu for other programming requirements.
OR
13) Press the SPK button twice to exit programming mode.
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Setting Up Optional Internal Modem

The DX-120 system can be equipped with an optional internal modem so you can remotely program the DX-120 using
PC-DBA. The optional modem module provides a dedicated communications path between the system processor and
PC-DBA. This communications path does not require use of analog port system resources.

=y NOTE
.% e The modem speeds are 1200 bps/ 2400 bps.

* Also see “Remote (Modem) Connection” on page 14 for more information about
modem connection to the switch.

SETTING UP OPTIONAL INTERNAL MODEM VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0. Line
Call Handling i

System Resource Attendant

.3
3
Restriction .3 Syskem Reminder
Extension Application 3 User Mames and Passwords
C.0, Line Application 13 O Line Names

System Application 3 Preprogrammed Message

Feature Key Programming  # SPD.Mo, Assignment and Programming

K5 DB Password CID Name Table Assignment and Programming

External Pager

Loud Bell

D355 Allocation

Modem And Serial Port
Remote Ext Table

CID Transfer Table

1) Go to ProgrammingP>System Resource®Modem and Serial Port to display the Modem and Serial Port
screen.

RP: Resource - Modem And Serial Port } |

Built-in Modem #_Rate
{ Dir Mo: |mv[ RMT: |gaun ~| bes

Baud Rate: |24DD vl bps CIL: I%DD 'I bps

Update | Initialize(FS)l Close | Help |

2) Select the directory number you want to use for the internal modem.
« Valid directory numbers are from those designated for extension directory numbers.

¢ The default is 100.

Dir Mo: 100

d Rate: [101
102
103
104
Updatq 105
106
107
108
109
110
111

Setting Up Optional Internal Modem via PC-DBA (continued on next page)
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Setting Up Optional Internal Modem via PC-DBA (continued)

3) Select either 1200 or 2400 (as appropriate) as the operating speed of the modem in the Baud Rate field.
e The default is 2400.

Baud Rate: {2400 vl hps

1200

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy your new database to the DX-120 switch system memory.

SETTING UP OPTIONAL INTERNAL MODEM VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 04-15 and press save to advance to the Built-in Modem programming screen.

5) Press show to advance to the Built-in Modem — Directory Number programming screen.

To change the modem directory number:
6) Press chg.

7) Enter the new directory number that you want to assign to the modem resource.
¢ Valid directory numbers are from those designated for extension directory numbers.

e The default is 100.
8) Press save to store the settings.
9) Press next to advance to you to the Built-in Modem — Baud Rate programming screen.

10) Press chg to choose either 1200 or 2400 as the operating speed of the modem.
e The default is 2400.

11) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Specifying PC-DBA Transmit Rate

The DX-120 system allows you to remotely program the DX-120 using PC-DBA on a laptop. You must set the

transmission rate for this communication between the switch and your laptop.

SPECIFYING PC-DBA TRANSMIT RATE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

Attendant:

BSOUFCE

.3
Sy & »
Restriction .3 Syskem Reminder
Extension Application 3 User Mames and Passwords
C.0, Line Application 13 O Line Names
System Application 3
Feature Key Programming  #

Preprogrammed Message
SPD.Mo, Assignment and Programming

External Pager

Loud Bell

D355 Allocation

Modem And Serial Port
Remote Ext Table

CID Transfer Table

C.0. Line

K5 DB Password CID Name Table Assignment and Programming

1) Go to ProgrammingP>System Resource®Modem and Serial Port to display the Modem and Serial Port

screen.

RP: Resource - Modem And Serial Port . |

Built-in Modem #_Rate

Dir Mo: |mv[ RMT: |gaun ~| bes
Baud Rate: |24DD vI bps CIL: I%DD 'I bps

Update | Initialize(FS)l Close | Help |

2) Select the appropriate transmit rate (i.e., baud rate) in the RMT field.

 Valid selections are
- 1200
- 2400
- 4800
- 9600 (the default)
- 19200

When you are finished:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy your new database to the DX-120 switch system memory.
Specifying PC-DBA Transmit Rate (continued on next page)
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Specifying PC-DBA Transmit Rate (continued)

SPECIFYING PC-DBA TRANSMIT RATE VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-16.

5) Press save to advance to the RTM XRATE field.

6) Press chg to select the transmission rate between your laptop and the switch.
7) Valid choices include 1200, 2400, 4800, 9800, and 19200.

8) The default is 9600.

9) Press save to store the settings.

10) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Selecting SMDR Transmit Rate

The DX-120 system allows you to specify the transmission rate of SMDR data consisting of:
« eight (8) bits
e one (1) stop bit
* no (0) parity

e The system outputs SMDR from the standard “SMDR” RS232 serial port located on the Central Processor Module
(CPM). You can connect an external serial printer or call accounting device for permanent record keeping or call
cost accounting.

e The system outputs each data record within the standard 80-character frame. Data communications occur in one
direction only through the SMDR port; you can program the baud rate during system programming.

= SMDR information includes the following:
- call direction, or a comment for special call handling record
- extension number
- COline used
- number dialed
- ring time to answer
- time and date the call was placed
- duration of the call
- account code (if specified)

= The system also provides ring-in duration and call processing information relative to the call as it was handled by
the system.

e The system outputs two records for incoming calls that are received with Caller ID (although this feature is a
standard feature of the DX-120, a telephone company subscription is required).

- The first record lists the telephone number of the calling party as it is received from the telephone company
(calls from CID blocked numbers will not have a CID number associated with that record).

- The second record will show the caller’'s name (“OUT OF AREA” or “PRIVATE” may appear in this field if the
calling party number is unavailable.)

EXAMPLE
The following is an example of an SMDR report. In this example, the two “I” records
are one incoming call record received with caller ID.

I§] 1 4 h | 4 ] f: 7

123456TARN12 4567890120454 7BF012 45670 B012345870 2012345670901 23456TEMLIZ 4567870
D EXT TRE DSET DIALED RTHNS DATE TIHE DURATION ACCOUNT

EXY LYY XUEX. .. HEHY MM HE YESER HMoMM:SE O HH: MM 88 I¥EXNEXY

2 101 801 303ISS51Z1I 00100 DASOL Ql:05:5Z DQ:00:35

I 103 BOD 4BO0ZZ24545% 00:13 DLOL 0l:07¢S51 00:00:39

I 103 BO0 JOHNSON LARRY 0O0:13 0Lf01 D1t07:51 00:0D0:39

G 101 BOl 3035551212 00:00 D1s01 Ol:13:5Z D0:00:15 L2G4567TH

T

Selecting SMDR Transmit Rate (continued on next page)
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Selecting SMDR Transmit Rate (continued)

e Example of Column Headings in the Report

HEADING DEFINITION

D Call Direction

In this first position you may also see...

| Incoming

6] Outgoing

A Operator transferred call
H Recalled trunk call

L Conference call

EXT Extension number/Incoming DISA CO line nhumber/Incoming ECF CO line

number
TRK CO line directory number
DGT_DIALED Telephone number (outgoing call only, maximum 16 digits, left aligned)
RING CO line incoming ringing duration before answer (incoming call only)
DATE Day/Month (DD/MM)
TIME Start time of call connection
MM Minute
HH Hour
SS Second
DURATION Length of the call
ACCOUNT Account code entered for billing purposes (maximum 8 digits, left aligned)

e The system generates a carriage return (CR) after each record output.
= After you have set up SMDR, be sure to assign SMDR to individual extensions as needed.

HINT
@ Remember to review “Programming Extensions for SMDR Output” on page 427.

Selecting SMDR Transmit Rate (continued on next page)
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Selecting SMDR Transmit Rate (continued)

SPECIFYING SMDR TRANSMIT RATE viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help
Extension
C.0. Line
Call Handling 3 —
System Resource 4 Attendant:
Restriction .3 Syskem Reminder
Extension Application 3 User Mames and Passwords
C.0, Line Application 13 O Line Names
System Application 3 Preprogrammed Message
Feature Key Programming  # SPD.Mo, Assignment and Programming
K5 DB Password CID Name Table Assignment and Programming

External Pager

Loud Bell

D355 Allocation

Modem And Serial Port
Remote Ext Table

CID Transfer Table

1) Go to ProgrammingP>System Resource®Modem and Serial Port to display the Modem and Serial Port
screen.

i
Built-in Modem #_Rate
{ Dir Mo RMT: |gaun v[bns

i

Baud Rate: |24DD vI bps CIL: I%DD 'I bps

Update | Initialize(FS)l Close | Help |

2) Select the SMDR data transmission rate in the CIL field.
« Valid choices include 1200, 2400, 4800, 9800, and 19200.

* The default is 9600.

CIL:  |9600 -| bps
1200
2400
4800
Close
19200

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy your new database to the DX-120 switch system memory.

Specifying SMDR Transmit Rate (continued on next page)

- 99 -



BASIC SYSTEM PROGRAMMING TASKS DX-120 Programming Manual

Specifying SMDR Transmit Rate (continued)

SPECIFYING SMDR TRANSMIT RATE VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 04-17.

5) Press save to advance to the CIL X RATE field.

6) Press chg to select the SMDR data transmission rate.
« Valid choices include 1200, 2400, 4800, 9800, and 19200.

e The default is 9600.
7) Press save to store the settings.

8) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up the CID Transfer Table

You can set up the information in the CID Transfer Table that will be used to transfer calls to the appropriate extension.
The DX-120 will look at each incoming CID and determine whether or not it matches the number in the table. If it finds
a match, the call will automatically be transferred to the extension listed in the "Transfer No." field (for PC-DBA) or

Transfer No screen (for the DET).

NOTE

SETTING UP THE CID TRANSFER TABLE VIA PC-DBA

From the PC-DBA main screen:

This table has precedence over any other transfer table, including the Translation
Table - see “Setting Up the Translation Table” on page 171.

Programming Maintenance  Help

Extension
C.0, Line
Call Handling

3

= 3
Restriction 3
Extension Application »
.0, Line Application 2
System Application 3
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>System ResourceP>CID Transfer Table to display the CID Transfer Table screen.

.

Attendant:
Syskem Reminder
User Names and Passwords

0 Line Mames

Preprogrammed Message

SPD.Mo, Assignment and Programming

CID Mame Table Assignment and Programming
External Pager

Loud Bell

D355 Allocation

Modem And Serial Pork

Remote Ext Table

CID Mo CID Number Transfer Mo

x|

ooz
[uinc
oog
0o0s
006
o7
oo

i

}|

CID Mo

CID Number

Transfer Mo

T

| B[

Update

InitializedF &) | Close |

Help |

Setting Up the CID Transfer Table via PC-DBA (continued on next page)
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Setting Up the CID Transfer Table via PC-DBA (continued)

2) Select the extension in the list to which you want to assign a CID Transfer number.

B
CID Mo CID Number Transfer Mo

ooz
[uinc
oog
0o0s
006
o7

oo LI

CID No CID Number Transfer No
o | [ B[

Update

InitializedF &) | Close | Help |

3) Enter the number that represents the incoming CID call to be transferred.

CID Mo CID Murnber
0o |9415559000

4) Select the extension to which you want the call transferred.

Transfer Mo

|

-

101 k

102
103
104
105
106
107
108
104
110
111
12
113 >

5) Click |1| to move the number into the scroll list.
e Program other caller IDs as needed using the steps above.
When all assignments have been made:
6) Click the Update button to enter and save your settings into the database on your local disk.

7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

8) Perform a SEND to copy your new database to the DX-120 switch system memory.
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Customizing the Numbering Plan

The DX-120 system comes with a default directory numbering system already set up for you. If this default system
meets your customer’s needs, you do not need to modify the default numbering scheme. However, if your customer
requires changes to this plan, you can use this feature to do so. When one extension user calls another extension, the
system uses the settings in the numbering plan to correctly direct the call. For this reason the numbering plan is often
referred to as the system directory numbers.

EXAMPLE

A customer may tell that he/she wants all extension numbers to begin with a 1; so
that instead of an extension having a designation of "305", it will then have a
designation of "1305".

E CAUTION!

If you do customize the numbering plan, you will have to re-program it every
time you perform a cold start. You can make a copy of your custom database
using PCDBA, but you will have to have the copy and your laptop with you on
site each time you perform the cold start.

= In addition to the basic change you can make to extension designations, the DX-120 numbering plan functionality
allows you to easily configure numbering for the various system resources. Resources are defined primarily as
“port” oriented components of the system.

= Although the flexibility of the directory number structure is provided primarily for system port resources, you can
also customize some feature access (e.g., account code, paging groups, and speed dial).

e As you assign codes, the system checks for conflicts with other codes to keep you from improperly programming
resource directory numbers. To successfully implement changes to the default (factory programmed) directory
number plan, the system does not allow you to enter a new code if it is in use elsewhere. You can, however,
reuse that code if you delete it from its other assignment.

= When you are programming system resources, start by specifying the length (from 1-4 digits) of the directory
number the system uses to access the resource. Then assign the specific digits you want to use for the resource.
Use caution when assigning the digits to resources, as you can assign a resource all specified digits (i.e., hunt
group directory numbers begin with any number), or only leading digits (i.e., hunt group directory numbers must
begin with “2”, or “34", etc.).

e The default settings for all items are shown in the following tables. The valid range for all directory number
lengths is from one to four digits. Valid options for leading fields include any available, non-conflicting directory
number. This means that if you have assigned a directory number to begin with “41”, for example, no other types
of directory numbers can begin with 41.

e There are 2 main tasks associated with setting up the DX-120 numbering plan. Default values in all fields in the
numbering plan have been assigned. You can use the numbering plan as is with the default values, but you may
need to customize it for your clients’s particular local calling area and needs.

Customizing the Numbering Plan (continued on next page)
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Customizing the Numbering Plan (continued)

THE NUMBERING PLAN CONSISTS OF TWO MAJOR PORTIONS
e Designate Specific Numbering Plan Settings (Numbering Plan 1 Screen)
- Number of digits in DX-120 extensions
- Number of digits in the extension paging, hunt, and pickup group directory numbers, if required.
- Directory numbers extension users must dial to access page, hunt, and pickup groups.
- Length of individual and system speed dials
- Numbers used by extension users to enter to access either an individual speed dial or a system speed dial
e Create and modify CO Groups Information (Numbering Plan 2 Screen)
- Group CO lines according to function

- Specify the number of digits in the CO line, music source, loud bell, external pager, virtual number, and meet
me conference directory numbers as well as what directory numbers you want extension users to dial to
access these resources.

g NOTE

'. The system does not allow you to assign the same set of numbers to different types of
directory numbers. For example, if you leave the system default for extension
numbers set to 100-299, you cannot also assign any number within that range to
page groups, hunt groups, speed dial numbers, etc.

NUMBERING PLAN DEFAULTS

Flexible Numbering Plan — Directory Number Defaults

LEADING DIGITS RESULTING
LENGTH 3 4 5

Operator Code 1 0 n/a 0
Account Code 2 79 n/a 79
Extension 3 1 2 Null 100-299
Ext. Page Group 3 40 Null | Null n/a 400-408
Hunt/UCD Groups 3 41 42 43 n/a 410-433
Pickup Groups 3 44 Null | Null n/a 440-447
Individual Speed Dial 3 47 48 49 n/a 470-499
CO Line DIR No. 3 8 Null | Null n/a 800-899
Music Source 3 771 | 772 | Null n/a 771,772
Loud Bell Control 3 779 | Null | Null n/a 779
External Pager 3 777 | Null | Null n/a 777
Virtual Number 3 70 71 72 n/a 700-729
Meet-Me Conference 3 39 Null | Null n/a 390-397

Customizing the Numbering Plan (continued on next page)
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Customizing the Numbering Plan (continued)

EXAMPLES OF ASSIGNING NUMBERS TO PICKUP GROUPS

PICKUP GROUP DIRECTORY NUMBER EXAMPLES

leading digits resulting

length code comments

« Users dial 40-47 for group pickup.

A 2 4 Null Null 40-47 * The digit “4” is unavailable as the first
digit for any other directory number use.

 Users dial 44 or 45 for group pickup.
« There are only two group pickup groups.

B 2 44 45 Null 44, 45 « Digits 40-43, 46-49 are available as the
first two digits for other numbering plan
requirements.

 Users dial 440-447 for group pickup.

« Digits 40-43, 45-49 are available as the
first two digits for other numbering plan
requirements.

C 3 44 Null Null 440-447

EXAMPLES OF ASSIGNING NUMBERS TO EXTENSIONS
extension DIRECTORY NUMBER EXAMPLES

leading digits resulting

5 code comments

 Users dial 1000-1999 when dialing
other extensions.

The digit “1” is unavailable as the first
digit for any other directory number
use.

Users dial 100-199 when dialing other
extensions.

The digit “1” is unavailable as the first
digit for any other directory number
use.

A 4 1 Null 1000-1999

B 3 1 Null 100-199

Users dial 10-39 when dialing other
extensions.

C 2 1 2 3 Null 10-39

Digits 1, 2 & 3 are unavailable as the
first digit for any other directory number
use.

Users dial 11-17 when dialing other
extensions.

The digit “1” is unavailable as the first

D 2 10| 12| 12| 13| 14| 15| 16 | 17 11-17 digit for any other numbering plan
requirements.

Only eight extensions will have
intercom numbers.

Customizing the Numbering Plan (continued on next page)
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Customizing the Numbering Plan (continued)

CUSTOMIZING THE NUMBERING PLAN VIA PC-DBA

NUMBERING PLAN (PART 1): EXTENSION SETTINGS

From the PC-DBA main screen:

Extension
C.0, Line
Call Handling

Restriction

Syskem Resource

Extension Application
.0, Line Application

Sy 1 Application
Feature Key Prograrmming
K5U DE Password

Programming Maintenance  Help

3
3
13
L3
L3
13
L3

‘DX-120

General Settings

Time Switching t!

DIR# and Port Map  »
Configuration Copy
Syskem Time

1) Go to ProgrammingP>System Application®Numbering Plan to display the Numbering Plan (Part 1)

screen.

—Extension
Lenath:

Leading 1:]1
Leading 2:| 2
Leading 3:
Leading 4:
Leading 5:
Leading &:
Leading ¥:

AT

Leading 8:

RP: System Application. - Numbering Plan (Pm'tl}

—Ext. Page Group ——

Length: |2 >
Leading 1:| 40

Leading 2:

117

Leading 3;

x|
Ext. Pickup Group
Lenath: m
Leading 1:|=1=1—
Leading 2:|_
Leading 3:|_

— Ext. Hunt Group——
Lenath: |2 -

d

Leading 1: 41

More ...

Leading 2:| 42
Leading 3:| 43

:

—Indiv. SPD. Mo,
Length: |3 <
Leading 1.] 47

Leading 2 48
Leading 3:{ 49

REEY

—System SPD. Mo, ——
Lenath:

N

Leading 1:

Leading 2: | 6

1T

Leading 3:

Update

InitializedF &)

Close

Help

ddill

2) Enter the settings in the fields as described below for each section of this screen:

In the Extension fields:

— Extension
Lenath:

| A4

Leading 1:

[}

Leading 2:

Leading 3:
Leading 4:
Leading 5:
Leading &:

Leading 7:

AT

Leading 8:

Customizing the Numbering Plan via PC-DBA (continued on next page)
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Customizing the Numbering Plan via PC-DBA (continued)

3) Select the number of digits (1 to 4) you want to use in extension numbers.
e The default is 3.

Extension
Length:

Leading 1: b
Leading 2: ]

4) Enter the digits you want to require as the beginning digits in your exten}sion numbers in Leading 1 field,
as appropriate.

EXAMPLE

If you want all of your extension numbers to begin with 5, enter 5 here. Or, to allow
only extension numbers 590 through 599, enter 59 (assuming a 3-digit length). The
default is 1, so the default extension numbers include 100 through 299.

5) Enter the digits you want to require for an additional range of extension numbers Leading 2 field, as
appropriate.

EXAMPLE
If you want to allow extension numbers 570-579 in addition to extension numbers you
specified in the Leading 1 field, enter 57 here.

¢ Use the same method shown in step 5 to assign the remaining leading digits as needed.
¢ By default, the second through the eight leading digit fields are blank (unused).

In the remaining areas and fields:

6) Specify the length and any appropriate leading digits for extension page groups, extension hunt groups,
extension pickup groups, individual speed dial numbers, and system speed dial numbers using the same
method as shown in the steps 4 and 5 above.

When you are finished:
7) Click the Update button to store the settings into the database on the local disk.
8) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
9) Perform a SEND to copy your new database to the DX-120 switch system memory.

Customizing the Numbering Plan via PC-DBA (continued on next page)
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Customizing the Numbering Plan via PC-DBA (continued)

NUMBERING PLAN (PART 2): CO GROUPS

From the PC-DBA main screen:

Extension
C.0, Line
Call Handling

Restriction

Syskem Resource

.0, Line Application

1 Application
Feature Key Prograrmming
K5U DE Password

3
3
3
Extension Application 3
3
13
.3

Programming Maintenance  Help

‘DX-120

General Settings

Time Switching t!

DIR# and Port Map  »
Configuration Copy
Syskem Time

1) Go to ProgrammingP>System Application®Numbering Plan to display the Numbering Plan (Part 1)

screen.

—Extension
Lenath:

Leading 1:]1
Leading 2:| 2
Leading 3:
Leading 4:
Leading 5:
Leading &:
Leading ¥:
Leading 8:

AT

—Ext. Page Group ——

Length: |2 >
Leading 1:| 40

Leading 2:

117

Leading 3;

x|

Ext. Pickup Group

Lenath: m
Leading 1: |44—
Leading 2:|_
Leading 3:|_

— Ext. Hunt Group——
Lenath: |2 -

d

Leading 1: 41

More ...

Leading 2:| 42
Leading 3:| 43

:

—Indiv. SPD. Mo,
Length: |3 <

Leading 1.] 47

Leading 2 48

REEY

Leading 3:{ 49

—System SPD. Mo, ——
Lenath:

N

Leading 1:
Leading 2: | 6

1T

Leading 3:

Update

InitializedF &)

Close

ddill

Help

Customizing the Numbering Plan via PC-DBA (continued on next page)
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Customizing the Numbering Plan via PC-DBA (continued)

2) Click More... to display the Numbering Plan (Part 2) screen:

RP: System Application - Numbering Plan (Part 2) ll
-COLline DIRNo.———— External Pager———————————— ~¥iual Mumber——————
Length: I_ 'I Length: |3 'I Length: |3 'I

Leading 1: | & Leading 1: | 777 Leading 1: | 7q
Leading 2; Leading 2; Leading 2: |71
Leading 3; Leading 3; Leading 3: |72
~Music Source —Loud Bell —Meet Me Conference
Length: |3 vI Length: |3 vl Lenagth: |2 vl
Leading 1: I??1 Leading 1: I??Q Leading 1: [ag
Leading 2: | 772 Leading 2: | Leading 2:
Leading 3: | Leading 3: I Leading 3: |
—CO Group Operator Code Account Code——
tengtne |1 =lf3  =lfs =z =izl engt [t =] enom [ o
Leading: | 9 [74 ] [ | Leading: | 0 Leading: [ 7
~ Remote Extension
Length: |3 vlLeading i |3g Leading 2: |31 Leading 3: |32 Leading 4: | a3
Leading 5: | a4 Leading 6: | a5 Leading 7: I 6 Leading 8: | a7
Update | InitializedF &) | Close | Help |

3) Enter the settings in the fields as described below for each section of this screen.

In the CO Group fields (located in the bottom left area of the screen):

CO Group
Length:|1 j|3 j|3 j|3 j|3 j
Leading:lg |74 I I I

4) Select the number of digits (1 to 4) in the directory number you want to assign to CO line group 1 in the
first Length field.
e The default is 3.

5) Enter the digits (0 to 9999) you want to use for accessing CO line 1 in the first Leading field.
e The default is 9.
« Use the method shown in the steps 1 and 2 to assign the lengths and directory numbers for CO line
groups 2 through 5.

In the remaining areas and fields:

6) Specify the length and any appropriate leading digits for CO line directory, Music Source, Loud Bell,
External Pager, Virtual Number, and Meet Me Conference using the same method as shown in the steps
3 and 5 above.

When you are finished:
7) Click the Update button to store the settings into the database on the local disk.
8) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
9) Perform a SEND to copy your new database to the DX-120 switch system memory.

Customizing the Numbering Plan via PC-DBA (continued on next page)
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Customizing the Numbering Plan via PC-DBA (continued)

CUSTOMIZING THE NUMBERING PLAN VIA THE DET
You can program the numbering plan for extensions as well as for CO groups.

=S NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

NUMBERING PLAN (PART 1): EXTENSION SETTINGS

Setting the directory number:

From the DB Item Select screen (see steps 1-3 above):
4) Enter 08-09-02.
5) Press save to enter directory number programming.

6) Press show to display the length setting (go to step 5 in the next section).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the length of the extension group number:
Use the steps below to select the number of digits (1 to 4) you want to use in extension numbers

From the DB Item Select screen (see steps 1-3 above):
4) Enter 08-09-02-01.

5) Press save to display the length of the number you want to use in extension numbers.
e The default is 3

6) Press chg until the length you want to use appears.
7) Press save to store the setting.

8) Press next to display the Leading 1 setting (go to step 5 in the next section).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Customizing the Numbering Plan via the DET (continued on next page)
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Customizing the Numbering Plan via the DET (continued)

Setting Leading 1:

EXAMPLE

If you want all of your extension numbers to begin with 5, enter 5 here. Or, to allow
only extension numbers 590 through 599, enter 59 (assuming a 3-digit length). The
default is 1 for Leading 1 and 2 for Leading 2, therefore, the default extension
numbers include 100 through 299.

From the DB Item Select screen (see steps 1-3 on page 110):
4) Enter 08-09-02-02.

5) Press save to display the Leading:1 (i.e., leading digit) setting for this extension group.
e The default is 1.

6) Press chg until the leading digit you want to use appears.
7) Press save to store the setting.
8) Press next to display the Leading 2 setting (go to step 5 in the next section).
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Leading 2:

EXAMPLE

If you want to allow extension numbers 570-579 in addition to extension numbers you
specified in the Leading 1 field, enter 57 here. The default is 1 for Leading 1 and 2 for
Leading 2, therefore, the default extension numbers include 100 through 299.

From the DB Item Select screen (see steps 1-3 on page 110):
4) Enter 08-09-02-03 to display the Leading:2 (i.e., second leading digit) setting for this extension group.
5) Press chg until the leading digit you want to use appears.
6) Press save to store the setting.

7) Press next to display the Leading 2 setting (go to step 5 in the next section).
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Customizing the Numbering Plan via the DET (continued on next page)
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Customizing the Numbering Plan via the DET (continued)

Setting Leading 4 through 9:
Use the steps below to specify the appropriate leading digits for extension page groups, extension hunt groups,
extension pickup groups, individual speed dial numbers, and system speed dial numbers

From the DB Item Select screen (see steps 1-3 on page 110):
4) Enter 08-09-02-04~09.
5) Press save to display the Leading: 3~8.
6) Press chg until the leading digit you want to set appears.
7) Press save to store the setting.

8) Press next to display the next leading setting.
* Repeat steps 4 through 7 in this section for each leading you want to set.

OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

NUMBERING PLAN (PART 2): CO GROUPS

From the DB Item Select screen (see steps 1-3 on page 110):
4) Enter 08-09-01
5) Press save to display the Numbering Plan - CO Group programming.
6) Press show to enter into CO Group numbering plan programming.
OR
Press next until the numbering plan item you want to program appears on the display.
7) Press show to display the Length parameter.

8) Press chg until the length you want to use appears.
 Valid choices are 1-4.

9) Press next until the leading digit you want to program displays.
10) Press chg to allow an entry into this item.

11) Enter the leading digit(s) you want to assign to this system resource, then press save.
« Leading digits allow you to specify the starting digits of a directory number.

¢ You can use the leading digit fields to specify a range of numbers (e.g., 74 in a three digit field allows a
range from 740 to 749 and excludes all other numbers).

12) Press next until the next numbering plan item you want to change appears.
* Repeat these steps above for all numbering plan items you want to change.

13) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Phantom Lines / Virtual Numbers

Phantom lines (i.e., virtual numbers) are software resources that act as placement mechanisms for call processing.

e CO line and intercom calls can be routed to phantom lines where they can be accessed by any extension that has
an appearance (button) for that phantom line.

= If internal call routing requires a connection (CO line or intercom) to be placed in a general access location,
phantom lines can be a good solution.

e Phantom lines do not ring.

e The system indicates a call at a phantom line by fast flashing the associated LED only.

= Calls that are connected to phantom lines are usually announced using the page feature for proper pickup.
* You must program phantom lines onto Feature Keys (see “Assigning Feature Keys” on page 442).

= If no appearance of the phantom line exists in the system, the user attempting to call the phantom line or transfer
a call to the phantom line will receive error tone and OUT OF SERVICE wil appear on the display:

= Phantom lines/virtual numbers are set up within the Numbering Plan (see “Customizing the Numbering Plan” on
page 103)
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SECTION 5 - PROGRAMMING C.O. LINES

OVERVIEW

Programming CO Lines is probably the first thing you will want to do when programming either an existing database or
a new database. You can program the CO lines using either PC-DBA or a DET

IMPORTANT!

A e |If you are programming an existing database using PC-DBA, be sure to upload the
current switch database to your laptop before making any changes. This way, you
will be working on the customized database and will not have to reprogram all the
custom settings.

 If you are programming a brand new database from scratch without using any
templates, you can skip this step.

=y NOTE
The DX-120 provides you with a shortcut to use when programming CO lines - see
“Shortcuts that Help You Work Faster” on page 29 for more information.

CAUTION

Database changes reside only on your computer. When all changes have been
made to the database, perform a SEND operation (see “Sending Data to the
Switch” on page 19) to download the new database to the DX-120 switch.

BASIC CO LINE PROGRAMMING TASKS

Perform the following tasks for each line:

= Assign the CO line to a tenant group (see page 116)
e Assign the CO line to a line group (see page 119)

* Assign the Day and Evening classification, as well as the Music Source
for this CO line for the CO line (see page 121)

* Assign the CO line type (see page 126)

e Enable/disable call abandon (see page 129)

e Set up privacy for this CO line (see page 131)

e Set up the CO ring type (see page 134)

e Assign the answer position for Day and Evening modes (see page 136)
e Set up Time Switching (see page 140)

e Set up Pre-Defined Call Forward for this line (see page 144)

e Set up the PBX code and hunt method for line group 1-8 (see page 147)
e Set up the alternate CO group (see page 150)

e Set up Fax detection (see page 153)

e Setupthe T1 or ISDN (T1/PRI) Card - optional* (see pages 155 and 164)
e Set up the Translation Table - optional* (see page 171)

*If there is no T1 or ISDN (T1/PRI) Card installed, this processes is not necessary.
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Assigning the Tenant Group

The Tenant Groups feature allows you to separate system resources so the DX-120 system can operate as two or
three independent systems deployed at a single site.

Tenant Grouping allows you to independently allocate resource directory numbers. The directory numbers for system
resources then interact only with the resources within the tenant group.

EXAMPLE

If you designate attendant extensions for each tenant group; these attendant
extensions act independently for the assigned tenant group. When a caller dials 0 to
reach the attendant, the system automatically calls the attendant extension you
designated for that group (attendant extension 2 for tenant group 2, etc.).

= The following conditions apply to setting up tenant groups:

You can set up a maximum of three tenant groups in the DX-120 system.

Extension directory numbers remain unique to system ports and are not duplicated for each tenant group
(although extension dialing may be restricted across tenant group barriers).

When tenant calling is restricted from one tenant group to another tenant group, intercom calls, call transfers,
and recall operations will not operate across these designations.

—y NOTE
|5 , .
. If you want intercom calls, call transfers, and recall operations to work across tenant
group barriers, do not set up separate tenant groups.

All tenant groups can be set up to allowed to dial intercom directory numbers of extensions in all other tenant
groups (“Assigning Extensions to Tenant Groups” on page 391). The range is Y/N for each calling direction
between tenant groups.)

ASSIGNING THE TENANT GROUP VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

Assigning the Tenant Group via PC-DBA (continued on next page)
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Assigning the Tenant Group via PC-DBA (continued)

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
B

C.0. Line |m'| Private To: I 'I
Answering Positions

e Bl g 1E-)aif1:1n1 = e =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5 =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

« Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

NOTE

If this line is a private line for a particular extension, click the down arrow to the right of
the Private To field and select the extension to which it is to be assigned. By default,
this field is blank.

3) Select the tenant group (1, 2, or 3) to which this line is to be assigned.

Tenart Group: |1 5

- L3

e 2
Dialing: 3

4) Click the Update button to enter your settings into the database on your local disk.
¢ Assign Tenant Groups to other C.O. Lines as needed using the steps above.

When all assignments have been made:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy your new database to the DX-120 switch system memory.

Assigning the Tenant Group (continued on next page)

- 117 -



BAsic CO LINE PROGRAMMING TASKS DX-120 Programming Manual

Assigning the Tenant Group (continued)

ASSIGNING THE TENANT GROUP VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 02-XXX-02 (where XXX is the CO line directory number: 800-839).
5) Press save to display the Tenant Group selection for the CO line you specified.
6) Press chg until the tenant group you want to use for this CO line appears.
7) Press the Hold button to enter a new CO line to program.
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning the CO Line Group

The system provides eight CO line groups that you can assign to specific CO lines. The CO line group assignment is
used for CO line pool access.

NOTE

@ The CO line groups are, by default, designated by three-digit notation when
programmed on DET programmable feature buttons. The exception to this is CO line
group 1, which is by default designated as a one-digit 9. You can program CO line
groups 2 through 8 by dialing 740 through 746.

ASSIGNING THE CO GRoup viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource 3
Restriction 3
Extension Application 3
C.0, Line Application 3
Syskem Application 3
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
i

C.0. Line |m'l Private To: I 'l
Answering Positions

e Bl g 1E-)aif1:1n1 ol =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5] =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

¢ Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

Assigning the CO Group via PC-DBA (continued on next page)
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Assigning the CO Group via PC-DBA (continued)

3) Select the CO group number you want to assign to this CO line from the C.O. Group field.
 Valid entries are 1 though 8.

¢ The default is 1.

4) Click the Update button to enter your settings into the database on your local disk.
¢ Assign C.O. Groups to other C.O. Lines as needed using the steps above.

When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ASSIGNING THE CO GROUP VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Program your extensions for CO Line Access.

5) Enter 02-XXX-03 (where XXX is the CO line directory number: 800-839).
6) Press save to advance to CO line group for the CO line you specified.

7) Press chg until the CO line group you want to assign displays.
 Valid entries are 1 though 8.

e The default is 1.
8) Press the volume UP button to return to the DB Item Select screen.
9) Enter another CO line.
OR
Press the Hold button to select another CO line you want to program.
10) Press show.
11) Press next twice to advance to the CO line group programming for the CO line you specified.

When finished programming CO line groups
12) Press the volume UP button to return to the DB Item Select screen or exit programming.
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Setting the Day and Evening Class of Services (COS)
and Music On Hold (MOH) Source

The DX-120 allows you to assign a different class of service for day mode and evening mode.

Whenever a CO line is placed on hold, the system plays programmed music. If you need background music or music
on hold, you must connect the music channels to some music source.

CO lines that are placed on hold are connected to one of two external music sources. The DX-120 system provides
two sources of MOH, since the system may be installed in a location that serves two separate businesses and MOH
requirements.

As an alternative, the system can play a “tone” to callers while on hold. If neither of the two music channels is
connected to a music source, or if the music sources are not intended for the MOH function, you can use the beep tone
to signify to callers on hold that their call is still holding. The tone duration is one second, and repeats every 4 seconds.

=y NOTE
To use the internal music tone, the MUSIC option strap (JPC1) must be connected to
the INT position on the CPM board. For further details on connecting MOH sources,
see the DX-120 Technical Manual, Volume I, Installation and Maintenance.

SETTING DAY AND EVENING COS AND MOH SouRcCE viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
|

C.0. Line |m'| Private To: I 'I
Answering Positions

e Bl g 1E-)aif1:1n1 = e =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5 =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

Setting Day and Evening COS and MOH Source via PC-DBA (continued on next page)
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Setting Day and Evening COS and MOH Source via PC-DBA (continued)

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

« Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

3) Complete the fields as shown below:

IN THIS FIELD... SELECT...

The class of service that you want the system to use during

daytime hours for this CO line.

Day Class « Valid options are 0 through 7.

* The default is class of service 0.

The class of service that you want the system to use during

evening hours for this CO line.

Eve Class « Valid options are 0 through 7.

¢ The default is class of service 0.

The music on hold source that you want to use for this CO
line. Available options are:

¢ MC1(default - music channel 1)
* MC2

* TONE (select if you want to provide music sources for
some other purpose)

MOH Source

4) Click the Update button to enter your settings into the database on the local disk.
¢ Use the procedure shown above to line types to other CO lines.

When you are finished:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Day and Evening COS and MOH Source (continued on next page)
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Setting Day and Evening COS and MOH Source (continued)

SETTING DAY AND EVENING COS AND MOH SOURCE VIA THE DET

NOTE
¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Assign the day and evening classifications for the CO line

5) Enter 02-XXX-04 (where XXX is the CO line directory number: 800-839).

6) Press save to advance to the Day Classification programming screen for the CO line you entered (CO line
1 =800, CO line 40 = 839).

7) Press chg until the appropriate day class (0 through 7) appears.
e The default is 0.

8) Enter 02-XXX-05 (where XXX is the CO line directory number: 800-839).

9) Press save to advance to the Evening Classification programming screen for the CO line you entered (CO
line 1 = 800, CO line 40 = 839).

10) Press chg until the appropriate evening class (0 through 7) appears.
e The default is 0.

11) Enter 02-XXX-06 (where XXX is the CO line directory number: 800-839).

12) Press save to advance to the MOH Source programming screen for the CO line you entered (CO line 1 =
800, CO line 40 = 839).

13) Press chg until the appropriate MOH source (MC1, MC2, Tone) appears.
14) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting the Dial Tvpe
You can designate CO lines as pulse dial or DTMF (Touch Tone®) dial types. This setting determines how the system
delivers telephone number dialing to the telephone company.

You can temporarily force a CO line that is marked as dialing type “pulse” to tone mode for use with automated
answering devices etc. using the Pulse to DTMF Conversion feature.

SETTING THE DIAL TYPE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
|

C.0. Line |m'| Private To: I 'I
Answering Positions

e Bl g 1E-)aif1:1n1 = e =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5 =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

¢ Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

Setting the Dial Type via PC-DBA (continued on next page)
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Setting the Dial Type via PC-DBA (continued)

3) Select the dialing mode you want to set (Tone or Pulse).

e The default is Tone.
Dialing: |TOME -
FULSE
Iy Twng:

4) Click the Update button to enter your settings into the database on the local disk.
¢ Use the procedure shown above to assign dial types to other CO lines.

When you are finished:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING THE DIAL TYPE VIA THE DET

—3 NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 02-XXX-07 (where XXX is the CO line directory number: 800-839).
5) Press chg to select Tone or Pulse dialing mode.
6) Press the volume UP button to return to the DB Item Select screen to enter a new CO Line number.
7) Continue making other programming changes.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting the CO Line Type
You can assign each CO line one of the following CO line circuit connection types: CO, PBX, EMPTY, PAGE, and CO
DEV.

DESCRIPTION
CO Standard interface lines that require no special handling for advanced system features.
PBX Invokes system automatic operations for handling of PBX ports. When the user dials a

programmed PBX trunk access code, the system is alerted that the user is accessing a telephone company
facility to make a network call. When this occurs, the system monitors digits dialed after the PBX access
code and compares them against the allowed digit interval table in that station’s class of service.

The programmed PBX trunk access code also tells the system to insert a pause when re-dialing telephone
numbers dialed on that CO line, beginning with the PBX access code. This operation applies for Speedily,
Last Number Redial, Saved Number Redial, MemoPad, and Automatic Redial.

EMPTY Use this assignment for CO lines equipped on the system, but not connected to telephone company net-
work facilities. The EMPTY type eliminates the CO line from access by system features that automatically
access CO line resources.

PAGE The PAGE type identifies a CO line circuit as being connected to special apparatus. This type effectively.
Removes the CO line circuit from automatic access by system features while maintaining its direct accessi-
bility for the specific purpose of its connection. Typical use would include connection of ancillary paging
equipment.

CODEV Identifies a CO line circuit as being connected to special apparatus. This type effectively

removes the CO line circuit from automatic access by system features, while maintaining its direct accessi-
bility for the specific purpose of its connection. Typical use would include connection of ancillary analog
intercom calling device.

T1 Identifies a CO line circuit as being connected to a T1 line. It does not require any special han-
dling for advance system features.

T1/PRI Identifies a CO line circuit as being connected to an ISDN (T1-PRI) line. It does not require any
(ISDN) special handling for advance system features.

Setting the CO Line Type (continued on next page)
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Setting the CO Line Type (continued)

SETTING THE CO LINE TYPE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
|
C.0. Line |m'| Private To: I 'I

Answering Positions

e Bl g 1E-)aif1:1n1 = e =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5 =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
¢ Available entries are 800 through 839.

« Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

3) Select the dialing mode you want to set (Tone or Pulse).
e The default is Tone.

Setting the CO Line Type via PC-DBA (continued on next page)
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Setting the CO Line Type via PC-DBA (continued)

4) Select the Connection Type.

CO LN Type:

CO Group: PHX
EMPTY

PAGE

e e

5) Click the Update button to enter your settings into the database on the local disk.
« Use the procedure shown above to set line types for other CO lines.

When you are finished:
6) Click the Close button to exit the current screen and return to the PC-DBA main screen.
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING THE CO LINE TYPE VIA THE DET

=y NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Enter 02-XXX-08 (where XXX is the CO line directory number: 800-839).
4) Press save to displays the selected CO line.

5) Press chg until the appropriate CO Line Type displays.

6) Press the volume UP button to return to the DB Item Select screen and another CO line number for
programming.

OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Call Abandon
CO line supervision is a Central Office (telephone company) feature. This feature provides advanced handling of call
connections when the distant-end party disconnects.

This function is especially useful when calls that have been placed on hold go unattended and the caller hangs up, or
when the caller is connected to voice mail, leaves a message, and hangs up.

The DX-120 receives the disconnect signal from the telephone company and forces the CO line on-hook to release the
system resource for other uses.

SETTING CALL ABANDON VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
]

C.0. Line |m'| Private To: I 'I
Answering Positions

Tenant Group: |1 vl Day Class: IU vI 1E_)aif1_m1 j 4 | j
Dialing: |TONE vl Eve Class: |D j e I j 5.| j

CO LM Type: |CO vI MOH Source: |MC1 j g | j 6.| j
CO Group: |1 vl CO Ring Type: |D vl Eva Pre-CEW Mosns

v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

¢ Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

Setting Call Abandon via PC-DBA (continued on next page)
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Setting Call Abandon via PC-DBA (continued)

3) Make sure the checkbox (¥ ) next to Call Abandon is checked to enable the Call Abandon feature (¥ ).
If it isn’t, click on it to enable the feature.

[ Call Abandon

« Clicking on this box toggles the setting between on/enable (a checkmark ¥ ) and off/disable (no
checkmark ).

+ The default is on (checkmark ).

When you are finished:

4) Click the Update button to store the settings into the database on the local disk.
« Use the procedure shown above to set the call abandon for other CO lines.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING CALL ABANDON VIA THE DET

NOTE
.g « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Enter 02-XXX-09 (where XXX is the CO line directory number [800-839]).

4) Press save to advance to the selected CO line call abandon setting for CO line “XXX.”
5) Press chg repeatedly until the appropriate value (Y/N) displays for this CO line.

6) Press the volume UP button to return to the DB Item Select screen and enter another CO line.
OR

Press the Hold button to select another CO line you want to program.
7) Enter the CO line number.
8) Press show.

9) Press next to advance through database items until the Call Abandon database item displays.

Setting Call Abandon via the DET (continued on next page)
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Setting Call Abandon via the DET (continued)

When finished programming CO line call abandon:
10) Press the volume UP button to return to the DB Item Select screen.
OR

Use back or next to skip to the appropriate database item.

When finished programming call abandon database items:
11) Press the volume UP button to return to the DB Item Select screen and another CO line number for
programming.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Privacy and Enabling Privacy Release

The DX-120 system is shipped with all intercom and CO line calls set for privacy, which means these calls may not be
monitored or interrupted by other extensions. If a user’s programmed class of service allows him/her to have the
Privacy Release and OHVA (Off Hook Voice Announce) features, they may use those them to override the CO line
privacy settings.

NOTE
. To intrude or monitor, a user must have a “lower” monitor class (i.e., number).

e If Privacy Release is disabled (the default), conversations are private from interruption.
e |If Privacy Release is enabled:
- conversajtions on that CO line may be interrupted (either by intrusion or monitor) by another extension.

- the Monitor feature can be used to listen in on existing conversations (see “Setting Up Monitoring Privileges”
on page 404).

- the Intrusion feature can be used to barge in on existing conversations (see “Setting Up Intrusion
Capabilities” on page 407).

* Privacy Release simplifies call processing by removing one of the safeguards.

e Having the Privacy Release disabled is typically required in most business applications, but in some
environments, this setting may be used in certain application (e.g., monitoring Technical Support calls for quality
control, etc.)

e The privacy release setting is applied on a CO line basis. That is, one CO line may be assigned privacy release
status while another is still marked for privacy thereby ensuring uninterrupted, private conver}sations.

e The following conditions apply to privacy release:
- Three extensions maximum may join a CO line conversation in progress.

- Privacy Release uses the system conference circuitry, therefore while up to three extensions can join a CO
line connection (the maximum Privacy Release), multi-party conversations are limited to eight (that is, eight
four-party conferences).

Setting Privacy and Privacy Release (continued on next page)
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Setting Privacy and Privacy Release (continued)

ENABLING PRIVACY RELEASE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
|

C.0. Line |m'| Private To: I 'I
Answering Positions

e Bl g 1E-)aif1:1n1 = e =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5 =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
cocroup: 1 | CORngTye:[o | Eve Pre-CFA Moans

v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

¢ Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

3) Click the checkbox (I ) next to Privacy Release to place a check mark there to enable the Privacy

Release (¥ ).

I7| Privacy Release
« Clicking on this box toggles the setting between on/enable (a checkmark ¥ ) and off/disable (no

checkmark 7).
¢ The default is off (no checkmark).

Enabling Privacy Release via PC-DBA (continued on next page)
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Enabling Privacy Release via PC-DBA (continued)

4) Click the Update button to store the settings into the database on the local disk.
¢ Use the procedure shown above to set the privacy release for other C.O. lines.
When you are finished:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ENABLING PRIVACY RELEASE VIA THE DET

$~ NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Enter 02-XXX-12 (where XXX is the CO line directory number: 800-839).

4) Press save to advance to the Privacy Release programming for the CO line you specified.

5) Press chg to select Yes or No.
e The default setting is No.

6) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Ring Type for the CO Line
The DX-120 system provides eight different ring types, so your customers can tell what CO line is ringing by the sound
of the ringing. You can allocate one of the eight available ring types to any CO line.

When you use this feature, the phone rings according to the specific ring type you assigned to the CO line handling the
incoming call. This feature is helpful when you arrange CO lines into groups for specific call handling—the ring type
helps to identify the CO line and the group to which it belongs.

ASSIGNING RING TYPE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
]
C.0. Line |m'| Private To: I 'I

Answering Positions

Tenant Group: |1 vl Day Class: IU vI 1E_)aif1_m1 j 4 | j
Dialing: |TONE vl Eve Class: |D j e I j 5.| j

CO LM Type: |CO vI MOH Source: |MC1 j g | j 6.| j
CO Group: |1 vl CO Ring Type: |D vl Eva Pre-CEW Mosns

v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

¢ Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

Assigning Ring Type via PC-DBA (continued on next page)
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Assigning Ring Type via PC-DBA (continued)

3) Select the ring type you want to use from the CO Ring Type field.

0 Ring Type: |n

Privacy Releas

J Initialize(

 Valid entries are 0 though 8.
« If you set this field to 0, there is no ring assigned to the CO line so the system uses the extension’s ring

type.
« If you set this field to 1 through 8, the CO ring type you assign overrides the extension’s ring type.

¢ The default for the CO Ring Type field is 0 (off).

4) Click the Update button to enter your settings into the database on your local disk.
< Program other ring types as needed using the steps above.

When all assignments have been made:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ASSIGNING RING TYPE VIA THE DET

=S NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Enter 02-XXX-11 (where XXX is the CO line directory number: 800-839).
4) Press chg until the appropriate ring type displays.
5) Continue making other programming changes.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Setting the Answer Position for Day and Evening

The DX-120 system has several ringing modes to allow flexible ringing patterns depending on office conditions. The
ringing modes available are: DAY, EVEning, ALTernate, and TIME. You can program the day and evening modes for
ringing assignments as required in these two operational conditions.

Ringing Mode Description

DAY Ringing pattern for CO line ringing assignments while the system is in Day mode.

EVE Ringing pattern for CO Line ringing assignments while the system is in Evening mode.

Scheduled time clock that automatically adjusts the mode of system operation from day mode to
TIME evening mode, based upon pre-programmed settings in “Setting CO Line Time Switching” on
page 140.

Used only if the optional Auto Attendant Module is installed (see page 298). This mode re-directs
ALT callers who have dialed 0 (zero) at the auto-attendant prompt to a temporary (alternate) destination.
This is typically used for primary attendant break periods, etc.

CONDITIONS FOR MANUALLY CHANGING CO RINGING MODES/ANSWER POSITIONS
= This function can only be operated at the attendant extension.

* You can assign the feature access code (Feature 63 + 9999) to an available “Flexible Feature Button Inquiry” on
page 450 at the attendant extension to provide one button operation.

e The displays of all DETs indicate their current ringing mode.The prompts EVE and ALT above the center LCD
interactive button indicate these active modes. The DAY mode is indicated by the absence of the other
indicators.

SETTING THE ANSWER POSITION FOR DAY AND EVENING viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

Setting the Answer Position for Day and Evening via PC-DBA (continued on next page)
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Setting the Answer Position for Day and Evening via PC-DBA (continued)

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
i

C.0. Line |m'l Private To: I 'l
Answering Positions

e Bl g 1E-)aif1:1n1 ol =]
Dialing: [Tone |  Bwclss[o -+ |||2 | <] 5] =]
colNType: [co =] MOHSource: [wc1 <] |||a | =] & -]
CO Group: m co RinngEm Eve Pre-CFYY NoAns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

e Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

3) Select the information for fields in this screen as shown below:

Answering Positions

- Diay
L R

Pre-CFW MoAns

Setting the Answer Position for Day and Evening via PC-DBA (continued on next page)
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Setting the Answer Position for Day and Evening via PC-DBA (continued)

In this field... Select...

Day 1 The directory number you want to use for the first daytime ringing position for
this CO line.
« Valid directory numbers are as follows:

- extensions 101-204

- UCD numbers 410-433

- Virtual number 700-729

- The default is extension 101.

Eve The directory number you want to use for the evening ringing position for this

CO line.
« Valid directory numbers are as follows.
- extensions 101-204
- UCD numbers 410-433
- virtual number 700-729
- The default is extension 101.

If there are additional daytime ringing positions:

4) Select the appropriate information for Day 2 through Day 6 fields (as needed) in the corresponding fields
as shown above.

5) Click the Update button to enter your settings into the database on the local disk.
« Use the procedure shown above to assign day and evening answer positions to other CO lines.
When you are finished:
6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

=3 NOTE
You can also set up a schedule so that the DX-120 automatically switches the CO line
® answer position based on the time of day.

Setting the Answer Position for Day and Evening via PC-DBA (continued on next page)
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Setting the Answer Position for Day and Evening via PC-DBA (continued)

SETTING THE ANSWER POSITION FOR DAY AND EVENING VIA THE DET

=y NOTE
.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

Program the day mode answering positions:
3) Enter 02-XXX-14-01-01 (where XXX is the CO line directory number: 800-839).
4) Press save to display the current Day mode Member 1 Answering Position.
5) Press chg to set the ringing/answering position for the day mode.

6) Enter the directory number for the ringing position (extension: 101-156; UCD: 410-433; or virtual number:
700-729).
e The default is 101.

7) Press save to store your changes.

Program the evening mode answering positions:
8) Enter 02-XXX-14-02 (where XXX is the CO line directory number: 800-839).
9) Press save to display the current Eve mode Answering Position.
10) Press chg to set the ringing/answering position for the evening mode.

11) Enter the directory number for the ringing position (extension, 101-156; UCD, 410-433; or virtual number,
700-729).
e The default is 101.

12) Press save to store your changes.
13) Continue making other programming changes.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting CO Line Time Switching

You can program the system to follow a seven day, twenty-four hour, time schedule that automatically switches
incoming CO lines to their programmed Day, Evening or Alternate ringing status and destinations. The programmed
timed switching of ringing modes is flexible and can be broken down into individual tenant groups.

HINT
¢ You can also manually change the CO line ring mode.

« Also see “Setting the Answer Position for Day and Evening” on page 136.

* You must program the time settings for all seven days of the week
e The system ringing mode must be set to Time Mode for Automatic CO Line Ringing.

= The time you enter when programming time switching is the time of day that the system changes the service
mode to the associated service mode.

e The system by default operates in the Day mode operation. Therefore, if you do not use time switching, the
system remains in day mode until manually switched to evening or alternate mode. It then remains in that mode
until you manually switch it again.

e The default Time Switching programming is set so the system operates in day mode from 8am to 5pm, Monday
through Friday; alternate mode from 12noon to 1pm, Monday through Friday; and evening mode at all other
times. However, you can change these settings.

EXAMPLE

If you do not want the system to use a different extension during the lunchtime hours,
you disable the alternate mode.

= Once programmed, time switching needs no user intervention.
e The current mode of operation is disjplayed for easy identification and verification as follows:
EXAMPLE

Day Mode Display:

JUN1g SUN 543
EXT 105

Alternate Mode Display:

JUN18 SUN 543

EXT  ALT 105

Evening Mode Display:

JUH18 SUN 543

EAT  EVE 105

Setting CO Line Time Switching (continued on next page)
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Setting CO Line Time Switching (continued)

SETTING CO LINE TIME SWITCHING VIA PC-DBA

From the PC-DBA main screen:

Programming. Maintenance: Help

Extension
L0, Line =

Call Handi 'Dx-‘la

System Resource
General Settings

Festrickion
Mumbiering Flan

Extension Application
DIR# and Port Ma& »

C.0, Line Application
Canfiguration Capy
System Time:

m Application

Bl v v v v~

Feature Key Pragramming -
K5 DB Password

1) Go to ProgrammingP>System Application® Time Switching to display the Application—Time Switching

screen.
RP: System Application. - Time Switching _5'
Tenant! Tenant2 Tenant3d ‘

Follows Tanant! 3 i ¥
At || 1300 [12:00 1300 [12:00 [13:00

Manday To To To
gve | [17:00 0800 [17:00 0800 [17:00 [ o800
Tuesay alt [ ]12:00 . | 1300 1200 TD_|13:nu 1200 T0:|13:00
Evi |1?:nc| : |na:nc| |1mu |na:nu |1mu |na:nu
o At | {1200 13:00 12:00 | 1300 12:00 13:00

Wednesday To To. To
Eve |[17:00 2 logo0 17:00 | na:00 17:00 0g:00
g [f1zoo 13:00 12:00 | 1300 12:00 13:00

Thursday To To Ta
Eve |[17:00 0g:00 [17.00 | na:00 [17.00 [ oz00
Alt | [12:00 13:00 12:00 13:00 12:00 13:00

Friday Th - T5 To
Eve ||17.00 08:00 17:00 | 000 1700|0800
At | | oooo 00:00 | no:on 00:00 | no:on | no:on

Saturday To T To
Eve ||o0:00 00:00 | no:on 0000 | no:on [ o0:00
Gungay At |[ 0000 5 00:00 | no:on L 00:00 | no:on T_u|un:un
Eve |nu:nu |nu:nu Inu:nu | o000 Inu:nu Inu:nu

Update | Initialize(F 8) | Close | Help |
Q_-\‘ NOTE

.é » For each tenant group, this screen contains two columns of entry fields. The first is
the starting time (From) and the second is the ending time (To) for the day you are
setting up.

e Times entered here are in military format: 00:00 to 24:00 hours.

* You only have to enter four (4) digits to set the time. The colon (:) is automatically
added by the system.

Setting CO Line Time Switching via PC-DBA (continued on next page)
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Setting CO Line Time Switching via PC-DBA (continued)

2) Enter the information in the fields as described below:

IN THIS FIELD ENTER...

The time you want the time switching to begin for tenant group

Alt (for Monda
( ) « The default is 12:00 PM.

The time you want the time switching to end for tenant group 1.

To (for Monda
( ) « The default is 01:00 PM (13:00).

The time you want the night, or evening, time switching to start for ten-
Eve (for Monday) ant group 1.
* The default is 05:00 PM (17:00).

The time you want the night, or evening, time switching to end for ten-
Eve To (for Monday) ant group 1.
* The default is 08:00 AM.

3) Make the time settings for Alternate and Evening modes for the remainder of the week.
« If you do not want to use time switching for a particular day, set the beginning and ending times to
00:00.

=3 NOTE
.é * Once you have set up the time switching you want to use for tenant group 1 and
are using multiple tenant grouping, use the steps above to set up time switching for
tenant groups 2 and 3, as needed.

e The DX-120 provides a shortcut if you are using multiple tenant groups, and want
to use the same time switching settings. If this is the case, program your settings
for tenant group 1, then click the Follow Tenantl boxes at the top of the screen
until a check mark appears for tenant group 2 and/or 3.

If you do this, the system programs time switching for these groups to the identical
settings you entered for tenant group 1. Thus there is no need to re-enter the
settings for the remaining tenant groups.

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting CO Line Time Switching (continued on next page)
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Setting CO Line Time Switching (continued)

SETTING CO LINE TIME SWITCHING VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Enter 08-15-1-02 to program time switching for Tenant Group 1 (08-15-2-02 for Tenant Group 2, or 08-15-
3-02 for Tenant Group 3).

4) Press save to display the first day of the week (Sunday).

If changes are necessary for this day press show, otherwise:
5) Press next until the day of the week you want to change appears.

6) Press show to display the first time period for which the Service Mode may switch for the day selected
(e.g. “ALT START" i.e., Alternate Start Time).

7) Press chg to change this data.
OR
Press next to select the Service Mode for which a time schedule must be entered.
e The data items that can be changed are ALT START, ALT END, EVE START, EVE END.
When the Service Mode you want to change appears:
8) Press chg and enter the new value in 24-hour format (e.g., 1:00 PM is entered as 13:00).
9) Press save to store this data.
OR

Enter 08-15-1-02-01 to program ALT START.
e The default is 12:00 PM (noon).

OR

Enter 08-15-1-02-02 to program ALT END.
¢ The defaultis 1:00 PM (13:00).

OR

Enter 08-15-1-02-03 to program EVE START.
e The default is 5:00 PM (17:00).

OR

Enter 08-15-1-02-04 to program EVE END.
e The default is 8:00 AM.

Setting CO Line Time Switching via the DET (continued on next page)
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Setting CO Line Time Switching via the DET (continued)

Continue programming as required:
10) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Setting the Pre-Defined Call Forward No Answer

The Pre-Defined Call Forward No Answer feature allows you to control where the system forwards a call on a CO line
when an extension does not answer. You may want the system to forward these calls to the attendant extension, a
departmental secretary, another department, etc. This feature is CO line specific; that is, the system forwards all
unanswered calls on a CO line.

=3 NOTE
. If you only want to forward unanswered calls for specific extensions, set that up in the
* individual extension’s programming.

HINT
@ Also see “Setting Predefined Call Forward Time” on page 282.

SETTING THE PRE-DEFINED CALL FORWARD NO ANSWER VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance He

Extension

Call Handling & 3

Syskem Resource
Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

3
3
13
L3
3
L3

1) Go to ProgrammingP>C. O. Line to display the C. O. Line screen.
i
C.0. Line |m'l Private To: I 'l

Answering Positions

Tenant Group: |1 vl Day Class: IU vI 1E_)aif1_m1 j 4 | j
Dialing: |TONE vl Eve Class: |D j e I j 5.| j

CO LM Type: |CO vI MOH Source: |MC1 j g | j 6.| j
CO Group: |1 vl CO Ring Type: |D vl Eva Pre-CEW Mosns

[v Call Abandan [~ Privacy Release |131U1 j | j

Update | initialzeFs) | close | Help |

Setting the Pre-Defined Call Forward No Answer via PC-DBA (continued on next page)
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Setting the Pre-Defined Call Forward No Answer via PC-DBA (continued)

2) Select the central office line you wish to assign.
« Available entries are 800 through 839.

« Entries 840 to 843 are for future use only.

C.0.Line |1:800

2:am
3:802
4:803
5:804
6:805
7:806
8:807 ¥

Enant Group:

Dialing:

3) Select the (Pre-CFW NoAns) directory number to which you want the system to forward unanswered calls
for this CO line.

Fre-CRW hosns

« Valid directory numbers are as follows.
- extensions 101-204
- UCD numbers 410-433
- virtual number 700-729
- The default is blank.

4) Click the Update button to enter your settings into the database on the local disk.
« Use the procedure shown above to assign predefined call forward "no answer" (i.e., unanswered)
directory numbers to other CO lines.

When you are finished:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting the Pre-Defined Call Forward No Answer (continued on next page)
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Setting the Pre-Defined Call Forward No Answer (continued)

SETTING THE PRE-DEFINED CALL FORWARD NO ANSWER VIA THE DET

=S NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 02-XXX-14-03 (where XXX is the CO line directory number: 800~839).
5) Press save to display the Pre-CFW NoAns menu.

6) Press chg.

7) Enter the directory number for the ringing position (extension, 101-156; UCD, 410-433; or virtual number,
700 through 729).
* The default is NONE.

8) Press save to store the data.

9) Continue making other programming changes.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up the PBX Code and Hunt Method

You can install the DX-120 system as a subordinate of a host PBX. In this case, users access PBX facilities using a

DX-120 CO line button. To make a PBX call (PBX extension numbers and trunks) the user accesses the PBX port
using the CO line button and dials the appropriate PBX code.

You can also program the DX-120 to recognize the code used to access PBX trunks on PBX type CO ports. This code
identifies the type of call being placed so that the system can process the call accordingly. When the system
recognizes the PBX code, it automatically conditions the call for redial features and applies the class of service
restrictions you have programmed for that user.

e The following conditions apply to assigning a PBX code to a CO line.

When you have programmed the PBX code, the system applies extension toll restriction(s) when the code is
dialed.

Last Number Redial and Automatic Redial recognize the code; the system automatically inserts a pause
following the code, if that is how you have programmed it.

The PBX access code can be from 1 to 4 digits.

= Other programming that can affect how the system processes PBX calls include the following.

CO Line — CO Line Type (see “Setting the CO Line Type” on page 126)
CO Line — CO Group (see “Assigning the CO Line Group” on page 119)

Call Handling — CO Flash Time, PBX Flash Time, Pause and PBX Auto Pause (see “Section 6 - Programming
Call Handling” on page 187)

System Resource - Speed Number Programming (see “Programming Speed Dial Numbers” on page 64)

SETTING Up THE PBX CoDE AND HUNT METHOD VIA PC-DBA

From the PC-DBA main screen:

Programming. Malntenance. Help

Extension

.0, Line

Zall Handling 3

Syét_an'r Resource L3

Restriction »

Extension Application r
L3
3
13

DX-120

.0, Line Application

20 Group Sethings
Fax Detection k
T1 Card

FK5U DB Passward Translation Table

1500
Alternate Line ID Table

Syskem Application;
Feature Key Programming

Setting Up the PBX Code and Hunt Method via PC-DBA (continued on next page)
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Setting Up the PBX Code and Hunt Method via PC-DBA (continued)

1) Go to ProgrammingPC. O. Line Application®CO Group Settings to display the C. O. Line Application--
CO Group Settings screen.

RP: C. 0. Line Application -CO Line Group Settings ﬂ
cocou: -]
P Code: |9 Search Order: ¢ SEQF & SEQL " RAN
~Altarnate CO Group
CO Group Mo, Delete Digits Ingerted Digits
Atcocrupt [0 = oo
Atcosrupz [0 7] o

i DIR No. Swapping

DIR Mo 8 DIR# Swapping: I 'I

Update | Initiarlze(Fa)l Close | Help |

2) Select the CO group you want to program.

CO Group: |1

PEX Code:

Alternate GO

00 - 0RO Lk

Alt. CO Grou

3) Enter/select the information in the fields as described below:

IN THIS FIELD... DO THIS...

Enter the code required to access a PBX trunk on the CO line circuit in
this group.

PBX Code + Valid numbers range from 0 to 9999.

¢ The default is 9.

Select the search order (i.e., hunt method) (search order) for the selected
CO line group.

« Valid options are:

Search Order - SEQL (SEQuential Last)
- SEQF (SEQuential First)
- RAN (RANdom access)

- The default is SEQL.

4) Click the Update button to store the settings into the database on the local disk.
« Use the procedure above to assign PBX codes and hunt methods to other CO groups in the system.

When you have finished all programming changes:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up the PBX Code and Hunt Method (continued on next page)
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Setting Up the PBX Code and Hunt Method (continued)

SETTING UP THE PBX CoODE AND HUNT METHOD VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Programming PBX Codes for PBX trunk access:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-01-0X-01 (where X represents the line group: 1~8).
5) Press save to advance to the PBX Code programming screen for the specified CO line group.
6) Press chg.

7) Enter the PBX code.
 Valid numbers range from 0 to 9999.

e The default is 9.
8) Press save.

9) Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming the hunt method (search order) for the selected CO line group:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-01-0X-02 (where X represents the line group: 1~8).
5) Press save to advance to the hunting method programming screen for the specified CO line group.

6) Press chg until the order you want to use appears (i.e., SEQL = Sequential Last, SEQF = Sequential First,
or RAN = Random access).
e The default is SEQL.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up the Alternate CO Line Group

CO Line Alternate Route works with the DX-120 system CO line groups. When this feature is invoked, the system may
route users over CO line groups that they did not necessarily access. This feature is useful in high traffic environments
when the use of second and third CO line selections may periodically be required.

When a user accesses a CO line group and all of the CO lines in this group are in use, the system automatically ports
over the user to the alternate CO line groups you specify. The system handles special call handling using delete digits
and insert digits, as required by the alternate lines. The following conditions apply when assigning alternate CO line
groups/routes.

 When CO lines in all groups are busy, the system plays a busy tone and displays a busy message on the LCD.
e An extension user may invoke callback to the first selected CO line group by pressing the chck button.

SETTING UP THE ALTERNATE CO LINE GROUP VIA PC-DBA

From the PC-DBA main screen:

Programming. Malntenance. Help

Extension

.0, Line

Zall Handling 3

Syét_an'r R‘esouré,e_ L3

Restriction ]

Extension Application r
L3
3
13

p:

DX-120 |
0 Group Settings I
Fax Detection k

Feature Key Programming T1 Card
FK5U DB Passward : Translation Table

150N
Alternate Line ID Table

1) Go to ProgrammingPC. O. Line Application®CO Group Settings to display the C. O. Line Application--
CO Group Settings screen.

.0, Line Application

Syskem Application;

RP: C. 0. Line Application -CO Line Group Settings x|

oo roun N~

PBEX Code: |9 Search Order: ¢~ SEQF = BEQL  RAN

- Altarmate GO Group.
CO Group Mo, Delete Digits Insered Digits

[=]

Atcocrupt [0 =
mtcosrouwpz |0 =]

B3

=]

i DIR No. Swapping

DIR Mo 8 DIR# Swapping: I 'I

Update | Initialize(FB)l Close | Help |

2) Select the CO group you want to program.

GO Group: |1

PBY Code:

Alternate CO

00 - 0RO Lk

Alt. CO Grou

Setting Up the Alternate CO Line Group via PC-DBA (continued on next page)
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Setting Up the Alternate CO Line Group via PC-DBA (continued)

3) Select/enter the information for the fields as described below:

IN THIS FIELD... DO THIS...

Select the first alternate CO group for the selected CO group.
Alt CO Group 1 « Valid alternate group numbers are line groups 0 through 8.
« The default is 0 (no alternate group).

Select the number of digits you want the system to delete at the begin-
ning of the dial string when it uses this alternate route.

« Valid digits are 0-16.
* The default is 0 (delete no digits).

Delete Digits

Enter the digits you want the system to insert at the beginning of the dial
string when it uses this alternate route.

« You can enter up to 16 digits using digits 0-9.
* The default is blank (insert no digits).

Inserted Digits

=y NOTE
.é Set the same information for Alt CO Group 2 as needed.

4) Click the Update button to store the settings into the database on the local disk.
« Use the procedure above to program alternate CO Line Groups for other CO groups in the system.

When you have finished all programming changes:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up the Alternate CO Line Group (continued on next page)
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Setting Up the Alternate CO Line Group (continued)

SETTING UP THE ALTERNATE CO LINE GROUP VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Enter 07-01-0X-03 (where X is 1 through 8, representing the CO Line Groups 9 and 740-746).

4) Press save to advance to Alternate CO Group.
5) Press show to display the Alternate CO Group screen
6) Enter the alternate route to program (1 for first alternate, or 2 for second alternate) for this CO line group.

7) Press show to display the CO Group Number screen: x (where “x” is the current programming).
« “0” means no alternate route.

To change this alternate route selection, press chg.
8) Enter the CO line group that you want to use as the (1st or 2nd) alternate route for this CO line group.
9) Press save.
10) Press next to advance to the Delete Digits for this alternate route selection.

If it is necessary to delete digits from the dialed digits when calls are routed to this alternate:
11) Enter the number of digits to be deleted.
AND/OR
12) Press chg.
13) Enter the quantity of digits to delete from the beginning of the number dialed (0-9).
14) Press save.
15) Press next to advance to the Inserted Digits for this Alternate Route selection.

If it is necessary to insert digits before sending the dialed digits when calls are routed to this alternate:
16) Enter the actual digits required here.
AND/OR
17) Press chg.
18) Enter the required digits (up to 16 digits).
19) Press save.
20) Press next to display the Alternate CO Group screen.

Setting Up the Alternate CO Line Group via the DET (continued on next page)
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Setting Up the Alternate CO Line Group via the DET (continued)

You can now program the next alternate route for this CO line group (if required) or skip to step 22:
21) Enter the alternate route to program (1 for first alternate, or 2 for second alternate) for this CO line group.
22) Press show.

Continue programming in the same manner.

When you are finished programming alternate CO line routes:
23) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up FAX Detection

The DX-120 system has a standard FAX tone detection capability on the fourth port of each CO line board, that is, CO
line ports 4, 8, 12 and 16 have the circuitry required to detect “CNG” FAX tone.

When you program the system to receive a facsimile transmission on one of these CO line circuits, it automatically
answers the ringing line and waits for FAX tone. If the system detects the FAX CNG tone it connects the call to the
facsimile extension you specify.

SETTING UrP FAX DETECTION VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help
Extension
G0, Line
Call Handling ¥
Syskem Resource r P
Festrickion » Dx-1 2 0 .
Extension Application ’ J
C.0, Line Application 4 O Group Settings
Syskem Application 3
Feafure Key Programming #  T1 Card
K5l DB Passward Translation Table
1SDN
_ Alternate Line 1D Table.

1) Go to ProgrammingP>C. O. Line Application® Fax Detection to display the Fax Detection screen.

RP: C. 0. Line Application —Fan Detection x|

CO Lihe Ma. CO Line DIR# Fayx Destination
4 803
8 807
12 811
18 815

Setting Up Fax Detection via PC-DBA (continued on next page)
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Setting Up Fax Detection via PC-DBA (continued)

2) Select a FAX Destination for each CO line port (4, 8, 12, or 16) at which you want faxes received.
< To do this, you will need to select the directory number of the analog port that is connected to the FAX
machine.

Fax Destination

|NONE 'I

« Valid numbers include any analog extension port directory number.
* The default is NONE.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP FAX DETECTION VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Enter 07-02-01.
4) Press save to advance to the first Fax Circuit Destination screen (i.e., circuit 803).
5) Press chg.
6) Enter the directory number of the analog port that is connected to the fax machine for this line.
7) Press save.
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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PROGRAMMING FOR THE
OPTIONAL T1 AND ISDN (T1/PRI) CARDS

Use the programming instructions in this section if you have installed either of the following optional cards on the
current system:

e T1 Card (see below)
OR
* ISDN (T1/PRI) Card (see 164)

Programming for an Optional T1 Card

The optional T1 card offers the capability for digital trunking as well as increases trunk capacity (i.e., to 40 when
including 16 analog CO lines). ANI, DID, DNIS, Ground Start, Loop Start, E&M Wink Start, and E&M Immediate Start
are supported with the T1.

HINT
@ Also see...
e “T1 Call Operation” on page 320
e “Appendix F - T1 Maintenance” on page 480

e “Appendix D - Trunk Directory Numbers” on page 475

PROGRAMMING FOR A T1 CARD VIA PC-DBA

From the PC-DBA main screen:

Programming. Maintenance: Help

Extension

2.0, Line

- Call Handling

system Resource
Festrickion

Extension Application:
C.0n Line Application
System Application

00 Group Settings
Fax Detection

Feature Key Programming -
K50 OB Passward Translation Table ;
Bicl

>
3
»
»
3
13
b

Programming for a T1 Card via PC-DBA (continued on next page)
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Programming for a T1 Card via PC-DBA (continued)

1) Go to ProgrammingP>C.O. Line Application®T1 Card to display the C.O. Line Application—T1 Card

screen.

~General Setting.
Frarme Type: | _vI.EN Code |EISZS v.l Systern LEBK: INone v.l
- Wink Setting
T, Diuration: |3nn YIRK.-UF‘Eand: 400 ~| Rx LowBond: |50 -
—Caller 1D Setting
statDGT. [+ ~| EndpoT: [+ =] MaxLength: 10 -
Mamn: [NoNE 5] T Padding
) — R Gain
— Channel Setting e
|D 'V_.I dhb
DIR# M. |1:816 vl
TH Gain
Channel Type © Dwink. Start E&M he I~ Loop Back |D -vl ‘db
- Tie Line (T1 Remata Ext)
Delete Digits Insert Digits Route:
Jo El [1 i
Update | In'itiarLg_é(Fs)l Close | Help |

2) Select information for the fields as described below.

IN THIS FIELD

T1 CARD PROGRAMMING FIELDS

SELECT...

General Setting

Frame Type

* SF (i.e., Super Frame) - default*
The standard T1 mode consists of 12 frames per superframe cycle. The first frame bit

remains constant and rotates through the 12-bit pattern. By identifying the frame pat-
tern, the system can select the sixth and twelfth frame for the AB bit signalling inband
method. T1 parameters allow for 24 64-Kbit user channels.

IMPORTANT!
A If you are programming for ISDN (T1/PRI) and not T1, be sure to leave this
setting at SF.

« ESF (i.e., Extended Super Frame)
This setting consists of 24 frames. The frame bit uses only 6 frames leaving 18 bits for

other purposes (i.e., 6 bits for CRC information, and 12 bits for a facility data link).

T1 Card Programming Fields (continued on next page)
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IN THIS FIELD

T1 CARD PROGRAMMING FIELDS (continued)

SELECT...

EN Code

* AMI (i.e., Alternate Marked Inversion)

* B8ZS (i.e., Binary 8 Zero Substitution) - default*
This setting is used to send an “all zero” channel without violating the “ones-density”
requirement (i.e., a single “1” in each channel and no more than 15 zeros in a row).
Voice transmission will not allow an all zero channel, therefore, the B8ZS setting must
be used.

IMPORTANT!
A If you are programming for ISDN (T1/PRI) and not T1, be sure to leave this
setting at B8ZS.

System LPBK
(i.e., Loop Backs)

* None (default)

e Local
- This method loops the T1 board’s transmit output and receive input paths. The
loopback terminates all traffic and halts call processing (i.e., idle). While in the idle
condition, the system continues to transmit the T1 transmit stream to the network, but
it will not answr incoming calls.

- The main purpose of local loopback is to verify that the T1 board can properly
synchronize. Loopback local oepration is applicable to superframe and extended
superframe modes.

« Payload
- This is to be used with the ESF mode only (see previous description in this table).
This method loops the network receive input path with the remote T1 equpment’s
transmit output path.

- This method does not allow looping of the first bit of each frame to allow the T1
board’s facility data link to continue to transmit maintenance information.

- The T1 board goes “out of service” during this loopback time.
« Analog
* Framer
« All Chan

Wink Setting (all can be set within the range of 50-500ms intervals)

TX Duration (default = 300)

RX UP Bond (default = 400)

RX Low Bond (default = 50)

*)

Caller ID Setting (Max length

choices are 0 through 15 digits)

Start DGT *AD,0-9, % or#
End DGT *« A-D, 0-9, *, or#
Max Length *+0-15

T1 Card Programming Fields (continued on next page)
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IN THIS FIELD

T1 CARD PROGRAMMING FIELDS (continued)

SELECT...

Channel Setting

DIR # NO

Channel Type

* Loop Start

* Ground Start

« DID

¢ Immed Start E&M

* Wink Start E&M (default)
¢ Loop Back

(T1 Remote Ext)

T1 Padding
* Rx Gain
- -12to +12
¢ Tx Gain
- -12to +12
Tie Line

Reserved for Future Use

*If you are programming an ISDN (T1/PRI) card,
make sure that this default is set.

When you are finished:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming for a T1 Card (continued on next page)
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Programming for a T1 Card (continued)

PROGRAMMING FOR A T1 CARD VIA THE DET
See Field Descriptions beginning on pagel56 for more information about the settings via the DET.

=5 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
; Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 07-03 (see information in the following sections for making T1 settings).
5) Press save to enter T1 programming.

6) Press show to display the Alarm screen (now go to step 6 in “Viewing the T1 Alarm Screen” below).
AND/OR

7) Press next to go on to other T1 programming screens.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Viewing the T1 Alarm Screen - see step 6 above or step 5 below):

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-03-01.
5) Press save to display Alarm screen (display only).
6) Press next to display the Frame Type screen (now go to step 6 in “Setting the Frame Type:” below).

=g NOTE
.é Alarm is a display only field that will display an Alarm being sent from the T1 board.

Programming for a T1 Card via the DET (continued on next page)
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Programming for a T1 Card via the DET (continued)

Setting the Frame Type:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-03-02.
5) Press save to display Frame Type screen.

6) Press chg to select ESF.
« If you want to leave the setting at SF, skip to step 7.

IMPORTANT!
A If you are programming for ISDN (T1/PRI) and not T1, be sure to leave this setting at
SF.

7) Press next to display EN Code screen (now go to step 6 in “Setting the EN Code:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the EN Code:

From the DB Item Select screen (see steps 1 through 3 on page 159):
4) Enter 07-03-03.
5) Press save to display the EN Code screen.

6) Press chg to select AMI.
« If you want to leave the setting at B8ZS, skip to step 8.

IMPORTANT!
A If you are programming for ISDN (T1/PRI) and not T1, be sure to leave this setting at
B8ZS.

7) Press next to display Loopback screen. (now go to step 6 in “Setting the LPBK (Loopback) Option:”
below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for a T1 Card via the DET (continued on next page)
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Programming for a T1 Card via the DET (continued)

Setting the LPBK (Loopback) Option:

From the DB Item Select screen (see steps 1 through 3 on page 159):
4) Enter 07-03-04.
5) Press save to display the Loopback screen.

6) Press chg until the setting you want appears on the display.
e The default is NONE.

7) Press next to go to the first Wink Setting programming screen.

8) Press show to display TX Duration screen (now go to step 6 in “Make the appropriate Wink Settings:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Make the appropriate Wink Settings:

From the DB Item Select screen (see steps 1 through 3 on page 159):
4) Enter 07-03-05.
5) Press save to display the TX Duration screen.

6) Press chg to select another setting (from 50 to 500 in increments of 50).
e The default is 300.

7) Press next to display RX Up Bond screen.

8) Press chg to select another setting (from 50 to 500 in increments of 50).
e The default is 400.

9) Press next to display RX Low Bond screen.

10) Press chg to select another setting (from 50 to 500 in increments of 50).
e The default is 50.

11) Press next to go to the first Caller ID programming screen.

12) Press show to display Start Digit (now go to step 6 in “Make the appropriate Caller ID Settings:” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for a T1 Card via the DET (continued on next page)
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Programming for a T1 Card via the DET (continued)

Make the appropriate Caller ID Settings:

From the DB Item Select screen (see steps 1 through 3 on page 159):

4) Enter 07-03-06.
5) Press save to display the Caller ID screen.
6) Press show to display the Start Digit screen.
7) Press chg until the appropriate alphanumeric setting (using A-D, 0-9, * or #) appears.
8) Press next to display End Digit screen.
9) Press chg until the appropriate alphanumeric setting (using A-D, 0-9, * or #) appears.
10)Press next to display the Max Length setting.

11) Press chg until the appropriate setting (0-15) appears.

12) Press next to display the Channel setting screen.

13) Press show to display the Trunk screen (now go to step 6 in “Make the appropriate Channel Settings:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Make the appropriate Channel Settings:

From the DB Item Select screen (see steps 1 through 3 on page 159):
4) Enter 07-03-07.
5) Press save to display the Channel setting screen.
6) Press show to display the Trunk screen.
7) Enter the appropriate directory number (using digits 0-9).
8) Press save to store the settings.
9) Press next to display the Channel Type screen.

10) Press chg until the appropriate type is displayed.
e WINK: START E&M is the default.

11) Press save to store the settings.
12) Press next (twice) to display the Padding screen.

13) Press show to display the TX Gain screen (now go to step 6 in “Make the appropriate Padding Settings:”
below).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for a T1 Card via the DET (continued on next page)
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Programming for a T1 Card via the DET (continued)

Make the appropriate Padding Settings:

From the DB Item Select screen (see steps 1 through 3 on page 159):
4) Enter 07-03-09.
5) Press save to display the Padding screen.
6) Press show to display the TX Gain screen.

7) Press chg until the appropriate setting is displayed (-12 to 12).
¢ The default is O (zero).

8) Press next to display the RX Gain screen.

9) Press chg until the appropriate setting is displayed (-12 to 12).
e The default is O (zero).

10) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming for Optional ISDN (T1/PRI)

You can make the settings needed for outgoing and incoming ISDN (T1/PRI) calls by using the following procedure.

HINT

@ Also refer to the Vertical DX-120 Installation and Maintenance Manual which can be
found on the Vertical CCC website (www.vertical.com/ccc). There are other DX-120
user guides and manuals located on the CCC that are also useful in the installation,
programming, maintenance, and use of the DX-120 system.

PROGRAMMING FOR AN ISDN (T1/PRI) CARD viA PC-DBA

ISDN (T1/PRI) technology is similar to the T1 (see page 155), by adding another option for digital trunking and allowing
you to increase the DX-120 trunk capacity (i.e., to 39 when including 16 analog CO lines). The ISDN (T1/PRI) also
adds Caller ID Flexibility (Inbound Number & Name, Outbound Number).

HINT
@ Also see...
e “Setting Up the Translation Table” on page 171
e “ISDN (T1/PRI) Call Operation” on page 321
e “Appendix F - T1 Maintenance” on page 480

e “Appendix D - Trunk Directory Numbers” on page 475

From the PC-DBA main screen:

Programming Maintenance  Help

Extenision
.0, Line
‘Zall Handling »
Syshem Resource *
Restriction ¥
Extension Application 3
) 13
L4
b

.0, Line Application €0 Group Settings
Syshem Application Fasx Detection
Featurs Key Programring T1 Card

KSU DB Password Translation Table

_ Nternate Lina ID le

1) Go to ProgrammingP>C.O. Line Application®ISDN to display the C.O. Line Application -ISDN screen.

RP: C. 0. Line Application -ISDN _5[

Clock Maode :

~Gehearal

GLIP: |Present 'I COLP: |Present .v.i
Send Mode ! lEanock vI

~zalling f Answaring Party Mumber
Site Number: |
Prafi |
Update | Initializa(Fe) Close Help

Programming for an ISDN (T1/PRI) Card via PC-DBA (continued on next page)
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Programming for an ISDN (T1/PRI) Card via PC-DBA (continued)
2) Select the information for the fields as described below:

ISDN CARD PROGRAMMING FIELDS

FOR THIS FIELD... SELECT...

* Master

- The master (the CO in this case) provides the 8 kHz clock
signal.

- If Master is set, the system works in the Master clock mode.
« Slave (Default)

- The slave gets the signal from the master and makes sure
the incoming data is synchronized with it.

- If Slave is set, the system works in the Slave clock mode.

Clock Mode

* Present (Default)

- When set to Present, the Calling Party Number will be sent to
the Digital Network when making a trunk call through the

CLIP Digital Network.

(Calling Line Identifica-

. . * Restrict
tion Presentation)

- If Restrict is set, no Calling Party Number will be sent to the
Network whatever the type of the Trunk is.

* Present (Default)
- When set to Present, the Answering Party Number will be

COLP* sent to the Digital Network when an Extension answers a
(Connected Line Identifi- trunk call from Digital Network.
cation Presentation) * Restrict

- If Restrict is set, the Answering Party Number will not be sent
to the Network regardless of the type of trunk.

* Overlap

- If Overlap is set, the dialed called party Number will be sent
to the Network in overlap mode when the Outgoing Trunk is
digital (T1/PRI).

» Enblock (default)

Send Mode - If Enblock is set, the whole called party Number dialed by
user will be sent to the Network when the Outgoing Trunk is
digital (T1/PRI).

IMPORTANT!
A The Enblock setting must always be used in

the U.S.

Programming for an ISDN (T1/PRI) Card via PC-DBA (continued on next page)
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Programming for an ISDN (T1/PRI) Card via PC-DBA (continued)

3) Enter the information in the fields as described below.

ISDN CARD PROGRAMMING FIELDS (continued)

FOR THIS FIELD... ENTER...

¢ Site Number

- The site number defines the numbers to be sent to the Digital
Network as the Calling /Answering Party Number for the digital
trunk. Twelve digits (0~9) can be programmed in this field.

- Default is “None”.
Calling/Answering Party * Prefix

Number* - “Prefix” number will be used for composing the Calling /
Answering Party Number works in conjunction with Alternate
Line IDs (see “Setting Up Alternate Line IDs (ALI) - for
Systems with ISDN (T1/PRI) Installation Only” on page 177).

- Twelve digits (0~9) can be programmed in this field.

- Default is “None”.

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

6) Go to the T1 Screen (ProgrammingP C.O. Line Application®T1 Card).
« See “Programming for an Optional T1 Card” on page 155 for more information.

7) Make sure the Frame type is set to SF.
8) Make sure the EN Code is set to B8ZS.
9) Make T1 Padding settings, as needed.

When all settings are complete:
10) Click the Update button to store the settings into the database on the local disk.
11) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
12) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming for an ISDN (T1/PRI) Card (continued on next page)
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Programming for an ISDN (T1/PRI) Card (continued)

PROGRAMMING FOR A ISDN (T1/PRI) CARD VIA THE DET
See Field Descriptions on pages 165 and166 for more information about the settings via the DET.

Qh—:- NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 07-04 (see information in the following sections for making ISDN/T1/PRI settings - see table on
page 165 for details about each of these settings.).

5) Press save to enter ISDN (T1/PRI) programming.

6) Press next to go on to other ISDN (T1/PRI) programming screens.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting CLIP (Calling Line Identification Presentation):

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-01.
5) Press save to display the CLIP screen.

6) Press chg to change the setting.
« If you want to leave the current setting as is, skip to the next step.

7) Press next to display the COLP screen (now go to step 6 in “Setting COLP” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for an ISDN (T1/PRI) Card via the DET (continued on next page)
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Programming for an ISDN (T1/PRI) Card via the DET (continued)

Setting COLP (Connected Line Identification Presentation:

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-02.
5) Press save to display the COLP screen.

6) Press chg to change the setting.
« If you want to leave the current setting as is, skip to the next step.

7) Press next to display Site Number screen (now go to step 6 in “Setting the Site Number:” below).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Site Number:

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-03.
5) Press save to display the Site Number screen.

6) Press show to display the current setting.
« If you want to leave the current setting as is, skip to step 9.

7) Press chg.
8) Enter the site number (using digits 0-9).
9) Press save to store the setting.
10) Press next display the Prefix screen (now go to step 6 in “Setting the Prefix:” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for an ISDN (T1/PRI) Card via the DET (continued on next page)
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Programming for an ISDN (T1/PRI) Card via the DET (continued)

Setting the Prefix:

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-04.
5) Press save to display the Prefix screen.

6) Press show to display the current setting.
« If you want to leave the current setting as is, skip to step 9.

7) Press chg.
8) Enter the appropriate prefix (using digits 0-9).
9) Press save to store the setting.

10) Press next to display the Send Mode screen (now go to step 6 in “Using the Enblock Send Mode Setting:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Using the Enblock Send Mode Setting:

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-05.

5) Press save to display the Send Mode screen.

IMPORTANT!
A » The ENBLOCK setting must always be used in the U.S.

e You can press chg to change the setting, but ENBLOCK (i.e., the default) is the
selection that MUST be used in the US.

6) Press next to display Clock Mode screen (now go to step 6 in “Setting the Clock Mode:” below).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for an ISDN (T1/PRI) Card via the DET (continued on next page)
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Programming for an ISDN (T1/PRI) Card via the DET (continued)

Setting the Clock Mode:

From the DB Item Select screen (see steps 1 through 3 on page 167):
4) Enter 07-04-06.

5) Press save to display the Clock Mode screen.
 Slave is the default setting.

IMPORTANT!
A » Since slave mode uses the signal from the master and makes sure the incoming
data is synchronized, you will most likely want to leave the system in SLAVE mode.
The master (the CO in this case) mode provides the 8 kHz clock signal.

¢ You can press chg to change the setting to Master mode. However, if you want to
leave the setting at SLAVE, skip to step 6.

6) Press the Hold button to return to the ISDN programming screen.
OR
Press next to display the Translation Table - see “Setting Up the Translation Table” on page 171.
OR

Press next until the Alternate Line ID screen appears - see “Setting Up Alternate Line IDs (ALI) - for Sys-
tems with ISDN (T1/PRI) Installation Only” on page 177.

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up the Translation Table

This information is used by the system to determine how to interpret incoming DID calls. You can program DIDs for
DAY, EVEning, and ALTernate modes for incoming T1 and ISDN (T1/PRI) calls.

HINT

@ Also see “Programming for an Optional T1 Card” on page 155 or “Programming for
Optional ISDN (T1/PRI)” on page 164 depending upon which card is installed or
being installed in the system.

SETTING UP THE TRANSLATION TABLE VIA PC-DBA

From the PC-DBA main screen:

Programming  Maintenance  Help.
Extenszion
.0, Line
- Call Handling
Syshem Resource
Restriction
Extension-Application
Z.0, Line Application
Syskem Application Faix Detection
Feature Key Programming T1 Card

K5 DB Passward | Tondaten abe ), |
150N
Alketriate Line 10 Table:

1) Go to ProgrammingP>C.O. Line Application® Translation Table to display the C.O. Line Application -
Translation Table screen.

DX-120

CO Group Sethings

L4
¥
3
»
.3
L3
13

MO Incaming Dy Alt Eva ii

DIE Length : |_ ".l Intercept: I ".l

Update | intiaizetm | ciose | Hew |

Programming for the Translation Table via PC-DBA (continued on next page)
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Programming for the Translation Table via PC-DBA (continued)

2) Enter/select information for the fields as described below:

IN THIS FIELD... DO THIS...

Incoming Enter the DID number for which you want to program incoming modes.

Enter the number to which the Incoming digits are translated in Day Service
Mode.

Day » The Destination Number can be an Extension, Hunt Group. Max 4 digits
(0~9, *<wild card>) can be programmed.

¢ The default is “Null” for all entries.

Enter the number you want the C.O. to use for the Alt Mode, as needed.

Alt * This setting is similar to the one made in the ‘Day’ field but it works for Alt
(Noon) Service Mode.

Enter the number you want the C.O. to use for the Eve Mode, as needed

Eve
« This field is similar to ‘Day’ field but it works for Night Service Mode.

Select the number of digits of the DID you want the CO to send to the DX-120
when an incoming call is received.

« Valid selections are from 0-12 digits.
e The default is 3.

DID Length

Select the extension that you want the C.O. to use when a matching DID can-
Interceptor not be found in the Translation Table.

* The default is blank (none).

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming for the Translation Table via the DET (continued on next page)
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Programming for the Translation Table via the DET (continued)

SETTING UP THE TRANSLATION TABLE VIA THE DET
See Field Descriptions beginning on page 172 for more information about the settings via the DET.

Qh'\‘ NOTE

.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

¢ You can also use steps from “Programming for a ISDN (T1/PRI) Card via the DET”
on page 167, to access the Translation Table.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 07-05.

5) Press save to enter Translation Table programming.

6) Press show to display each Translation Table screen (see information in the following sections for setting
up the Translation Table - see table on page 172 for details about each of these settings).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting DID Length:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-05-01.
5) Press save to display the Length setting.

6) Press chg until the number of digits you want the system to send to the switch (i.e., 1 - 12).
e The default is 3.

7) Press next to display the Intercept screen (now go to step 6 in “Setting the Interceptor:” below)
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for the Translation Table via the DET (continued on next page)
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Programming for the Translation Table via the DET (continued)

Setting the Interceptor:

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-05-02.
5) Press save to display the Intercept screen.
6) Press chg.

7) Enter the extension that you want the C.O. to use when a matching DID cannot be found in the
Translation Table (using digits 0-9).

8) Press save to store the setting.
9) Press next to display the previous Translation Table programming screen.

10) Enter XXX (where XXX represents the appropriate table row number: 001~ 100. Now, go to step 6 in “Setting the
Incoming Number” below)

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Incoming Number

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-05-03-XXX (where XXX represents the appropriate table row number: 001~ 100).
5) Press save to display Incoming number screen.
6) Press chg.
7) Enter the DID number for which you want to program incoming modes (using digits 0-9).
8) Press save to store the setting.

9) Press next to display the Day Destination screen (now go to step 6 in “Setting the Day Service Mode:”
below).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for the Translation Table via the DET (continued on next page)

- 174 -



DX-120 Programming Manual PROGRAMMING FOR THE OPTIONAL T1 AND ISDN (T1/PRI) CARDS

Programming for the Translation Table via the DET (continued)

Setting the Day Service Mode:

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-05-03 XXX-2 (where XXX represents the appropriate table row number: 001~ 001).
5) Press save to display the Day Destination screen.
6) Press chg.
7) Enter the number to which the Incoming digits are translated in Day Service Mode.
8) Press save to store the setting.

9) Press next to display the Alternate Destination screen (now go to step 6 in “Setting the Alternate Service
Mode:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Alternate Service Mode:

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-05-03 XXX-3 (where XXX represents the appropriate table row number: 001~ 100).
5) Press save to display the Alternate Destination screen.
6) Press chg.
7) Enter the number you want the C.O. to use for the Alt Mode, as needed.
8) Press save to store the setting.

9) Press next to display Evening Destination screen (now go to step 6 in “Setting the Evening Service
Mode:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming for the Translation Table via the DET (continued on next page)
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Programming for the Translation Table via the DET (continued)

Setting the Evening Service Mode:

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-05-03 XXX-4 (where XXX represents the appropriate table row number: 001~ 100).
5) Press save to display the Evening Destination screen.
6) Press chg.
7) Enter the number you want the C.O. to use for the Eve Mode, as needed.
8) Press save to store the setting.

9) Press next to go to the next row in the Translation Table (repeat steps previously shown for Incoming
Number, DAY, ALT, and EVE modes, as necessary).

OR

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Alternate Line IDs (ALI) -
for Systems with ISDN (T1/PRI) Installation Onl

If an ISDN (T1/PRI) card has been installed on the current system, alternate line ID can be set up to allow users to
make outbound call from extensions on a ISDN (T1/PRI) line while sending out a different telephone as the Caller ID
information instead of than the main number of the system (i.e., the "Calling/Answer Party - Site Number).

=g NOTE
.é  If you do not put anything in any of these fields then nothing gets sent out and it
y then becomes the responsibility of the CO to attach a name and number.

« |If the prefix and alternate line ID are not programmed appropriately, the site
number will be assigned as the calling/answering party number.

SETTING UP ALTERNATE LINE IDs (ALI) - viA PC-DBA
FOR SYSTEMS WITH ISDN (T1/PRI) INSTALLATION ONLY

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling 13

Syskem Resource 13

Restriction 2

Extension Application 3
13
3
3

'DX-120

CO Group Settings
Fax Detection

T1 Card

Translation Table

ISDM

Alkernate Line ID Table

.0, Line Application
System Application
Feature Key Programming
K5U DE Password

1) Go to Programming®C.O. Line ApplicationP Alternate Line ID Table to display the Alternate Line ID Table

screen.
MNumber Complete
[ -
N
N
N
N
N
N
" =
Index Mumbar Cormnplete
| N R
Update InitializedF &) | Close | Help |

Setting Up Alternative Line IDs via PC-DBA (continued on next page)

- 177 -



PROGRAMMING FOR THE OPTIONAL T1 AND ISDN (T1/PRI) CARDS DX-120 Programming Manual

Setting Up Alternative Line IDs via PC-DBA (continued)

2) Click on the appropriate line that corresponds to the index number for which you want to define an
alternate line ID.

HINT
Fie e The index number is used when specifying an Alternate Line ID for a specific
extension.
* Once you click on an index number, the associated fields will appear at the bottom
of the screen. This allows you to enter (or change existing) information for the
corresponding Index number.

3) Enter the alternate line ID information in the remaining fields as described below:

FOR THIS FIELD... DO THIS...

Number Enter the Number (e.g., 555-3514) to be sent to the
Digital Trunk as Calling / Answering Party Number for
the extension when Alternate Line ID Index is pro-
grammed at the extension.

« Twelve digits (0~9) can be programmed.

Complete Select “Y” (Yes) if you want only the Number defined

in this entry to be sent to the Digital Trunk as the Call-

ing / Answering Party Number.

OR

Select "N" (No), if you want the "Prefix" (as defined

for the C.O. Application for ISDN) to be added to the

beginning of the number (in this row) to be sent as

the calling/answering party.

« In other words, this setting will cause the entire
number, including the prefix to be sent to the to the
Digital Trunk as the calling/answering party number.

« Default is set to “N” for all entries.

4) Click |1I to move the entry up into the corresponding row of the table.
« Use the process as described above for each extension to which you want to assign an ALI.

When you are finished setting up all the alternate line IDs in the table:

5) Click the Update button to store the settings into the database on the local disk.
6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.
8) NOTE

=3 NOTE
.é You can now program the ALI for the extensions, as needed (see page 182).

Setting Up Alternative Line IDs (continued on next page)
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Setting Up Alternative Line IDs (continued)

SETTING UP ALTERNATE LINE IDs (ALI) - viA THE DET

FOR SYSTEMS WITH ISDN (T1/PRI) INSTALLATION ONLY
See Field Descriptions beginning on page 178 for more information about the settings via the DET

Qh-\'- NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

* You can also use steps from “Programming for a ISDN (T1/PRI) Card via the DET”
on page 167, to access the Translation Table.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 07-06.

5) Press save to enter Alternate Line ID programming.

6) Press show to display the Index screen.

7) Enter XXX (where XXX represents the appropriate table row number: 001~ 100).

8) Press show to display the Complete setting (now go to step 6 in “Setting the Calling / Answering Party
Number:” below).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Calling / Answering Party Number:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 07-06-XXX-01 (where XXX represents the appropriate table row number: 001~ 100).
5) Press save to display the Complete setting.

6) Press chg if you want to change the setting to Y (i.e., Yes - if you want only the Number defined in this
entry to be sent to the Digital Trunk as the Calling / Answering Party Number).
e The default is N (No)

7) Press next to display the Number screen (now go to step 6 in “Setting the Calling / Answering Party
Number for the Extension” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Alternative Line IDs (continued on next page)
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Setting Up Alternative Line IDs (continued)

Setting the Calling / Answering Party Number for the Extension

From the DB Item Select screen (see steps 1 through 3 on page 173):
4) Enter 07-06-XXX-02 (where XXX represents the appropriate table row number: 001~ 100).
5) Press save to display the Number screen.

6) Press show to display the current setting.
e The default is EMPTY.

7) Press chg.

8) Enter the Number (e.g., 555-3514) to be sent to the Digital Trunk as Calling / Answering Party Number for
the extension when Alternate Line ID Index is programmed at the extension (using digits 0-9).

9) Press save to store the setting.
10) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Extensions for Alternate Line IDs
for Systems with ISDN (T1/PRI) Installation Onl

Once you have set up the Alternate Line IDs in the appropriate table, you need to program the appropriate extensions
so that the each extension will use the corresponding alternate line ID. Be sure to review all of the conditions and
results for programming Extension ALIs.

ALTERNATE LINE ID CONDITIONS AND RESULTS
Consider the following conditions and results when programming extensions:

CONDITION... RESULT

If Alternate Line ID Index is programmed
at the extension and “Number” in the
corresponding Index of the Alternate
Line ID Table is not programmed.

The Calling / Answering Party Number
will be the “Prefix” number (defined by
C.O. Line Application - ISDN) plus the
Extension Directory Number of the
extension.

If Alternate Line ID Index meets all of the
following conditions:

* is programmed at the extension

« the “Complete” field in the
corresponding Index of the Alternate
Line ID Table is set to “N” the
“Number” field in the corresponding
Index of the 2Alternate Line ID Table is
programmed

The Calling / Answering Party Number
will be the “Prefix” number (defined by
C.O. Line Application - ISDN) plus the
number defined in “Number” field at the
corresponding Index in the Alternate
Line ID Table.

If Alternate Line ID Index is not pro-
grammed at the extension...

The Calling / Answering Party Number
will be the “Prefix” number (defined by
C.O. Line Application - ISDN) plus the
Extension Directory Number of the
extension.

If Alternate Line ID Index is programmed
at the extension, but both of the following
are also true:

« the “Complete” field in the
corresponding Index of the Alternate
Line ID table is set to “Y".

« the “Number” field in the corresponding
Index of the Alternate Line ID Table is
programmed

The Calling / Answering Party Number
will be the whole number defined in
“Number” field at the corresponding
Index in the Alternate Line ID Table.

Programming Extensions for Alternative Line IDs (continued on next page)
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Programming Extensions for Alternative Line IDs (continued)

PROGRAMMING EXTENSIONS FOR ALTERNATE LINE IDs viA PC-DBA
FOR SYSTEMS WITH ISDN (T1/PRI) INSTALLATION ONLY

IMPORTANT!
Be sure you have already set up the alternate line IDs for the extension(s) you want
to program (see 177).

From the PC-DBA main screen (and after you have set up the alternate line IDs - see page 177):

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.
Rresension ]
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: 4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. I—LI
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: I

2) Select the extension number you want to program.

Programming Extensions for Alternative Line IDs via PC-DBA (continued on next page)
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Programming Extensions for Alternative Line IDs via PC-DBA (continued)

In the Alternate Line ID field:

Alternate Line D I—
Indes:{1-100)

3) Enter the corresponding row number for the alternate line ID made in the Alternate Line ID field of the
Alternate Line ID table (see page 177 for information about setting up the Alternate Line ID table).

EXAMPLE

If the Site Number for a company is 555-8000, so when you called out (regardless of
the extension) the party you were calling would see that site number (i.e., 555-8000).
However, if you use the Alternate Line ID you can enter it so that the specific calling
extension number (e.g., if you are calling from extension 3514) is shown to the called
party (e.g., 555-3514).

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy your new database to the DX-120 switch system memory.

Programming Extensions for Alternative Line IDs (continued on next page)
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Programming Extensions for Alternative Line IDs (continued)

PROGRAMMING EXTENSIONS FOR ALTERNATE LINE IDS VIA THE DET
FOR SYSTEMS WITH ISDN (T1/PRI) INSTALLATION ONLY

IMPORTANT!
Be sure you have already set up the alternate line IDs for the extension(s) you want
to program (see 179).

=S NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.
« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.
* You can also use steps from “Programming for a ISDN (T1/PRI) Card via the DET”
on page 167, to access the Translation Table.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-33 (where XXX represents the extension number you want to program: 101~204).

5) Press chg.

6) Enter the corresponding row number (001~100 for the alternate line ID made in the Alternate Line ID field
of the Alternate Line ID table (see page 177 for information about setting up the Alternate Line ID table).

EXAMPLE

If the Site Number for a company is 555-8000, so when you called out (regardless of
the extension) the party you were calling would see that site number (i.e., 555-8000).
However, if you use the Alternate Line ID you can enter it so that the specific calling
extension number (e.g., if you are calling from extension 3514) is shown to the called
party (e.g., 555-3514).

7) Press save to store the setting.
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SECTION 6 - PROGRAMMING CALL HANDLING

OVERVIEW

The call handling features allow you to control how the DX-120 processes calls. In this section provides instructions for
programming the following call handling features:

IMPORTANT!

A e If you are programming an existing database using PC-DBA, be sure to upload the
current switch database to your laptop before making any changes. This way, you
will be working on the customized database and will not have to reprogram all the
custom settings.

e If you are programming a brand new database from scratch without using any
templates, you can skip this step.

CAUTION!

A Remember! While you are programming in PC-DBA, the system saves your
changes in the working directory residing on the laptop. While it may appear
that you have re-programmed the switch, the system does not update the
switch database with your changes until you perform a SEND command from
the laptop.

s NOTE

.é e The DX-120 provides you with a shortcut to use when programming call handling
on a new system. You can use a pre-programmed database template that is
provided on the DX-120 product CD to reduce your programming time, and to
decrease the likelihood of premature recall and voice mail transfer issues.

» This template also provides a call restriction class of service so your customer can
limit toll calls on individual extensions.

BASIC CALL HANDLING PROGRAMMING TASKS

This section provides you with instructions for programming the following features:

= Specify the CO flash time - see page 193

e Specify the PBX flash time - see page 196

» Specify the pause time - see page 199

= Specify the ring abandon - see page 202

e Set up the hold remind - see page 205

e Select the exclusive hold time - see page 207

= Establish the warning time - see page 210

e Set the transfer intercom recall and transfer busy recall - see page 213
e Set up hold recall - see page 217

= Set up the dial wait time and dial delay - see page 220

e Establish the dialing ratio - see page 223

e Establish the start and end of the SLT hook flash - see page 228

Basic Call Handling Programming Tasks (continued on next page)
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Basic Call Handling Programming Tasks (continued)

Program auto redial - see page 232

Set up external call forward - see page 237

Set up conference talk time intervals and conference tones - see page 241
Set up the camp on interval - see page 245

Set up the alarm play intervals - see page 247

Enable/disable the hotel feature - see page 249
Enable/disable the system speed check - see page 252
Enable/disable the TSI connection - see page 254
Enable/disable the conference tone - see page 256

Specify the call duration - see page 258

Specify caller ID codes and establish the local area code - see page 264
Enable/disable tenant calling per tenant group - see page 271
Enable/disable SMDR call output - see page 274

Set the fax ring time - see page 280

Set the pre-defined call forward time - see page 282

Program the recognition time interval - see page 285

Set the hold abandon time interval - see page 291

Set the unsupervised talk time - see page 294

Program the auto attendant - see page 298

Set the DISA access - see page 312

Program the voice mail - see page 363

Ringing Line Priority

Ringing Line Priority is a system-wide feature that automatically connects incoming calls based on a predetermined
priority. The ringing extension is automatically connected to the priority ringing facility, upon lifting the handset or
pressing the ringing button.

Ringing Line Priority can be overridden at the extension by first pressing a direct appearing line, CO line group, feature
button, or by dialing an intercom number on hook.

The following list shows the ringing line priority, from highest to lowest.

Callback — extension
Callback — CO line
Recalling CO line call
Transferred CO line call
Incoming CO line call
Incoming ICM call

NOTE
Ringing Line Priority is not a programmable feature on the DX-120. The information
provided below is provided for reference only.
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Programming Conference Calls

= The system can simultaneously accommodate eight, four-member (party) conferences. Conference
combinations may consist of three CO lines maximum, and any number of extensions, to a maximum of four
parties (members).

e A supervised conference is a conference in which at least one member is an extension of the DX-120 system.
The DX-120 extension that establishes a conference is the conference controller, and may add and/or delete
members of the conference at any time. The conference controller also has the privilege of establishing an
unsupervised conference.

* An unsupervised conference is a conference in which only CO lines are members. All members are therefore
outside of the premises and connected together using the DX-120 conference resource. An unsupervised
conference may be re-joined by the initiating DX-120 extension, however, that extension maintains control of the
conference even though it is unsupervised.

= One extension directory number is the controller of the conference and constitutes one conference member.
Extension users must first establish a three-member conference before they can establish a four-member
conference.

= Conditions for CO Line Conferences
- The extension that establishes a conference is called the controlling party.
- Only the conference controller can add a new conference connection (party).

- Only the controlling party is allowed to invite or forcibly release any attending internal or external party, or to
setup a “private talk” with any one attending party.

- When adding new parties to a conference and while speaking privately to a particular conference member
other members of the conference will be connected to Music On Hold.

- Each of the calls involved in a holding conference will be placed on Exclusive Hold.

- When the controlling party exits a conference, the most recently invited internal party will be designated as
the new controlling party.

- When a conference is established, each party will hear a burst of conference tone when the conference tone
is enabled.

- You can program the unsupervised conference feature code Feature 7 7 on any available programmable
feature button.

- Only the controller of an unsupervised conference may rejoin an unsupervised conference.
- Conference can only be established at a digital speakerphone.

WHEN PROGRAMMING CONFERENCE CALLS
- Program the maximum CO lines you want to allow in a conference (none, 2 or 3).
- Program the time allowed for unsupervised conferences (CO Line-to-CO Line).
- Turn the conference tone on (Yes) or off (No).
e Other features that May Affect Conference Calling
- CO Line Loop Supervision
- CO Line — Call Abandon

PROGRAMMING THE CONFERENCE CALL SETTINGS INCLUDES 3 BASIC TASKS:
e Select the maximum number of lines - see page 189
e Set the conference tone - see page 241
e Set the unsupervised talk time - see page 294

Programming Confernce Calls (continued on next page)
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Programming Conference Calls (continued)

PROGRAMMING CONFERENCE CALLS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
C.0, Line

l
Col Handing T
Syskem Resource Timing

Restriction CID Programming Code
DISA

Extension Application
C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming

KSU DB Password _

1) Go to ProgrammingP> Call HandlingPFeature Control to display the Call Handling—Feature Control
screen.

13
3
13
13
3
13

RP :Call Handling - Feature Control - |
Wi Reserve Fort: |D vl

SMDR Call Output

Co Line Conference:

[~ Hotel Enable
I Sys SFPD. Toll Check
V¥ TSl Connect Enable

[~ Incoming Call
v Outgoing Call

¥ Conference Tone I Account Code
v Daylight Saving Time ¥ Call Start
Update | InitializedF &) | Close | Help |

2) Select the maximum number of lines you want to use for conference combinations from the CO Line
Conference field.
« Options are: No (none), 2Lines, or 3Lines.

¢ The default is 3Lines.

3) Select whether or not you want to use a Conference Tone (see page “Enabling/Disabling Conference
Tone” on page 256 for more information).

When you are finished making settings as shown above:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have completed the settings on the Control Features screen (as shown above), from the
PC-DBA main screen:

Programming Maintenance  Help

Extension |

.0, Line I =
Feature Control

Syskem Resource W

Restriction CID Programntiig Code

Extension Application DISA

Auko Akkendant

Tenant Calling
Feature Key Programming

Sl Password _

Programming Confernce Calls via PC-DBA (continued on next page)

C.0, Line Application
System Application

.3
3
13
13
3
13
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Programming Conference Calls via PC-DBA (continued)

6) Go to Programming P Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vI Mit. Predefined Forward Time: |10 x| sec ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Unsupervised Talk Time field (located in the third column on the right) - “Setting Unsupervised Talk
Time” on page 294

Unsupervised Talk Time: ID T Min.
Wi Monitor Time: i Sec
®FRE_B Recall: |2q Sec

¥FR_I Recall: 32 e L

7) Select the length of time you want to allow for unsupervised conference calls.
 Valid options are 0 to 120 minutes, in increments of 10 minutes.

¢ The default is 0, which means unlimited unsupervised conference call minutes.

When you are finished making the unsupervised talk time setting:
8) Click the Update button to store the settings into the database on the local disk.

9) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
10) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming Confernce Calls (continued on next page)
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Programming Conference Calls (continued)

PROGRAMMING CONFERENCE CALLS VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Programming the maximum number of CO lines that may be in a conference:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-01.
5) Press save to display the Conference Line screen.

6) Press chg until the appropriate value displays (NO/2LNS/3LNS).
e The default is 3 lines.

7) Press next to display the Unsupervised Conference Time screen (now go to step 6 in “Programming the
Unsupervised Conference Time:” below).

OR

Press the volume UP or Down to return to the DB ltem Selection screen.
OR

Exit programming (see nte).

Programming the Unsupervised Conference Time:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-39.
5) Press save to display the Unsupervised Talk Time screen.

6) Press chg until the Unsupervised Conference Time displays the number of minutes you want to allow for
the unsupervised conference time.
¢ Valid entries are 0 to 120, in ten minute intervals (0,10,20, 30, etc.).

e The default is 0, which means unlimited unsupervised conference calls.

7) Press next to display the Conference Tone Operation screen (now go to step 6 in “Program the
Conference Tone Operation:” below).

OR

Press the volume UP or Down to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Confernce Calls via the DET (continued on next page)

- 192 -



DX-120 Programming Manual BAsic CALL HANDLING PROGRAMMING TASKS

Programming Conference Calls via the DET (continued)

Proaram the Conference Tone Operation:

From the DB Item Select screen (see steps 1 through 3 on page 192):

4) Enter 03-23.
5) Press save to display the Conference Tone Operation screen.

6) Press chg until the appropriate Conference Tone operation displays (Y/N).
e The defaultis Y.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Specifying CO Flash Time

The CO flash time determines what flash timing the DX-120 presents to the telephone company central office when the
user issues a hook-flash command while connected to a CO line. This feature is a requirement when the DX-120 is
installed “behind” a Centrex or PBX system. In these two cases, program the flash feature code as a Flexible Feature
Button for easy access.

If call waiting service is provided, the extension user can use the flash feature to answer a second incoming call while
connected to another outside party.

e Conditions for Setting the CO Flash Time

The flash time is programmable from 100ms to 3000ms in increments of 100ms (1/10th of a second).
When extension users enter the flash code at a DET, the phone displays CO Flash temporarily.

Single line extension users must generate a hook-flash and then dial # 3 to generate a hook-flash on a CO
line.

You can store the flash code in any speed dial location.

You can store the flash code in the last number redial buffer. When you activate redial, a digital speakerphone
display shows a / to indicate the flash code.

e Other features that May Be Affected by the CO Flash Time

Speed Dial (System and Station)
Memo Pad

Last Number Redial

Automatic Redial

Specifying CO Flash Time (continued on next page)
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Specifying CO Flash Time (continued)

SPECIFYING CO FLASH TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming

KSU DB Password _

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.
[kecaiinondingTmng E

Camp On Interval:  |EOEE 'l Sec.  Extension Alarm Play Time 30 ~| sec PBX Auto Pause |1.D 'I Sec.
Call Duration Time: |10 x| sec FARRing Time:  [1p »| Zec. Ring On Recognition Tirme: |1DD 'I ms
C0O Line Guard Time:  [1.0 =l Sec Hold Abandon | Go0 | ms Ring Abandon; |6 vl Sec.
COFlash: |05 x| sec Hold Reminder: |30 | gec. Talk Abandon Time: 600 ~lms
CID Ring Time: 3.5 S Sec. hMeet e Conference Talk Time: 0 | Min e 0 | win,
DialWalt Time:  |g | sec Pause Time: |2.0 'I Zec. WM Manitar Tirme |1u 'I Sec
Dial Delay Time: (100 | ms FBEAFlash: |0& | Sec ¥FR_B Recall  |go ~| zec
Ex_Hold Tirme: |2 vI hin. Predefined Forward Time: |10 7| 2o WFR_| Recall: |30 ~| cee
At tic Redial —————— -Dialing Ratio.————————
utomatic Redia =N =R ~Edemal CFW———————————
Aftempts: |2 ~| Timeas Break Time: |s0 | ms 5
: = = ERICE. | Always ¥
Interval: - Inter-Digit: =
60 et [ gt Jaon x| ms TalkTime: [z =
Waiting Time: |15 ~| Sec Tone Time: |7g | ms —
—Hold Recall———— SLT Hook Flash Wh Dialing Ratio————  ~Warning Time ——————————
SLT: 1.0 - |Min. Start: {200 ~|ms. Tone Time: (B0 | ks Outgoing CaII:IS | Min
DEKT: [1n = |Min. End: l1gpn = |ms Int-Digit Time: |50 |ms. Incoming Call:ls - | Min
Update | Initialize{F&) | Close Help |

In the C.O. Flash field in the first column:

COFlash: |0.8 Se
Ring Time: Se
I'Wait Time: Se
Delay Time: ms

2) Select the CO line hook-flash timing you want to use.
 Valid options are between .1 and 3.0 seconds.

* The default is .8 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.
When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.
Specifying CO Flash Time (continued on next page)
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Specifying CO Flash Time (continued)

SPECIFYING CO FLASH TIME VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-02.

5) Press save to display the CO FLASH screen.

6) Press chg until the appropriate CO line hook-flash timing appears.
 Valid options are between .1 and 3.0 seconds.

e The default is .8 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Specifving PBX Flash Time

The PBX flash time tells the DX-120 what flash timing to present to the host telephone system, when the DX-120 is
installed as a subordinate system to the PBX. This feature is critical to perform accurate host-system functions like
PBX call transfer. When used “behind” a PBX, program the flash feature code as a Flexible Feature Button for easy
access.

= The following conditions apply to the PBX flash time.
- The flash time is programmable from 100ms to 1500ms in increments of 100ms (1/10th of a second).
- At a Digital Speakerphone, the phone temporarily displays PBX Flash when the flash code is dialed.
- You can store the flash code in any speed dial location.

- You can store the flash code in the last number redial buffer. When you activate redial, a digital speakerphone
display shows a / to indicate the flash code.

- Single line extension users must generate a hook-flash, then dial # 3 to generate a hook-flash on a PBX line.
= Other features that may be affected by the PBX flash time include the following.

- Speed Dial (system and individual)

- Memo Pad

- Last Number Redial

- Automatic Redial

SPECIFYING PBX FLASH TIME viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I

Call Handling

Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application

Feature Control t

CID Program%g Code

DISA
Auko Akkendant

Tenant Calling
Feature Key Programming

Sl Password _

* v v v v vl

Specifying PBX Flash Time via PC-DBA (continued on next page)
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Specifying PBX Flash Time via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms

CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vlSec.

COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn |3 Inter-Digit: R4 =
e |5 ol I | Talk Time: |5 ~[Min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) Close Help |
In the PBX Flash field in the center column:
PBA Flash: |06 ¥ | Sec.
ard Time: Sec.

2) Select the PBX line hook-flash timing you want to use.
« Valid options are between .1 and 3.0 seconds.

¢ The default is .6 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Specifying PBX Flash Time (continued on next page)
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Specifying PBX Flash Time (continued)

SPECIFYING PBX FLASH TIME VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-03.

5) Press save to display the PBX Flash screen.

6) Press chg until the appropriate PBX line hook-flash timing appears.
 Valid options are between .1 and 3.0 seconds.

e The default is .6 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

- 198 -



DX-120 Programming Manual

BAsic CALL HANDLING PROGRAMMING TASKS

Specifying Pause Time

You can instruct the system to automatically generate a pause in dialing on outgoing CO line calls. The system
monitors digits dialed on PBX type CO lines for PBX codes that extension users may enter. If the system recognizes a
PBX code, it automatically inserts a pause between that digit and the remaining digits for last number redial system
features.

e Important points to keep in mind:

A pause or a combination of pauses may be stored in the speed dial bins to allow timed access to special
services, while allowing you to monitor the progress of the call.

A pause occupies one digit position when stored in a speed dial. A pause appears as “P” on the DET display.

When storing numbers in a speed dial, use the feature code Feature 7 0 to insert a pause.

Program the pause insertion time to adequately apply a pause time based on the host PBX requirements for

trunk calls.

The time interval is from the time the trunk access code is dialed to the time that trunk dial tone is heard.

When last number redial is used (at a DX-120 extension) on a PBX type CO line circuit, the system
automatically inserts a pause of this duration between the PBX code dialed and the remaining digits to be re-

dialed.

Program the pause time for the anticipated requirement of pause time for speed dial numbers.

= Other features that may be affected by the PBX pause time include the following:

Automatic Busy Redial

Saved Number Redial

Last Number Redial

Speed Dial - Extension, System
Memo Pad

PBX Compatibility

SPECIFYING PAUSE TIME vIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |

.0, Line I

Call Handling
Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application

* v v v v vl

Specifying Pause Time via PC-DBA (continued on next page)

Feature Control

DISA
Auko Akkendant
Tenant Calling

CID Program%g Code

Feature Key Programming
K5U DE Password
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Specifying Pause Time via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vI Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Pause Time field in the center column:

2) Select the timing you want to use.
« Valid options are from 0.5 to 7.0 seconds.
¢ The default is 2.0 seconds.
In the PBX Auto Pause field in the third column:

This field allows you to set the auto pause insertion time (used with PBX type CO line ports).

FEX Auto Pause:
Fecognition Time:

Ring Ahandaon:

Lonl e S

3) Select the timing you want to use.
« Valid options are from 0.5 to 7.0 seconds.

* The default is 1.0 second.

When you are finished:

4) Click the Update button to store the settings into the database on the local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.
When you have finished all programming changes:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Specifying Pause Time (continued on next page)

- 200 -



DX-120 Programming Manual BAsic CALL HANDLING PROGRAMMING TASKS

Specifying Pause Time (continued)

SPECIFYING PAUSE TIME VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Programming the Auto Pause Insertion Time (used with PBX type CO line ports):

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-15.
5) Press save to display the PBX Auto Pause programming screen.

6) Press chg until the appropriate PBX Auto Pause Time appears.
« Valid options are from 0.5 to 7.0 seconds, in .5 second intervals.

e The default is 1.0 second.

Press the volume UP or Down to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Program the pause time (used with speed dial):

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-04.
5) Press save to display the Pause Time programming screen.

6) Press chg to view the pause time choices.
« Valid options are from 0.5 to 7.0 seconds, in .5 second intervals.

¢ The default is 2.0 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Specifying Ring Abandon

The system allows you to set the ring abandon time. Ring abandon is the interval the system waits for the next
ring before classifying the call as dropped from the CO trunk.

Typically, CO ring cycles include one second of ring (voltage) followed by three seconds of no ring (removal of
voltage). Itis possible for COs to vary from this pattern, and if your customer’s CO varies this way, you may need
to adjust the default ring abandon setting.

A longer ring abandon gives the system more time to realize the absence of CO trunk ringing, but while the
system waits it continues to ring the extension. If in fact the call has been dropped by the trunk, the extension
user can receive dial tone when picking up a ringing line.

The ring abandon time starts when the CO trunk ring (voltage) occurs, and includes the interval after the ring
(removal of voltage). So, if the CO is using the 1/3 pattern, a ring abandon time of 10 seconds means the system
will wait another 6 seconds for a ring (voltage) to occur before classifying the line as a ring abandon and stopping

the system ring at the extension (1 second ring + 3 seconds no voltage + 6 additional seconds no voltage = 10
seconds).

A short ring abandon (<4 seconds) means the system may drop the call before the CO trunk can present voltage
again. In this case the system rings the extension once and abandons the call.

SPECIFYING RING ABANDON VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I
Call Handling

Syskem Resource

Feature Control t

CID Program%g Code

3

13

3
Extension Application 3 DISA

13

3

3

Restriction

C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming
K5U DE Password

Specifying Ring Abandon via PC-DBA (continued on next page)
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Specifying Ring Abandon via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) Close Help |

In the Ring Abandon field in the third column:

Ring Ahandon:

handon Time:

2) Select how long you want the system to wait for voltage (ring) from the CO trunk before dropping the call.
« Valid choices are 1 to 10 seconds.

* The default is 6 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Specifying Ring Abandon via the DET (continued on next page)
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Specifying Ring Abandon via the DET (continued)

SPECIFYING RING ABANDON VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-06.

5) Press save to display the Ring Abandon screen.

6) Press chg until the appropriate length of time to wait for voltage (ring) from the CO trunk before dropping
the call appears.
 Valid choices are 1 - 10 seconds.

¢ The default is 6 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Hold Remind

The system provides a programmable timer to remind you that a call has been left on system or exclusive hold. When

enabled, the system sounds one ring tone repeated each time the selected hold time expires. The following conditions
apply:

= Hold Reminder applies to CO line calls that are on System Hold or Exclusive Hold
e Hold Reminder applies to both intercom and CO line calls

SETTING UP HOLD REMINDER VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>Call HandlingP Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec. PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min. Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl —External Gy
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update InitializedF &) Close Help |

Setting Up Hold Reminder via PC-DBA (continued on next page)
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Setting Up Hold Reminder via PC-DBA (continued)

In the Hold Reminder field in top center of the screen:

Hold Reminder:

nce Talk Time:
Fause Time:

FBEX Flash:

2) Select the frequency with which you want the system to sound the reminder tone for calls on system
hold or exclusive hold.
« Valid choices are 0, 10, 30, 60, and 90 seconds. The default is 30 seconds.

« If you want to disable the hold reminder tone, select 0.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP HOLD REMINDER VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-07.

5) Press save to display the Hold Reminder screen.

6) Press chg until the appropriate frequency with which you want the system to sound the reminder tone for
calls on system hold or exclusive hold appears.
« Valid choices are 0, 10, 30, 60, and 90 seconds.

* The default is 30 seconds.
« If you want to disable the hold reminder tone, select 0.

7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Selecting Exclusive Hold Time
When using the feature button and the hold button together, extension users may place an outside call on private/
exclusive hold. The system indicates that the line is in use to other extensions.

You can control how long the system allows that line to remain on exclusive hold. After the time period you specify
elapses, the system converts the call to system hold.

= Other features that may be affected by setting the exclusive hold time include the following:

Hold Remind

Hold - System

Hold - Common (System)
Call Key

e The following conditions apply to setting exclusive hold time:

Exclusive hold is used only for CO line calls.
You specify how long you want the system to allow exclusive holds, from 1-8 minutes.

When extension users place a CO line call on exclusive hold, the system fast flashes the green lamp for that
line and lights the red lamp steadily for that CO line at other extensions.

The system places the CO line call on system hold after the exclusive hold time expires.

The system plays a tone alerting extension users that the timer has expired, and the system changes the hold
condition for that CO line to system hold.

The system slow flashes the green lamp for the line at the extension user’s phone, and slow flashes the red
lamp for that CO line at other extensions.

SELECTING ExcLuUsIVE HoLD TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I

Call Handling
Syskem Resource
Restriction

Feature Control t

CID Program%g Code

3

13

3
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling

3

Feature Key Programming
K5U DE Password

Selecting Exclusive Hold Time via PC-DBA (continued on next page)
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Specifying Ring Abandon via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time——————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Ex Hold Time field in first column of the screen:

Ex_Hald Time: |3_§ Min.

4
i
5] -

i Redial—

2) Select the exclusive hold time you want to use.
 Valid options are 0 - 8 minutes.

e The default is 3 minutes.
« If you do not want to allow exclusive holds on the system, set this field to O.
When you are finished:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Selecting Exclusive Hold Time (continued on next page)
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Specifying Ring Abandon (continued)

SELECTING EXcLUSIVE HOLD TIME VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-08.

5) Press save to display the EX_HOLD TIME screen.

6) Press chg until the appropriate Exclusive Hold Time appears.
 Valid options are 0 - 8 minutes.

¢ The default is 3 minutes.
« If you do not want to allow exclusive holds on the system, set this field to 0.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Establishing Warning Time for Limited Call Lengths

You can limit an extension to calls that fall within a specific programmed time. You can set the DX-120 to warn an
extension that the time has expired, thereby advising the user to disconnect. In this mode, the system plays a warning
tone repeatedly once the timer has expired.

In this mode, the system automatically disconnects the call moments after playing the warning tone. You can set the
CO line call limiter for extensions on a per-extension basis and according to call type (outgoing, incoming, or both).

EXAMPLE
This feature could be used for lobby phones in a hotel or retail environment where
lengthy calls are discouraged.

s NOTE

.é You are only programming the warning time here. To control when the system
* disconnects calls that have exceeded the limit you set, you have to program the
individual extensions.

IMPORTANT!

A Because extension users can make additional calls after the system plays the
warning tones or drops the call, it is NOT recommended to use this feature as a toll_
saver option. Use this feature only for specific applications.

HINT
@ Also see...
e “Section 7 - Programming Toll Restrictions” on page 329.

« “Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops” on
page 411.

ESTABLISHING WARNING TIME FOR LIMITED CALL LENGTHS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

DISA

Call Handling
Syskem Resource
Restriction

Extension Application
C.0, Line Application Auto Attendant
System Application Tenant Calling
Feature Key Programming

Sl Password _

* v v v v vl

Establishing Warming Time for Limited Call Lengths via PC-DBA (continued on next page)
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Establishing Warning Time for Limited Call Lengths via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'l Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Warning Time field in the lower right portion of the screen:

Warning Time

Qutgaing CaII:|5 ? Min.
Incaming Call: 21 Min.
[

=

Help | g = Warning Time——————————

2) Select the appropriate information for the fields as shown below:

FOR THIS FIELD... SELECT...

The length of time after the outgoing call begins that you want
the system to sound the warning to the extension user.

« Valid options include 1 through 30 minutes.
* The default is 5 minutes.

Outgoing Call

The length of time after the incoming call begins that you want
the system to sound the warning time to the extension user.

« Valid options include 1 through 30 minutes.
» The default is 5 minutes.

Incoming Call

Establishing Warming Time for Limited Call Lengths via PC-DBA (continued on next page)
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Establishing Warning Time for Limited Call Lengths via PC-DBA (continued)

When times are set:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ESTABLISHING WARNING TIME FOR LIMITED CALL LENGTHS VIA THE DET

=S NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-09-01.

5) Press save to display the Warning Time Outgoing screen.
6) Press chg.

7) Enter the number of minutes (1~30) after the outgoing call begins that you want the system to sound the
warning time to the extension user.
« Valid options include 1 - 30 minutes.

e The default is 5 minutes.
8) Enter 03-09-02
9) Press save to display the for Warning Time Incoming prompt.
10) Press chg.

11) Enter the number of minutes (1~30) after the incoming call begins that you want the system to sound the
warning time to the extension user.
« Valid options include 1 - 30 minutes.

e The default is 5 minutes.
12) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

- 212 -



DX-120 Programming Manual BAsic CALL HANDLING PROGRAMMING TASKS

Setting Up Transfer Recalls for Idle and Busy Extensions

The system allows extension users to transfer calls from their extensions to other extensions, while maintaining the
privacy of the connection. This means that calls can be routed to DX-120 system destinations (extensions, UCD
groups, virtual numbers, etc.) in such a way that the wrong party cannot easily intercept them.

= There are two types of transfer you may use:

- Screened/Supervised transfer
Supervised transfer means that before the transfer is completed, the system announces the call to the
destination extension. This transfer method allows the transferring party to transfer the call to another
extension if the destination extension cannot take the call.

- Unscreened/Unsupervised transfer
Unsupervised transfer means that the system simply delivers the call to the destination, regardless of the

destination’s readiness to accept the call.
= When extension users complete a transfer the system places the outside line on exclusive hold.

The call can then be retrieved only at the extension user’s telephone or the telephone where they transferred the
call.

e Calls that are transferred are subject to a unique transfer recall time.

= When transferred calls go unanswered at the destination, the system recalls (rings) the call to the transferring
party when this timer expires.

= There are two recall timers that affect transferred calls:
- Transfer-Busy Recall Time

Transfer-ldle Recall Time

* Idle and Busy represent the status of the destination extension during unsupervised transfers.
- If the destination extension is busy, the system uses the Transfer-Busy Recall Timer.
- If the extension destination is idle, the system uses the Transfer-ldle Recall Timer.

* The following conditions apply to setting the transfer recall time.
- Extension users can transfer CO line calls and intercom calls.
- The system places transferred CO lines that recall on system hold.

- When transferring CO line recalls, the system displays the line number and extension number from where the
call was transferred.

- The transferred party will hear ring-back tone while the call is transfer ringing.

- In a screened transfer, if the destination extension answers the intercom call in voice announce hands-free
mode and does not go off hook, the system rings the destination extension.

- In screened transfer, if the destination extension answers the intercom call by lifting the handset, the system
immediately connects the caller to the destination extension.

- The system does not direct recalls to the programmed Alternate Attendant extension.
» Other features whose programming may be affected by transfer recall time include the following:
- Transfer and Answer Call
- Recall
- Call Forward
- Forced Intercom Tone Ring
- Call Park / Call Park Answer

Setting Up Transfer Recalls for Idle and Busy Extensions (continued on next page)
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Setting Up Transfer Recalls for Idle and Busy Extensions (continued)

SETTING UP TRANSFER RECALLS FOR IDLE AND BUSY EXTENSIONS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line

Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #
K5U DE Password _

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Eension Alarm Play Time: 30 ¥| sec. PBX Auto Pause: |1.D 'l See.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Tirne;  [1.0 x| Sec. Hold Abhandon  |&o0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
e | R | S ! I Min- - nsipervised Talk Time: |0 1 Min,
DialWait Time: |0 Tl sec Pause Time: 2.0 'I Sec. WM Manitar Tirme: |1D 'l Sec,
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Time: |3 vl Min Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
—Aut fic Redial——— —Dialing Ratio:
utomatic Redia _ ey ~External CRf—————————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
: — S BIVICE. | Always >
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
SLT: (1.0 = |Min. Start: {200 | ms. Tone Time: |60 x|ms. Outgoing CaII:|5 vl Min.
DEKT: [10  =|Min End: [1gon | ms. Int-Digit Tirme: |60 T |ms. Incoming CaII:|5 vl Min.

Update InitializedF &) Close Help |

Setting Up Transfer Recalls for Idle and Busy Extensions via PC-DBA (continued on next page)
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Setting Up Transfer Recalls for Idle and Busy Extensions via PC-DBA (continued)

In the XFR B (Busy) and XFR | (Idle) Recall fields on the right side of the screen:

WFR_B Recall |50 _N Sec.

XFR_| Recall: |30 <] ger
40 1 RFR_IRecall: |an | sec
120 -

&0
40
120 il

2) Enter/select the information in the fields as described below:

IN THIS FIELD... SELECT...

The length of time that you want the system to ring a busy extension
before pulling the call back.

XFR_B Recall « Valid options include 16, 30, 60, 90, and 120 seconds.
* The default is 60 seconds.
The length of time that you want the system to ring an idle extension
before pulling the call back.

XFR_I Recall

« Valid options include 16, 30, 60, 90, and 120 seconds.
¢ The default is 30 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up Transfer Recalls for Idle and Busy Extensions (continued on next page)
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Setting Up Transfer Recalls for Idle and Busy Extensions (continued)

SETTING UP TRANSFER RECALLS FOR IDLE AND BUSY EXTENSIONS VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Setting Transfer-ldle Recall

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-10.
5) Press save to advance to the Transfer-ldle Recall programming screen.

6) Press chg to select how long you want the system to ring the idle extension before pulling the call back.
 Valid options include 16, 30, 60, 90, and 120 seconds.

¢ The default is 30 seconds.

7) Press next to advance to the Transfer-Busy Recall programming screen (now go to step 6 in“Setting
Transfer-Busy Recall” below).

OR

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Transfer-Busy Recall

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-11.
5) Press save to advance to the Transfer-Busy Recall programming screen.

6) Press chg to select how long you want the system to ring the busy extension before pulling the call back.
 Valid options include 16, 30, 60, 90, and 120 seconds.

* The default is 60 seconds.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Hold Recall

Extension users may place any CO line on system hold by pressing the Hold button. When they place a line on
System Hold, the system flashes the green lamp for that line at the I-Hold rate. The system flashes this system-held
line using the red lamp at all other extensions.

= |-Hold Indication allows extension users to easily distinguish between a call they placed on hold at their
telephones, and calls placed on hold at other telephones.

e The DX-120 allows you to tell the system to automatically return a call put on hold to the originating extension
after a period of time has elapsed. You can control the recall time separately for SLT and DETSs.

e Other features that may be affected by hold recall include the following:
- Call Transfer
- Hold Reminder
- Hold Abandon

= The following conditions apply to hold recall:

- Pressing Hold will place a conference on exclusive hold if the extension user is the controlling party and they
temporarily exit to add another party.

- When a conference call is placed on hold, the steady lamp indication at other extensions remain steady
(follows exclusive hold functions).

- Any party who is placed on hold will hear music only if it is available through the external music source
connection.

- When calls placed on exclusive (private) hold exceed the exclusive hold programmed time, the system
automatically places recalls on system hold.

SETTING UP HOLD RECALL VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I

Call Handling
Syskem Resource
Restriction

Feature Control t

CID Program%g Code

3

13

3
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling

3

Feature Key Programming
K5U DE Password

Setting Up Hold Recall via PC-DBA (continued on next page)
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Setting Up Hold Recall via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'l Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| sec ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 =|ms Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Hold Recall fields in bottom left corner of the screen:

Haold Recall
SLT: (1.0 Min.
DEKT: - ~Min. Hold Recall——————
20 = SLT: [1.0  [x[Min.
5 T DEKT: [1.0 Min.
1.5 (=
5 =

2) Select settings for the fields as described below:

IN THIS FIELD... SELECT...

The length of time that calls placed on hold at analog devices
remain on hold before ringing-back to the extension that placed
SLT them on hold.

« Valid choices range in increments from 0 to 5.0 minutes.

e The default is 1.0.

The length of time calls can be placed on hold at Digital Speaker-
phones, before the system rings back the extension with the call.

« Valid choices range in increments from 0 to 5.0 minutes.
» The default is 1.0.

DEKT

Setting Up Hold Recall via PC-DBA (continued on next page)
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Setting Up Hold Recall via PC-DBA (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP HOLD RECALL VIA THE DET

=S NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Programming an SLT Hold Recall:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-12.
5) Press save to advance to SLT Hold Recall programming.

6) Press chg to select the length of time you want the system to allow a call to remain on hold until it recalls
it to the SLT extension user’s phone.
 Valid choices range from 0 to 5.0 minutes.

¢ The default is 1.0.

7) Press next to display the EKT Hold Recall screen (now go to step 6 in “Programming an EKT Hold
Recall:” below).

OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Hold Recall via the DET (continued on next page)
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Setting Up Hold Recall via the DET (continued)

Programming an EKT Hold Recall:

From the DB Item Select screen (see steps 1 through 3 on previous page):
4) Enter 03-13.
5) Press save to advance to EKT Hold Recall programming.

6) Press chg to select the length of time you want the system to allow a call to remain on hold until it recalls
it to the DET extension user’s phone.
« Valid choices range from 0 to 5.0 minutes.

e The default is 1.0.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Dial Wait Time and Dial Delay

The DX-120 allows you to specify the timing you want the system to use for dial wait and dial delay. Dial wait time is
how long the system waits before outputting DTMF tones on outgoing calls. Dial delay is how long the system waits
after the extension user has gone off hook before presenting dial tone to the speaker/ear piece.

SETTING Up DIAL WAIT TIME AND DIAL DELAY vIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

3

13

3
Extension Application 3 DISA

13

3

3

Call Handling

Syskem Resource
Restriction

C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming
K5U DE Password

Setting Up Dial Wait Time and Dial Delay via PC-DBA (continued on next page)
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Setting Up Dial Wait Time and Dial Delay via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWait Time: |0 Tl sec Pause Time: 2.0 'I Sec WM Manitar Tirme: |1D 'l Sec,
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Dial Wait Time field in the top left side of the screen:

Dial Wait Time:
Dial Delay Time:
Ex_Hold Time:

2) Select settings for the fields as described below:

IN THIS FIELD... SELECT...

The length of time that you want the system to wait before outputting DTMF

_ o tones.
Dial Wait Time « Valid choices are 0 - 8 seconds.

» The default is 0 seconds.

The length of delay before the system presents dial tone to the extension
user.

« Valid choices are 100, 300, 1000, 1500, and 2000 milliseconds.
» The default is 100 milliseconds.

Dial Delay Time

When you are finished:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.
When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up Dial Wait Time and Dial Delay (continued on next page)
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Setting Up Dial Wait Time and Dial Delay (continued)

SETTING UP DIAL WAIT TIME AND DIAL DELAY VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Programming the Dial Wait Time:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-16.
5) Press save to advance to Dial Wait Time programming.

6) Press chg to select to specify how long you want the system to wait before outputting DTMF tones.
 Valid choices are 0 - 8 seconds.

¢ The default is 0 seconds.
7) Press next to display the Dial Delay screen (now to go step 6 in the next section).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Programming Dial Delay:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-17.
5) Press save to advance to Dial Delay programming.

6) Press chg until you see the length of time you want the system to wait before it sounds dial tone to the
extension user.
« Valid choices are 100, 300, 1000, 1500, and 2000 milliseconds.

e The default is 100 milliseconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Establishing the Dialing Ratio
You can modify the settings for manually dialed or system automatically dialed digits, depending on the outside plant
environment, type of Central Office, and customers’ specialized dialing requirements.

= The system provides two features that control dialing options:
- DTMF “on” time (tone) and
- Pulse dialing — pulse time/Pulse dialing — inter-digit time.
$~ NOTE
.é Usually it is not necessary to modify the settings of these features. However, in some
installation environments the outside plant equipment may be antiquated, or line

conditions may be poor. In these instances you can increase tone duration and/or
inter-digit duration timing to offset these poor conditions.

e The following conditions apply to setting the dialing ratio:

- You can use a longer DTMF “on” time and/or inter-digit tone time to ensure more reliable interaction with
remote voice mail and similar remote DTMF dial-pad-actuated devices.

- At default the DTMF duration is set to 70 milliseconds.

- Longer tone duration or inter-digit duration times cause a slower output of manual or automatic system-dialed
numbers.

ESTABLISHING THE DIALING RATIO VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

3

13

3
Extension Application 3 DISA

13

3

3

Call Handling
Syskem Resource
Restriction

C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming
K5U DE Password

Establishing Dialing Ratio via PC-DBA (continued on next page)
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Establishing Dialing Ratio via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Camp On Interval; |m'l Sec. Extension Alarm Flay Time: 30 | Sec PBEX Auto Pause: |1.D 'lSec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms

CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vlSec.

COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms

i ime: - Meet Me Conference Talk Time: | mi | i
IR | [ L ) Bl Unsuperdised Talk Time; |0 =1 Min.
Dial¥ait Time: | Jhd =0 Fause Time. |2.0 'I Sec. M Manitar Tirme: |1D 'l Sac.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl hin. Predefined Forward Time:  [10 x| sec. FR_|Recall  [ag =] sec.

— Aut tic Redial —————————— —Dialing Ratio:

utomatic Redia _ oAl —External Gy
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: (1.0 ~ | Min. End: [1oon «|ms. Int-Digit Time: |60 T |ms. Incoming CaII:|5 vl Mir.
Update | InitializedF &) | Close Help |
From the Dialing Ratio fields near the center of the screen:
Dialing Ratio:
Break Time:
Inter-Digit:
Tona Time: Dialing Ratio:
Break Time: |g0 | ms.
Inter-Digit: |agp | ms.
Tone Time: ﬁ
= M Dialing Ratio.
| M Dial X Break Time: |g0 x| ms.
Inter-Digit: 1agp | ms.
Tone Time: [7q .

Establishing Dialing Ratio via PC-DBA (continued on next page)
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Establishing Dialing Ratio via PC-DBA (continued)

2) Select the information for the fields as described below:

FOR THIS FIELD... SELECT...

The length of time you want the system to play each individual pulse

during out-dialing from the Break Time field.

Break Time « Valid choices are 60 or 67 milliseconds.

» The default is 60 milliseconds.

The time you want the system to pause between each pulse during
out-dialing.

Inter-Digit » Valid choices are 400 - 800 milliseconds, in increments of 50
milliseconds.

* The default is 800 milliseconds.

The length of time you want the system to play each individual DTMF
tone during out-dialing.

Tone Time * This time is also used for time between DTMF digits.
* Valid options are 70, 90, or 120 milliseconds.
 The default is 70 milliseconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Establishing Dialing Ratio (continued on next page)
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Establishing Dialing Ratio (continued)

ESTABLISHING THE DIALING RATIO VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-05.

5) Press save to advance to Dialing Ratio.

6) Press next to display each Dialing Ratio screen (see information in the following sections for setting the
the Dialing Ratio).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Break Time:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-05-01.
5) Press save to advance to Break Time.

6) Press chg to select how long you want the system to play each individual pulse during outdialing.
« Valid choices are 60 or 67 milliseconds.

* The default is 60 milliseconds.

7) Press next to advance to Pulse Dialing Inter-digit Time (now go to step 6 in “Setting the Pulse Dialing
Inter-digit Time:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Establishing Dialing Ratio via the DET (continued on next page)
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Establishing Dialing Ratio via the DET (continued)

Setting the Pulse Dialing Inter-digit Time:

From the DB Item Select screen (see steps 1 through 3 on page 226):
4) Enter 03-05-02.
5) Press save to advance to Pulse Dialing Inter-digit Time.

6) Press chg to select the time you want the system to insert between each pulse during outdialing.
« Valid choices are 400 - 800 milliseconds.

* The default is 800 milliseconds.
7) Press next to advance to Tone Time (now go to step 6 in “Setting the Tone Time:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Tone Time:

From the DB Item Select screen (see steps 1 through 3 on page 226):
4) Enter 03-05-03.
5) Press save to advance to Tone Time.

6) Press chg to select the length of time you want the system to play each individual DTMF tone during
outdialing.
e This time is also used for time between DTMF digits.

 Valid options are 70, 90, or 120 milliseconds.
e The default is 70 milliseconds.

7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

- 227 -



BAsIiC CALL HANDLING PROGRAMMING TASKS DX-120 Programming Manual

Establishing Start and End of SLT Hook Flash

= Single Line Telephones and similar analog devices connected to analog ports of the DX-120 system must use
unsophisticated signaling to administer call-processing operations (like transfer and hold). This fundamental call
control is handled in the form of specific hook-switch operations. These are known as hook-switch flash (or just
flash) commands.

e Whenever extension users want to invoke a system feature at a single line telephone, they must operate the
hook-switch in a fashion that is distinguishable from an on-hook (hang up) request. This becomes essential for
proper handling of calls, considering the user may operate the hook-switch quickly to hang up and place a new
call. Yet this fast operation of the hook-switch might be interpreted as a hook-switch flash operation.

e Considering these factors, the DX-120 system allows you to customize the hook-switch command monitoring.
You can direct the system to ignore hook-switch operations that are considered too short to be valid, and to limit
the time allotted.

= The following conditions apply to SLT hookswitch flash:

If the analog device/SLT does not have a hook-flash operation button, extension users must operate the

hook-switch within the time you specify in the “Start” and “End” settings. If they do not, the system does not

process the user’s action as a valid hook-flash operation.

The system ignores hook-switch operations that are shorter than the “Start” time.

The system considers hook-switch operations that are longer than the “End” time as hang ups.

ESTABLISHING START AND END OF SLT HOOK FLASH viIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I t

Call Handling Feature Control

CID Program%g Code

DISA

Syskem Resource
Restriction

Extension Application
C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming
K5U DE Password

* v v v v vl

Establishing SLT Hook Flash via PC-DBA (continued on next page)
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Establishing SLT Hook Flash via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWait Time: |0 Tl sec Pause Time: 2.0 'I Sec WM Manitar Tirme: |1D 'l Sec,
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

From the SLT Hook Flash fields in the lower left area of the screen:

SLT Hook Flash

Start: W ms. SLT Hook Flash

End: ~1ms. Start: [200 | ms.
300 . =
00 End: 11000 ms.

2) Select the settings for the fields as described below:

For this field... Select...

The minimum time that an analog/SLT must flash the hook-switch to be con-
sidered a valid flash-hook request.

* A hook-flash that is shorter than this timer is considered a mistake; no
action is taken.

« Valid options include from 60 - 1400 milliseconds.
* The default is 200 milliseconds.

Start

The maximum time that an analog/SLT must flash the hook-switch to be con-
sidered a valid flash-hook request.

End » A hook-flash that is longer than this timer is considered a hang up.
« Valid options include from 100 - 1500 milliseconds.
* The default is 1000 milliseconds.

Establishing SLT Hook Flash via PC-DBA (continued on next page)
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Establishing SLT Hook Flash via PC-DBA (continued)

When both times have been set:
3) Click the Update button to store the settings in the database on your local disk.
4) Click the Close button to exit the current menu and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ESTABLISHING START AND END OF SLT HOOK FLASH VIA THE DET

Qh-\'- NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
y Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-14.

5) Press save to advance to the SLT Hook Flash programming screen.

6) Press next to display each SLT Hook Flash screen (see information in the following sections for setting
the Dialing Ratio).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Establishing SLT Hook Flash via the DET (continued on next page)

- 230 -



DX-120 Programming Manual BAsic CALL HANDLING PROGRAMMING TASKS

Establishing SLT Hook Flash via the DET (continued)

Setting the Start Range:

From the DB Item Select screen (see steps 1 through 3 above):
7) Enter 03-14-01.
8) Press save to advance to the Start screen.

9) Press chg to set the Start range setting.
¢ This timer indicates the minimum time that an analog/SLT must flash the hook-switch to be considered
a valid flash-hook request.

* A hook-flash that is shorter than this timer is considered a mistake; no action is taken.
« Valid options include from 60 - 1400 milliseconds.
* The default is 200 milliseconds.

10)Press next to advance to the End screen (now go to step 6 in “Setting the End Range:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the End Range:

From the DB Item Select screen (see steps 1 through 3 on page 230):
4) Enter 03-14-02.
5) Press save to advance to the End screen.

6) Press chg to set the End range setting.
¢ This timer indicates the maximum time that an analog/SLT must flash the hook-switch to be considered
a valid flash-hook request.

¢ A hook-flash that is longer than this timer is considered a hang up.
 Valid options include from 100 - 1500 milliseconds.
e The default is 1000 milliseconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Auto Redial

Extension users can use Automatic Redial (AR) to redial the last number dialed. The system automatically dials the
number and then waits for a predetermined time period. Following this predetermined time period if no action is taken,
the system hangs up and the redial cycle continues until it reaches the number of attempts you specify.

= The system continues redial attempts until one of the following occurs:
- The call rings through and caller picks up
- The maximum number of attempts is reached
- Any other feature is used on the telephone.

e [fall CO lines or CO line groups are busy when the system attempts the auto redial, that attempt counts as a valid
attempt and reduces the remaining number of attempts.

e You can program the feature code Feature 7 8 as a flexible feature button on the DET. If you do, the extension
user can use that button to invoke the feature. While the feature is active the system lights the button LED a
steady red. When extension users are attempting a redial the system flashes the button red.

= You set the number of redial attempts and the timed interval between attempts; these cannot be changed at the
extension level.

e Other features that may be affected by auto redial include the following:
- Voice Malil - Digital Integration
- Extension Application - Voice Mail Table, Record Digit, and Automatic Record Member

PROGRAMMING AUTO REDIAL vIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I

Call Handling
Syskem Resource
Restriction

Feature Control t

CID Program%g Code

Extension Application DISA
C.0, Line Application Auto Attendant

System Application Tenant Calling

Feature Key Programming
K5U DE Password

* v v v v vl

Programming Auto Redial via PC-DBA (continued on next page)
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Programming Auto Redial via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Camp On Interval; |m'l Sec. Extension Alarm Flay Time: 30 | Sec PBEX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms

CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vlSec.

COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
IR | [ L ) Bl Unsuperdised Talk Time; |0 =1 Min.
Dial¥ait Time: | Jhd =0 Fause Time. |2.0 'I Sec M Manitar Tirme: |1D 'l Sac.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl hin. Predefined Forward Time:  [10 x| sec. FR_|Recall  [ag -| gec
— Autormatic Redlal+ - Dialing Ratia: —External CFw
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn |3 Inter-Digit: R4 =
o [|23545 800 I 7 Talk Time: [5 ~ |min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: (1.0 ~ | Min. End: [1oon «|ms. Int-Digit Time: |60 T |ms. Incoming CaII:|5 vl Mir.
Update | InitializedF &) | Close | Help |
From the Automatic Redial area (located in the left center area of the screen):
—Automatic Redial
Afternpts: |2 | Times
Interval: |0 Sec.
s L e, Automatic Redial—————————————————
Attermnpts: |2 Times
Interval: Sen.
iatinuiiine: S CAUDmatc Redial ]
Hold Recall —{120 ~ Hook Flag RS | b Ejies
Intereal: | o | Sec.
Wiaiting Time: Sec.
Hold Recall Hook Fl
( SLT: 200

Programming Auto Redial via PC-DBA (continued on next page)
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Programming Auto Redial via PC-DBA (continued)

2) Select the information for the fields as described below:

For this field... SELECT...

Attempts The number of times you want to allow the system to try re-dialing the last

dialed number.

« Valid options include O - 2 times.

« If you want to disable redial, select 0.
» The default is 2 times.

Interval The length of time you want the system to wait in between redial attempts.

« Valid choices are 30, 60, 90, and 120 seconds.
¢ The default is 60 seconds.

Waiting Time The length of time you want the system to wait (during ringing) before classi-

fying the attempt as "no answer", and proceeding to the next interval/attempt.
* Valid choices are 10, 15, 20, 25, and 30 seconds.

¢ The default is 15 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming Auto Redial (continued on next page)
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Programming Auto Redial (continued)

PROGRAMMING AUTO REDIAL VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-32.

5) Press save to advance to the Automatic Redial screen.

6) Press next to display each Automatic Redial screen (see information in the following sections for setting
the Automatic Redial).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Number of Attempts:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-32-01.
5) Press save to advance to the Attempts screen.

6) Press chg to set the number of times you want to allow the system to try re-dialing the number.
« Valid options include 0, 1, and 2.

« If you want to disable redial, select O.
e The default is 2.

7) Press next to advance to the Interval field (now go to step 6 in “Setting the Intervals:” below).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Auto Redial via the DET (continued on next page)

- 235 -



BAsIiC CALL HANDLING PROGRAMMING TASKS DX-120 Programming Manual

Programming Auto Redial via the DET (continued)

Setting the Intervals:

From the DB Item Select screen (see steps 1 through 3 on page 235):
4) Enter 03-32-02.
5) Press save to advance to the Interval screen.

6) Press chg to set how long the system waits in between redial attempts.
« Valid choices are 30, 60, 90, and 120 seconds.

* The default is 60 seconds.
7) Press next to advance to the Waiting Time field (now go to step 6 in “Setting the Waiting Time:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Waiting Time:

From the DB Item Select screen (see steps 1 through 3 on page 235):
4) Enter 03-32-02.
5) Press save to advance to the Waiting Time screen

6) Press chg to set how long you want the system to wait during ringing before classifying the attempt as no
answer, and proceeding to the next interval/attempt.
 Valid choices are 10, 15, 20, 25, and 30 seconds.

* The default is 15 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Programming External Call Forward

The DX-120 enables extension users to forward their calls to another location or different telephone number. You
control whether or not the system allows these external call forwards. Also, you can exclude or include specific
extensions individually.

= The following conditions apply to setting external call forwards:

- Regardless of whether the extension where calls are being forwarded to is a DET or single line telephone, the
system plays a special intercom reminder tone alerting the extension user that call forward is activated.

- The system does not light the auxiliary lamp green in call forward mode if that function has been disabled via
the attendant in Attendant Administration.

- If aflexible feature button has been programmed for call forward mode, the LED associated to that button will
light red indicating the telephone is in call forward mode.

- The extension invoking call forwarding overrides any applicable predefined call forward in the database.
When the system releases the extension forward mode it reactivates predefined call forward.

- In addition to programming what you want to use for call handling here, you must also program the individual
extensions’ receive assignments - see page 435.

= Other features whose programming may be affected by external call forward include the following:
- Do Not Disturb
- Forced Intercom Call Forward
- Intercom Mode Selection
- Forced Intercom Tone Ring
- Messaging — Call Me, Text or Voice

= NOTE:
.g The system externally forwards transferred CO line calls only.

Programming External Call Forward (continued on next page)
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Programming External Call Forward (continued)

PROGRAMMING EXTERNAL CALL FORWARD VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
_all Handling 3 Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | i | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CF
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
: — == BRICED | Always b
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the External CFW fields (located in the right center area of the screen):

External CFi
Semvice: | Always N
TalkTime: [Day ahin.

External CFiY

Service: | Always -
TalkTime: {s

Iin.

rWarning Time

" bdie

Programming External Call Forward via PC-DBA (continued on next page)
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Programming External Call Forward via PC-DBA (continued)

2) Select the information for the fields as described below:

For this field... SELECT...

The time during which the external call forward mode (time) is

) active.
Service « Valid choices are Never, Day, Evening, and Always.
e The default is Always.
The length of time you want the system to allow talk times for
external call forward calls.
Talk Time

« Valid options are 5, 10, 20, 30, 60, and 120 minutes.
¢ The default is 5 minutes.

When you are finished making the settings:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memaory.

Programming External Call Forward (continued on next page)
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Programming External Call Forward (continued)

PROGRAMMING EXTERNAL CALL FORWARD VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Setting External Call Forward:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-33-01.

5) Press save to advance to ECF Service Mode.

6) Press chg to specify when the external call forward mode (time) is active.
 Valid choices are Never, Day, Evening, and Always.

¢ The default is Always.

7) Press next to advance to External Call Forward Talk Time (now go to step 6 in “Setting the External Call
Forward Talk Time:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the External Call Forward Talk Time:

From the DB Item Select screen (see steps 1 through 3 above):
8) Enter 03-33-02.

9) Press chg to specify how long you want the system to allow talk times for external call forward calls.
« Valid options are 5, 10, 20, 30, 60, and 120 minutes.

¢ The default is 5 minutes.

10)Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Conference Talk Time Intervals and Conference Tones
Conference is used to join telephone connections together. Meet Me Conference simplifies the setup process by
assigning designated system resources as conference destinations. The result is eight separate conference locations
that are joined by dialing the location number.

Callers can easily be transferred to these locations; extension users simply dial the location number. Outside parties
can join the conference via the automated attendant simply by dialing the location number at the auto attendant
greeting.
e Other features that may be affected by conference talk times include the following:
- CO Line — Call Abandon
- Call Handling — CO Line Conference
- Call Handling — Talk Abandon Time

- System Application — Meet Me Conference Directory Number

K NOTE
When Call Abandon (see page 129) is set to N for any CO line, you must set the Meet
® Me Conference Talk Time (see page 244) to some value other than 0. This is the only
setting that will allow the CO line to be disconnected if Call Abandon is set to no.

SETTING CONFERENCE TALK TIME INTERVALS AND CONFERENCE TONES VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

DISA
Auko Akkendant

Tenant Calling
Feature Key Programming

Sl Password _

Call Handling

Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application

* v v v v vl

Setting Conference Talk Time Intervals and Confernce Tones via PC-DBA (continued on next page)
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Setting Conference Talk Time Intervals and Conference Tones via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWait Time: |0 Tl sec Pause Time: 2.0 'I Sec WM Manitar Tirme: |1D 'l Sec
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
: — == BRICED | Always b
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

From the Meet Me Conference Talk Time field:

Meet Me Caonference Talk Time: ]
FPause Time:

FBX Flash:

Predefined Forward Time:

2) Select the length of time that you want the system to allow for Meet Me Conferences.
e The valid range is from 0 to 120 minutes, in 10 minute increments.
e The default is O (unlimited).

When you are finished setting the Meet Me Conference Talk Time:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Setting Conference Talk Time Intervals and Confernce Tones via PC-DBA (continued on next page)
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Setting Conference Talk Time Intervals and Conference Tones via PC-DBA (continued)

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line =
Col Handing | reseciay

Syskem Resource Timing

Restriction CID Programming Code
Extension Application DISA

C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming

1) Go to ProgrammingP> Call HandlingP>Feature Control to display the Feature Control screen.
| WM Resere Port: |D vl

SMDR Call Output

13
3
13
13
3
13

Co Line Conference:

[~ Hotel Enable
[~ Sys SFPD. Toll Check
V¥ TSl Connect Enable

[~ Incoming Call
v Outgoing Call

¥ Conference Tone I Account Code
v Daylight Saving Time ¥ Call Start
Update | InitializedF &) | Close | Help |

2) Select No, 2Lines, or 3Lines from the CO Line Conference field.
e The default is 3Lines.

Co Line Conference: |3lines

Mo
2Lines

[~ Hotel Enab

3) Click the checkbox (") next to Conference Tone to place a check mark there to enable the Conference
Tone (¥).
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no

checkmark 7).
¢ The default is on (check mark).

When you are finished making the settings:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Conference Talk Time Intervals and Confernce Tones (continued on next page)
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Setting Conference Talk Time Intervals and Conference Tones (continued)

SETTING CONFERENCE TALK TIME INTERVALS AND CONFERENCE TONES VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Setting Meet Me Conference Time:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-38.

5) Press save to display Meet Me Conference.

6) Press chg to specify the length of time that you want the system to allow for Meet Me Conferences.
e The valid range is from 0 to 120 minutes, in 10 minute increments.

¢ The default is 0 (unlimited).

7) Press next to advance to External Call Forward Talk Time (now go to step 6 in “Setting the Conference
Tone Operation:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Conference Tone Operation:

From the DB Item Select screen (see steps 1 through 3 above):
8) Enter 03-23.
9) Press save to display Conference Tone.

10) Press chg to specify whether or not you want the system to play conference tones.
 Valid choices are yes or no.

e The default is yes.
11) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Camp On Interval

The DX-120 allows you to specify how long before the system waits before sounding a beep to extension users,
alerting them that another call is camped on to their extension.

SETTING UrP CAMP ON INTERVAL VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line

Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #
K5U DE Password _

1) Go to ProgrammingP>Call HandlingP Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec. PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min. Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vI Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl —External Gy
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Camp On Interval field in the top left side of the screen:

Camp On Interval; IQU Sec.
all Duration Time: Sec.
Line Guard Time: Sec.

Co Flash : Sec.

2) Select the length of time that you want the system to wait before sounding the camp on beep to the
extension user at a busy extension.

« The valid range is from 0 to 60 seconds, in 10 second increments.
¢ The default is 20 seconds.

Setting Up Camp On Interval via PC-DBA (continued on next page)
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Setting Up Camp On Interval via PC-DBA (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP CAMP ON INTERVAL VIA THE DET

Qh-\'- NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-18.

5) Press save to display the Camp On Time screen.

6) Press chg to specify the length of time you want the system to wait before sounding the camp on beep (to
the extension user at a busy extension).
* The valid range is from 0 to 60 seconds, in 10 second increments.

* The default is 20 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Alarm Play Intervals

Extension users can activate their own private alarm on their telephones to remind them of special appointments,
events, etc. When the alarm activates, the system ring tones the extension for a time that you specify. After this
period, the system automatically cancels the alarm.

You can program the alarm for a single use or recurring use. When programmed for recurring use, the system sounds
the alarm at the same time every day.

IMPORTANT!

Be sure the system time and date is set to the correct local time and date before
programming the alarm play interval (see “Setting System Time, Date, and/or Hour
Mode” on page 49).

=3y NOTE
.é Distinctive Ringing may be affected by alarm play interval.

ABOUT THE ALARM INTERVAL
= The display remains unchanged until ack is pressed or until the telephone is used for another call.
* You can program the Alarm Clock feature code at any programmable flexible feature button.

SETTING UP ALARM PLAY INTERVALS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

Restriction CID Program%g Code

3

13

3
Extension Application 3 DISA

13

3

3

Call Handling
Syskem Resource

C.0, Line Application Auto Attendant
System Application Tenant Calling
Feature Key Programming

Sl Password _

Setting Up Alarm Play Intervals via PC-DBA (continued on next page)
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Setting Up Alarm Play Intervals via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| sec ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Extension Alarm Play Time field in the top center of the screen:

Extension Alarm Flay Time: |30 Sec.
FAxX Ring Time: Sec.
Hold Abhandon ms
Hold Reminder: Sec.

2) Select the frequency with which you want the system to repeat the alert tone when the set alarm time is
reached.

« Valid options are 10 - 600 seconds.
e The default is 30 seconds.
When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up Alarm Play Intervals (continued on next page)
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Setting Up Alarm Play Intervals (continued)

SETTING UP ALARM PLAY INTERVALS VIA THE DET

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-19.

5) Press save to display the Alarm Play screen.

6) Press chg to select the time you want the system to repeat the alert tone when the set alarm time is
reached.
« Valid options are 10~600 seconds, in 30 second intervals (10, 20, 30, etc.).
e The default is 30 seconds.

7) Press the Hold button to return to the previous menu level.

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27)

Enabling/Disabling Hotel Feature

This feature allows the system attendant to administer certain system extension features to emulate hotel operations.
The system attendant can:

e Set extension wakeup calls via the Alarm Clock-Extension feature.

e Set extension status to Checked IN/Checked OUT/Clean such that the associated LED of DSS/BLF buttons for
the extension indicate the current status. In “Checked Out” and “Clean” modes, dialing at the extension is
restricted to intercom calls only.

HINT
@ If you have programmed a release key, you can use it to clear any active condition
(extension alarm clock mode, etc.) with one touch.

Enabling the Hotel Feature (continued on next page)
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Enabling the Hotel Feature (continued)

ENABLING THE HOTEL FEATURE VIA PC-DBA

From the PC-DBA main screen:

Extension
C.0, Line
Call Handling

Syskem Resource
Restriction
Extension Application
C.0, Line Application
System Application

K5U DE Password

Programming Maintenance  Help

Feature Key Programming

Timing

CID Programming Code
DISA

Auko Akkendant

Tenant Calling

1) EGo to ProgrammingP Call Handling® Feature Control to display the Feature Control screen.

RP :Call Handling - Feature Control 1

=i

Co Line Conference: [N

~| VM Reserve Port:

—

[~ Hotel Enable

I Sys SFPD. Toll Check
V¥ TSl Connect Enable
¥ Conference Tone

¥ Daylight Saving Time

SMDR Call Output

[~ Incoming Call

¥ Outgoing Call

¥ Account Code

v Call Start

Update | Initialize(FS)l

Close | Help

2) Click the checkbox (I ) next to Hotel Enable to place a check mark there to enable the Hotel Features

().
Clicking on this box toggles the setting between yes/enable (a checkmark ) and no/disable (no
checkmark 7).

L]

The default is off (no check mark ™).

When you are finished making the settings:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Enabling the Hotel Feature (continued on next page)
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Enabling the Hotel Feature (continued)

ENABLING THE HOTEL FEATURE VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-20.

5) Press save to advance to the Hotel Enable programming screen.

6) Press chg to select yes (on) or no (off).
e The default is no (off).

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Enabling/Disabling System Speed Toll Check

The System Speed Toll Check feature allows you to instruct the system to perform a toll restrictions check on a system
speed dial. Normally, system speed dials are exempt from the toll check while the DX-120 does perform toll restriction
checks on individual speed dials and processes the call accordingly.

EXAMPLE

Suppose your customer has a corporate office in Tampa, Florida, and a satellite office
in Houston, Texas. Your client may wish to allow the corporate employees to call the

Houston office, even though long distance calls are prohibited in their class of
service. To do this, you would set up a system speed dial for the corporate office
employees with system speed toll check disabled—since the Houston number is set
up on a system speed dial it is processed without a toll check.

Now suppose another customer has a corporate office in Tampa, Florida, and a
satellite office in Honolulu, Hawaii. This customer wants to allow the CEO to call
Honolulu but not allow the remaining employees to do so. In this instance, you could
set up a speed dial for the CEO with system speed toll check enabled, and assign the
CEO a separate class of service whose toll restrictions include the ability to call
Honolulu. The remaining employees’ class of service would disallow this toll call.

ENABLING/DISABLING SYSTEM SPEED ToLL CHECK VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Syskem Resource
Restriction

C.0, Line Application
System Application

13
3
i
Extension Application 3
13
3
3

Feature Key Programming

Extension
C.0, Line
Cal Handing m

Timing

CID Programming Code
DISA

Auko Akkendant
Tenant Calling

Sl Password _

1) Go to ProgrammingP>Call HandlingP>Feature Control to display the Call Handling—Feature Control

screen.

RP :Call Handling - Feature Control |

Co Line Conference:

| WM Resere Port: |D vl

[~ Hotel Enable

I~ Sys SPD. Toll Check
V¥ TSl Connect Enable
¥ Conference Tone

¥ Daylight Saving Time

SMDR Call Output

I Incaming Call
¥ Outgoing Call
¥ Account Code
v Call Start

Update InitializedF &)

Close Help

Enabling/Disabling System Speed Toll Check via PC-DBA (continued on next page)
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Enabling/Disabling System Speed Toll Check via PC-DBA (continued)

2) Click the checkbox (") next to Sys SPD. Toll Check to place a check mark there to enable the System
Speed Toll Check option (¥)).
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

« The default is off (no check mark I ).

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ENABLING/DISABLING SYSTEM SPEED ToLL CHECK VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

e You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-21.

5) Press save to advance to the System Speed Toll Check Enable programming screen.

6) Press chg to select whether or not you want the system to perform toll checks on system speed dials
(Y/N) so that the system does not perform toll checks on system speed dials.
e The default is no (N).

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Enabling/Disabling TSI Connection

Enabling the TSI Connection tells the system to establish the voice path between the extension and the CO line without
checking the toll restrictions set up for that extension. If you disable TSI Connection, the system does not establish the
voice path between the extension and the CO line until after it has checked the toll restrictions.

ENABLING/DISABLING TSI CONNECTION VIA PC-DBA

From the PC-DBA main screen:

Extension
C.0, Line

Call Handling
Syskem Resource
Restriction

C.0, Line Application
System Application
Feature Key Programming

K5U DE Password

Programming Maintenance  Help

13
3
3
Extension Application 3
13
3
3

Timing

CID Programming Code
DISA

Auko Akkendant

Tenant Calling

1) Go to ProgrammingP> Call HandlingP>Feature Control to display the Call Handling—Feature Control

screen.

RP :Call Handling - Feature Control ]

=i

Co Line Conference: [l

~| VM Reserve Port:

—

[~ Hotel Enable

I Sys SFPD. Toll Check
V¥ TSl Connect Enable
¥ Conference Tone

¥ Daylight Saving Time

SMDR Call Output

[~ Incoming Call
v Outgoing Call

¥ Account Code
v Call Start

Update | Initialize(FS)l

Close | Help

2) Make sure there is a check in checkbox ( ¥ ) next to TSI Connect Enable to enable the TSI Connection

option ().

« Clicking on this box toggles the setting between yes/enable (a checkmark ) and no/disable (no

checkmark ).

+ The default is on (check mark ).

When you are finished:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Enabling/Disabling TSI Connection (continued on next page)
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Enabling/Disabling TSI Connection (continued)

ENABLING/DISABLING TSI CONNECTION VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-22.

5) Press save to advance to the TSI Connection programming screen.

6) Press chg to select whether or not you want the system to ignore the toll restrictions (Y/N).
e The default is yes (Y).

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Enabling/Disabling Conference Tone

The DX-120 can sound a tone to parties in a conference call whenever a new party is added to the call. The system
also sounds this tone when the conference call is initially set up, to signify that the conference is active. You can
choose to set the conference tone on or off. If you set the tone to off, existing parties in a conference call may be
unaware when new parties are added to the call.

HINT
@ See “Programming Conference Calls” on page 189.

ENABLING/DISABLING CONFERENCE TONE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line =
Cal Handing m

Syskem Resource Timing
Restriction

13

3

» CID Programming Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling

3

Feature Key Programming

KSU DB Password _

1) Go to ProgrammingP> Call HandlingPFeature Control to display the Call Handling—Feature Control
screen.

RP :Call Handling - Feature Control 1 ll
CoLine Conference:  [elNGEEg ~| M Resere Port: |D vl

SMDR Call Output

[~ Hotel Enable
I Sys SFPD. Toll Check
V¥ TSl Connect Enable

[~ Incoming Call
¥ Outgoing Call

¥ Conference Tone I Account Code
v Daylight Saving Time ¥ Call Start
Update | InitializedF &) | Close | Help |

2) Make sure there is a check in checkbox (¥ ) next to Conference Tone to enable the Conference Tone
(b).
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

+ The default is on (check mark ).

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Enabling/Disabling Conference Tone (continued on next page)
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Enabling/Disabling Conference Tone (continued)

ENABLING/DISABLING CONFERENCE TONE VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-23.

5) Press save to advance to the Conference Tone programming screen.

6) Press chg to select whether or not you want the system to sound the conference tone (Y/N).
e The default is yes (Y).

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Specifying Call Duration Time

This option allows you to specify the length of time before an outgoing call is displayed on the phones LCD and used in
the SMDR. In other words, the time set here is the number of seconds that the software waits after the telephone user
dials the last digit of the outgoing number (i.e., the start of the call) before it displays the call information on the LCD
and records it in the SMDR.

BASIC SETTINGS
You can set the DX-120 to either:

e warn an extension that the time has expired, thereby advising the extension user to disconnect.
- In this mode, the system plays a warning tone repeatedly once the timer has expired.
e automatically disconnect the call moments after playing the warning tone.

ADDITIONAL SETTINGS

You determine what call length you want to allow and when you want the system to play the warning tones while
programming call handling. You then set the warming tones/call drops on or off while programming the individual
extensions.

HINT
@ Also see...

» See “Establishing Warning Time for Limited Call Lengths” on page 261.
e See “Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops” on page 411.

SPECIFYING CALL DURATION VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

3

13

3
Extension Application 3 DISA

13

3

3

Call Handling
Syskem Resource
Restriction

C.0, Line Application Auto Attendant
System Application Tenant Calling
Feature Key Programming

Sl Password _

Specifying Call Duration via PC-DBA (continued on next page)
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Specifying Call Duration via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Camp On Interval; |m'l Sec. Extension Alarm Flay Time: 30 | Sec PBEX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time: |34 x| gec. 0 7| Min Unsupenised Talk Time: |9 = Min.
Dial¥ait Time: | Jhd =0 Fause Time. |2.0 'I Sec M Manitar Tirme: |1D 'I Sac.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl hin. Predefined Forward Time:  [10 x| sec. FR_|Recall  [ag -| gec
Pl i ~External CRf—————————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn |3 Inter-Digit: R4 =
o [|23545 800 I | S Talk Time: [5 ~ |min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: (1.0 ~ | Min. End: [1oon «|ms. Int-Digit Time: |60 T |ms. Incoming CaII:|5 vl Mir.
Update | InitializedF &) | Close Help |
In the Call Duration Time field in the first column:
Call Duration Time: |1D r| Sec
[2 Line Guard Time: 7 Sec,
COFlash: |12 Sec,
CID Ring Time: |12 Zl sec)

2) Select the maximum length of time you want the call displayed and used in the SMDR.
« Valid choices are 1 through 25 seconds in increments of 1 second.

¢ The default is 10 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Specifying Call Duration (continued on next page)
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Specifying Call Duration (continued)

SPECIFYING CALL DURATION TIME VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-24.

5) Press save to advance to the Call Duration screen.

6) Press chg until the maximum length of time you want the call displayed and used in the SMDR appears.
« Valid choices are 1 through 25 seconds in increments of 1 second.

¢ The default is 10 seconds.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Establishing Warning Time for Limited Call Lengths

You can limit an extension to calls that fall within a specific programmed time. You can set the DX-120 to warn an
extension that the time has expired, thereby advising the user to disconnect. In this mode, the system plays a warning
tone repeatedly once the timer has expired.

In this mode, the system automatically disconnects the call moments after playing the warning tone. You can set the
CO line call limiter for extensions on a per-extension basis and according to call type (outgoing, incoming, or both).

EXAMPLE

This feature could be used for lobby phones in a hotel or retail environment where lengthy calls are
discouraged.

NOTE

You are only programming the warning time here. To control when the system
disconnects calls that have exceeded the limit you set, you have to program the
individual extensions.

IMPORTANT!

Because extension users can make additional calls after the system plays the
warning tones or drops the call, it is NOT recommended to use this feature as a toll
saver option (see “Section 7 - Programming Toll Restrictions” on page 329). Use this
feature only for specific applications.

HINT
Also see...
» See “Establishing Warning Time for Limited Call Lengths” on page 261.

e See “Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops” on
page 411.

ESTABLISHING WARNING TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

DISA
Auko Akkendant

Tenant Calling
Feature Key Programming

Sl Password _

Call Handling

Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application

* v v v v vl

Establishing Warning Time via PC-DBA (continued on next page)
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Establishing Warning Time via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWait Time: |0 Tl sec Pause Time: 2.0 'I Sec WM Manitar Tirme: |1D 'l Sec
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
: — == BRICED | Always b
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Warning Time field in the lower right portion of the screen:

2) Select the appropriate information for the fields as shown below:

FOR THIS FIELD... SELECT...

The length of time after the outgoing call begins that you want
the system to sound the warning to the extension user.

Outgoing Call « Valid options include 1 through 30 minutes.
* The default is 5 minutes.
The length of time after the incoming call begins that you want
the system to sound the warning time to the extension user.
Incoming Call

« Valid options include 1 through 30 minutes.
» The default is 5 minutes.

When times are set:

3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy your new database to the DX-120 switch system memory.

Establishing Warning Time via the DET (continued on next page)

- 262 -



DX-120 Programming Manual BAsic CALL HANDLING PROGRAMMING TASKS

Establishing Warning Time via the DET (continued)

SPECIFYING CALL WARNING TIME VIA THE DET

=y NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 03-09-01 to set the outgoing call duration time.

5) Press chg to select the maximum amount of time you want to allow for limited outgoing calls.
« Valid choices are 1 through 30 minutes.

* The default is 5 seconds.
6) Enter 03-09-02 to set the incoming call duration time.

7) Press chg to select the maximum amount of time you want to allow for limited incoming calls.
« Valid choices are 1 through 30 minutes.

* The default is 5 seconds.

8) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Caller ID Codes and Local Calling Areas

The DX-120 allows you to program and store information for use in dialing outgoing calls. You can specify area codes
as well as international code so that they are automatically used when dialing corresponding telephone numbers.

= The following conditions apply when programming the caller ID table:

You must properly program the local area code and long distance prefix so the system can accurately re-dial
the CID number from the caller ID table.

If no name is delivered from the telephone company, the system displays the number only.

Any digital speaker phone user can review the caller ID table if the attendant password is known, but the table
can be reviewed by only one telephone at a time.

You can exit the caller ID call table mode at any time.

e When programming the caller ID table, enter the following:

International prefix (typically not required in the USA or Canada).

Country code (typically not required in the USA or Canada).

Long distance prefix (usually 1).

Local area codes (enter them as the prefix if the local phone company uses 10 digit dialing).
HINT

Also see...
* “Programming CID Names and Assignments Table” on page 72.

¢ “Programming Caller ID Codes and Local Calling Areas” on page 264.

PROGRAMMING CALLER ID CODES AND LOCAL CALLING AREAS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line I ]
Call Handling Feature Control

Syskem Resource
Restriction

Timing

.3

3

3 CID Programming Code
Extension Application » DISA k

3

3

3

C.0, Line Application Auto Attendant
Syskem Application Tenant Calling

Feature Key Programming
K5U DE Password

Programming Caller ID Codes and Local Calling Areas via PC-DBA (continued on next page)
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Programming Caller ID Codes and Local Calling Areas via PC-DBA (continued)

1) Go to ProgrammingP> Call Handling®CID Programming Code to display the Call Handling—CID
Programming Code screen.

F
Inter. Prefix Code: | Country Code: I
Long Dist Prefix Code:

rLocal Area Code

Mo Area Code Area Prefix
1

, L I
5 . NS
: A .
. I I
- I I
. I I
- I I

Update | mitialize(FE) | Close | Help

2) Select the information for the fields as described below:

CALLER ID CODE FIELDS

For this field... ENTER...

The (international) code you want the system to dial if/when dialing interna-
tional calls (e.g., if you dial the following international number: 44-1536-555-
1111, the "1536" portion of the numbers is the international prefix code - also
Inter. Prefix Code see Country Code below).

e The range is from 0 to 9999.
» The default is blank (none).

The code you want the system to dial (in addition to the international prefix,
as appropriate) iffiwhen dialing international calls (e.g., if you dial the following
international number: 44-1536-555-1111, the "44" portion is the country code
Country Code for the England - also see International Prefix Code above)).

e The range is from 0 to 9999.
» The default is blank (none).

The code you want the system to dial if/when dialing long distance calls. The
typical code is 1 (e.qg., if you dial
Long Dist Prefix Code 1-805-555-9999, the "1" is the long distance prefix)

* The range is from 0 to 9999.
» The default is blank (none).

The first (i.e., most commonly used) local area code of the customer’s site
(e.g., 310 if the customer is located in Los Angeles).

Area Code (1) * The range is from 0 to 999.

» The default is blank (none).

Call ID Code Fields (continued on next page)
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CALLER ID CODE FIELDS (continued)

Additional local area codes as appropriate. While many local calling areas
only include one area code, some local calling areas contain several (e.g., in
addition to 310, the Los Angeles area also includes area codes 213, 323,
Area Code (2-8) 562, and 818).

* The range is from 0 to 999.
» The default is blank (none).

The first (most commonly dialed) code you want the system to dial (if any)
when dialing local calls. Use this field when 10 digit dialing is required on
local calls (e.g., in the Los Angeles area, callers must use a 10 digit number
when calling within the 310 area code - meaning that each time they dial
Area Prefix (1) within the 310 area, they must include that area code as well as the individual
telephone number).

* The range is from 0 to 999.
» The default is blank (none).

Additional area prefixes as appropriate. Depending upon whether or not you
have entered more than one local area code (see Area Code 2-8 above), you
may need to add additional area prefixes if any of those area codes require
Area Prefix (2-8) 10 digit dialing.

* The range is from 0 to 999.
» The default is blank (none).

When you are finished:

3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

PROGRAMMING CALLER ID CODES AND LOCAL CALLING AREAS VIA THE DET
Refer to the table on page 265 for more information about each of the settings.

—3y NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
: Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Programming Caller ID Codes and Local Calling Areas via the DET (continued on next page)
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Programming Caller ID Codes and Local Calling Areas via the DET (continued)
PROGRAMMING THE CID CODES

Setting the International Code:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-26.
5) Press save to display the International Prefix screen.
6) Press show to display the current setting.
7) Press chg.

8) Enter the code you want the system to dial (if any) when dialing international calls.
e The range is from 0 to 9999.

e The default is NULL (none).
9) Press save to store the number.

10)Press next to display the Country Code screen (now go to step 6 in “Setting the Country Code:” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Country Code:

From the DB Item Select screen (see steps 1 through 3 on page 266):
4) Enter 03-27.
5) Press save to display the Country Code screen.
6) Press show to display the current setting.
7) Press chg.

8) Enter the code you want the system to dial (if any) when dialing international calls.
e The range is from 0 to 9999.

e The default is NULL (none).
9) Press save to store the number.

10)Press next to display the Long Distance Prefix screen (now go to step 6 in “Setting the Long Distance
Prefix:” below).

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Programming Caller ID Codes and Local Calling Areas via the DET (continued on next page)

- 267 -



BAsIiC CALL HANDLING PROGRAMMING TASKS DX-120 Programming Manual

Programming Caller ID Codes and Local Calling Areas via the DET (continued)

Setting the Long Distance Prefix:

From the DB Item Select screen (see steps 1 through 3 on page 266):

4) Enter 03-28.

5) Press save to display the Long Distance Prefix screen.
6) Press show to display the current setting.

7) Press chg.

8) Enter the code you want the system to dial (if any) when dialing long distance calls.
¢ The range is from 0 to 9999 (the typical code is 1).

¢ The default is NULL (none).
9) Press save to store the number.

10)Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

PROGRAM THE LOCAL AREA CODES AND PREFIXES
Local area code programming requires two entries:

The local area code

The digits required when 10 digit dialing is required on local calls (e.g., in the Los Angeles area, callers must
use a 10 digit number when calling within the 310 area code - meaning that each time they dial within the 310
area, they must include that area code as well as the individual telephone number).

=S NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

» Refer to the table on page 265 for more information about each of the settings.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-29.

5) Press save to advance to the Local Area Code and Prefix programming screens.

6) Press show to display the Area Code 1 screen (now go to step 6 in “Setting Local Area Codes:” below).
AND/OR

Press next to display the Area Prefix 1 screen (now go to step 6 in “Setting Local Area Prefixes:” on
page 270).

HINT

You can press next to continue to display consecutive screens for programming the
area codes and prefixes - see corresponding sections below for more information.

Programming Caller ID Codes and Local Calling Areas via the DET (continued on next page)
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Programming Caller ID Codes and Local Calling Areas via the DET (continued)

Setting Local Area Codes:

From the DB Item Select screen (see steps 1 through 3 above):

4) Enter 03-29-01 (for Local Area Code 1).
e To program other local area codes, see NOTE below.

$~ NOTE
.é To program other local area codes:
: Enter 03-29-03 (for Local Area Code 2).

e Enter 03-29-05 (for Local Area Code 3).
e Enter 03-29-07 (for Local Area Code 4).
e Enter 03-29-09 (for Local Area Code 5).
e Enter 03-29-11 (for Local Area Code 6).
e Enter 03-29-13 (for Local Area Code 7).
e Enter 03-29-15 (for Local Area Code 8).
Once you have entered the correct code as shown above, go to step 5.

5) Press show to display the corresponding area code table (i.e., 1 or 2).
6) Press chg.

7) Enter the actual local area code that will be received with CID from the local calling area for the
customer’s site.
e The range is from 0 to 999.

¢ The default is NULL (none).
8) Press save to store the number.
9) Press next to display the area prefix (now go to step 6 in “Setting Local Area Prefixes:” below).
OR

Press next twice to display the next area code.
* Repeat the steps shown in this section for each area code (and/or prefix) you want to program -
up to 8).

OR

Press the volume UP button to return to the DB Item Selection screen.
« If you choose to use this method, you can use the individual codes to program the area codes as shown
in the NOTE under step 4 on the previous page.

OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Caller ID Codes and Local Calling Areas via the DET (continued on next page)
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Programming Caller ID Codes and Local Calling Areas via the DET (continued)

Setting Local Area Prefixes:
Set this for any areas that require a 10 digit number for local calls.

From the DB Item Select screen (see steps 1 through 3 on page 268):

4) Enter 03-29-02 (for Local Area Prefix 1).
« To program other local area prefixes, see NOTE below.

=g NOTE
.é To program other local area prefixes:
* Enter 03-29-04 (for Local Area Prefix 2).

* Enter 03-29-06 (for Local Area Prefix 3).
e Enter 03-29-08 (for Local Area Prefix 4).
e Enter 03-29-10 (for Local Area Prefix 5).
e Enter 03-29-12 (for Local Area Prefix 6).
* Enter 03-29-14 (for Local Area Prefix 7).
o Enter 03-29-16 (for Local Area Prefix 8).
Once you have entered the correct code as shown above, go to step 5.

5) Press show to display the corresponding area code table (i.e., 1, 2, 3, etc.).
6) Press chg.

7) Enter the code you want the system to dial (usually the same digits as the area code) when dialing local
calls
« Use this field when 10 digit dialing is required on local calls.
¢ The range is from 0 to 999.

¢ The default is NULL (none).

—y NOTE
While many local calling areas only include one area code and prefix, some local
calling areas contain several. If you need to specify more than one local calling area
code and prefix, use the remaining area code/prefix fields to do so. If you do not need
multiple local area codes/prefixes, leave the remaining area code/prefix fields set to
NULL.

8) Press save to store the setting.

9) Press next to display the area code (now go to step 6 in “Setting Local Area Codes:” on page 269).
OR
Press next twice to display the next area prefix.

* Repeat the steps shown in this section for each area prefix (and/or code) you want to program -
up to 8).

OR

Press the volume UP button to return to the DB Item Selection screen.
« If you choose to use this method, you can use the individual codes to program the area prefixes as
shown in the NOTE under step 4 on the previous page.

OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Tenant GI’OUQS
Tenant Groups allow you to separate system resources so the DX-120 system can operate as two or three independent
systems deployed at a single site.

You can completely isolate extension functions depending on how you assign the tenant groups; i.e., you can prohibit
calling from one tenant group to another. However, extensions do not need to be isolated in order to isolate system
resources.

Tenant Grouping allows you to independently allocate resource directory numbers. The directory numbers for system
resources then interact only with the resources within the tenant group.

EXAMPLE

If you designate attendant extensions for each tenant group; these attendant
extensions act independently for the assigned tenant group. When a caller dials 0 to
reach the attendant, the system automatically calls the attendant extension you
designated for that group (attendant extension 2 for tenant group 2, etc.).

e The following conditions apply to setting up tenant groups:
- You can set up a maximum of three tenant groups in the DX-120 system.

- Extension directory numbers remain unique to system ports and are not duplicated for each tenant group
(although extension dialing may be restricted across tenant group barriers).

- When tenant calling is restricted from one tenant group to another tenant group, intercom calls, call transfers,
and recall operations will not operate across these designations.

$~ NOTE
] If you want intercom calls, call transfers, and recall operations to work across tenant
group barriers, do not set up separate tenant groups.

e Other features whose programming may be affected by how you assign tenant groups during call handling include
the following:

- CO Line - Tenant Group
- Extension - Tenant Group

e All tenant groups can be set up to allowed to dial intercom directory numbers of extensions in all other tenant
groups. (Range is Y/N for each calling direction between tenant groups.)

HINT
Q Also see...
e “Setting the CO Line Type” on page 126.
» “Assigning Ring Type for the CO Line” on page 134.

e “Setting the Answer Position for Day and Evening” on page 136.

Programming Tenant Groups (continued on next page)
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Programming Tenant Groups (continued)

PROGRAMMING TENANT GROUPS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Call Handling
Syskem Resource
Restriction

.3
3
13
Extension Application »
C.0, Line Application r
Syskem Application r
Feature Key Programming *

K5U DE Password

Extension
C.0, Line =

Feature Control
Timing

CID Programming Code

DISA
Auko Attendant
Tenant Calling

1) Go to Programming Call Handling® Tenant Calling to display the Call Handling—Tenant Calling screen.

]
‘ FROM/TO ‘ Tenant1 Tenant2 Tenant3
Tenant1 V1 v 2 v 3
Tenant2 V1 V2 v 3
Tenant3 V1 v 2 3
Update Initialize(Fa) | Close | Help |

=3 NOTE
The system assumes that intercom calls will be allowed within a tenant group (e. g.,
® From Tenant 1/To Tenant 1). Thus, these entries are checked, but grayed out. They

cannot be changed.

2) Click the checkbox(es) (I ) that correspond to the tenant groups combinations for which you want to

allow () or disallow (") intercom calls.

« Clicking on this box toggles the setting between yes/allow (a checkmark ™ ) and no/disallow (no

checkmark 7).

+ The default for all boxes is yes/allow (checkmark ¥ ).
* Remember to allow intercom calls in BOTH directions between tenant groups, you must check BOTH
corresponding settings (i.e., the to and the from for each - see example below).

EXAMPLE

To allow intercom calls between groups 1 and 2, click the second item in the first
column (From Tenant 2/To Tenant 1) and the first item in the second column (From

Tenant 1/To Tenant 2). Both should have check marks if you wish to allow
intercom calls in both directions between the groups.

Programming Tenant Groups via PC-DBA (continued on next page)
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Programming Tenant Groups via PC-DBA (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

PROGRAMMING TENANT GROUPS VIA THE DET

Qh-\'- NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-30.

5) Press save to display the Tenant Calling screen.

6) Press show.

7) Enter the tenant group that you want to program.

8) Press show to display the status of this tenant group.
e The default is yes (Y).

9) Press chg to select no (N) if you want to deny calling to this tenant group.
OR
Press next to skip to the next the tenant group.
10) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up SMDR Call Output

This feature allows the system administrator to track all incoming and outgoing CO line traffic, chronologically by
extension number. The system outputs account code data for each call record.

The system outputs SMDR from the standard “SMDR” RS232 serial port located on the Central Projcessor Module
(CPM). You can connect an external serial printer or call accounting device for perjmanent record keeping or call cost
accounting. The system outputs each data record within the standard 80-character frame. Data communications occur
in one direction only through the SMDR port; you can program the baud rate during system programming
(see“Selecting SMDR Transmit Rate” on page 97).

e SMDR information includes the following:
- call direction, or a comment for special call handling record
- extension number
- COline used
- number dialed
- ring time to answer
- time and date the call was placed
- duration of the call
- account code (if specified)

e The system also provides ring-in duration and call processing information relative to the call as it was handled by
the system.

= The system outputs two records for incoming calls that are received with Caller ID (although this feature is a
standard feature of the DX-120, a telephone company subscription is required).

- The first record lists the telephone number of the calling party as it is received from the telephone company.
(Calls from CID blocked numbers will not have a CID number associated with that record.)

- The second record will show the caller’'s name (“OUT OF AREA” or “PRIVATE” may appear in this field if the
calling party number is unavailable).

HINT
@ After you have set up SMDR, be sure to assign SMDR to individual extensions as
needed (see “Programming Extensions for SMDR Output” on page 427).

Setting Up SMDR Call Output (continued on next page)
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Setting Up SMDR Call Output (continued)

EXAMPLE
The following is an example of an SMDR report. In this example, the two “I” records are one incoming
call record received with caller ID.

5] L -4 | 4 5 & 7

123458TRAS0 12451010 S4TER0 12 4SETES0IZIASETRR0LZIASETEASOLIZIAS6TEMIZI4567290
D EXT TRE D&ET LIALED RING DATE TIHE DURATION ACOOUNT

EXY XXX XXXEX. . .XXEEX MM 8= T¥SEIX HMoHM: 3F HH:MM:; 38 I¥IXXTXX

2 101 80l 3035551212 00200 DL1/01 QLl:05:52 DO:00:35

I 1037 BOD 4BOZZZ4AS545 00:13 DLsO1 OL:07:51 OO0:00:3F

I 103 BO0 JOHNBOHN LARRY O0:13 01701 D1:07:51 00:00:3%9

@ 101 201 JI0ISFSIZTIZ 0D:00 DISOL D1:13:52 0O0:00:15 12545678

Column Headings in the Report
The system generates a carriage return (CR) after each record output.

HEADING DEFINITION

D Call Direction

in this first position you may also see...

| Incoming

(0] Outgoing

A Operator transferred call

H Recalled trunk call

L Conference call
EXT Extension number/Incoming DISA CO line number/Incoming ECF CO line number
TRK CO line directory number

DGT_DIALED Telephone number (outgoing call only, maximum 16 digits, left aligned)

RING CO line incoming ringing duration before answer (incoming call only)
DATE Day/Month (DD/MM)
TIME Start time of call connection

MM Minute

HH Hour

SS Second

DURATION Length of the call

ACCOUNT Account code entered for billing purposes (maximum 8 digits, left aligned)

Setting Up SMDR Call Output (continued on next page)
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Setting Up SMDR Call Output (continued)

e The system generates a carriage return (CR) after each record output.

e After you have set up SMDR, be sure to assign SMDR to individual extensions as needed (see “Programming
Extensions for SMDR Output” on page 427).

HINT

\’f

See “Selecting SMDR Transmit Rate” on page 97.

SETTING Up SMDR CALL OUTPUT VIA PC-DBA

From the PC-DBA main screen:

Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

Programming Maintenance  Help

Extension
C.0, Line
Call Handling 13

]

Timing

CID Programming Code
DISA

Auko Akkendant

Tenant Calling

1) Go to ProgrammingP> Call HandlingP>Feature Control to display the Call Handling—Feature Control

screen.

=i

RP :Call Handling - Feature Control _
Co Line Conference: Wl Reserve Port: |D vl

[~ Hotel Enable

I Sys SFPD. Toll Check
V¥ TSl Connect Enable
¥ Conference Tone
¥ Daylight Saving Time

SMDR Call Output

[~ Incoming Call
¥ Outgoing Call
¥ Account Code
v Call Start

Update InitializedF &)

Close Help

Setting Up SMDR Call Output via PC-DBA (continued on next page)
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Setting Up SMDR Call Output via PC-DBA (continued)

In the SMDR Call Output area:

—SMDR Call Output
[ Incaming Call
¥ Outgoing Call
¥ Account Code
v Call Start

2) Set options described below:

means INEERS
Incoming call information will not appear on
Incoming Call | SMDR will include incoming calls the SMDR.
This is the default (i.e., no checkmark).
. SMDR will include outgoing calls. Outgoing call information will not appear on
QOutgoing Call o )
« This is the default (i.e., checkmark). the SMDR.
If account codes are used, they will be . . .
Account included in the SMDR. Account Code information will not appear on
Code o . the SMDR.
« This is the default (i.e., checkmark).
The SMDR will include data from an Incoming call information ONLY appears once
incoming call AFTER the ring absorb acallis ans_wered, trans_ferreq, o_r if the caller
Call Start time hangs up (i.e., when this option is
) ) unchecked, calls will only appear on the
» The default is yes (i.e., check mark). SMDR after the call has ended).

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Up SMDR Call Output (continued on next page)
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Setting Up SMDR Call Output (continued)

SETTING UP SMDR CALL OUTPUT VIA THE DET
See table on page 277 for more information about each setting.

=S NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Specifying the SMDR Call Output for Outgoing Calls:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-31-01.
5) Press save to display the SMDR Output selection screen for Outgoing Calls.

6) Press chg to specify whether or not you want to record for outgoing calls in the SMDR.
« Valid choices are Y (yes) or N (no).

e The default is Y (yes) - include outgoing calls.

7) Press next to display the Output selection screen for Incoming calls.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Specifying the SMDR Call Output for Incoming Calls:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-31-02.
5) Press save to advance to the SMDR Output selection screen for Incoming Calls.

6) Press chg to specify whether or not you want to record incoming calls in the SMDR.
« Valid choices are Y (yes) or N (no).

¢ The defaultis N (No) - do NOT include incoming calls.

7) Press next to display the Output selection screen for Account Codes.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up SMDR Call Output via the DET (continued on next page)
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Setting Up SMDR Call Output via the DET (continued)

Specifying the SMDR Call Output for Account Codes:

From the DB Item Select screen (see steps 1 through 3 on page 278):
4) Enter 03-31-03.
5) Press save to display the SMDR Output screen for Account Codes.

6) Press chg to specify if you want the account code to appear in the SMDR field.
« Valid choices are Y (yes) or N (no).

e The defaultis Y (yes) - include account codes.

7) Press next to display the Output selection screen for Call Start.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Specifying the SMDR Call Output for Call Start:

From the DB Item Select screen (see steps 1 through 3 on page 278):
4) Enter 03-31-04.
5) Press save to display the SMDR Output screen for Call Start.

6) Press chg to specify if you want the account code to appear in the SMDR field.
¢ Valid choices are Y (yes) or N (no).

e The default is Y (yes) - include Call Start information.

7) Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming the (CIL) Call Information Log serial port baud rate (CIL X RATE)

From the DB Item Select screen (see steps 1 through 3 on page 278):
4) Enter 04-17.
5) Press save to display the SMDR CIL port transmission rate setting.

6) Press chg until the appropriate baud rate appears.
 Valid options are 1200, 2400, 4800, 9600, and 19200.

¢ The default is 9600.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Fax Ring Time

The DX-120 allows you to specify how many seconds you want it to ring a fax line before dropping the call.

SETTING FAX RING TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec. PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min. Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vI Min Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl —External Gy
Attempts: |2 | Times Break Time: |gn | me. Sohi
: — == BRICED | Always b
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Fax Ring Time field in the center of the screen:

Fax Ring Time: |1 0

Hold Ahandon
Hold Reminder:

ce Talk Time:

2) Select the length of time (in seconds) that you want the system to ring a fax line before dropping the call.
 Valid options are 10, 20, 30, 40, 50, and 60.

¢ The default is 10 seconds.

Setting Fax Ring Time via PC-DBA (continued on next page)
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Setting Fax Ring Time via PC-DBA (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING FAX RING TIME VIA THE DET

Qh-\'- NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-37.

5) Press save to advance to the Fax Ring Time field.

6) Press chg until you see the number of seconds you want the system to ring a fax line before dropping the
call.
 Valid options are 10, 20, 30, 40, 50, and 60.

* The default is 10 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting Predefined Call Forward Time

The system uses the Predefined Call Forward setting to determine how long to ring a directory number before
classifying the call as “unanswered.” Once the system classifies the call as unanswered, it can process the call
according to the programming associated with an answered call.

EXAMPLE
You can set up an extension or CO line to transfer unanswered calls to the attendant
extension, a departmental secretary, another department, etc.

Q’__\‘ NOTE
.é * If you want to forward unanswered calls for all calls coming in on a CO line, set that
up during CO line programming.
e If you want to forward unanswered calls for all calls coming in to a particular
extension, set that up during extension programming.

¢ The Predefined Call Forward time affects how the CO line and extension are
programmed.

HINT
@ Also see...

e “Setting the Pre-Defined Call Forward No Answer” on page 144.
e “Programming Extensions for SMDR Output” on page 427.

SETTING PREDEFINED CALL FORWARD TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control

CID Program%g Code

DISA

Call Handling
Syskem Resource
Restriction

Extension Application
C.0, Line Application Auto Attendant
System Application Tenant Calling

Feature Key Programming
K5U DE Password

* v v v v vl

Setting Predefined Call Forward Time via PC-DBA (continued on next page)
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Setting Predefined Call Forward via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fause Time. |2.0 'I Sec M Monitor Time: |1D 'I Sec
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Predefined Forward Time field in the center of the screen:

Fredefined Forward Time: |1D Sec.
12 o=t
14

EElEEe 16 hd I

2) Select the length of time you want to allow before the system classifies the call as “unanswered.”
 Valid options are from 6 to 30 seconds, in 2 second increments (6,8,10,12, etc.)

* The default is 10 seconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Predefined Call Forward Time (continued on next page)
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Setting Predefined Call Forward (continued)

SETTING PREDEFINED CALL FORWARD TIME VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-40.

5) Press save to advance to the Predefined FWD Time field.

6) Press chg until you see the number of seconds you want to allow before the system classifies the call as
“unanswered.”
 Valid options are from 6 to 30 seconds, in 2 second increments (2,4,6,8,10, etc.)

e The default is 10 seconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting Ring On Recognition Time Interval

The DX-120 allows you to control the length of time (in milliseconds) that ring voltage needs to be present on a line for
the system to classify it as valid ringing.

SETTING RING ON RECOGNITION TIME INTERVAL VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vI Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Atternpts: |2 ¥ | Times Break Time: |g0 | ms. S
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close | Help |

In the Ring On Recognition field in the top right side of the screen:

Ring On Recognition Time: |1DD ms
Ring Ahandaon; Sec,

Talk Abandon Time: ms

Ll i e Tollo T hdis

2) Select the minimum length of ring time you want the system to recognize.
« Valid options are between 50 and 1500 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).
e The default is 100 milliseconds.

Setting Ring On Recognition Time Interval via PC-DBA (continued on next page)
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Setting Ring On Recognition Time Interval via PC-DBA (continued)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING RING ON RECOGNITION TIME INTERVAL VIA THE DET

Qh-\'- NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-41.

5) Press save to advance to the Ring on Recognition screen.

6) Specify the minimum number of milliseconds of ring time you want the system to recognize.
 Valid options are between 50 and 1500 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).

e The default is 100 milliseconds.
7) Press save to store the setting.
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting the Daylight Savings Time Feature

The Daylight Saving Time feature allows you to instruct the DX-120 to automatically switch the system clock to coincide
with Daylight Savings Time changes. When enabled, the DX-120 automatically changes the system time at the start
and end of the Daylight Saving Time period (i.e., the spring and fall). When turned off, the system does not make a
time change to correspond to Daylight Savings Time.

NOTE
The DX-120 uses information provided by Astronomical Application Department of
U.S. Naval Observatory to determine when to make these time changes.

SETTING THE DAYLIGHT SAVINGS TIME FEATURE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line =
Cal Handing m

Syskem Resource Timing
Restriction

13

3

» CID Programming Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #

Sl Password _

1) Go to ProgrammingP>Call HandlingP>Feature Control to display the Call Handling—Feature Control
screen.

RP :Call Handling - Feature Control 1 ll
| WM Resere Port: |D vl

SMDR Call Output

Co Line Conference: [N

[~ Hotel Enable
[~ Sys SFPD. Toll Check
V¥ TSl Connect Enable

[~ Incoming Call
¥ Outgoing Call

¥ Conference Tone I Account Code
v Daylight Saving Time ¥ Call Start
Update | InitializedF &) | Close | Help |

2) Click the checkbox (I ) next to Daylight Savings Time to place a check mark there to enable the Daylight
Savings Time (¥ ).
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

« The default is off (no check mark I")).
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting the Daylight Savings Time Feature (continued on next page)
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Setting the Daylight Savings Time Feature (continued)

SETTING THE DAYLIGHT SAVINGS TIME FEATURE VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
y Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-49.

5) Press save to display the Daylight Savings Time screen.

6) Press chg to specify whether or not you want to enable the Daylight Savings Time schedule.
« Valid choices are Y (yes) or N (no).

e The defaultis N (N) - do NOT use Daylight Savings.
7) Press save to store the setting.
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting Talk Abandon Time Interval

Talk abandon occurs when the system experiences a drop of loop current for longer than a specified length of time,
while the call is active (talk time). If this time period expires, and the drop of CO loop current is still present, the system

abandons the call and drops the CO line. The DX-120 allows you to control how long the system waits before
abandoning the call.

SETTING TALK ABANDON TIME INTERVAL VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
3

Feature Key Programming
K5U DE Password

1) Go to ProgrammingP>Call HandlingP Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing _ ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'I Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 =|ms Incorming CaII:|5 vl Min.
Update InitializedF &) Close Help |

Setting Talk Abandon Time Interval via PC-DBA (continued on next page)
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Setting Talk Abandon Time Interval via PC-DBA (continued)

In the Talk Abandon Time field in the top right side of the screen:

Talk Abandon Time: Iﬁﬂﬂ

Lipervised Talk Time:
Wit Monitor Time:
#FR_B Recall:

2) Select the length of time that you want the system to wait before abandoning an active call ifiwhen it
detects a drop in loop current.
« Valid options are between 50 and 1000 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).

¢ The default is 600 milliseconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING TALK ABANDON TIME INTERVAL VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-42.

5) Press save to display the Talk Abandon Time screen.

6) Specify the number of milliseconds you want the system to wait when detecting a drop in loop current
before abandoning an active call.
« Valid options are between 50 and 1500 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).
e The default is 600 milliseconds.

7) Press save to store the setting.
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting Hold Abandon Time Interval

Hold abandon occurs when the system experiences a drop of loop current for longer than a specified length of time
while the call is on hold; the system abandons the held call and drops the CO line. The DX-120 allows you to control
how long the system waits before abandoning the call.

Each CO line has a programming option that directs the system to monitor distant party disconnect. This is a useful
network feature in busy office environments where the inside party accidentally presses the Hold, ICM, or DSS button
while expecting the outside line conversation to be concluded.

= Any time the system detects a disconnect signal from the Central Office, it releases an existing hold condition,
freeing that line for future inbound/outbound traffic.

= All types of hold (e.qg., system hold, exclusive hold, and conference hold) are subject to the Hold Abandon feature.
e Certain Central Offices do not provide loop supervision; these line should be programmed Call Abandon = “N.”

« At default call abandon is enabled for all CO lines.

e If the outside (held party) disconnects, the system automatically releases the held CO line.

e The CO line must have the loop supervision interrupt signal from the local carrier for Hold Abandon to function.

SETTING HOLD ABANDON TIME INTERVAL VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension |
.0, Line I

Call Handling

Syskem Resource
Restriction

Extension Application
C.0, Line Application
System Application

Feature Control t

CID Program%g Code

DISA
Auko Akkendant

Tenant Calling
Feature Key Programming

Sl Password _

* v v v v vl

Setting Hold Abandon Time Interval via PC-DBA (continued on next page)

- 291 -



BAsIiC CALL HANDLING PROGRAMMING TASKS DX-120 Programming Manual

Setting Hold Abandon Time Interval via PC-DBA (continued)

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

RP:Call Handling-Timing x|
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'I Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time: 1.0 x| Sec. Hald Ahandon BO0 | ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | i
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fause Time. |2.0 'I Sec. M Monitor Time: |1D 'I Sec
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vI Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— - Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio———— —Warning Time —————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update | InitializedF &) | Close Help |

In the Hold Abandon field at the top center of the screen:

Hold Ahandon
Hold Reminder:
ce Talk Time:

Fause Time:

2) Select the length of time that you want the system to wait before abandoning a call on hold after detecting
a drop in loop current.

« Valid options are between 50 and 1000 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).
¢ The default is 600 milliseconds.
When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting Hold Abandon Time Interval (continued on next page)
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Setting Hold Abandon Time Interval (continued)

SETTING HOLD ABANDON TIME INTERVAL VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-43.

5) Press save to display the Hold Abandon Time field.

6) Press chg until you see the number of milliseconds you want the system to wait when detecting a drop in
loop current before abandoning a call on hold.
« Valid options are between 50 and 1000 milliseconds, in intervals of 50 (50, 100, 150, 200, etc.).

e The default is 600 milliseconds.
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Setting Unsupervised Talk Time
The DX-120 allows you to specify how long you want to allow unsupervised talk time to continue before the system
drops the call. This setting applies to conference calls.

HINT

Also see...

e “Programming Conference Calls” on page 189.

e “Setting Talk Abandon Time Interval” on page 289.

SETTING UNSUPERVISED TALK TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line

Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #
K5U DE Password _

1) Go to ProgrammingP>Call Handling® Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec. PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | i | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min. Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'l Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CF
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
T [10 = |Min. Start (200  +|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update InitializedF &) Close Help |

Setting Unsupervised Talk Time via PC-DBA (continued on next page)
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Setting Unsupervised Talk Time via PC-DBA (continued)

In the Unsupervised Talk Time field in the top right side of the screen:

Unzupervized Talk Time:
Wi Monitor Time:
#FR_B Recall:

HFR_I Recall:

2) Select the length of time that you want to allow for conference calls before callers are disconnected.

3) Valid options are between 0 and 120 minutes, in intervals of 10 (10, 20, 30, 40, etc.).
* The default is 0 minutes which means unlimited unsupervised conference calls.

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UNSUPERVISED TALK TIME VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.
4) Enter 03-39.

5) Press save.

6) Press chg until you see the number of seconds you want to allow in conference calls before the system
drops the callers.
 Valid options are 0 to 120 minutes.

e The default is O (i.e., unlimited unsupervised conference calls).
7) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.
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Specifving CO Line Guard Time
The CO Line Guard time allows you to define a time period after a CO line disconnect, during which the line cannot be

used for an outgoing call. Incoming CO line calls are accepted and processed normally. During the Guard Time
period, the system lights the affected CO line key red, and no extensions can access that line.

; HINT
Q Also see “Section 5 - Programming Lines” on page 83
SPECIFYING CO LINE GUARD TIME VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line

Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #
K5U DE Password _

1) Go to ProgrammingP>Call HandlingP Timing to display the Call Handling—Timing screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec L IV | o720 Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | i | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec M Monitor Time: |1D 'l Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirme: |3 vl Min. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
~ — = BIVICE. | Alwyays g
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 i) TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash Wi Dialing Ratio —Warning Time ——————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 =|ms Incorming CaII:|5 vl Min.
Update InitializedF &) Close Help |

Specifying CO Line Guard Time via PC-DBA (continued on next page)
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Specifying CO Line Guard Time via PC-DBA (continued)

In the CO Line Guard field in the first column:

CO Line Guard Time:
CO Flash :

CID Ring Time:

Dial Wait Time:

2) Select the CO line guard timing you want to use.
« Valid options are between 1 and 10 seconds, in half-second intervals
(1, 1.5, 2, 2.5, etc.).

¢ The default is 1 second.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SPECIFYING CO LINE GUARD TIME VIA THE DET

= NOTE
.g ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-48.

5) Press save to display the CO Line Guard Time programming screen.

6) Press chg until CO line guard timing you want to use appears.
« Valid options are between 1 and 10 seconds, in half-second intervals
(1, 15,2, 25, etc.).
e The default is 1 second.

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Auto Attendant Module (AAM)

=S NOTE . . . .
The AAM is optional and must be present in order to program the feature for use in the system. If you
are not sure that the Automated Attendant Module (AAM) has been included in the current system,
please contact Vertical Technical Support for more information.

e The DX-120 Auto Attendant option can greatly enhance business office productivity by providing a full-duty
"Automated Attendant" to handle all incoming system calls. It can also provide a part-duty automated attendant
to handle:

- overflow traffic only when the primary attendant cannot handle calls, or
- after hours calls when the primary attendant position may not be staffed.

= The AAM is installed inside of KSU1, and provides a maximum of 120 seconds of programmable voice
announcements.

e The AAM provides four ports to handle four simultaneous callers. The AA voice announcements include:
- Day, Evening, Noon, and Alternate greeting messages
- Waiting, Invalid, Busy, No Answer, Good-Bye, and Inquiry prompts/instructions

e You set up the maximum recording time for each greeting/message and the actual recording for each voice
announcement using the Attendant Administration feature.

e Proper setup of the automated attendant requires some planning before you program. It is essential to successful
automated attendant operation that you adequately plan announcements and their required results.

= When programming and setting up messages for the AAM, consider the following:
- What are the extension numbers that should be listed in the greeting, if any?
- Should any UCD group directory numbers be announced (e.g., dial 410 for Sales)?

- Will you be using the “inquiry” message? (The Inquiry code may be dialed during the DAY, ALT, or EVE
greetings to provide a recorded announcement to the caller, for example, directions to the office: “To get
recorded directions to our office, press the star key. Otherwise, stay on the line and we’ll be with you soon.”)

- Do you want to advise callers of the “waiting code”? (Callers can dial the waiting code when the called party’s
extension is busy. When callers hear the busy message they may dial the waiting code to wait a specified
number of seconds and then try the extension again.)

- What do you want each message/greeting to say, specifically? Write down the content of each message/
greeting.

NOTE

Automatic CO Line Ringing time settings must be programmed in Time Switching,
and completely set for a seven day week, for Automatic CO Line Ringing Modes to
properly follow an automatic switching schedule. For details on programming time
switching, see “Setting CO Line Time Switching” on page 140.

e Other features that may affect the Auto Attendant include DISA (Direct Inward System Access) and Time
Switching.

HINT
Q See “Setting the Answer Position for Day and Evening” on page 136.

Programming Automated Attendant (continued on page)
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Programming Automated Attendant (continued)

SAMPLE AUTOMATED ATTENDANT MESSAGES

The following provides several samples automated attendant messages.

SAMPLE AUTOMATED ATTENDANT MESSAGES

Definition

Example

DAY GREETING

This is the greeting the callers hear when they are
answered while the system is in DAY mode of oper-
ation.

“Hello, this is xyz company. If you know
your party’s extension number, dial it
now. Or, dial zero for the system atten-
dant. For sales, dial 4 1 0. To hear direc-
tions to our office, press the star key.”
Otherwise stay on the line, we will be
with you shortly.”

ALT GREETING

This is the greeting that callers hear when they are
answered while the system is in ALTernate mode of
operation.

“Hello, this is xyz company. We are
closed today due to inclement weather
conditions. Thank you for calling.”

EVE GREETING

This is the greeting that callers hear when they are
answered while the system is in EVEning mode of
operation.

“Hello, this is xyz company. You have
reached us after our regular business
hours. If you know your party’s extension
number, dial it now. To hear directions to
our office, press the star key. Thank you
for calling.”

This is the message that callers hear after their call

planned events.

WAITING MSG. "Your call is being transferred.”
has been processed.
This is the message that callers hear when they “We're sorrv that is not a valid extension
INVALID MSG have dialed a number that is not defined in the DX- y "
. on our system.
120 system directory.
“We're sorry, that extension is currently
This is the message that callers hear when they busy. To wait for this extension, press the
BUSY MSG . . . . )
have dialed an extension number that is busy. pound key, or dial another extension
now.”
This is the message that callers hear when the N
. Your party does not answer, please
extension they entered does not answer the call. . .
NO_ANS MSG ) : enter another extension number or dial O
Another extension request may be made at this "
. for the system attendant.
time.
This is the message that callers hear when the DX-
120 system is about to disconnect them. This . N
BYE MSG occurs when the caller dials nothing after the sys- Goodbye.
tem plays a busy message or no-answer message.
o . . Directions to the office... “From SR101,
This is a special message that can provide callers take the Via deVentura exit - West. two
INQUIRY MSG \t/)vr[r;1 |Iri1\jgrmea;tslg: without ever having to be handled blocks to Hayden - North, to 14645 N.
y P ' Hayden Road”
TEMP MSG This is a message that can be used to announce Our offices are closed in observance of

the holiday.”

Programming Automated Attendant (continued on page)
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Programming Automated Attendant (continued)

PROGRAMMING AUTO ATTENDANT MODULE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

e

Feature Control

Timing

CID Programming Code
DISA

Tenant Calling [ g

1) Go to ProgrammingP> Call HandlingPAuto Attendant to display the Call Handling—Auto Attendant

screen.
[29: Coll Handing-Auto Attendant |
Ring Time To Answer: |_L Sec. Waiting Code: |# =]
Mo Answer Time: |20 ~| Sec. Inquiry Code: |* =]
#FR Mode: |RET ~| DISA Code: |9 =]
Drop Mo Dial ™
Mo DIR#: |1:BDD vl
Service: |Never vl Auto Att Line ™
—Answering Position
Tenant1 Tehant? Tenant3 |
oy [ior 5 | o | =l
a | o 5 e -l
=0 | — N —
Update | Initialize(FB)l Clase | Help |

Programming Automated Attendant via PC-DBA (continued on page)
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Programming Automated Attendant via PC-DBA (continued)

2) Select the information for the fields as described below.

AUTOMATED ATTENDANT FIELDS

FOR THIS FIELD... SELECT...

The length of time that the system plays a ring-back tone to callers

before the AA answers the line.

Ring Time to Answer « Valid options are from 0 to 20 seconds, in increments of 1 second.

¢ The default is 0.

The length of time that a call rings the AA (when all auto attendant
ports are in use and unavailable to handle the call) before the sys-
tem considers the call unanswered. Once a call is recognized by
No Answer Time the system as unanswered, it routes the call to the designated
answer position.

« Valid times are 10-90 seconds, in 10 second increments.
¢ The default is 20 seconds.

Yes (¥) to tell the system to automatically drop callers if they do
not make a selection or dial a valid extension directory number.
OR

Drop No Dial ]
No ( & ) to tell the system to (NOT drop callers and) automatically

route callers to the designated answering position if they do not
make a selection or dial a valid extension directory number.

¢ The default is no.

The mode, (i.e., RBT: ring-back tone or MOH: music on hold) used
by the system when processing calls after callers have made a
selection and are being routed in the system.

» The default is ring-back tone.

XFR Mode

A key callers can press when waiting for a busy extension. Such an

option allows them to wait for a busy extension, and automatically

try that extension again after 10 seconds by pressing a certain key

Waiting Code on their phone pad.

« Valid options are 0-9, *, #, or None (i.e., callers don't get the option
to wait). See IMPORTANT! note below.

* The default is #.

A key that callers can press to hear a general announcement (e.g.,
press 2 to hear company hours)

Inquiry Code « Valid options are 0-9, *, #, or None (i.e., callers don't get the option
to hear an announcement). See IMPORTANT! note below.

* The default is *.

IMPORTANT!

The system will not allow you to assign the same digit to more than one
function. Therefore, determine what digits you want to use for the inquiry
code and DISA code when assigning the waiting code.

AAM Fields (continued on next page)
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AUTOMATED ATTENDANT FIELDS (continued)

FOR THIS FIELD... SELECT...

A key callers can use to access to any DX-120 system resource
(e.g., extensions, CO lines, etc.).

DISA Code « Valid options are 0-9, *, #, or None (i.e., callers don't get the option
to access resources). See IMPORTANT! note below.

* The default is 9.

The desired directory number (e.g., 3:802) for which you want to set

No DIR# Automated Attendant settings.

Yes (¥ ) if you want the automated attendant to answer this CO
line.

OR
Auto Att Line*

No ( I~ ) if you do not want the AA to answer this CO line, make
sure the box is blank.

« The default is no (blank).

The time during which you want the AA to answer this CO line.
« Valid options are Always, Never, Day, and Eve.
* The default is Never.

—) NOTE
Service* « If you set the Auto Att Line field to N, the system does not
use AA for this CO line regardless of what you enter in
the Service field.

« Similarly, if you turn on AA for a CO line but set the
service to Never, the system does not use AA for that CO
line.

The daytime answer position you want to use for each tenant group
(1 to 3). This answer position is the DX-120 system directory num-
ber (extension, UCD group, or virtual number) to which you want the
Day system to route callers when they cannot be routed automatically.

« Acceptable entries include any valid directory number.

* The default is extension 101.

* Use this method when assigning other CO line directory numbers to the AA.

IMPORTANT!

The system will not allow you to assign the same digit to more than one
function. Therefore, determine what digits you want to use for the inquiry
code and DISA code when assigning the waiting code.

AAM Fields (continued on next page)
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AUTOMATED ATTENDANT FIELDS (continued)

FOR THIS FIELD... SELECT...

The alternate answer position you want to use for each tenant group
(1 to 3). This answer position is the DX-120 system directory num-
ber (extension, UCD group, or virtual number) to which you want the
Alt system to route callers when they cannot be routed automatically.

« Acceptable entries include any valid directory number.

¢ The default is extension 101.

The evening answer position you want to use for each tenant group
(1 to 3). This answer position is the DX-120 system directory num-
ber (extension, UCD group, or virtual number) to which you want the
Eve system to route callers when they cannot be routed automatically.

» Acceptable entries include any valid directory number.

¢ The default is extension 101.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

PROGRAMMING AUTO ATTENDANT MODULE VIA THE DET
See Field Descriptions on page 302 for more information about the settings via the DET.

=3 NOTE

.é e chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 03-46 (see information in the following sections for making Automated Attendant settings - see table
on page 302 for details about each of these settings.).

5) Press next to go on to other AAM programming screens.
OR
Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Setting Ring Time to Answer:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-46-01.
5) Press save to display first Auto Attendant screen: Ring Time To Answer.
6) Press chg.

7) Enter the number of seconds that a caller will hear ring-back before the line is answered by the auto
attendant.
 Valid options are from 0 to 20 seconds, in increments of 1 second.

* The default is 0.
8) Press save to store the setting.

9) Press next to display the Ring No Answer screen (now go to step 6 in “Setting Ring Time No Answer:”
below).

OR
Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Ring Time No Answer:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-02.
5) Press save to display the Ring Time No Answer screen.

6) Press chg until you see the length of time that a call rings the auto attendant (with no answer) before the
system routes it to the designated Answer Position (i.e., if all auto attendant ports are in use and
unavailable to handle the call).
 Valid times are 10-90 seconds, in 10 second increments.

e The default is 20 seconds.
7) Press save to store the setting.

8) Press next to display the Drop No Extension # Dialed screen (now go to step 6 in “Setting the Drop No
Extension # Dialed option:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Setting the Drop No Extension # Dialed option:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-03.
5) Press save to display the Drop No Extension # Dialed screen.

6) Press chg to select whether or not you want the system to automatically drop callers if they do not make
a selection or dial a valid extension directory number (Y/N).
* When set to no, the system automatically routes callers to the designated answering position if they do
not make a selection or dial a valid extension directory number.

e The default is no.
7) Press save to store the setting.

8) Press next to display the XFR (Transfer) Mode screen (now go to step 6 in “Setting the XFR (Transfer)
Mode:” below).

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting the XFR (Transfer) Mode:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-04.
5) Press save to display the XFR (Transfer) Mode screen.

6) Press chg to choose either Ring-Back Tone (RBT) or Music On Hold (MOH).
e This is the call processing that is provided to callers after they have made a selection and are being
routed in the system.

« The default is ring back tone.
7) Press save to store the setting.

8) Press next to display the Waiting Code screen (now go to step 6 in “Programming the Waiting Code:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Proaramming the Waiting Code:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-05.
5) Press save to display the Waiting Code screen.

6) Press chg.

7) Enter the new Waiting Code digit (see IMPORTANT! note on page 311).
¢ The waiting code gives callers the option to wait for a busy extension and try that extension again after

10 seconds.
« The code may be any dial pad single-digit from 0-9, *, or #.
* The default is #.
8) Press save to store the setting.
9) Press next to display the Inquiry Code field (now go to step 6 in “Programming the Inquiry Code:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Proaramming the Inquiry Code:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-06.
5) Press save to display the Inquiry Code screen.

6) Press chg.

7) Enter the new Inquiry Code digit (see IMPORTANT! note on page 311).
¢ Use the inquiry code to provide callers the option to hear a general announcement (company hours,

directions to the office, etc.).
¢ The code may be any dial pad single-digit from 0-9, *, or #.
e The default is *.
8) Press save to store the setting.
9) Press next to display the DISA Code screen (now go to step 6 in “Programming the DISA Code:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Programming the DISA Code:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-07.
5) Press save to display the DISA Code screen.

6) Press chg.

7) Enter the new DISA Code digit (see IMPORTANT! note on page 311).
« Use the DISA code to provide a caller access to any system resource (e.g., extensions, CO lines, etc.).

« The code may be any dial pad single-digit from 0-9, *, or #.
* The default is 9.

8) Press save to store the setting.

9) Press next to display the Answer Position screen (now go to step 6 in “Selecting the Answering Position:”
below).

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Selecting the Answering Position;

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-08.
5) Press save to display the Answering Position screen.

6) Press show to display the Tenant screen.
« Since answering positions may be assigned as unique destinations per tenant group, the system
requires you to enter the tenant group now.

7) Enter the tenant group (1~3) for which you want to make programming changes.
8) Press show to store the setting.

9) Press next to display the Current Day Mode - Answer Position for the tenant group you specified above
(now go to step 6 in “Setting the Current Day Mode - Answer Position:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)

- 307 -



BAsIiC CALL HANDLING PROGRAMMING TASKS DX-120 Programming Manual

Programming Automated Attendant via the DET (continued)
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Setting the Current Day Mode - Answer Position:

From the DB Item Select screen (see steps 1 through 3 on page 303):

4) Enter 03-46-08-XX-01 (where XX represents the tenant group for which you want to set
the Day Mode: 1~3).

5) Press save to display the current Day Mode screen.
6) Press chg.

7) Enter the appropriate directory number (extension, UCD group, or virtual number) to which you want the
system to route callers when they cannot be routed automatically.
e The default is extension 101.

8) Press save to store the setting.

9) Press next to display the current ALT (alternate) Mode - Answer Position screen (now go to step 6 in
“Setting the Current Alternate Mode - Answer Position:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Current Alternate Mode - Answer Position:

From the DB Item Select screen (see steps 1 through 3 on page 303):

4) Enter 03-46-08-XX-02 (where XX represents the tenant group for which you want to set
the ALT Mode: 1~3).

5) Press save to display the ALT Mode screen.
6) Press chg.

7) Enter the appropriate directory number (extension, UCD group, Virtual Number) to which want the system
to route callers when they cannot be routed automatically.
e The default is extension 101.

8) Press save to store the setting.

9) Press next to display the current EVE (evening) Mode - Answer Position for the tenant group specified
above now go to step 6 in “Setting the Current Evening Mode - Answer Position:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Setting the Current Evening Mode - Answer Position:

From the DB Item Select screen (see steps 1 through 3 on page 303):

4) Enter 03-46-08-XX-02 (where XX represents the tenant group for which you want to set
the ALT Mode: 1~3).

5) Press save to display the ALT Mode screen.
6) Press chg.

7) Enter the appropriate directory number (extension, UCD group, Virtual Number) to which you want the
system to route callers when they cannot be routed automatically.
e The default is extension 101.

8) Press save to store the setting.

9) Press next to display a prompt that allows you to specify another new tenant group.
« Repeat steps above programming additional tenant groups (1 to 3).

OR
Press the Hold button to return to the previous programming screen (Answer Position) - see page 307.
OR

10)Press next to display the Auto Attendant Line screen (now go to step 6 in “Enabling the Auto Attendant
Line on the CO Line:” below).
« You will be prompted for the CO line directory number.

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Enabling the Auto Attendant Line on the CO Line;

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-09-XXX (where XXX represents the CO line you want to program: 800~839).
5) Press save to display the Auto Attendant Line screen.

6) CO line (Y/N).
« If you want the AA to answer this CO line, set this field to yes (Y).
e The default is N (no) - do NOT use the Auto Attendant on this CO line.

7) Press next to display the Auto_A Line screen (now go to step 6 in “Enabling the Auto Attendant line:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming Automated Attendant via the DET (continued on page)
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Programming Automated Attendant via the DET (continued)

Enabling the Auto Attendant line:

From the DB Item Select screen (see steps 1 through 3 on page 303):
4) Enter 03-46-09-XXX-02 (where XXX represents the CO line you want to program: 800~839).
5) Press save to display the Service screen.

6) Press chg to select the time during which you want the AA to answer this CO line.
« Valid options are ALWAYS, NEVER, DAY, and EVE.
* The default is NEVER.
7) Press next to display a prompt asking for the next CO line you want to program for automated attendant
answering.
* Repeat steps above for each CO line you want to program for AAM use.

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27.

IMPORTANT!

The system will not allow you to assign the same digit to more than one
function. Therefore, determine what digits you want to use for the inquiry code
and DISA code when assigning the waiting code.
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Setting Direct Inward System Access (DISA)

This feature allows you to remotely access system resources such as system speed dial, CO line access, and intercom

dialing.
IMPORTANT!
A The optional AAM board is required for DISA.

e You can assign any number of DISA lines as incoming DISA access based on the system service mode (day,
evening).

= You can access DISA using the Automated Attendant or by using dedicated DISA lines.

e The system secures access to DX-120 system resources for out-calling by means of verified passwords against
the assigned extension number. Users can use system resources only after they enter a valid extension number,
and enter a valid password for that extension.

e Related features that may affect DISA include the following.
- Auto Attendant
- System Speed Dial

e The following conditions apply to the DISA feature.

- Four DISA CO lines can be used simultaneously. If more than four DISA CO lines are signaling for answer,
the system plays an internal busy tone for subsequent calls.

- While DISA-to-CO calls are in use, DTMF receivers on the AAM are dedicated to the function. Therefore, the
quantity of the four DTMF resources are reduced by one for each DISA-to-CO call in progress. This affects
Automated Attendant operation since DTMF receivers are required to collect digits from outside callers.

- The default class of service of day and night for DISA CO lines is 0. Each DISA CO line has its own class of
service for dialing privileges.

- DISA CO line class of service assignment coincides with toll restriction COS tables.
- The activation time for a DISA CO line is programmable for “never”, “day”, “night”, or “always”.
- If you dial an extension number which is non-existent, the system directly transfers your call to the attendant.

- The DISA talk time is programmable for 1, 2, 3, 5, 10, and 15 minutes (default is 5 minutes). The DISA talk
time is set to automatically drop the connected outside parties upon expiration of the preprogrammed time. A
warning tone is heard 10 seconds prior to the disconnect operation.

- You can extend the DISA talk time while connected to a DISA call. To extend the talk time, dial O * (this
restarts the DISA talk timer).

- To disconnect a call originated via DISA (before the talk time expires), dial 0 #.

Setting DISA (continued on next page)
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Setting DISA (continued)

SETTING DISA via PC-DBA

From the PC-DBA main screen:

1) Go to ProgrammingP> Call HandlingP DISA to display the Call Handling—DISA screen.

Help

e

Feature Control
Timing
CID Programming Code

Programming Maintenance

Extension
C.0, Line

Call Handling

13
Syskem Resource 13
Restriction r
Extension Application 3
13
3
3

nidant

Auto
Tenant Calling

C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

| RP: Call Handling- DISA

X

~General DISA Settings

Ring Time Ta Answer: |_ 'I Sec.

’rAllowed Extention COS

v COS0 [T COS-1 [T COS-2[ COS-3
[C'COS-4 [T COSE [ COSE COST

~Individual DISA Settings

No DIR# |1:BDD 'I

DISA Line T Day COS: |D 'l
Service: |Always 'i

Eve COS: lD 'l
Talk Time: |5 vl Iin.

Update | Initialize(Fa) |

Claze | Help |

2) Select the number of seconds (in the Ring Time to Answer field) that you want the system to wait on an
unanswered incoming call before classifying it as a DISA line.
 Valid options are 0 through 99, in 1 second increments.

* The default is 0 seconds.

3) Use the check boxes under Allowed Extension COS to select which class(es) of service you want to allow
to use the DISA feature to make system CO line calls.

EXAMPLE

DISA ().

+ Make sure the checkbox (1) next to COS 0 has a check mark to allow COS 0 to

« Clicking on this box toggles the setting between yes/enable (a checkmark ¥) and

no/disable (no checkmark I")).

¢ The default is COS-0 allowed (i.e., checkmark) while all others are not allowed

(i.e., no checkmark).

Setting DISA via PC-DBA (continued on next page)
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Setting DISA via PC-DBA (continued)

4) Select the directory number (i.e., No DIR#) you wish to set up for DISA.
« Valid entries are directory numbers 800 through 839.

« Initially, this is set to 800.
e Entries 840 to 843 are for future use only.
IMPORTANT!
e When a T1 or ISDN (T1/PRI) is in use, valid entries are 816 through 839. When

any of these are selected, the DISA Line checkbox is automatically checked
(enabled) by default.

¢ DO NOT CHANGE THIS SETTING IF YOU ARE USING T1 OR ISDN (T1/PRI).
This setting must remain CHECKED.
5) Click the checkbox (") next to DISA Line to place a check mark there to make the selected directory a
DISA line ().
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

« The default is no/disable (no checkmark I ).

6) Complete the remaining fields as described below:

For this field... Select...

The class of service to use for the CO line directory during daytime

hours.

Day COS « Valid entries are 0 through 7.

* The default is 0.

The class of service to use for the CO line directory during evening

hours.

Eve COS « Valid entries are 0 through 7.

* The default is 0.

The frequency with which you want the DISA feature to be active

for the CO line directory.

Service « Valid options are Always, Never, Day, and Eve (evenings).

« The default is Always.

The allowed duration of outgoing calls made via the DISA feature
for the CO line directory. Extension users can extend this talk time,
in amounts corresponding to what you have set here.

« Valid options are 1, 2, 3, 5, 10, and 15 minutes.

Talk Time « The default is five minutes.

EXAMPLE

If you set this field to 3 minutes, extensions users can
make outgoing calls of up to 3 minutes, then the caller
can extend the time for another 3 minute period.

Setting DISA via PC-DBA (continued on next page)
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Setting DISA via PC-DBA (continued)

7) Click the Update button to store the settings into the database on the local disk.

« Use the procedure described above to make DISA settings for CO line directory numbers 800 through
839 as appropriate.

« Entries 840 to 843 are for future use only.

When you are finished:

8) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
9) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING DISA viA THE DET

Qh-\'- NOTE

.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 03-47.

5) Press save to display the DISA programming screen.

6) Press next to display the Ring Time to Answer screen (now go to step 6 in “Setting the Ring Time to
Answer:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting DISA via the DET (continued on next page)
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Setting DISA via the DET (continued)

Setting the Ring Time to Answer:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-47-01.
5) Press save to display the Ring Time to Answer screen.
6) Press chg.

7) Enter the number of seconds that you want the system to wait on an unanswered incoming call before
classifying it as a DISA line.
« Valid options are 0 through 99, in 1 second increments.

¢ The default is 0 seconds.

8) Press save to store the setting.

9) Press next to advance to the Allowed Extension COS screen (now go to step 6 in “Setting the Allowed
Extension COS:” below).

OR
Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Allowed Extension COS:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-02-0X (where X represents the correct extension COS: 1~8).
5) Press save to display the Extension COS screen.

6) Press chg to change the setting of each class(es) of service you want to allow to use the DISA feature to
make system CO line calls (Y/N).

AND/OR

7) Press next to display the next extension COS.
¢ Repeat steps 7 and 8 for each Extension COS you want to change.

When you have finished selecting Extension COS settings:
8) Press the Hold button to exit Extension Class of Service and return to the previous screen.

9) Press next to advance to CO line specific DISA programming and the CO Line prompt (now go to step 6
in “Setting the CO LN:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting DISA via the DET (continued on next page)
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Setting DISA via the DET (continued)

Setting the CO LN:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03.
5) Press save to display the CO LN screen.

6) Enter the CO line directory number.
 Valid entries are from 800 to 839.

¢ The default is 800.

IMPORTANT!

e When a T1 or ISDN (T1/PRI) is in use, valid entries are 816 through 839. When
any of these are selected, the DISA Line checkbox is automatically checked
(enabled) by default.

* DO NOT CHANGE THIS SETTING IF YOU ARE USING T1 OR ISDN (T1/PRI).
This setting must remain CHECKED.

7) Press show to display the DISA CO LINE (Y/N) screen (now go to step 6 in “Programming the DISA CO
LINE:" below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming the DISA CO LINE;

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03-XXX-01 (where XXX represents the appropriate directory number: 800~839).
5) Press save to display the DISA CO Line.

6) Press chg to select Y (yes) or N (no).
e The default is no.

7) Press next to display DISA DAY COS (now go to step 6 in “Programming the DISA DAY COS:” below).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting DISA via the DET (continued on next page)
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Setting DISA via the DET (continued)

Proagramming the DISA DAY COS:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03-XXX-02 (where XXX represents the appropriate directory number; 800~839).
5) Press save to display the DISA CO Line.

6) Press chg until you see the class of service you want to use for this CO line directory number during
daytime hours.
« Valid entries are 0 through 7.

¢ The default is 0.

7) Press next to advance to DISA EVE COS (now go to step 6 in “Programming the DISA EVE COS:”
below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Proaramming the DISA EVE COS:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03-XXX-03 (where XXX represents the appropriate directory number: 800~839).
5) Press save to display the DISA CO Line.

6) Press chg to assign the class of service you want to use for this CO line directory number during evening
hours.
 Valid entries are 0 through 7.

e The defaultis 0.
7) Press next to display SERVICE mode (now go to step 6 in “Programming the Service Mode:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting DISA via the DET (continued on next page)
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Setting DISA via the DET (continued)

Programming the Service Mode:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03-XXX-04 (where XXX represents the appropriate directory number; 800~839).
5) Press save to display the Service mode screen.

6) Press chg until you see the DISA feature you want to be active for this CO line directory number.
« Valid options are Always, Never, Day, and Eve (evenings).

e The default is Always.
7) Press next to display TALK TIME (now go to step 6 in “Programming the DISA Day COS:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Programming the DISA Day COS:

From the DB Item Select screen (see steps 1 through 3 on page 315):
4) Enter 03-47-03-XXX-05 (where XXX represents the appropriate directory number: 800~839).
5) Press save to display the DISA CO Line.

6) Press chg until you see the duration of outgoing calls made via the DISA feature you want to allow for this
CO line directory.
« Extension users can extend this talk time, in amounts corresponding to what you have set here.

 Valid options are 1,2,3,5,10, and 15 minutes.
* The default is five minutes.
EXAMPLE

If you set this field to 3 minutes, extensions users can make outgoing calls of up to 3
minutes, then the caller can extend the time for another 3 minute period.

7) Press next to display the CO line directory number prompt asking for the next CO line you want to
program for DISA.
* Repeat the steps above (starting at the top of page 317) to set the DISA line on/off, day class of service,
evening class of service, service time, and talk time for other directory numbers, as needed.

When all CO Line Directory have been programmed:
8) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27.
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T1 AND ISDN (T1/PRI) CALL OPERATION

The following provides in formation about how the system process calls when either a T1 or ISDN (T1/PRI) is installed.

HINT
@ Be sure to review “Appendix D - Trunk Directory Numbers” on page 475.

T1 Call Operation

OUTGOING CALLS
e Dial trunk group access code (e.g. the default of “741"), or press individual trunk line button to seize an idle trunk.

= If a trunk group consists of analog trunk and T1 trunk lines, access to the trunk group will be assigned to an idle
trunk line in accordance with the programmed hunting methods such as SEQF (sequential from the first), SEQL
(sequential from the last) or Random.

e The hunting sequence is based on the physical port number assigned to the individual trunk, either analog or
digital.
INCOMING CALLS
e Shall be treated as the normal analog trunk call and ring the programmed answering extensions for notification.
= Calling party number will be displayed when received.
e Multiple Call Handling using programmable Call Keys is available
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ISDN (T1/PRI) Call Operation

OUTGOING CALLS

Outgoing ISDN Trunk can be made by dialing the Trunk Group Code (according to the programming of the CO
Route for the ISDN trunks and the Trunk Route Numbering Plan) or press the individual ISDN Trunk button.

When accessing a Trunk via Trunk Group access, system will try to select one idle ISDN trunk According to the
Hunt Method (see page 147) set for the route.

If no ISDN trunk is available, system will select another trunk instead according the Alternate Route programming
in the database if Alternate Route has been programmed.

While trying to access an idle ISDN trunk, if the ISDN trunk is temporary unavailable or released for any reason
from Network, the call will be dropped, a double beep will sound and the LCD of the EKT will display TRt Releaze
for 3 seconds.

A Congestion Tone will be provided if the extension is SLT.
If CLIP is set to “Present”, Calling Party Number will be sent to the Network.

INCOMING CALLS

After an incoming call arrives, the DID digits are received by the system and are checked against the Translation
Table assigned for the ISDN trunk (see “Setting Up the Translation Table” on page 171).

If one entry is matched and the corresponding destination exists, the call will be routed to the destination.
Otherwise, the call will ring to the Intercept. If Intercept is not programmed, it will ring to the Tenant Attendant.

If the designated extension has Call Forward set or Predefined CFW programmed, Call Forward still applies.
If the final called extension is busy, a busy tone will be provided to the calling party.

If COLP is set to "Present”, the Answering Party Number will be sent to the Network after the extension answers
the ISDN call.

If the incoming ISDN call is translated and routed for an outgoing trunk call, the ISDN trunk’s COS will be
referenced for Toll Restriction checking when making the outgoing call.

No Answering Party Number will be sent to the Network in such case.

The incoming ISDN Trunk Call will ring the destination (Extension or Hunt Group) until the destination answers or
the outside party abandons the trunk.

For ISDN Trunk Calls, call control as performed at the extension (Hold and Transfer) will follow ordinary trunk call
operations.

If the caller ID of the calling party has been received from the Network, then been allowed to be shown according
to the Presentation Indicator flag received from the Network, the caller ID can be shown on the destination
extension.

If the caller ID is restricted (prevented from showing), "Private" will been shown instead of the caller ID of the
calling party.

If a number is not provided, "Out of Area" will be displayed.

If the caller's (phone/extension) has an associated name and number, the caller's (phone/extension) name will be
shown on the destination extension.

After the call is received by the destination phone, the recipient of the call can press either the first and/or third
keys to toggle between the caller's name and number on the display.

For the extensions in the system, only speech, as well as analog modems and fax machines are allowed.

- 321 -



MULTIPLE CALL HANDLING DX-120 Programming Manual

MULTIPLE CALL HANDLING
(USING CALL KEYS FOR MANAGING MULTIPLE CALLYS)

The Multiple Call Handling utility known as Call Key (Feature Code 66) provides a method for tracking the status for a
“pool” of CO lines. More specifically, the Call Key reflects the status of any active Trunk calls for a specific extension
(assuming there is not a Line Key programmed for that individual CO line that the Trunk call is associated with).
Furthermore, users can program multiple Call Keys on their phone to allow for tracking the status and management of
additional, simultaneous Trunk calls.

A Feature key (i.e., Call Key) can be programmed on any designated Vertical Comdial phone for use in handling
multiple calls (see “Assigning Feature Keys” on page 442). The Call Key can be programmed on any feature key of an
extension. Once invoked, the Call Key becomes associated with that Trunk call and the Call Key lamp indicator reflects
the status of that Trunk call for the duration of that call at the extension.

Q_'\‘ NOTE
.é « The maximum number of Call Keys that can be programmed is equal to the
y number of feature keys available on the phone being used.

¢ Only programmed Call Keys work. The Feature Access Code itself is not valid.

» The Call Key will work for any CO line (i.e., loop start as well as digital - T1 or T1/
PRI). However, if you have a Line Key programmed for a particular line then the
Line Key will be used for that particular line. In other words, Call Keys are only
associated with CO lines that do not have a Line Key programmed for them.

e The Call Key will provide status for Trunk calls whether the Trunk call is incoming
or outgoing. However, users cannot press an available Call Key to access a CO
line to initiate an outbound call.
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Multiple Call Handling - Incoming Calls
Multiple Call Keys can be programmed at a user’s extension. The table below provides detail of how the Call Key will
function as for multiple incoming Trunk calls.

CALL KEY SETTING RESULT

No Call Key programmed Intercom calls and Trunk calls are processed as usual.

The Call Key will become associated with and provide status for
the incoming Trunk call assuming the following conditions are met:

1) There is not a Line Key already programmed for the line that
the incoming trunk call is coming in on.
AND

2) There is an available Call Key programmed on the phone
(i.e., the Call Key that is programmed is not already being
Only one Call Key programmed used by another trunk call on that extension)

—% NOTE
'I » Regardless of whether the extension is busy (on a call)
. or not, once the call becomes associated with the

available Call Key, the lamp indicator will be a fast
flashing red light.

« If the user is already on a call, answering the new
incoming call by pressing the Call Key will automatically
put the initial call on hold.

Programming Multiple Call Keys allows the user to simultaneously
manage multiple Trunk calls. The additional programmed Call

Multi Call Key programmed Keys follow the same rules that apply when only a single Call Key
is programmed (refer to the item above). However, each Call Key
provides status for the Trunk Call with which it became associated.

=3 NOTES
'. When there is an incoming Trunk call, the Call Key will NOT be invoked / utilized if
* there is a Line Key programmed for the incoming Trunk call on the phone.

Multiple Call Handling - Outgoing Calls

When an idle Call Key is pressed, “NO INCOMING CALL” message will be shown on the phone display (i.e., Call Keys
cannot be pressed to access available CO lines). However, once a Trunk is seized by an extension through any
means such as: Trunk Directory Number, Trunk Route Directory Number, or Speed Dial, the first available Call Key will
become associated with that Trunk call, assuming there is no Line Key programmed for the seized Trunk at the
extension.

The Call Key lamp indicator provide status of that Trunk call until that trunk call is completed at that extension (see
“Multiple Call Handling - General Lamp Indicators” on page 326).
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Placing Call Key Calls on Hold

A Call Key call can be placed on System HOLD or Exclusive HOLD. The table below describes the status indicators for

both cases:
HOLD SETTING DESCRIPTION
« A slow flashing green light will be provided on the Call
Key of the holding extension.
System HOLD . S . .
« A slow flashing red light indicator will be provided on the
(Press the HOLD key) associated Line Key of other extensions in the system.
Other extensions can pick up this Trunk call.
¢ A fast flashing green light indicator will be provided on
the Call Key of the holding extension.
Exclusive HOLD « A solid red light indicator remains on the associated Line
(Press the Feature key + HOLD) Key of other extensions in the system. Only the extension
which placed this call on "exclusive hold" can retrieve this
Trunk call.
S NOTES

.é e When a user is on a call at Call Key 1, he/she can answer a second call which is
received at Call Key 2. The first call will be put on exclusive hold automatically no
matter whether or not "AUTO HOLD" is enabled.

* When a trunk call(s) is placed on hold and there is no Line Key or Call Key at the
extension, the phone will ring to remind the user to retrieve the held call(s).
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Multiple Call Handling - Transferring Calls
With the Call Key, users are able to track status of Trunk calls without needing a Line Key for each CO line. As
indicated, the Call Key becomes associated with the Trunk call and provides status for that call as long as the call is

active at the user’s extension. When transferring Call Key calls, the Call Key provides status during the transfer
process.

The table below indicates the Call Key lamp status when a Trunk call is being transferred from one extension to
another extension. Note that the table below assumes that neither Extension A or Extension B has a Line Key
programmed for the CO line that the Trunk call is using, thus the status is provided on the Call Keys.

CALL TRANSFER LAMP INDICATORS

EXTENSION

CALL KEY

LAMP BEFORE
TRANSFER

CALL KEY
LAMP DURING
TRANSFER

CALL KEY
LAMP AFTER
TRANSFER IS
COMPLETE

CALL KEY
LAMP AFTER
CALLED
PARTY

ANSWERS

Fast flashing
(flickering)
green

Ext. A
(Transferring Party)

Slow flashing
green

Slow flashing

green Dark (available)

Ext. B

(Extension Trunk call
being transferred to -
i.e., answering party)

Multiple Call Handling - Conference Calls

When a user establishes a conference call with trunks, assuming there is no Line Key for the CO lines that are utilized
in the conference call and the user has available Call Keys, the Call Key lamp indicator will provide status of the active
Trunk calls that make up the conference call. The user can deliberately release or talk privately by pressing the
associated Call Key.

Fast flashing
(flickering)
green

Fast flashing red

Dark (available) (CO line ringing)

Dark (available)

HINT

Also refer to “Multiple Call Handling - Transferring Calls” on page 325 and “Multiple
Call Handling - General Lamp Indicators” on page 326.

Once the user (controller) performs an Unsupervised Conference (Feature +77), the Call Key lamp indicators involved
with the conference call become dark and available and the user’s extension is returned to idle.

If the user rejoins the conference call (Feature +77), the Call Keys will provide status of the trunks involved in the
conference call assuming there are available Call Keys available.
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Multiple Call Handling - General Lamp Indicators

Aside from the Hold button, the buttons on the phones have lights that indicate call status, as shown below:

EVENT INDICATOR

Incoming Call Red Fast Flashing
Using Call Green Steady
Holding Call Green Slow Flashing
Exclusive Holding Call Green Fast Flashing
Unused Dark

HINT
@ Also see “Multiple Call Handling - Transferring Calls” on page 325 and “Call Transfer
Lamp Indicators” on page 325

Hold Key Lamp Indicator

The purpose of the Hold Key Lamp is to allow users to handle multiple calls in the DX-120 more easily.

=S NOTE
] The Hold Key Lamp does not function when a 7261-00 Edge 120 phone is connected
to a DX-80.

e Trunk Call Holding

The Hold Key lamp is fast red flashing when Trunk calls are placed on either System Hold or Exclusive Hold by
the extension.

e Intercom Call Holding
The Hold Key lamp is slow red flashing when Intercom calls are placed on Hold by the extension.

Q’__\‘ NOTE

.é The Hold Key Lamp is useful for users to handle multiple calls on hold, especially for
systems with T1 or T1/PRI where there are no Line Key(s) or Call Key(s) programmed
at the extension. In this case the Hold Key Lamp provides a reminder for the user that
there is a call(s) on Hold.

Held Trunk calls have a higher indicator priority when both Trunk and Intercom calls
are placed on Hold at the same time.

¢ When Trunk and Intercom calls are on hold at the same time, Intercom calls can
not be retrieved by pressing the Hold Key until all of the Held Trunk calls are first
retrieved and released (completed, transferred, etc.).

e The lamp indication of the Hold Key lamp immediately changes from a fast flash
slow flash once there are no more Held Trunk calls at the extension.

Hold Key Lamp Indicator (continued on next page)
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Hold Key Lamp Indicator (continued)

ADDITIONAL HOLD LAMP DETAILS

SCENARIO
(calls on hold)

LAMP
INDICATOR
BEFORE
OPERATION

OPERATION

(press HOLD to
retrieve held call)

LAMP
INDICATOR
AFTER
OPERATION

No call on hold

dark n/a dark
The held intercom
One Intercom call slow flashing red call will be dark
retrieved.
One trunk call fast flashing red The held trunk call dark

will be retrieved.

Multiple Intercom
calls

slow flashing red

The held Intercom
call placed on hold
first will be
retrieved.

slow flashing red

Multiple Trunk calls

fast flashing red

The held Trunk call
placed on hold at
first will be
retrieved.

fast flashing red

Multiple Intercom
calls and one Trunk
call

fast flashing red

The held Trunk call
will be retrieved
independent of
when the Trunk call
was placed on
Hold.

slow flashing red

Multiple Intercom and
Trunk calls

fast flashing red

The held Trunk call
will always be
retrieved from old-
est to newest prior
to any Intercom
calls being
retrieved.

fast flashing red

HINT
@ Also refer to “Call Transfer Lamp Indicators” on page 325 and “Multiple Call Handling
- General Lamp Indicators” on page 326.
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SECTION 7 - PROGRAMMING TOLL RESTRICTIONS

OVERVIEW

Toll restrictions allow you to place restrictions on outbound toll calls, per tenant group and account code.

BASIC TOLL RESTRICTION PROGRAMMING TASKS

In order to program the toll restrictions for use, you will need to perform the following basic tasks:
= Set up Class of Service and Digit Interval
e Program the account code length and passwords and passwords

Class of Service and Digit Intervals

= The DX-120 provides sophisticated monitoring of outbound digits dialed by callers on CO lines. You can assign
COSs for a broad range of call control. For example, if a digit or range of digits dialed on a CO line is inconsistent
with the dialing extension’s or CO line’s class of service, the system denies the call. You can apply this calling
COS criteria to local calls, long distance calls, and specific numbers that are considered allowed in areas where
other numbers may be restricted.

e The DX-120 provides a toll restriction table of 100 entries. Each entry can contain 10 digits in the "From" column
and 10 digits in the “To” column. These fields allow you to specify a range of digits in a truth-table fashion known
as digit intervals.

e You then set extension COS and CO line COS per table entry as Y/N (e.g., does this table entry apply to this
COS? Yes or No.). You specify two conditions for extension and CO line COS assignments, per table entry: Day
mode and Evening mode. This allows you to assign each table entry to each COS differently for these day or
evening modes.

EXAMPLE:

« An example of a table entry may be as simple as “From 0”, “To 0”. The result of this
truth table is that the system monitors calls associated to this COS for only the first
digit dialed. If that digit is “0”, the system allows the call and no further restriction
monitoring takes place.

¢ Another example is a table entry of “From 1813412", “To 1813450". In this case,
the system monitors calls in this COS sequentially for the first seven digits dialed,
or until the caller enters the first digit inconsistent with this setting. Thus the system
denies a call dialed as 1813410 as soon as the caller enters the digit “0”. The
system allows the caller to dial 1813419 + any digits.

e Conditions for Assigning Class of Service and Digit intervals
- Digitinterval 001 is programmed as: From “0”, To “#” (this allows all digits to be dialed).
- You can program up to 100 digit intervals, 10 per tenant group.

e Callers can override an extension’s class of service if you set up an account code password that instructs the
system to use a different class of service for the call.

HINT
Also see...
e “Assign the toll restriction for Extension COS. ” on page 331.

e “Setting the Account Code Length and Password” on page 336.

2

Class of Service and Digit Intervals (continued on next page)
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Class of Service and Digit Intervals (continued)

e You can set a system speed dial to override toll restriction. For example, suppose your customer has a branch
office out of state where they want to allow the corporate extension users to call, while still prohibiting all other toll
calls. In this case, you can set up a system speed dial to allow calls to the branch office.

NOTE

It must be a system speed dial, as the system checks the toll restrictions for individual speed
dial numbers and abides by them. System speed dial numbers override toll restrictions as long
as you have System Speed Toll Check enabled.

HINT
See “Programming Speed Dial Numbers” on page 64.

CLASS OF SERVICE AND DIGIT INTERVALS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling
Syskem Resource
Restriction

s“ll’ T o

Account Code gle

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

v v vEd v -~

1) Go to ProgrammingP> Restriction® Toll Restriction to display the Restriction—Toll Restriction screen.
THIS SCREEN IS COMPOSED OF TWO MAJOR PARTS:

a scrolling table of toll restriction settings for each extension in the current tenant group

RP: Restriction - Toll Restriction x|
Tenant:l_vl
Extension COS C.0. Line COS
Allowed Digit Intervals Day Eve Day Eve
D, From To [o]1]2]=]als]e]z]]o]1]2]=]a]s]e |7 ][] ]2]z]a]5]e]7]]o]1]2]2]4]5]e]7 ~
0 # el el e[ Pelele el e e e e e e e e e e e e e e e e e Do e | o
z WOMON NN N NN N N N N N N N N N N N N N N N N N N N N N N NN
3 MONCH NN N NN N N N N N N N N N N N N N N N N N N N N N NN
a NOMON NN NN N N NN N N N NN M N N N NN N N NN N NN NN
5 MMM NN N N N N N N N N N N N N N N N N N N N N N N N N NN
65 NUNN NN NN NN NN N NN NN NN NN N NN NN N N N NN
Mo, Allowed Intervals Extension COS C.0, Line COS
i me:lu— cos 0 1 2 3 4 5 B8 7 COos o1 2 3 4 5 6 7
Cay W W ¥ v v ¥ [# Day W WMV IVIFINVIENKIW
’ TDil# Ee VWV VVMIVIVINVIVIF Ee W RWMWINVFININKIW
/ Update | InitializedF &) Close | Help |

b) an entry line you use to enter new information and settings for the selected extension.

Class of Service and Digit Intervals via PC-DBA (continued on next page)
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Class of Service and Digit Intervals via PC-DBA (continued)

2) Select the tenant group you wish to program.

3) Click in any line of the scroll list to select the toll restriction you wish to define.
< By default, the first one is already set up.
¢ You can change it or click line NO. 2 to begin defining a new restriction.
 In the entry line at the bottom of the screen, the No. field at the far left will match the line number (NO.)
you selected above.

4) Enter the first number in the range of digits you want to allow in the From field.
 Valid options include digits 0-9, * (all), and # (none).
e This field can be up to ten digits in length, so you can make your restrictions as narrow or as broad as
required.

EXAMPLE

If you want to restrict long distance and operator calls, enter 2 in this field. This way,
the system does not allow 0 and 1 as possible digits in the first position of the dial
string.

5) Enter the last number in the range of digits you want to allow in the To field.
6) Valid options include digits 0-9, * (all), and # (none).
7) This field can be up to ten digits in length.

EXAMPLE

If you want to restrict long distance and operator calls, enter # in this field. This way,
the system does not allow any digits to be dialed in the second position when the
caller enters a 0 or 1 as the first digit in the dial string.

8) Assign the toll restrictions to be applied to each class of service.
« In the Extension COS and C.O. Line COS fields, you assign the current toll restrictions to the specific
class of services. Each class of service number can be set for both day and evening times. You have
two options for restricting calls. You can apply restrictions:

- on a per-extension basis (Extension Class of Service)
- on a per CO line basis (CO Line Class of Service).
9) Assign the toll restriction for Extension COS.
* Program remaining class of services (1-7) as needed using the steps above for the boxes under the

respective COS numbers. You can do this for all eight class of services in both Day and Evening
modes.

When all COSs have been programmed as needed:
10) Assign toll restrictions in the C.O Line COS Eve fields for both Day and Eve modes.
e The assignments you make here affect toll restrictions on a CO line basis.
* The settings in the CO Line COS fields override the settings in the Extension COS fields.

* The default toll restriction allows all calls, in all extension and CO line class of services, at all times.
Your customer may need more restrictions than the default.

EXAMPLE

There may be a need for a restricted COS that does not allow long distance calls, but
does allow toll free 1-800, 1-866, 1-877, and 1-888 calls. This can be set up with
appropriate toll restriction entries.

Class of Service and Digit Intervals via PC-DBA (continued on next page)
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Class of Service and Digit Intervals via PC-DBA (continued)

Once all toll restrictions are set for Extension COS and CO Line COS:

11) Click IEI located below the center of the scroll list to enter your settings in the table.
12) Assign the appropriate COS for the affected extensions in both Day and Evening modes.

=3 NOTE
You can set up toll restrictions for another tenant group by going back to step 2,
* selecting a new tenant group, then following the remaining steps.

When all assignments have been made:
13) Click the Update button to enter and save your settings into the database on your local disk.
14) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
15) Perform a SEND to copy the database changes to the DX-120 switch system memory.

CLASS OF SERVICE AND DIGIT INTERVALS VIA THE DET

=g NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
: Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Setting the Beainning of the Interval Range for the Tenant Group:

4) Enter 05-01-X-NNN (where X is the tenant group: 1~3; and NNN is the restriction number you want to
program: 001~100).

5) Press save to display the “FROM” screen of the tenant group and restriction you specified.

6) Press chg to change the start of this interval range (FROM).

7) Enter the first number in the range of digits you want to allow.
 Valid options include digits 0-9 and # (all).

* The default is 0.

EXAMPLE

 If you want to restrict long distance and operator calls, enter 2 in this field. This
way, the system does not allow 0 and 1 as possible digits in the first position of the
dial string.

¢ If you want to allow all long distance and operator calls in this toll restriction, enter
0 in this field.

Class of Service and Digit Intervals via the DET (continued on next page)
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Class of Service and Digit Intervals via the DET (continued)

8) Press save to store the number.

9) Press next to display the TO column of the tenant group and interval you specified (now go to step 6 in
“Setting the End of the Interval Range for the Tenant Group:” below).

OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the End of the Interval Range for the Tenant Group:

From the DB Item Select screen (see steps 1 through 3 on page 333):

4) Enter 05-01-X-NNN-02 (where X is the tenant group: 1~3; and NNN is the restriction number you want to
program: 001~100).

5) Press save to display the “To” screen of the tenant group and restriction you specified.
6) Press chg to change the end of this interval range.

7) Enter the last number in the range of digits you want to allow.
« Valid options include digits 0-9 and # (all).

* The default is #, which allows all digits following the FROM digit.
8) Press save to store the number.

9) Press next to display the extension COS screen (now go to step 6 in “Restricting Calls by Extension
COS:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Class of Service and Digit Intervals via the DET (continued on next page)
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Class of Service and Digit Intervals via the DET (continued)

Restricting Calls by Extension COS:

From the DB Item Select screen (see steps 1 through 3 on page 333):

4) Enter 05-01-X-NNN-03 (where X is the tenant group: 1~3; and NNN is the restriction number you want to
program: 001~100).

5) Press save to display to display the Extension COS screen.

6) Press show to display the Day Allowed screen.

7) Press show again to display the COS screen.

8) Press chg to set the toll restriction on for currently displayed class of service (Y/N).
AND/OR

Press next until the COS you want to change displays.

9) Press next to display the DAY Allowed parameter screen for the CO Line COS (now go to step 6 in
“Restricting Calls by CO Line COS:” below).

OR

Press the Hold button to return to the Day Allowed screen.

HINT
@ You can then press next to display the Eve Allowed screen. Once you do that, repeat
steps 7 and 8 above for the Evening Allowed COS setting.

OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Class of Service and Digit Intervals via the DET (continued on next page)
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Class of Service and Digit Intervals via the DET (continued)

Restricting Calls by CO Line COS:

From the DB Item Select screen (see steps 1 through 3 on page 333):

4) Enter 05-01-X-NNN-04 (where X is the tenant group: 1~3; and NNN is the restriction number you want to
program: 001~100).

5) Press save to display to display the COS CO LN.
6) Press show to display the Day Allowed screen.
7) Press show again to display the COS screen.
8) Press chg to set the toll restriction on for currently displayed class of service (Y/N).
AND/OR
Press next until the COS you want to change displays.

9) Press next to display the DAY Allowed parameter screen for the CO Line COS (now go to step 6 in
“Restricting Calls by CO Line COS:” below).

OR
Press the Hold button to return to the Day Allowed screen.

HINT

You can then press next to display the Eve Allowed screen. Once you do that, repeat
steps 7 and 8 above for the Evening Allowed COS setting.

¥

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming the Specific Extension COS:

From the DB Item Select screen (see steps 1 through 3 on page 333):

4) Enter 01-XXX-NN (where XXX is the extension: 101~204; and NN represents 05 is DAY Class Of Service
and 06 is EVE Class Of Service).

5) Press save to display the extension COS screen.
6) Press chg until you see the COS you want to assign for the selected service mode.

7) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting the Account Code Length and Password

You can program an extension so that the user is forced to enter an account code (password) to make certain line calls,
or before making any line calls. You determine the account code length (from 2 to 8 digits) during programming. This
single setting determines the length of account codes for the entire system.

When the extension user dials a valid account code, the system monitors the call for toll restriction against the class of
service associated with the entered account code.

Once you have set up the account codes, you then have to program the individual extensions to restrict their calls.

HINT
@ Also see, “Assigning a User Password, Password Length, and/or Name to
Extensions” on page 387.

SETTING THE ACCOUNT CODE LENGTH AND PASSWORD VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling

Syskem Resource
Restriction

Extension Application
.0, Line Application
Syskem Application
Feature Key Prograrmming
K5U DE Password

8lllnu\.ll' i e~ e~

Toll Restriction

__—

3
3
13
il Account Code Table
3
13
.3

1) Go to ProgrammingP>Restriction® Account Code Table to display the Account Code Table screen.
THIS SCREEN IS COMPOSED OF TWO MAJOR PARTS:

a scrolling table of passwords (account codes) that have
been assigned to user extensions

RP: Restriction - Account Code Table 1 |
Mo Password Ccos Disable CO Group  LCR Enable
i N 1 N -
2 il H 1 H
3 il H 1 H
4 i H 1 H
5 o H 1 H
& il H 1 H
7 il H 1 H
8 il N 1 N
2 i N 1 H
- . . —|
Password ﬂ
L Mo, Passward cos CO Group
[ = 4 |l [0 =] I Disable [ -
/ Update | Initialize(Fa) | Cloze | Help |

an entry line you use to input new passwords.

Setting the Account Code Length and Password via PC-DBA (continued on next page)
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Setting the Account Code Length and Password via PC-DBA (continued)

2) Click the line of the scroll list for which you wish to make a password entry.
« The number in the No field of the entry line at the bottom of the screen should now match the No field
for the selected line of the table.

3) Specify the length of the passwords to be assigned.
e The default is 3.

* When you specify the length of the password, the system changes the number of digits in the Password
field accordingly.

CAUTION
Changing the account code length will delete all previously programmed
account codes.

4) Enter the password you want to assign.
e The default is blank (no password).

 Valid passwords are numbers from 0 to 9, containing as many digits as you specified in the Length field.

5) Click the down arrow to the right of th.e COS field to assign this password a class of service (0 through 7).
e The default is 0.
* When an extension user enters this password, the system autojmatically assigns the class of service
you specify here to that call. The system follows all of the restrictions associated with that class of
service.

6) Click the box next to Disable to enable or disable this password.

IMPORTANT!

By default, this box is blank, meaning that the password is enabled (i. e., NOT
disabled). You must click the Disable box so it displays a check mark if you DO NOT
want to use the password.

Once the entries are completed:

7) Click |1I below the center of the table to move your selections from the entry line to the table line number
you selected in Step 2.

HINT
Assign additional passwords and their classes of service by repeating the steps
above. You can assign up to 600 passwords in this way.

LI

Once all passwords are entered:
8) Click the Update button to enter all of your password settings into the database on your local disk.

9) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
10) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Setting the Account Code Length and Password (continued on next page)
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Setting the Account Code Length and Password (continued)

SETTING THE ACCOUNT CODE LENGTH AND PASSWORD VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 05-02.

5) Press save to display the Account Code programming screen.

6) Press show to display the account code LENGTH screen (now go to step 6 in “Setting the Account Code
length:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Account Code length:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 05-02-01.
5) Press save to display the length screen.
6) Press chg.

7) Enter the number of digits you want to use for account codes.
« Valid options are 2 - 8 digits.

e The default is 3.
8) Press save to store the setting.
9) Press next to display the account code Password screen.
10) Enter the appropriate ID Number (001~600).
11) Press show to display the Password screen (now go to step 6 in “Setting the Password:” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Account Code Length and Password via the DET (continued on next page)
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Setting the Account Code Length and Password via the DET (continued)

Setting the Password:

From the DB Item Select screen (see steps 1 through 3 on page 338):
4) Enter 05-02-02-XXX-01 (where XXX represents the row in the account code table: 001~600).
5) Press save to display the Password screen.
6) Press chg.

7) Enter the new password.

» Valid passwords are numbers from 0 to 9, containing as many digits as you specified for the length in
step 8.

e “NULL” = empty, which is the default.
8) Press Save to store the new password.

9) Press next to display the COS screen (now go to step 6 in “Setting the COS for an Account Code” below).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the COS for an Account Code

From the DB Item Select screen (see steps 1 through 3 on page 338):
4) Enter 05-02-02-XXX-02 (where XXX represents the row in the account code table: 001~600).
5) Press save to display the Class of Service for this account code.
6) Press chg until you see the class you want to assign to this password.
7) Press next to display the Disabled screen (now go to step 6 in “Temporarily Disable the Account:” below).
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting the Account Code Length and Password via the DET (continued on next page)
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Setting the Account Code Length and Password via the DET (continued)

Temporarily Disable the Account:
This setting is used temporarily to disable the use of a particular account code without removing its programming.

From the DB Item Select screen (see steps 1 through 3 on page 338):
4) Enter 05-02-02-XXX-03 (where XXX represents the row in the account code table: 001~600).
5) Press save to display the Disable Account screen.
6) Press chg to select Y (disabled) or N (enabled).

7) Press next to display the CO Group screen (now go to step 6 in “Setting the CO Group for the Account:”
below).

8) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the CO Group for the Account:

From the DB Item Select screen (see steps 1 through 3 on page 338):
4) Enter 05-02-02-XXX-04 (where XXX represents the row in the account code table: 001~600).
5) Press save to display the CO Group screen.

6) Press chg until the CO Group number you want appears.
 Valid choices are 1~8.

¢ The default is 1.

7) Press next to display the ID Number screen.
* You can then enter the appropriate ID and continue to program for the next item.

OR

Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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OVERVIEW

Uniform Call Distribution is an exceptionally flexible function of the DX-120 system. UCD grouping allows you to link
system resources (primarily extensions) for call handling. The DX-120 provides 24 UCD groups. Each group has a
lead (or pilot) number; this is the access point of the UCD group.

Extensions may call a group of extensions by dialing the associated UCD group number. Calls may also be transferred
to UCD groups for handling by one of the UCD group members. UCD group members are also often referred to as
“agents.”

e The following conditions apply to programming UCD groups.
- Calls can be transferred to a UCD group.
- Intercom calls can be made to a UCD group.

- UCD group directory numbers are 410-433, by default. Callers can dial these numbers as though they are
extension numbers.

- You can assign CO lines to ring directly into UCD groups. For more details see Setting the Answer Position
for Day and Evening.

- You can program overflow destinations and reroute destinations for use with the (optional) integrated voice
mail system. When doing so, program UCD group 433 as the destination for each of these entries. This
routes the queued caller to the DX-120 voice mail system, where you can record and store announcements
you want the system to play to UCD callers waiting in the UCD queue. For more details, see Programming
Third Party VM, Analog Ports.

- When you install the DX-120 Voice Mail system, it uses UCD group 24. Therefore this UCD group is not
available for any other purpose when using the in-skin Voice Mail system.

= There are three ways to configure a UCD group:

- Linear—the system routes incoming or transferred calls beginning always with the first member of the group.
Thus, the first member of a linear UCD group is the primary answering point for all calls received by this
group.

Each subsequent member receives calls only when the previous member is unavailable to take a call
(unavailable status includes: busy, DND active, Agent Log Off active, or when calls to the member go
unanswered.)

- Distributed—the system routes incoming or transferred calls uniformly. That is, the system routes each new
call to the next available UCD member (and retains previous call routing).

EXAMPLE

If the third UCD group member handled the last call into the UCD group, the system
will route the next call to group member four, regardless of the status of other UCD
group members. If group member four is unavailable, the system routes the call to
group member five, etc.

- All Ring—the system routes incoming or transferred calls to all group members simultaneously. That is, for
each call into the UCD group, the system rings all available members (unavailable status includes: busy, DND
active, Agent Log Off active, or when calls to the member go unanswered.)
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e While a caller waits for a UCD group member to answer (in queue), several queued call operations are possible:

No Answer — Member advancement
Each UCD group has a No Answer Timer. You can set this timer to advance the call from one UCD group
member to the next when the ringing member does not answer the call within the time allotted.

Overflow 1 Destination programming

Each UCD group has an overflow 1 timer and destination. You can set this timer to determine how long calls
will remain in queue, before being routed to the overflow 1 destination. The destination can be an extension
responsible for handling calls that remain in queue too long, or a voice announcement device.

You can use recorded announcement devices to play recorded messages to callers waiting in queue, e.g.,
“All agents are still busy - please continue to hold.” The system plays the overflow 1 destination only once.

For high traffic scenarios, you can use a recorded voice announcement UCD group to play the same
message to multiple callers.

Overflow 2 Destination programming.

Each UCD group has an overflow 2 timer and destination. You can set this timer to determine how long calls
will remain in queue, following the overflow 1 timer, before being routed to the overflow 2 destination (overflow
1 timer + overflow 1 destination recorded message time + overflow 2 timer.)

The destination can be an extension responsible for handling calls that remain in queue too long or a voice
announcement device. You can use recorded announcement devices to play recorded messages to callers
waiting in queue, e.g., “Please continue to hold to reserve your place in queue.”

For high traffic scenarios, you can use a recorded voice announcement UCD group to play the same
message to multiple callers.

Overflow Count programming.
Each UCD group has an overflow count that is associated with the overflow 2 timer. You can set this timer to
allow a specific number of times that the system may repeat the overflow 2 timer.

For each cycle of the overflow 2 timer, the system plays the overflow 2 destination recording. If a call remains
in queue so long that the overflow count counter expires, the system routes this call to the programmed
reroute destination.

Reroute Destination programming.
Each UCD Group has a reroute destination. You can program this with an extension number the system uses
to remove the call from UCD group queue. The system then routes the call for immediate handling.

e Other features that may affect UCD programming include the following:

CO Line Ring Assignment - see page 134

UCD Reroute Destination - see page 345

UCD Voice Announce Group - see page 358

UCD Agent Log On/Log Off - see page 358

Voice Mail - (third party) Analog Integration - see page 363
Voice Mail - (internal) Digital Integration - see page 381
Recorded Announcement Devices (RADS) - see page 429

HINT:
@ Also see “Programming UCDs” on page 345.
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CONTROLLING OVERFLOW AND REROUTE SITUATIONS

The DX-120 system allows for flexible handling of callers waiting in UCD queue (waiting to be answered by an UCD
Group Agent) in the following situations:

UCD OVERFLOW CAN BE APPLIED IN EITHER OF THE FOLLOWING...

e Overflow can be a simple UCD-external destination, where the system routes callers to another DX-120 extension
following some predetermined time. The system immediately removes the caller from the UCD agent queue and
delivers it to the overflow destination for handling.

Other callers in UCD queue move up in their respective UCD queue position to reduce the time-to-answer for
their call.

OR

e Overflow can be a more sophisticated and comprehensive application, where the system routes callers to a third
party Recorded Announcement Device (RAD). The most effective implementation of RAD is using the DX-120
optional built-in voice mail module.

In this implementation, the system plays the recording without removing callers from their respective UCD queue
position.

YOU CAN PROGRAM OVERFLOW IN A RAD ENVIRONMENT TO USE TWO ANNOUNCEMENTS...
To do this, you specify two overflow destinations. Each destination has an associated timer that determines how long
the call remains in the queue before the system plays the announcement.

The system can play the first overflow destination message only once. The system can play the recording in the
second overflow destination up to 128 times, depending on your specifications. How often the system plays the
message in the second overflow destination depends on the time you specify in its timer.

THE FINAL STEP IN HANDLING OF CALLERS IN A UCD QUEUE...

The final step in handling of callers in a UCD queue is the reroute destination, which is an exit from the UCD queue.
Reroute is the least preferred action for callers waiting in a queue, because most callers prefer to speak with a UCD
agent. The reroute destination is usually an extension (external to UCD) designated to handle callers who have waited
for a longer than anticipated time in UCD queue.

When the system routes a caller to the reroute destination it removes the caller from the UCD queue. You can assign
the reroute destination to an extension that can further process the call, or you can assign the reroute destination to a
RAD. However, if you route the call to a RAD, the system disconnects the caller when the RAD announcement is
finished

- 343 -



UCD AGENT LoG OFF/LOG ON DX-120 Programming Manual

CONDITIONS FOR PROGRAMMING IN A RAD APPLICATION

Overflow Destination 1 is usually recorded as: “All agents are busy assisting other callers. Please continue to
hold.”

Overflow Destination 2 is usually recorded as: “All agents are still busy, please continue to hold. Calls will be
handled in the order that they were received.”

When using the Corporate Office DX voice processing (PN7270 or PN7271) the system can route the caller to a
screen box for further routing. For more details, see Corporate Office DX Supervisor’s User Guide, GCA70-393.

When using the optional DX-120 Voice Processing module, overflow and reroute destinations are shown in the
following voice mail boxes (i.e., the table below determines what messages from the voice mail the caller hears
depending into which group they are calling.

UCD Group Overflow and Reroute Destination
Announcement Boxes in DX-120

UCDh ucbD ucbD UcbD ucbD UcCD
Overflow Group Group Group Group Group

1 2 3 4 5
Overflow 1 3101 3102 3103 3104 3105
Overflow 2 3201 3202 3203 3204 3205
Overflow 3 3301 3302 3303 3304 3305

UCD AGENT LOG OFF/LOG ON

UCD members, or agents, can temporarily log off to disconnect from the UCD group.

Agents usually log off when they are on break or not able to attend the phone (employee “shift” cycles etc.) When
an agent logs off, the system skips that agent’s extension when queuing incoming calls.

Agents can log off of the UCD group but still be able to use all other extension features. Non-UCD group ringing
is unaffected when agents log off.

Agents can log off from any UCD group extension, however one agent must be logged on at all times. The DX-
120 will not allow all UCD group members to log off simultaneously.

While the extension is idle, the UCD group agent presses Feature * 9 1 to log on, or Feature 9 1 to log off. The
system momentarily displays the new agent status (Log On or Log Off).

You can program a Flexible Feature Button for agents to toggle for log off / log on. If you program this, the system
lights the LED associated with the button a steady red when the agent is logged off.
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PROGRAMMING UCDs

PROGRAMMING UCDS

Before programming a UCD, determine how you want the system to process calls in the queue and if you will use

RADs for overflow conditions (see “Controlling Overflow and Reroute Situations” on page 343).

PROGRAMMING UCDs viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help
Extension

C.0, Line

Call Handling

Syskem Resource

Restriction

Extension Application

C.0, Line Application

Syskem Application

Feature Key Programming

K5U DE Password

>
DX-120

Unifarm Call Distribution

Waoice Mail Table

Auto Recording Member

1) Go to ProgrammingP>Extension Application® Uniform Call Distribution to display the Extension
Application—UCD: Parameters screen.

RP: Extension Application - UCD: Parameters

Hunt Group:

1:410 -

Attribute:
Tenant Group:
MName:

Members:l

uco | Overflow 1 Timer: |U Sec. (0-255)

|1 vi Oyerflow 1 Dest.: | 'I

| Overflow 2 Timer: |D Sec. (0-255)
0 Crverflow 2 Dest: | vI

Hunting Method:

Mo Answer Timer:

ILinear [~ | Overflow Count: |1 {1-128)
il | B Re-Route Dest.: I 'I

Lpdate

| InitializedF &) | Close | Help |

Programming UCDs via PC-DBA (continued on next page)
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Programming UCDs via PC-DBA (continued)
2) Select/enter information up in the fields as described below:

UCD PROGRAMMING FIELDS

FOR THIS FIELD... DO THIS...

Select the hunt group for which you are defining UCD parameters.
Hunt Group « Valid entries range from 410 to 433.
* The default is 410.

Select UCD or VA. Use the VA option if you are using extensions on a RAD
for overflow destinations.

Attribute [ %) NOTE

.é If you expect high traffic on a third-party RAD device, program VA
analog ports into an available UCD group, and then set that UCD
group Attribute field to VA.

Assign this UCD to a tenant group.

« Valid options are 1, 2, and 3. If your system is not divided into tenant
groups, use 1.

* The default is 1.

Tenant Group

Name Enter the name you want to use for this UCD group.

Select the hunting method you want to use for this UCD group.
Hunting Method « Valid options are Linear, Distributed, and All Ring.
* The default is Linear.

Select how long you want the system to ring an extension in this UCD group

before pulling the call back and ringing the next extension in the hunt group.

No Answer Timer « Valid options are 5 to 60 seconds.

¢ The default is 10.

Enter the length of time (in seconds) that you want a call to remain in the
gqueue before the system routes it to the overflow 1 destination.

« Valid options are 0 to 255 seconds.
e The defaultis 0

Overflow 1 Timer

Enter the UCD directory number to which you want the system to send the
queued caller when the overflow 1 timer has expired.

« Valid options include any valid extension or UCD directory number.
» The default is blank (no destination).

« If the destination is a third-party RAD device that is connected to a DX-120
analog port, enter that port number here.

« If the destination is the DX-120 optional integrated voice mail, set this field
to extension 433.

Overflow 1 Dest.

UCD Programming Fields (continued on next page)
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UCD PROGRAMMING FIELDS (continued)

FOR THIS FIELD... DO THIS...

Enter the length of time (in seconds) that you want a call to remain in the
queue after the overflow 1 timer has expired. When this occurs, the system
Overflow 2 Timer routes the queued call to the overflow 2 destination.

« Valid options are 0 to 255 seconds.
e The default is 0.

Enter the UCD directory number to which you want the system to send the
queued caller when the overflow 2 timer has expired.

« Valid options include any valid extension or UCD directory number.
» The default is blank (no destination).

« If the destination is a third-party RAD device that is connected to a DX-120
analog port, enter that port number here.

« If the destination is the DX-120 optional integrated voice mail, set this field
to extension 433.

Overflow 2 Dest field

Enter the number of times you want the system to play the Overflow 2
announcement to a caller in UCD group queue.

 The valid options are from 1 to 128 times.
* The default is 1.

—% NOTE

.é The system removes the call from this UCD queue once it plays the
announcement the number of times you specify here.

Overflow Count

Enter the UCD directory number to which you want the system to send the
queued caller when it removes callers from this UCD group (after the over-
flow count expires).

« Valid options include any valid extension number.
» The default is blank (no destination).
« If you are using the optional integrated voice mail, set this field to extension

433 so callers can leave
Re-Route Dest messages if they wish.

=3 NOTE
.é « Since you are removing the caller from this UCD group, the caller
loses his or her place in the queue. If you enter an extension
within this UCD group, the system places the call back in the
queue at the bottom, and plays the first message again.

« An alternative would be to reroute the call to another UCD group or
extension.

Once you have completed the fields as described above:
3) Click the Members button to display the member list for the selected hunt group (e.g., 24).

Huntin et

Programming UCDs via PC-DBA (continued on next page)
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Programming UCDs via PC-DBA (continued)

4) Select the digital channel directory number as a member in the first field (i.e., field 1).

RP : Extension Application - UCD : Members 5 ll
Hunt Group 1:410
—UCD Members
1 (-] 7 RARE] = 18] 7|
2 | |8 [ =] 14 -| 20 =
3 ]9 =15 -] a1 [F
1 =] 10] =] 18 ~| 22 =
5 | =] 1] =7 -] 23 =
5 | =] 12 x| a5 =
InitializeF &) | Close | Help |

« The VM hunt group is the new UCD group you selected and programmed with the digital channel
members.

¢ Repeat this process to identify up to 23 other extensions you want to use in this hunt group.
=3 NOTE

.é Use the process as described above to program as many UCD groups as needed.
When you are finished:

5) Click the Update button to store the settings into the database on the local disk.

6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

PROGRAMMING UCDs VIA THE DET
Refer to the table on page 346 for more information about each of the settings for this feature.

Qh—:- NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 06-01-XX (where XX represents the UCD group: 01~24) to go to the appropriate UCD group.
5) Press save to display the Tenant screen.

6) Press chg until the tenant you want to program appeatrs (i.e., 1~3).

7) Press next to display each of the UCD programming screens.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Assigning the UCD to a tenant group:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 06-01-XX-01 (where XX represents the UCD group: 01~24).
5) Press save to display the currently set tenant group for the specified UCD group

6) Press chg to until you see the appropriate tenant number.
 Valid options are 1, 2, and 3.

* The default is 1.

=y NOTE
.é If your system is not divided into tenant groups, use 1.

7) Press next to display the Attribute screen (now to go step 6 in the next section).
OR

HINT

If you want to assign tenant groups for other UCDs, press the volume Up button to
return to the DB Item Selection screen, and repeat the steps in this section.

LI

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the Attribute for a UCD group:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-02 (where XX represents the UCD group: 01~24).
5) Press save to display the currently set attribute for the specified UCD group.

6) Press chg until you see the appropriate select UCD or VA.
« Use the VA option if you are using extensions on a RAD for overflow destinations.

QE\‘ NOTE
If you expect the traffic on a third-party RAD device to be high, program analog ports
of type VA into an available UCD group, and then set that UCD group Attribute field

to VA.

7) Press next to display the UCD Name screen (now go to step 6 in “Setting the Name for a UCD group:”
below).
OR

HINT
o If you want to set attributes for other UCD groups, press the volume Up button to

return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB ltem Selection screen.

OR
Exit programming (see “Exiting Database Administration” on page 27).

Setting the Name for a UCD group:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-03 (where XX represents the UCD group: 01~24).

5) Press save to display the Name screen for the specified UCD group.
e The default is NULL.

6) Press chg.
7) Use the keypad (using the alphanumeric table for reference) to enter a name for the specified UCD group.

HINT
@ see Appendix E for details about how to enter alphanumeric and special characters

8) Press save to store the new name.
9) Press next to display the UCD Member screen (now go to step 6 in “Setting the Members for a UCD
Group:” below).
OR

Setting the Name for a UCD Group via the DET (continued on next page)
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Setting the Name for a UCD Group via the DET (continued)

HINT
@ If you want to set names for other UCD groups, press the volume Up button to return
to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Members for a UCD Group:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-04 (where XX represents the UCD group: 01~24).
5) Press save to display the Member screen for the specified UCD group.
6) Press chg.

7) Enter the extension directory number of the extension you want to assign as a member of the specified
UCD group.
8) Press save to store the setting.
9) Press next if you want to assign other members to this group.
» Follow steps 6 through 8 for each member you want to assign.
OR
Press the Hold button to return to the previous screen level.

« You can then press next to display the Hunt Method screen, then go to step 6 in “Setting the Hunting
Method for a UCD Group:” below.

OR
HINT

If you want to set members for other UCD groups, press the volume Up button to
return to the DB Item Selection screen, and repeat the steps in this section.

LI

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the Hunting Method for a UCD Group:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-05 (where XX represents the UCD group: 01~24).
5) Press save to display the Hunting Method screen for the specified UCD group.

6) Press chg until you see the appropriate hunting method for this UCD group.
 Valid options are Linear, Distributed, and All Ring.

* The default is Linear.
7) Press save to store the setting.

8) Press next to display the UCD No Answer Timer screen (now to go step 6 in “Setting the UCD No Answer
Timer:” below).

OR
HINT
@ If you want to the set Hunting Method for other UCD groups, press the volume Up
button to return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the UCD No Answer Timer:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-06 (where XX represents the UCD group: 01~24).
5) Press save to display the No Answer Timer screen for the specified UCD group.
6) Press chg.

7) Enter the number of seconds you want the system to ring an extension in this UCD group before pulling
the call back and ringing the next extension in the hunt group.
 Valid options are 5 to 60 seconds.

e The default is 10.
8) Press save to store the setting.

9) Press next to display the UCD Overflow 1 Timer screen (now to go step 6 in “Setting the UCD Overflow 1
Timer:” below ).

OR
HINT
@ If you want to set the No Answer Timer for other UCD groups, press the volume Up
button to return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the UCD Overflow 1 Timer:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-07 (where XX represents the UCD group: 01~24).
5) Press save to display the Overflow 1 Timer screen for the specified UCD group.
6) Press chg.

7) Enter the number of seconds you want you want a call to remain in the queue before the system routes it
to the overflow 1 destination.
 Valid options are 0 to 255 seconds.

* The default is 0.
8) Press save to store the setting.

9) Press next to display the UCD Overflow 1 Destination screen (now to go step 6 in “Setting the UCD
Overflow 1 Destination:” below).

OR
HINT
@ If you want to set the Overflow 1 Timer for other UCD groups, press the volume Up
button to return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the UCD Overflow 1 Destination:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-08 (where XX represents the UCD group: 01~24).
5) Press save to display the Overflow 1 Destination screen for the specified UCD group.
6) Press chg.

7) Enter the UCD directory number where you want the system to send the queued caller when the overflow
1 timer has expired, then press save.
 Valid options include any valid extension or UCD directory number.

¢ The default is NULL.

« If the destination is a third-party RAD device that is connected to a DX-80 analog port, enter that port
number here. If the destination is the DX-80 optional integrated voice mail, enter extension number
433.

8) Press save to store the setting.

Setting the UCD Overflow 1 Destination via the DET (continued on next page)
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Setting the UCD Overflow 1 Destination via the DET (continued)

9) Press next to display the UCD Overflow 2 Timer screen (now to go step 6 in “Setting the UCD Overflow 2
Timer:” below).

OR

HINT

@ If you want to set the Overflow 1 Destination for other UCD groups, press the volume
Up button to return to the DB Item Selection screen, and repeat the steps in this
section.

Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Setting the UCD Overflow 2 Timer:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-09 (where XX represents the UCD group: 01~24).
5) Press save to display the Overflow 2 Timer screen for the specified UCD group.
6) Press chg.

7) Enter the number of seconds you want a call to remain in the queue after the overflow 1 timer has
expired. When this occurs, the system routes the queued call to the overflow 2 destination.
« Valid options are 0 to 255 seconds.

e The defaultis 0.
8) Press save to store the setting.

9) Press next to display the UCD Overflow 2 Destination screen (now to go step 6 “Setting the UCD
Overflow 2 Destination:” below).

OR

HINT
@ If you want to set the Overflow 2 Timer for other UCD groups, press the volume Up
button to return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the UCD Overflow 2 Destination:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-10 (where XX represents the UCD group: 01~24).
5) Press save to display the Overflow 2 Destination screen for the specified UCD group.
6) Press chg.

7) Enter the UCD directory number to which want the system to send the queued caller when the overflow 2
timer has expired.
 Valid options include any valid extension or UCD directory number.

* The default is NULL.
8) Press save to store the setting.
« If the destination is a third-party RAD device that is connected to a DX-80 analog port, enter that port

number here. If the destination is the DX-80 optional integrated voice mail, enter extension number
433.

9) Press next to display the UCD Overflow Count screen (now to go step 6 in“Setting the UCD Overflow
Count:” below).

OR
HINT
If you want to set the Overflow 2 Destination for other UCD groups, press the volume

Up button to return to the DB Item Selection screen, and repeat the steps in this
section.

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the UCD Overflow Count:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-11 (where XX represents the UCD group: 01~24).
5) Press save to display the Overflow Count screen for the specified UCD group.
6) Press chg.

7) Enter the number of times you want the system to play the contents of the Overflow 2 Destination (RAD)
for this UCD group.
¢ The valid options are from 1 to 255 times.

¢ The default is 1.

=g NOTE
. The system removes the call from this UCD queue once it plays the announcement
® the number of times you specify here.
8) Press save to store the setting.
9) Press next to display the UCD Reroute Destination screen (now to go step 6 in the next section).
OR

HINT
@ If you want to set the Overflow Count for other UCD groups, press the volume Up
button to return to the DB Item Selection screen, and repeat the steps in this section.

Press the volume UP button to return to the DB ltem Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).
Programming UCDs via the DET (continued on next page)
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Programming UCDs via the DET (continued)

Setting the UCD Reroute Destination:

From the DB Item Select screen (see steps 1 through 3 on page 349):
4) Enter 06-01-XX-12 (where XX represents the UCD group: 01~24).
5) Press save to display the Reroute Destination screen for the specified UCD group.

6) Press chg.

7) Enter the directory number to which you want the system to send the queued caller when it removes
callers from this UCD group
« Valid options include any valid extension number.

e The default is NULL.
« If you are using the optional integrated voice mail, set this field to extension 433 so callers can leave
messages if they wish.

Qh-\'- NOTE

.é ¢ Since you are removing the caller from this UCD group, the caller loses their place
in the queue. If you enter an extension within this UCD group in the re-route field,
the system places them back in the queue at the bottom, and plays the first
message again.

¢ An alternative would be to reroute the call to another UCD group or extension.
8) Press save to store the setting.
9) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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SETTING UP UCD VOICE ANNOUNCE (VA) GROUPS

The DX-120 system provides UCD groups to allow you to handle high traffic using third-party ancillary RADs.
Whenever the overflow destinations of a UCD group require you to use more than one RAD to handle the volume of
call traffic, you can pool the RADs in a group (available UCD group) for access. If you do this, any of the available
devices can handle waiting calls with the same announcement.

The following conditions apply.
= You must assign all voice announce UCD group members to port type V.A.
e You must record all ancillary RAD devices individually for the same announcement.

=3 NOTE
These conditions do not apply when using the DX-120 voice mail system for UCD
Overflow announcements.

SETTING Up UCD VA GRoups vIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling
Syskem Resource
Restriction

C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

3
3
3
Extension Application 3
13
3
3

1) Go to ProgrammingP>Extension to display the Extension screen.
]
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

Setting Up UCD VA Groups via PC-DBA (continued on next page)
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Setting Up UCD VA Groups via PC-DBA (continued)

2) Select the extension number you want to use for the voice announce group.
 Valid entries include any non-conflicting extension number.

In the Port Type field at the right center portion of the screen:
3) Select VA for the analog port connected to the RAD.

4) Click the Update button to enter this setting into the database on the local disk.
¢ Use the procedure above to select the VA analog port connected to a RAD you want to use in the VA

group.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

From the PC-DBA main screen:

6) Program your UCD group as described in Setting Up UCDs (see “Programming UCDs via PC-DBA” on
page 345).

IMPORTANT!
A « Be sure to program the UCD group number you want to use as the V.A. group.
Also be sure to assign V.A. in the Attribute field.

 In the overflow destination fields, enter the V.A. UCD group number.

When you have finished all programming changes:
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING Urp UCD VA GROUPS VIA THE DET

=y NOTE
.é e chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Setting Up UCD VA Groups via the DET (continued on next page)
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Setting Up UCD VA Groups via the DET (continued)

Program the analog extension ports as type VA:

4) Enter 01-XXX-21 (where XXX is the extension number of the analog port connected to an ancillary RAD
Device).

5) Press save to display the corresponding extension Port Type screen.
6) Press chg to select VA.

7) Press the volume UP button to return to the DB Item Selection screen.
* Repeat steps 4 through 7 to set other analog extensions connected to RAD devices to port type V.A., as
needed.

8) Program your UCD group as described in Setting Up UCDs (see “Programming UCDs via the DET” on
page 349).

IMPORTANT!
A e Be sure to program the UCD group number you want to use as the V.A. group.
Also be sure to assign V.A. in the Attribute field.

¢ In the overflow destination fields, enter the V.A. UCD group number.

9) Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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SECTION 9 - PROGRAMMING VOICE MAIL

OVERVIEW

You can set up the DX-120 to interface with either:

« An external, analog third party voice mail system
You can connect the DX-120 system to a third-party voice mail system using spare analog ports.

Remember that while using a third-party voice mail system is a viable option, doing so occupies

available analog ports, thereby reducing the number of system ports that you can use for the telephones,
FAX machines, modems, etc.

=y NOTE
If you use analog voice mail, you must assign system ports to the voice mail system.
If you use the digital DX-120 Voice Mail, you do not use system ports and therefore do
not have any port loss.

OR

» The internal digital DX-120 Voice option
It is highly recommended that you use one of the DX-120 voice mail systems (7270C [hard drive] or

7271C [Compact Flash]), because it is a digital integration and therefore does not occupy valuable
analog port space of the DX-120 system.
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PROGRAMMING THIRD PARTY VOICE MAIL

IMPORTANT!
A Remember that while using a third-party voice mail system is a viable option, doing

S0 occupies available analog ports, thereby reducing the number of system ports that
you can use for the telephones, FAX machines, modems, etc.

Therefore, it is highly recommended that you use one of the DX-120 voice mail systems (7270C [hard
drive] or 7271C [Compact Flash]), because it is a digital integration and therefore does not occupy
valuable analog port space of the

DX-120 system

Using third party voice mail greatly enhances the use of the DX-120 system. Features accessible when voice mail is
installed vary depending upon the third-party product connected.

= Features that the DX-120 system accommodates include the following.

Automated Attendant

Extension unique voice mailboxes

Call Forward to extension voice mailboxes
Answering Machine Emulation

UCD Queue Announcements

Screen Routing

Voice Record

Automatic Voice Record

Specific CO Line Greetings on Automated Attendant

e The following conditions apply to analog voice mail.

Voice mail feature operation is limited only by the ancillary voice mail system.

When voice mail ports are used heavily (high call traffic), the system updates message indications notably
slower than usual.

When VM messages are waiting, the system flashes the auxiliary lamp green.
When transferring a call to voice mail, callers can choose to enter no mailbox number.
If they do so, the system routes them to the voice mail main greeting (e.g., Auto Attendant greeting).

If no voice mail ports are available at the time callers place their call into voice mail, the system plays a ring-
back tone until a port becomes available.

You can program the voice mail code Feature 6 4 on any available Flexible Feature Button.

When the voice mail code is programmed on a Feature Button, the system flashes the associated LED red
when VM messages are waiting.

You can program the voice mail UCD Group directory number (usually 433) on any available Flexible Feature
Button.
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Basic Programming for Third Party Voice Mail

To properly set up the system for Third Party Voice Mail, you need to perform the following tasks:

A) Assign the VM port type to the appropriate extensions - see 363
B) Program the UCD group members - see 365

C) Set the call handling digits - see 367

D) Set the voice mail dialing ratio - see 377

E) Activate Automated Attendant - see 298

A - Assigning the Voice Mail Port Type to
the Appropriate Extensions for Third Party VM

This is the first task you need to complete in order to set up third party voice mail (analog ports).

ASSIGNING THE VM PORT TYPE TO EXTENSIONS VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extension screen.
E
Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: 4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. I—LI
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: I

Assigning the VM Port Type to Extensions via PC-DBA (continued on next page)
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Assigning the VM Port Type to Extensions via PC-DBA (continued)
2) Select the extension number you want to program.

From the Port Type field:

Fort Type: EXT j
3) Select V.M.

DIR Mo, ExT

Swapping: WA

ECF CO Group m
e The default is EXT.

¢ The default for extensions 157 through 164 is VM, since these extensions are reserved for the in-skin
voice mail.

* Program other port types as needed using the steps above.

QE\‘ NOTE
. Use Voice Announce (VA) if this directory number is connected to a recording device,
Voice Mail (VM) if this directory number is connected to voice mail, or extension (EXT)
if this directory number is connected to an extension.

When all assignments have been made:

4) Click the Update button to enter and save your settings into the database on your local disk.

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Now, program the UCD members (see 365).

ASSIGN THE VM PORT TYPE TO EXTENSIONS VIA THE DET

—3 NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-21 to program the extension port type (where XXX is the analog port number: 101~204)
you want to use for the voice mail.

5) Press save.
6) Press chg until the system displays port type VM for this extension.
7) Press the Volume button (up or down) to return to the DB Item Selection screen.

Now, program the UCD members (see 366).
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B - Program the UCD Group Members for Third Party VM
You must also program the UCD group members - see “Programming UCDs” on page 345 for additional details. If
you have not assigned the VM port type, go back to page 363 and do so now.

PROGRAM THE UCD GRoOUP MEMBERS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling
Syskem Resource

Restriction

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

Auto Recording Member

1) Go to ProgrammingP>Extension Application® Uniform Call Distribution to display the UCD: Parameters
screen.

Xl

Attribute: |UCD vI Overflow 1 Timer: |U Sec. (0-255)
Tenant Group: |1 vi Overflow 1 Dest. | vI

Mame: | Overflow 2 Timer: |D Sec. (0-255)

Members:l 0 Cwerflow 2 Dest. | 'I
Hunting Mathod: L inear =l overow count [T 128
Mo Answer Timer: |1D 'I Sec. REROUE Dest: I vl

Lpdate | Initialize(FS)l Close | Help |

2) Select the UCD Group you want to program as the VM hunt group (e.g., usually 24) from the Hunt Group
field.

3) Click the Members button to display the member list for the selected hunt group (e.g., 24).

Huntin et

Program the UCD Group Members via PC-DBA (continued on next page)
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Program the UCD Group Members via PC-DBA (continued)

4) Select the digital channel directory number as a member in the first field (i.e., field 1).

Hunt Group 1:410

—UCD Members
1 (-] 7 RARE] = 18] 7|
7| e | = =l ] [
3 =] 9| =15 R =l
‘ o[ S i -
5 =] 1] =7 -] 23 =
i | =] 12 x| a5 =

InitializeF &) | Close | Help |

x|

« The VM hunt group is the new UCD group you selected and programmed with the digital channel

members.

« Use the steps above to continue programming all digital channel extensions currently connected to the

voice mail.

5) Click the Close button to exit the current screen and return to the UCD programming main screen.

When you are finished programming the UCD group:

6) Click the Update button to store the settings into the database on the local disk.

7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

8) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Now, set the Call Handling Digits in the Voice Mail Table (see page 367)

PROGRAM THE UCD GROUP MEMBERS VIA THE DET

From the DB Item Selection screen:

1) Enter 06-01-XX-04 (where XX is the group number: 01~24).

2) Press show to display Member #1 of the UCD group you specified.

3) Press chg.

4) Enter the extension directory of the analog port to program into this member.

5) Press save to store the setting.
6) Press next.

« Continue programming all voice mail ports as member of this UCD group, as needed, using the steps

above.

7) Press the volume UP button to return to the DB Item Selection screen.

Now, set the Hunt Group and Call Handling Digits in the Voice Mail Table (see page 370)
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C - Set Up the Voice Mail Table
(Call Handling Digits) for Third Party VM

Once the VM port type is assigned and the UCD members are programmed (see previous pages), you need to set the
Call Handling digits in the Voice Mail Table. These settings will tell the system how to handle incoming calls with regard
to the voice mail system.

SET THE CALL HANDLING DiGITS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Call Handling

Syskem Resource
iction

'DX-120

Unifarm Call Distribution

Auto Recording Mgber

.0, Line Application
System Application
Feature Key Programming
K5U DE Password

* v vRid v v~

RP: Extension Application - ¥Yoice Mail Table

4

Note:0-9#AB/C/D

Tenant: |_ l
WM Hunt Group: |D 'l

—Prefix Table

ICMAM Button: [#2
Transfer: I#’Ii

Busy Forward: |#37
Mo Ans Forward: r

Direct Forward: I#Si
CO Greeting: I#ﬁi
CORecal: [#8
UCD Overflow: IS‘DDi

Suffix Digit: |
Record Digit: |#? 8]

Delete Digit: |
isconnect Digit: |"*‘*‘*

Update | Initialize(FB)l

Close | Help |

2) Select the tenant group for which you want to program voice mail.

Set the

Call Handling Digits via PC-DBA (continued on next page)
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Set the Call Handling Digits via PC-DBA (continued)

3) Make the settings as described in the table below:

FOR THIS FIELD...

CALL HANDLING DIGIT FIELDS

DO THIS...

VM Hunt Group

Select the voice mail table to reference the UCD group you want to use for
the voice mail ports (e.g., usually 24)

PREFIX TABLE

ICM/VM Button

Enter the prefix numbers that you want the system to use when identifying a
call as originating at the mailbox owner's extension.

« Valid codes can include digits 0-9, *, #, and letters A-D.
« The default for this field is #2.

Transfer

Enter the prefix numbers that you want the system to use to identify a call as
"transferred" to mailbox.

« Valid codes can include digits 0-9, *, #, and letters A-D.
e The default for this field is #1.

Busy Forward

Enter the prefix numbers that you want the system to use to identify a call as
"“forwarded" from a busy mailbox.

« Valid codes can include digits 0-9, *, #, and letters A-D.
* The default for this field is #3.

No Ans Forward

Enter the prefix numbers that you want the system to use to identify a call as
"forwarded" from an unanswering mailbox.

« Valid codes can include digits 0-9, *, #, and letters A-D.
» The default for this field is #4.

Direct Forward

Enter the prefix numbers that you want the system to use to identify a call as
coming directly forwarded from a specific mailbox.

« Valid codes can include digits 0-9, *, #, and letters A-D.
» The default for this field is #5.

Enter the prefix numbers that you want the system to use to identify a call as
a specific CO line.

CO Greeting « Valid codes can include digits 0-9, *, #, and letters A-D.
 The default for this field is #6.
Enter the prefix numbers that you want the system to use to identify a call as
a specific CO line recalling.

CO Recall

« Valid codes can include digits 0-9, *, #, and letters A-D.
e The default for this field is #9.

UCD Overflow

Enter the prefix numbers that you want the system to use to identify a call as
a UCD overflow announcement.

« Valid options include any valid extensions on the system.
» The default for this field is #300.

Call Handling Digit Fields (continued on next page)
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CALL HANDLING DIGIT FIELDS (continued)

FOR THIS FIELD... DO THIS...

Enter the suffix digits that you want the system to use to identify a call as the
mailbox owner.

« Valid codes can include digits 0-9, *, #, and letters A-D.
» The default for this field is blank (none).

Suffix Digit

Enter the digits that you want the system to activate recording for a mailbox
owner.

« Valid codes can include digits 0-9, *, #, and letters A-D.
* The default for this field is #7.

Record Digit

Enter the digits that you want the system to use to delete the current record-
ing for a mailbox owner.

« Valid codes can include digits 0-9, *, #, and letters A-D.
» The default for this field is blank (none).

Delete Digit

Enter the digits that you want the system to use to force disconnect of the
active port.

« Valid codes can include digits 0-9, *, #, and letters A-D.
» The default for this field is ****** (6 asterisks).

Disconnect Digit

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Now, set the Voice Mail Dialing Ratio (see page 377)
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SET THE CALL HANDLING DIGITS VIA THE DET

=3 NOTE

.é ¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Press next to display each of the Call Handling Digits setting screens.

Setting Hunt Group for the VM table:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 06-02-X-01 (where X is the Tenant Group: 1~3).
5) Press save to display the Voice Mail Table for Tenant 1 — Hunt Group.
6) Press chg.

7) Enter the UCD group (0~24) you want to use as the VM hunt group.

e The VM hunt group is the UCD group where you have programmed all of the VM type analog ports as
members.

8) Press save to store the setting.

9) Press next to continue programming the Prefix Table - ICM/VM (now to go step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)

- 370 -



DX-120 Programming Manual PROGRAMMING THIRD PARTY VOICE MAIL

Set the Call Handling Digits via the DET (continued)

Programming the VM Table — Prefix Table — ICM/VM:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-01 (where X is the Tenant Group: 1~3).
5) Press save to display the ICM/VM screen.
6) Press chg.

7) Enter the prefix numbers you want the system to use when identifying a call as originating at the mailbox
owner’s phone.

8) Press save to store the setting.

9) Press next to continue programming the Prefix Table - Transfer (now to go step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming the VM Table — Prefix Table — Transfer:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-02 (where X is the Tenant Group: 1~3).
5) Press save to display the Transfer screen.
6) Press chg.

7) Enter the prefix numbers you want the system to use to identify a call as transferred to mailbox.
8) Press save to store the setting.

9) Press next to continue programming the Prefix Table - Busy FWD (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)

- 371 -



PROGRAMMING THIRD PARTY VOICE MAIL DX-120 Programming Manual

Set the Call Handling Digits via the DET (continued)

Programming the VM Table — Prefix Table — Busy FWD:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-03 (where X is the Tenant Group: 1~3).
5) Press save to display the Busy FWD screen.
6) Press chg.

7) Enter the prefix numbers you want the system to use to identify a call as forwarded from a busy mailbox.
8) Press save to store the setting.

9) Press next to continue programming thePrefix Table - No Answer FWD (now go to step 6 in the next
section).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Table — Prefix Table — No Answer FWD:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-04 (where X is the Tenant Group: 1~3).
5) Press save to display the No Answer FWD screen.
6) Press chg.

7) Enter the prefix numbers you want the system to use to identify a call when forwarded from a mailbox-no
answer.

8) Press save to store the setting.

9) Press next to continue programming the Prefix Table - Direct FWD (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)
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Set the Call Handling Digits via the DET (continued)

Programming the VM Table — Prefix Table — Direct FWD:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-05 (where X is the Tenant Group: 1~3).

5)
6)
7

8)
9)

Press save to display the Direct FWD screen.
Press chg.

Enter the prefix numbers you want the system to use to identify a call as immediately from this mailbox
owner.

Press save to store the setting.

Press next to continue programming the Prefix Table - CO Greeting (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Table — Prefix Table — CO Greeting:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-06 (where X is the Tenant Group: 1~3).

5)
6)
7
8)
9)

Press save to display the CO Greeting screen.

Press chg.

Enter the prefix numbers you want the system to use to identify a call as a specific CO line.

Press save to store the settings.

Press next to continue programming the Prefix Table - CO Recall (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)
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Set the Call Handling Digits via the DET (continued)

Programming VM Table — Prefix Table — CO Recall:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-07 (where X is the Tenant Group: 1~3).
5) Press save to display the CO Recall screen.
6) Press chg.
7) Enter the prefix numbers you want the system to use to identify a call as a specific CO line recalling.
8) Press save to store the setting.

9) Press next to continue programming the Prefix Table - UCD Overflow (now go to step 6 in the next
section).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Table — Prefix Table — UCD Overflow:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-02-08 (where X is the Tenant Group: 1~3).
5) Press save to display the UCD Overflow screen.
6) Press chg.
7) Enter the prefix numbers you want the system to use to identify a call as a UCD Overflow Announcement.
8) Press save to store the setting.

9) Press next to continue programming the VM Table - Suffix Digit (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)
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Set the Call Handling Digits via the DET (continued)

Programming VM Table — Suffix Diqit:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-03 (where X is the Tenant Group: 1~3).
5) Press save to display the Suffix screen.
6) Press chg.
7) Enter the suffix numbers you want the system to use to identify a call as the mailbox owner.

8) Press save to store the setting.

9) Press next to continue programming the VM Table - Record Digit (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Table — Record Digit:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-04 (where X is the Tenant Group: 1~3).
5) Press save to display the Record Digit screen.

6) Press chg.

7) Enter the numbers you want the system to use to activate recording for this mailbox owner.
8) Press save to store the setting.

9) Press next to continue programming the the VM Table - Delete Digit (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Set the Call Handling Digits via the DET (continued on next page)
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Set the Call Handling Digits via the DET (continued)

Programming VM Table — Delete Digit:

From the DB Item Select screen (see steps 1 through 3 on page 370):
4) Enter 06-02-0X-05 (where X is the Tenant Group: 1~3).
5) Press save to display the Delete Digit screen.
6) Press chg.
7) Enter the numbers you want the system to use to delete the current recording for this mailbox owner.

8) Press save to store the setting.

9) Press next to continue programming the various call handling digits VM Table - Disconnect Digit (now go
to step 6 in the next section).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Table — Disconnect Digit:

From the DB Item Select screen (see steps 1 through 3 on page 370):
10) Enter 06-02-0X-06 (where X is the Tenant Group: 1~3).
11) Press save to display the Disconnect Digit screen.
12) Press chg.
13) Enter the numbers you want the system to use to to force disconnect of the active port.
14) Press save to store the settings.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Now, set the Voice Mail Dialing Ratio (see page 379)
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D - Set the Voice Mail Dialing Ratio for Third Party VM

VM dialing ratio is the length of the DTMF (i.e., Tone Time), as well as the length of time between digits (i.e., Inter-
digits) being sent to the voice mail. This is because some voicemail systems may need longer tones to be able to
detect what digit is being sent or it may be that the voicemail may need more or less time between digits.

SET THE VOICE MAIL DIALING RATIO VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Feature Control
Syskem Resource .3 W
Restriction 3 CID Programntiig Code
Extension Application 3 DISA
C.0, Line Application » Auto Attendant
System Application 2 Tenant Calling
Feature Key Programming  #

S Password _

1) Go to ProgrammingP>Call HandlingP Timing to display the Call HandlingTiming screen.

| RP:Call Handling-Timing ll
Carnp On Interval: |m'l Sec.  Estension Alarm Play Time:  [30 ~| Sec. PBX Auto Pause: |1.D 'l Sec.
Call Duration Time: |10 =] Ser. FAXRing Time: 4 ~| ssc. Ring On Recognition Time: [100 =] ms
CO Line Guard Time:  |1.0 x| Sec. Hold Abandon | Goo r| ms Ring Abandon: |6 vl Sec.
COFlash: |08 x| sec R IV | oot Talk Abandon Time:  |600 =] ms
i ime: - Meet Me Conference Talk Time: | mi | Mi
CID Ring Time:  |3.5 x| gec. 1] 7| Min. Unsupervised Talk Time: |7 = Min.
DialWaitTime:  |o Tl sec Fle i) 0.0 'I Sec. M Monitor Time: |1D 'l Sec.
Dial Delay Time:  [100 x| ms FPBEX Flash: |og *| Sec. ®FR_BRecall: |60 *| Sec.
Ex_Hold Tirne: |3 vl Mit. Predefined Forward Time: |10 x| gec. ¥FR_|Recall: [ag -| Sec
— Aut tic Redial —————————— —Dialing Ratio:
utomatic Redia _ oAl ~External CFW———————————
Attempts: |2 | Times Break Time: |gn | me. Sohi
: — == BRICED | Always b
Intereal: |gn ~| Sec Inter-Diait: - —
7| sec. 800 s TalkTirme: [5 ~ [min.
Waiting Time: |15 *| Sec. Tone Time: |[7q »| ms. —
—Hold Racall————— SLT Hook Flash WM Dialing Ratio————  ~Warning Time———————————
oLt [10 = [Min Start {200 =|ms. Tone Time: |60 x|ms. Outgoing CaII:|5 'I Min.
DEKT: [1.0  «|Min. End: 11000 ~|ms. Int-Digit Time: |60 »|ms. Incorming CaII:|5 vl Min.
Update InitializedF &) Close Help |

Set the Voice Mail Dialing Ratio via PC-DBA (continued on next page)
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Set the Voice Mail Dialing Ratio via PC-DBA (continued)

From the Dialing Ratio fields near the center bottom of the screen.

%M Dialing Ratio
Tone Time: |60 T |ms.
Int-Digit Time: |60 rlms. Wi Dialing Ratio
Tone Time:
90 . Int-Digit Time:
tialize(Fa) | 10 | g
. .

2) Select the information for the fields as described below:

For this field... Select...

The time you want the system to pause between each pulse during
out-dialing.

Inter-Digit « Valid options are 60, 90, 120, and 150 milliseconds.
« Default is 60 milliseconds.
The length of time you want the system to play each individual
DTMF tone during out-dialing.

Tone Time « This time is also used for time between DTMF digits.

« Valid options are 60, 90, 120, and 150 milliseconds.
* Default is 60 milliseconds.

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.

4) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Set the Voice Mail Dialing Ratio (continued on next page)
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Set the Voice Mail Dialing Ratio (continued)

SET THE VOICE MAIL DIALING RATIO VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to actuate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Press next to display each of the Call Handling Digits setting screens.

Programming VM Dialing Ratio — Tone Time:

From the DB Item Select screen (see steps 1 through 3 above):

4) Enter 03-34-01.

5) Press save to display the Call Handling — VM Dialing Ratio — Tone Time screen.

6) Press chg until you see the appropriate Tone Time you want to use.

7) Press next to display the Inter-digit Time screen (now go to step 6 in the next section).
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).

Programming VM Dialing Ratio — Inter-Digit Time:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 03-34-02.
5) Press save to display the Call Handling — VM Dialing Ratio — Inter-Digit Time.
6) Press chg until the inter-digit time you want to use displays.
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

E- Activate Automated Attendant for Third Party Voice Malil

To activate Automated Attendant, set the answering position to the UCD group directory number that coincides with
voice mail (usually 433, UCD Group 24). See “Setting the Answer Position for Day and Evening” on page 104 for
details about making the appropriate settings via PC-DBA and/or DET.
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PROGRAMMING OPTIONAL INTERNAL DIGITAL VOICE MAIL

The optional DX-120 Voice Mail processing solution is fully integrated with the DX-120 system. Performance of the
digitally integrated DX-120 Voice Mail is notably superior to that of a regular analog integration. When you add the DX-
120 Voice Mail to the DX-120 system, the digital interface has the advantage of adding up to eight ports of voice mail.

= NOTE
.é « There is no port loss if you use the internal digital voice mail.

* When you install the DX-120 Voice Mail and turn the power back on, the DX-120
system detects the DX-120 Voice Mail system and configures it automatically.

= The DX-120 digital integration is easy to install because it automates setup of the three primary functions users
want in a voice processing system:

Voice Messaging
Automated Attendant
Screen Routing

* Some of the capabilities that the DX-120 Voice Mail adds include the following:

Automated Attendant

Extension-Unique Voice Mailboxes (100 mailboxes in the basic package)
Call Forward to Extension Voice Mailboxes

All Call Handling Conditions

Answering Machine Emulation

UCD Overflow Queue Announcements

Screen Routing

Voice Record

Automatic Voice Record

Specific CO Line Greetings on Automated Attendant

FAX Tone Detect supported an all calls answered by Auto Attendant

e The following conditions apply to the internal voice mail option:

When transferring a call to voice mail, callers can choose to enter no mailbox number. If they do so, the
system routes the caller to the voice mail main greeting (e.g., Auto Attendant greeting).

If no voice mail channels are available at the time callers place a call into voice mail, the system plays a ring-
back tone until a channel becomes available.

When voice mail ports are used heavily (high call traffic), the system updates message indications notably
slower than usual.

When VM messages are waiting, the system flashes the auxiliary lamp green.
You can program the voice mail code Feature 6 4 on any available Flexible Feature Button.

When the voice mail code is programmed on a Feature Button, the system flashes the associated LED red
when VM messages are waiting.

You can program the voice mail UCD Group directory number (usually 433) on any available Flexible Feature
Button.
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Basic Internal Voice Mail Proagramming Tasks

A) Specify the UCD group used as the voice mail group, as necessary

B) Set the voice mail table to reference the UCD group you want to use for voice mail
C) Activate Automated Attendant

A- Specifving the UCD Group for Internal VM
The first thing you’ll need to do when setting up Internal voice mail is program the UCD group members - see
“Programming UCDs” on page 345 for additional details.

SPECIFYING THE UCD GRoup viA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line
Call Handling

Syskem Resource
Restriction

>
DX-120
Unifarm Call Distribution
Waoice Mail Table
Auto Recording Member

Extension Application
C.0, Line Application
Syskem Application
Feature Key Programming
K5U DE Password

* v vRid v v ¥~

1) Go to ProgrammingP>Extension Application® Uniform Call Distribution to display the UCD: Parameters
screen.

RP: Extension Application - UCD: Parameters ﬂ
Hurt Grou: -

Attribute: |UCD vI Overflow 1 Timer: |U Sec. (0-255)
Tenant Group: |1 vi Overflow 1 Dest. | vI
Mame: | Overflow 2 Timer: |D Sec. (0-255)

Members:l 0 Overflow 2 Dest: | vI
DT ILinear [~ | Overflow Count: |1 {1-128)
Mo Answer Timer, |10 -| Sec Re-Routa Dest: I ,I

Lpdate | InitializedF &) | Close | Help |

2) Select the UCD Group you want to program as the VM hunt group (e.g., usually 24) from the Hunt Group
field.

3) You will also need to make this setting in the Voice Malil table (see “Set up the UCD Group in the Voice
Mail Table via PC-DBA” on page 383)

4) Click the Members button to display the member list for the selected hunt group (e.g., 24).

Huntin et

Specifying the UCD Group via PC-DBA (continued on next page)
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Specifying the UCD Group via PC-DBA (continued)

5) Select the digital channel directory number as a member in the first field (i.e., field 1).

5
Hunt Groug 1:410
~UCD Members
e - -
A I —
3 =] e |15 =il =
A =] 1nf <] 18 ~| 22 |
5 =] 1 =] ]2 =
6 | =] 12| R i | 2 4

Initialize(F &} | Close | Help |

¢ The VM hunt group is the new UCD group you selected and programmed with the digital channel
members.

¢ Use the steps above to continue programming all digital channel extensions currently connected to the
voice mail.

When you are finished:

6) Click the Update button to store the settings into the database on the local disk.
7) Click the Close button to exit the current screen and return to the PC-DBA main screen.
Now, go set up the UCD group in the Voice Mail Table... (see page 383)

SPECIFYING THE UCD GRoOuUP VIA THE DET

—x NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.

Use the three buttons below the LCD display to actuate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 06-01-24-04 (where 24 represents the group number).

5) Press save to display the UCD group member.

6) Press show to display Member #1 of the UCD group you specified.

7) Press chg.

8) Enter the extension directory of the voice mail port to program into this member.
9) Press save to store the setting.

10) Press next to display the next UCD group member.

« Continue programming all voice mail ports as member of this UCD group (as needed), using the steps
above.

OR

11) Press the the volume UP button to return to the DB Item Selection screen.

Now, set the UCD Group in the Voice Mail Table (see page 384)
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B - Setting up the UCD Group in the Voice Mail Table for Internal VM

After you change the UCD group, you need to then set it up in the Voice Mail table.

SET UP THE UCD GROUP IN THE VOICE MAIL TABLE VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension

C.0, Line

Call Handling
Syskem Resource

'DX-120

Unifarm Call Distribution

Auto Recording Mgber

Restriction

Extension Application
C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

* v vEd v v v

1) Go to ProgrammingP Extension Application®Voice Mail Table to display the Extension Application Voice
Mail Table screen.

RP: Extension Application - ¥Yoice Mail Table ﬂ
Tenart: | -] Mote:0-3/H#ABICD
WM Hunt Group: |D 'l
—Prefix Table

IS Button: |#2 Direct Forward: I#S
Transfer: I#’Ii CO Greeting: I#ai
Busy Forward: I#Si CO Recall: l#ai
Mo Ans Forward: r UCD Overflow: IS‘DDi

Suffix Digit: | Delete Digit: |
Record Digit: |#? Disconnect Digit: |"*‘*‘*

Update | Initialize(FB)l Close | Help |

2) Select the tenant group for which you want to program voice mail.

3) Select the voice mail table to reference the UCD group you want to use for the hunt group (e.g., 24 as it
was set in step 2 on page 381).

=y NOTE
The system ignores all other fields on this screen because you are using DX-120
Voice Mail (vs. a third party voice mail system).

When you are finished:
4) Click the Update button to store the settings into the database on the local disk.
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Set up the UCD Group in the Voice Mail Table (continued on next page)
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Set up the UCD Group in the Voice Mail Table (continued)

SET UP THE UCD GROUP IN THE VOICE MAIL TABLE VIA THE DET

[ NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to actuate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 06-02-0X-01 (where X is the Tenant Group: 1~3).

5) Press save to display the Voice Mail Table for Tenant 1 — Hunt Group.
6) Press chg.

7) Enter the UCD group you want to use as the VM hunt group (i.e., 24).
e The VM hunt group is the UCD group where you have programmed all of the VM type analog ports as
members.

8) Press save to store the setting.
9) Press next to continue programming the various call handling digits (prefix/suffix).
OR
10) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

C- Activate Automated Attendant for Internal Voice Mail

To activate Automated Attendant, set the answering position to the UCD group directory number that coincides with
voice mail (usually 433, UCD Group 24). See “Setting the Answer Position for Day and Evening” on page 104 for
details about making the appropriate settings via PC-DBA and/or DET
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SECTION 10 - PROGRAMMING EXTENSIONS

OVERVIEW

The final step in setting up a DX-120 system is programming the individual extensions. The DX-120 supports the
following phone types:

= DET phones—digital speakerphone with LCD display and 30 programmable feature buttons

e Digital Cordless Phone—2.4 GHz digital cordless phone with speakerphone, LCD, and 6 programmable feature
buttons.

e DSS console—digital 64 button device used with associated speakerphone (typically used with the System
Attendant/Administrator’s speakerphone, but can be used with any DET phone in the system)
e SLT phones—independent analog single line telephone devices.

Q’__\‘ NOTE
.é e The DX-120 provides you with a shortcut to use when programming extensions.
You can program one or more “baseline” extensions whose setups you want to use
for other extensions, and then copy the baseline setups to those other extensions.
¢ While the DX-120 supports SLTs, the majority of features are designed for the DET

phone. If you are using SLTs in a particular system, you must set up the analog
ports associated with those SLTs.

CAUTION

e Database changes reside only on your computer. When you have finished
making all changes to the database, perform a SEND operation to download
the new database to the DX-120 switch.

e Besuretoreview ALI programming prior to programming extensions - see
“Programming Extensions for Alternate Line IDS” on page 138

REMINDER TONES

e The system provides a specific sound to remind a user that a call processing feature is active.

= Whenever Do Not Disturb or Call Forward is enabled, the system plays this reminder tone when extension users
access intercom dial tone.

The system uses a series of faint clicks for the reminder tone.

Once users dial a digit, the system removes the reminder tone until the next time they access the intercom.

When users lift the handset or press the SPK button to active speakerphone or headset mode, the tone indicates
that Call Forward or Do Not Disturb is active.
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BASIC EXTENSION PROGRAMMING TASKS

To program the extensions in the system, perform the following tasks for each extension in the system.
e Setup Alternate Line IDs - see page 181.
= Assign a passwords and user names to the extension - see page 387
e Assign the extension to a tenant group - see page 391
* Assign the extension to a pickup group - see page 394
= Assign the extension to a paging group - see page 397
e Assign a class of service to the extension - see page 400
e Set up the Monitor classification - see page 404
= Set up intrusion capabilities - see page 407
e Set up warning tones, incoming call drops, outgoing call drops - see page 411
e Set up Off Hook Voice Announce (OHVA) - see page 415
= Enable/disable paging - see page 419
e Set up external call forward - see page 423
e Set up SMDR output - see page 427
= Assignh RAD devices - see page 429
e Set up port type - see page 430
e Set up CO line assignment - see page 433
= Set up receive assignments - see page 435
e Set up extension ring level - see page 437
e Perform directory/extension swapping - see page 439
= Configure Single Line Telephones (SLTs) - see page 438
e Assign feature buttons - see page 442

HINT
@ Also see...
» “Shortcuts that Help You Work Faster” on page 29
e “Resetting an Extension to the Default Set” on page 37.
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Assigning a User Password, Password Length,
and/or Name to Extensions

You can easily assign a password and/or user name to each extension in the system by following the instructions as
provided for each below.

= Extension Passwords

All extensions of the DX-120 system have an associated user password.
Passwords are required in order to use Phone Lock, Call Forward Remote, and Attendant features.

NOTE
Extension passwords can be changed at the extension only by using the Phone Lock
feature.

Passwords can be from four to eight characters in length.

You may want to program the overall system password length before programming individual extension
passwords.

= Extension User Names

You can assign an alphanumeric, seven-character title to each extension in the system.
The system then displays this title on the DET Speakerphone in place of the standard "EXT" message.

User names may consist of upper and lower case letters and numbers, and various "special" characters as
provided by the enhanced lettering scheme.

The system displays the user name whenever intercom calls are made for one extension to another.

The system displays the characters “EXT” whenever there is no extension user name programmed. If a user
name has been programmed, the system displays the name instead of EXT.

Names may be seven or fewer characters.

e User Password Lengths

You can set the password length from four to eight characters.
Extension passwords can be changed at the extension only by using the phone lock feature.

Changes to the length of the user password affect existing passwords - the system adds or subtracts one

default character to the end of the password.

That is, if you extend the length of the password, the system increases all passwords by adding a 0 in the

right-most position.

If you reduce the length of the password, the system truncates all passwords by one character in the right-
most position.

= NOTE
The default password for Extension 101 is "9999." Thus, changing the password
length will add or subtract 9s on this password only (e.g., changing the length to 5
makes the password change to "99999").

Assigning a User Password, Password Length,and/or Name to Extensions (continued on next page)
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Assigning a User Password, Password Length,and/or Name to Extensions (continued)

ASSIGNING A PASSWORDS, PASSWORD LENGTH,
AND USER NAMES TO EXTENSIONS VIA PC-DBA

From the PC-DBA main screen:

Programming Maintenance  Help

Extension
C.0, Line

Call Handling 3

: Resource 4 Attendant

Restriction 3 Syskem Reminder

Extension Application 3

C.0, Line Application L3 CO Line Mames

Syskem Application 13 Preprogrammed Message

Feature Key Programming  # SPD,Mo. Assignment and Programming

K5 DE Password CID Name Table Assignment and Programming
External Pager
Loud Bell

D35 Allocation

Modem And Serial Pork
Remote Ext Table

CID Transfer Table

1) Go to ProgrammingP>System ResourceP>User Names and Passwords to display the User Names and
Passwords screen.

THIS SCREEN IS COMPOSED OF TWO MAJOR PARTS:

a scrolling table of user names and passwords
/

RP: Resource - User Names and Passwords | x|
Extension User Mames Passwords
|01 | sa0 -
2:102 0000
2103 0000
4104 0000
5:105 0000
5:106 0000
7107 0000
2:108 0000
2:109 0000
10:110 0000
11:111 0000 hd|
fl Fassword
Extension User's Mame Password Lz
1:101 =l EEES
Update | InitializedF &) | Close |

an entry line you use to the name, password, and password length for each
extension.

2) Click on the line of the scrolling table for which you wish to enter a user password and/or name.
« The Extension that appears on the entry line now matches that on the table line you selected.

3) Set the appropriate password length, as needed.
¢ Valid entries are from 4 to 8 characters.

* The default is 4 characters.
AND/OR

Assigning a User Password, Password Length,and/or Name to Extensions via PC-DBA (continued on next page)
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Assigning a User Password, Password Length,and/or Name to Extensions via PC-DBA (continued)

Enter a password for this extension.
* The default for extension 101 is 9999. For all other extensions the default is 0000.

AND/OR

4) Enter a user name for this extension.
¢ The default name is blank (no name).

5) Click IEI to move the newly entered information next to the specified extension number.
* Use the steps shown above to assign passwords and/or names to other extensions as needed.
When assignments have been made:
6) Click the Update button to enter and save your settings into the database on your local disk.

7) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

8) Perform a SEND to copy your new database to the DX-120 switch system memory.

ASSIGNING A PASSWORDS, PASSWORD LENGTH,
AND USER NAMES TO EXTENSIONS VIA THE DET

e Once you have set up the Alternate Line IDs in the appropriate table, you need to program the appropriate
extensions so that the each extension will use the corresponding alternate line ID. Be sure to review all of the
conditions and results for programming Extension ALIs.

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

SETTING THE EXTENSION PASSWORD LENGTH
This setting will define the password length for all extensions.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-04-01.

5) Press save to display the current extension password length.
6) Press chg.

Setting the Extension Password Length (continued on next page)
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Setting the Extension Password Length (continued)

7) Enter the required extension password length (valid lengths 4-8).
e The default length is 4

8) Press save.
9) Press the Hold button to return to the previous menu level.
OR
Press the Volume button (up or down) to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

SETTING THE EXTENSION USER NAME

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.
4) Enter 04-05-XXX (where XXX represents the extension number: 101~204).

5) Press save to display the Extension User Name programming screen for the extension you specified (i.e.,
101~204).

6) Press chg.

7) Enter the user name for this extension using the dial pad and referring to the numbering scheme tables
(see “Appendix E - Setting Up Letter Type for Using Special Characters” on page 476).
¢ The default is null (no name).

8) Press save to store the setting.

9) Press next to display the Ext screen.
¢ You can then enter another extension number (i.e., 101~204), then press show. Then follow steps 6
through 9 for each extension for which you want to enter a name.

OR
Press the Hold button to return to the previous menu level.
OR

Press the Volume button (up or down) to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Assigning a User Password, Password Length,and/or Name to Extensions via the DET (continued on next page)
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Assigning a User Password, Password Length,and/or Name to Extensions via the DET (continued)

VIEW A USER PASSWORD
You can only use this feature to view a password. To change a password, you must use the specific extension (phone)
to which the password applies or use PC-DBA.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 04-04-02-XXX (where XXX represents the extension number: 101~204).
5) Press save to display the extension user password screen.

6) Press next to return to display the Ext screen.
¢ You can then enter another extension number (i.e., 101~204), then press show. Repeat this process for
any extension for which you want to view the password.

7) Press the volume UP button to return to the DB Item Selection screen.
OR

8) Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Assigning Extensions to Tenant Groups
You can completely isolate extension functions depending on how you assign the tenant groups; i.e., you can prohibit
calling from one tenant group to another.

e The following conditions apply when setting up tenant groups.
You can set up a maximum of three tenant groups in the DX-120 system.

- Extension directory numbers remain unique to system ports and are not duplicated for each tenant group
(although extension dialing may be restricted across tenant group barriers).

- When tenant calling is restricted from one tenant group to another tenant group, intercom calls, call transfers,
and recall operations will not operate across these designations. Note: If you want intercom calls, call
transfers, and recall operations to work across tenant group barriers, do not set up separate tenant groups.

e There are other features whose programming may affect your assignment of tenant groups to extensions.

HINT

@ You do not have to isolate extensions to be able to isolate system resources. For
information about isolating system resources without invoking full isolated tenant
operations see:

e “Setting the CO Line Type” on page 126
¢ “Assigning Ring Type for the CO Line” on page 134
e “Setting the Answer Position for Day and Evening” on page 136

Also see..."Programming Tenant Groups” on page 271.

Assigning Extensions to Tenant Groups (continued on next page)
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Assigning Extensions to Tenant Groups (continued)

ASSIGNING EXTENSIONS TO TENANT GROUPS VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.

E
‘ Extension |_v[ ‘ Update | Initialize(FS)l Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl

1:800:% - 1:800:% - [~ Drop Call Out Eve Class: m
2801y 2801 : :
3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: 4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. I—LI
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State

Alternate Line |D
Indes:{1-100)

Ii
DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: I

2) Select the extension nhumber you want to program.

Assigning Extensions to Tenant Groups via PC-DBA (continued on next page)
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Assigning Extensions to Tenant Groups via PC-DBA (continued)

3) Select the tenant group number for the group you want to assign from the Tenant Group field.

Tenant Group: |

Fickup Group: k

1
1
2
FPaging Group: |3

 Valid options are 1, 2, and 3.
e The defaultis 1.
« If your system is not divided into tenant groups, use group 1.

4) Click the Update button to enter and save your settings into the database on your local disk.
« Program other extensions as needed using the steps above.

When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ASSIGNING EXTENSIONS TO TENANT GROUPS VIA THE DET

R NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-02 (where XXX is the extension number: 101~204).

5) Press save to display the Tenant Group selection for the extension you specified.

6) Press chg until the tenant group you want to use for this extension displays.
¢ Valid options are tenant groups 1, 2, or 3.

e The defaultis 1.
« If your system is not divided into tenant groups, use group 1.

7) Press the volume UP button to return to the DB Item Selection screen.
< Assign other extensions (as needed) to tenant groups using the steps above.

OR

8) Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Extensions to Pickup Groups
The system provides eight extension pick up groups per tenant group to allow you to partition the system into separate
departments for organized call answering within the department.

An extension owner in a pick up group may retrieve calls ringing at another extension within the same pick up group.
Extension Pickup Groups are defined in the DX-120 Numbering Plan (see “Customizing the Numbering Plan” on
page 103).
= The following conditions apply to pickup groups.
- You can assign an extension to one pick up group only.
- Pick up priority is CO line calls first, then intercom calls.
- COline call priority is: camped-on calls first, recalling calls second, transferred calls third, then incoming calls.
- Intercom call priority is ringing calls, then voice calls.

HINT
Q Also see “Customizing the Numbering Plan” on page 103.
ASSIGNING EXTENSIONS TO PickuP GROUPS VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Assigning Extensions to Pickup Groups via PC-DBA (continued on next page)
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Assigning Extensions to Pickup Groups via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

E
‘ Extension |_v[ ‘ Update | Initialize(FS)l Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl

1:800:% - 1:800:% - [~ Drop Call Out Eve Class: m
2801y 2801 : :
3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803 4:803 : Tenant Group: | vl
58047 58047 SR :

BB05Y BB05Y [ SMDR output Pickup Graup: [ -
Te0enY Te0eY )

8807 B80T I Intrusion Active Faging Group: |1 'I
?naggg\(\f ?naggg\(\f [ Intrusion Accept e EXT T
11:810: 11:810: : DIR ha. |—L|
128115 128115 [ e Swapping:

13812y 13812y [~ Fir BT Disable ECF CO Group |1 vl
148137 148137

15814 15814 v Paging Alloy —Predefined Call Forward

1BB15Y 1BB15Y

17816 17816 [ Record Allow Wirong# Dest: I vl
18817y 18E1TY : .

Busy Dest: =
19818 19818 R usy Dest. | |
20:818Y | |zostev =l || & obvaaccept NoansDest [ =]

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

3) Select the pickup group number for the group you want to assign from the Pickup Group field.

Pickup Group: I1

Faging Group:
Fort Type:

DIR Mo
Swapping:

ECF CO Group

[ IR T )

« Valid options are 1 through 8.
e The default is 1.

4) Click the Update button to enter and save your settings into the database on your local disk.
« Program other groups as needed using the steps above.

When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Assigning Extensions to Pickup Groups (continued on next page)
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Assigning Extensions to Pickup Groups (continued)

ASSIGNING EXTENSIONS TO PiICKUP GROUPS VIA THE DET

IMPORTANT!

Before you begin assigning pickup groups, be sure to set up the tenant groups for
corresponding extensions (see “Assigning Extensions to Tenant Groups” on

page 391)

=3 NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-03 (where XXX is the extension number: 101~204).

5) Press save to display the Pickup Group selection for the extension you specified.

6) Press chg until the pickup group you want to use for this extension appears.
 Valid options are 1 through 8.

¢ The default is 1.

7) Press the volume UP button to return to the DB Item Selection screen.
« Assign other extensions (as needed) to pickup groups using the steps above.

OR
8) Press the Hold button to return to the previous menu level.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Extensions to Paging Groups

The system provides eight extension paging groups per tenant group to allow you to partition the system into separate
departments for page announcements.

= Extension users can also respond to a page announcement using Meet Me Paging. In this case, they dial a meet
me page code upon hearing their name paged. The system then establishes a private connection to the paging

extension.

e Paging is one-way only.
e The Page Allow/Deny setting does not interfere with an extension’s ability to make a page or to establish a meet

me page.
= The following conditions apply to paging privileges:

- The display will show PAGE FAILURE if a page fails due to that page group/zone being busy.

- You can assign any of the paging codes to a programmable feature button.

- The external pager port can be programmed to operate with any page group via system resource — external

pager programming.

- To make a page announcement, extension users have to enter the page code.
< At default the page codes are as follows:

- 400 = tenant all call

- 401~408 = page groups (zones) 1 through 8

- 777 = external pager.

NOTE
It is recommended that all page announcements be made using the handset to
reduce potential audio feedback and oscillation (squeal).

Assigning Extensions to Paging Groups (continued on next page)
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Assigning Extensions to Paging Groups (continued)

ASSIGNING EXTENSIONS TO PAGING GROUPS VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling
Syskem Resource
Restriction

C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

3
3
3
Extension Application 3
13
3
3

1) Go to ProgrammingP>Extension to display the Extensions screen.
B
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension nhumber you want to program.

3) Select the paging group number for the group you want to assign from the Paging Group field.
 Valid options are 1 through 8.

e The default is 1.
4) Click the Update button to enter and save your settings into the database on your local disk.
« Program other groups as needed using the steps above.
When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Assigning Extensions to Paging Groups (continued on next page)
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Assigning Extensions to Paging Groups (continued)

ASSIGNING EXTENSIONS TO PAGING GROUPS VIA THE DET

=3 NOTE

.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
* Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-04 (where XXX is the extension number: 101~204).

5) Press save to display the Paging Group selection for the extension you specified.

6) Press chg until the paging group you want to use for this extension appears.
 Valid options are 1 through 8.

¢ The default is 1.

7) Press the volume UP button to return to the DB Item Selection screen.
< Assign other extensions (as needed) to paging groups using the steps above.

OR

8) Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Extensions to a Class of Service
The DX-120 provides sophisticated monitoring of outbound digits dialed by extension users. You can assign COSs for
a broad range of call control.

EXAMPLE

If a digit or range of digits dialed on a CO line is inconsistent with the dialing
extension’s or CO line’s class of service, the system denies the call. You can apply
this calling COS criteria to local calls, long distance calls, and specific numbers that
are considered allowed in areas where other numbers may be restricted.

= The following conditions apply to assigning class of service to extensions:
- Callers can override an extension’s class of service if you set up an account code password (see “Assigning
a User Password, Password Length, and/or Name to Extensions” on page 387) that instructs the system to
use a different class of service for the call.

- You can set a system speed dial to override toll restriction.

EXAMPLE

Suppose your customer has a branch office out of state where they want to allow the
corporate extension users to call, while still prohibiting all other toll calls. In this case,
you can set up a system speed dial to allow calls to the branch office.

=S NOTE

.é This must be a system speed dial, as the system checks the toll restrictions for
individual speed dial numbers and abides by them. System speed dial numbers
override toll restrictions as long as you have System Speed Toll Check enabled (see
“Programming Speed Dial Numbers” on page 64).

ASSIGNING EXTENSIONS TO A CLASS OF SERVICE VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 3
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Assigning Extensions to a Class of Service via PC-DBA (continued on next page)

- 400 -



DX-120 Programming Manual BASIC EXTENSION PROGRAMMING TASKS

Assigning Extensions to a Class of Service via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

T
‘ Extension |_ -] ‘ Update | Initialize(F &) | Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl

1800 - 1800 - [~ Drop Call Out Eve Class: |D vl

2801y 2801 : :

3802 3802 I~ Drop Callin Manitor Class: |5 'l

4:803 4:803 : Tenant Group: | vl
58047 58047 SR :

B:605:Y 6:805:Y [ SMDR Outout Pickup Group: |1 vI
TB06Y TB06Y

8807 8807 [~ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R EXT -

118100 11:810:7 . DIR Ma. |
1281157 1281157 7 Intrusion Tane Swapping:

13812y 13812y I Fir BTH Disakle ECF CO Group |1 vl
14813 14813

loBley Bl I¥ Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

In the Day Class field:

Day Class; ]
Eve Class:

Monitor Class:

[Tenant Group:

Pickup Group:

— LD R =

FPaning Group:

3) Select the class of service you want to assign for the daytime hours for the selected extension.
« Valid choices are 0 through 7.

* The default is class of service 0.

In the Day Class field:

Eve Class: 1]

Monitor Class:

Tenant Graup:
Pickup Group:
Faging Group:
Fort Type:

~ M L R =

4) Select the class of service you want to assign for the evening hours for the selected extension.
« Valid choices are 0 through 7.

* The default is class of service 0.

Assigning Extensions to a Class of Service via PC-DBA (continued on next page)
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Assigning Extensions to a Class of Service via PC-DBA (continued)

5) Click the Update button to enter and save your settings into the database on your local disk.
« Program daytime and evening class of services to other extensions (as needed) using the steps above.
When all assignments have been made:

6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ASSIGNING EXTENSIONS TO A CLASS OF SERVICE VIA THE DET

$~ NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Press next to display each of the extension COS screens (see each section below for programming
information for each).

Setting the Daytime COS for an Extension:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-05 (where XXX is the extension: 101~204).
5) Press save to display the Daytime COS screen.

6) Press chg until the COS you want to assign appears.
« Valid choices are 0 through 7.

* The default is class of service 0.

7) Press next to display the Evening COS screen (now go to step 6 in “Setting the Evening COS for an
Extension:” below).

OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Assigning Extensions to a Class of Service via the DET (continued on next page)
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Assigning Extensions to a Class of Service via the DET (continued)

Setting the Evening COS for an Extension:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-06 (where XXX is the extension: 101~204).

5) Press chg until the COS you want to assign displays.
« Valid choices are 0 through 7.

e The default is class of service 0.
6) Press the volume UP button to return to the DB Item Selection screen.

@ :lszll-lg—jn daytime and evening class of services to other extensions (as needed) using
the steps above.
OR
7) Press the Hold button to return to the previous menu level.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Monitoring Privileges

The DX-120 system allows extension users to monitor conversations at other extensions, for the purpose of observing
service.

LEGAL NOTICE

A This feature may violate privacy laws if used in a manner that is inconsistent
with requirements of those laws. Vertical Communications, Inc. assumes no
responsibility with regard to the use of this feature; it is provided for the virtue
of ethical use only.

YOU are responsible for using this feature appropriately, considering all applicable laws.

e Monitoring of busy extensions and CO lines is possible only at extensions with a monitor class of service that has
a lower monitor class than the monitor COS of the extension to be monitored.

= When programming extensions, you define the monitor COS for each extension.

EXAMPLE

You may want to assign monitoring privileges to the manager in charge of your
client’s Customer Support department, so that manager has the ability to listen to how
department members handle phone inquiries. In this case, assign the department
manager a higher monitoring COS than the monitoring COS of the department
members.

e The following conditions apply to the monitoring capability.
- The highest level of priority in monitor class is “0”. The lowest priority level is “9".

- The system does not allow monitoring if the called extension’s monitor COS matches the calling extension’s
monitor COS.

- Since this feature is very similar to Intrusion (see page 407), it is possible to “shift” between these two
features when using monitor.

=y NOTE
If you assign monitoring privileges to an extension, set up a feature button for the
extension user to press to initiate the monitoring session.

HINT
@ Also see...

e Programming Feature Buttons
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SETTING UP MONITORING PRIVILEGES VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.
E
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

In the Monitor Class field:

Monitor Class:

[Tenant Group:

Fickup Group:

ok = O]

Faging Group:
Fort Type:

DIR Mo.
Swapping:

ECF CO Group

LooowcnI

3) Select the monitor class of service you want to use for this extension.
« Valid choices are classes 0 through 9 (where 0 is the highest monitoring COS and 9 is the lowest).

¢ The default is 5.

Setting Up Monitoring Privileges via PC-DBA (continued on next page)
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Setting Up Monitoring Privileges via PC-DBA (continued)

4) Click the Update button to store the setting in the database on the local disk.
« Use the procedure shown above to set monitoring for other extensions as needed.
When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP MONITORING PRIVILEGES VIA THE DET

=S NOTE
.g « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-07 (where XXX is the extension number: 101~204).

5) Press save to display the Monitor Class programming screen for the extension you specified.

6) Press chg to until you see the monitor class of service you want to use for this extension.
 Valid choices are classes 0 through 9 (where 0 is the highest monitoring COS and 9 is the lowest).

¢ The default is 5.

7) Press the volume UP button to return to the DB Item Selection screen.
< Assign monitoring services to other extensions (as needed) using the steps above.

OR

8) Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Intrusion Capabilities

Intrusion allows extension users to break into an existing call, provided you have given them the privilege to do so. This
feature can be very effective for observing service, and any time that callers have to forcibly enter a conversation on a
busy CO line or at a busy extension.

LEGAL NOTICE

A This feature may violate privacy laws if used in a manner that is inconsistent
with requirements of those laws. Vertical Communications, Inc. assumes no
responsibility with regard to the use of this feature; it is provided for the virtue
of ethical use only.

YOU are responsible for using this feature appropriately, considering all applicable laws.
e Intrusion can be used both on a busy CO line and on a busy extension.
e The following conditions apply:
- The calling extension must have Intrusion Active set to Y (yes) for this feature to operate.

NOTE
In order to use the Intrusion Active capability, you MUST have Monitoring Privileges
* set up (see “Setting Up Monitoring Privileges” on page 404)

The busy extension must have Intrusion Accept setto Y (yes) for this feature to operate.

The system plays an intrusion tone to all parties when it invokes intrusion (extensions and CO lines).
You can deactivate the intrusion tone.

SETTING UP INTRUSION CAPABILITIES VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Setting Up Intrusion Capabilities via PC-DBA (continued on next page)
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Setting Up Intrusion Capabilities via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.
E
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:Y «| [1sooy - I~ Drop Call Out Eve Class: |U 'I
2801y 2801 5 :

3802 3802 ™ Drop Call In Monitor Class: |5 -
4:803Y 4:803Y ) Tehant Group: I—L,
5804y 5804y L (EEkapctaian _ !

f:805: 6:805: [# SMDR Output Pickup Group: |1 vl
Te0enY Te0eY ) )

8807 B80T I Intrusion Active Paging Group: |1 -
9808y 9808y .

10:808: 10:808:Y ¥ Intrusion Accept e EXT X
11:810: 11:810: 5 Inrusion Tane DllRRdEy l—_l'
12:811¥ 12:811¥ Swapping:

13812y 13812y [~ Fir BT Disable ECF CO Group |1 vl
14:813Y 14:813Y

15814 15814 v Paging Alloy —Predefined Call Forward

16:8157Y 16:8157Y

17816 17816 [ Record Allow Wrong# Dest: I 'I
18817 18817 - . I—L,
198185 19:81 85 B S HisrhEst

20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl
Double Clicking Listed lterm to change State Alternate Line D

Indes:{1-100) I

DSS Unit1: | 0SS Unit 2: | DSS Unit 3: | DSS Unit 4: |

2) Select the extension number you want to program.

3) Click the checkbox (I ) next to Intrusion Active to place a check mark there to enable the Intrusion
feature (V).
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

« The default is no (no checkmark I )

EXAMPLE
If you want to allow supervisors to intrude on calls in their department, set this option
to yes for the supervisor’s extension.

4) Make sure there is a checkbox (¥ ) next to Intrusion Accept to enable the Intrusion Accept feature.
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no
checkmark 7).

« The default is yes (checkmark & ).

EXAMPLE

If you want to keep supervisors’ calls private, set this field to no for the supervisor’s
extension. If you want to allow supervisors to intrude on calls in their department, set
this option to yes for the department employees’ extensions.

Setting Up Intrusion Capabilities via PC-DBA (continued on next page)
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Setting Up Intrusion Capabilities via PC-DBA (continued)

5) Click the Update button to store the settings into the database on the local disk.
« Use the procedure described above to program the intrusion privileges for other extensions as needed.
When you are finished:

6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP INTRUSION CAPABILITIES VIA THE DET

$~ NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Setting the Intrusion Active Option:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-11 to set the intrusion privilege for an extension (where XXX is the extension: 101~204).
5) Press save to display the Intrusion Active screen.

6) Press chg to select Y or N.
e The default is no.

7) Press next to select the Intrusion Accept field which allows you to choose whether or not you want to
ALLOW intrusion on this extension (now go to step 6 in “Setting the Intrusion Accept Option:” below).

HINT
@ Assign Intrusion Privileges to other extensions (as needed) using the steps above.

8) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Intrusion Capabilities via the DET (continued on next page)
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Setting Up Intrusion Capabilities via the DET (continued)

Setting the Intrusion Accept Option:

From the DB Item Select screen (see steps 1 through 3 on page 409):

4) Enter 01-XXX-12 to set the intrusion privilege for an extension (where XXX is the extension: 101~204).
5) Press save to display the Intrusion Accept screen.

6) Press chg to select Y or N.
e The default is yes.

7) Press next to select the Intrusion Tone field which allows you to choose whether or not you want the

system to play warning tones when it initiates an intrusion on this extension (now go to step 6 in “Setting
the Intrusion Tone Option:” below).

HINT
@ Assign Intrusion Privileges to other extensions (as needed) using the steps above.
8) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting the Intrusion Tone Option:

From the DB Item Select screen (see steps 1 through 3 on page 409):

4) Enter 01-XXX-13 to set the intrusion privilege for an extension (where XXX is the extension: 101~204).
5) Press save to display the Intrusion Tone screen.

6) Press chg to select Y or N.
e The default is yes.

HINT
@ Assign Intrusion Privileges to other extensions (as needed) using the steps above.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting up Warning Tones,
Incoming Call Drops. Outgoing Call Drops

You can limit an extension to calls that fall within a specific programmed time.

EXAMPLE
A company can use this feature in a lobby or retail environment where lengthy calls
are discouraged.

e You can set the DX-120 to either:

- warn an extension that the time has expired, thereby advising the extension user to disconnect. In this mode,
the system plays a warning tone repeatedly once the timer has expired.

- automatically disconnect the call moments after playing the warning tone. You can choose between dropping
incoming calls, dropping outgoing calls, or both.

e You program the time allowed for calls while programming call handling.
IMPORTANT!
Extension users can make additional calls after the system plays the warning tones

or drops the call. Therefore, itis NOT recommended that this feature be used as a
toll saver option. Use this feature only for specific applications.

HINT
@ Also see...

» “Establishing Warning Time for Limited Call Lengths” on page 210.
» “Specifying Call Duration Time” on page 258.
e “Section 7 - Programming Toll Restrictions” on page 329.

P

SETTING UP WARNING TONES,
INCOMING CALL DROPS, OUTGOING CALL DrRoOPS viA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via PC-DBA (continued on next page)
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Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

T — E
‘ Extension |_ -] ‘ Update | Initialize(F &) | Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :
FE0ZY FE0ZY I~ Drop Callin Monitor Class: [5 -
4:803 4:803 : Tenant Group: -
8043 8043 I i _ [1 |
6805 6805 % SMDR Output Pickup Group: |1 vl
Te0enY Te0eY ) )
8:807: 8807 [ Intrusion Active Paging Group: |1 vl
9:808Y 9:808Y .
10:808: 10:808:Y I Intrusion Accept i EXT X
11:810:7 11:810:7 I Intrusion T DIR Ma. l—_l'
12811 12811 E Swapping:
1aszy Tamzy [~ Fir BT Disable ECF CO Group |1 vl
14813 14813
15:8147% 15:814% I Paging Allow —Predefined Call Forward
16818 16:818Y
17816 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3 =
19818 19:818 il Busy Dest: | |
2008195 [d I DR =l || 7 oHvaAccept MoAns Dest: |—_,v
Double Clicking Listed lterm to change State Alternate Line D
Indes:{1-100) I
DSS Unit 1: | DSS Unit 2: I DSS Unit 3: | DSS Unit 4: I

2) Select the extension number you want to program.
 Valid entries include any non-conflicting extension number.

3) Set options described below:

OPTION MEANS MEANS
The system plays warning tones on
this extension when the warning time
limit has expired.
Warning HINT The tones will not be played.
Tone @ For details on the warning * The default is no.
time limit, see “Establishing
Warning Time for Limited
Call Lengths” .
h ‘ ild { goi I If you select no, the calls will not be
Drop Call Out e system will drop out going calls dropped.
after the warning time has expired. .
* The default is no.
The system will drop incoming calls If you select no, it does not.
Drop Call In Lo ; .
after the warning time has expired. « The default is no.

Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via PC-DBA (continued on next page)
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Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via PC-DBA (continued)

4) Click the Update button to store the settings into the database on the local disk.
« Use the procedure shown above to make these same settings for other extensions.
When you are finished:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP WARNING TONES,
INCOMING CALL DROPS, OUTGOING CALL DROPS VIA THE DET
Qh-\'- NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
y Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-08 (where XXX is the extension: 101~204).
5) Press save to display the Warning Tone screen.

6) Press chg to select whether or not you want the system to play warning tones on this extension when the
warning time limit has expired.
« Valid options are Y or N.

e The default is N (no) - do NOT use a warning tone.

HINT
@ See “Establishing Warning Time for Limited Call Lengths” on page 242.

7) Press next for the Drop Call Out screen (now go to step 6 in “Setting the Drop Out Call option:” below).

HINT
@ Set Warning Tones for other extensions (as needed) using the steps above.

8) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via the DET (continued on next page)
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Setting up Warning Tones, Incoming Call Drops, Outgoing Call Drops via the DET (continued)

Setting the Drop Out Call option:

From the DB Item Select screen (see steps 1 through 3 on page 409):
4) Enter 01-XXX-09 (where XXX is the extension: 101~204).
5) Press save to display the Drop Out Call screen.

6) Press chg to specify if you want the system to drop outgoing calls after the warning time has expired.
« Valid options are Y or N.

e The default is N (no) - do NOT use Drop Out Call.
HINT
Q Set Drop Out Call for other extensions (as needed) using the steps above.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the Drop In Call option:

From the DB Item Select screen (see steps 1 through 3 on page 409):
4) Enter 01-XXX-10 (where XXX is the extension: 101~204).
5) Press save to display the Drop In Call screen.

6) Press chg to specify if you want the system to drop incoming calls after the warning time has expired.
« Valid options are Y or N.

e The default is N (no) - do NOT use Drop In Call.

HINT
@ Set Drop In Call for other extensions (as needed) using the steps above.

7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Off Hook Voice Announce

With Off Hook Voice Announce (OHVA), extension users can receive a voice announcement from a DX-120 system
extension while their telephone is busy. OHVA uses the speakerphone circuit to accommodate a second conversation
path to the telephone.

= When programming individual extensions, you allow or disallow use of OHVA.
This includes determining if the extension can use OHVA, and whether the extension can receive OHVA.

e To receive an OHVA call, extension users must be using the handset for the call in progress (they cannot be on
speakerphone and receive an OHVA announcement).

= An OHVA call can easily be rejected if the call in progress should not be interrupted.

e The following conditions apply to OHVA:

- When placing an OHVA call to an extension that is busy using the speakerphone, the display options will not
include the voice option.

- If extension users are on a line and have mute activated, the line will remain muted until the Voice Over Busy
is complete.

IMPORTANT!
Incoming calls cannot be received by a phone connected to a DPM16 (7221).
However, outgoing calls can be placed from a phone connected to a DPM16.

SETTING UP OFF HOOK VOICE ANNOUNCE VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Setting Up Off Hook Voice Announce via PC-DBA (continued on next page)
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Setting Up Off Hook Voice Announce via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

RP: Extension

‘ Extension |_ -] ‘ Update | Initialize(F &) | Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3802 3802 I~ Drop Callin Monitor Class: |5 -
4:803Y 4:803Y ) Tehant Group: I—L,
5804y 5804y L (EEkapctaian _ !

EB05Y 05 [ SMDR Output Pickup Group: |1 vl
Te0enY Te0eY ) )

8807 B80T I Intrusion Active Paging Group: |1 -
9808y 9808y .

10:808: 10:808:Y ¥ Intrusion Accept e EXT X
11:810: 11:810: 5 Inrusion Tane DllRRdEy l—_l'
12:811¥ 12:811¥ Swapping:

13812 13812 I~ Fir BTN Disable ECF CO Group |1 vl
14:813 14:813Y

15814 15814 v Paging Alloy —Predefined Call Forward

16:815: 16:815:

17816 17816 [ Record Allow Wrong# Dest: I 'I
18817 18:817: - : I—L,
198185 19:81 85 B S HisrhEst

2089y - 20819y - MoAns Dest: -

W OHvA Accept

Double Clicking Listad Item ta ch Stat

ouple Clcking Liste BIM 10 change olate Alternate Line 1D Ii

Indes:{1-100)

DS Unit1: | DS Unit 2: | DS Unit 3: | DSS Unit 4: |

2) Select the extension number you want to program.

In the OHVA Active and OHVA Accept fields at the bottom center of the screen:

3) Make sure there is a checkbox (¥ ) next to OHVA Active to enable the OHVA Active option.
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no

checkmark 7).

+ The default is yes (checkmark )

EXAMPLE

If you want to be able to use OHVA to contact other extensions, set this option to yes.

Setting Up Off Hook Voice Announce via PC-DBA (continued on next page)
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Setting Up Off Hook Voice Announce via PC-DBA (continued)

4) Make sure there is a checkbox (¥ ) next to OHVA Accept to place a check mark there to enable the
OHVA Accept option.
« Clicking on this box toggles the setting between yes/enable (a checkmark ¥ ) and no/disable (no

checkmark 7).

+ The default is yes (checkmark ¥ ).

EXAMPLE
If you do not want to allow others to contact you using OHVA, set this option to no (no

checkmark).

5) Click the Update button to store the setting in the database on the local disk.
¢ Use the procedure shown above to set OHVA capabilities for other extensions as needed.

When you are finished:
6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP OFF HOOK VOICE ANNOUNCE VIA THE DET

=y NOTE
.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

Setting the OHVA Active Option:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-14 (where XXX is the extension: 101~204).
5) Press save to display the OHVA Active screen.

6) Press chg to specify whether or not you want to this extension to be able to make announcements to

other extensions.
« Valid options are Y or N.
e The defaultis Y (yes) - allow announcements to be made from this extension.

Setting the OHVA Active Option (continued on next page)

- 417 -



BASIC EXTENSION PROGRAMMING TASKS DX-120 Programming Manual

Setting the OHVA Active Option (continued )
7) Press next for the OHVA Accept screen (now go to step 6 in “Setting the OHVA Accept Option:” below).
OR
HINT
Q Set the OHVA Active option for other extensions (as needed) using the steps above.

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.

OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting the OHVA Accept Option:

From the DB Item Select screen (see steps 1 through 3 on page 417):
4) Enter 01-XXX-15 (where XXX is the extension: 101~204).
5) Press save to display the OHVA Accept screen.

6) Press chg to specify whether or not you want this extension to receive OHVA from other extensions.
« Valid options are Y or N.

* The defaultis Y (yes) - allow OHVA to be heard on this extension.
OR

HINT
@ Set the OHVA Active option for other extensions (as needed) using the steps above.

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Paging Privileges

Extension users can perform several types of page announcements:

Internal Paging - they can page a group or place a system-wide internal page.
External Paging - they can access external ancillary paging equipment.
All Call Paging - they can access all paging zones (internal and external).

Extension users can also respond to a page announcement using Meet Me Paging. In this case, they dial a meet
me page code upon hearing their name paged. The system then establishes a private connection to the paging
extension.

Paging is one-way only.
The Page Allow/Deny setting does not interfere with an extension’s ability to make
a page or to establish a meet me page.
The following conditions apply to paging privileges:
- The display will show PAGE FAILURE if a page fails due to that page group/zone being busy.
- You can assign any of the paging codes to a programmable feature button.
- The external pager port can be programmed to operate with any page group via system resource — external
pager programming.
To make a page announcement, extension users have to enter the page code. At default the page codes are as
follows:
- 400 =tenant all call
- 401~408 = page groups (zones) 1 through 8
- 777 = external pager.

$~ NOTE
.é It is recommended that all page announcements be made using the handset to
reduce potential audio feedback and oscillation (squeal).

HINT

If you want to allow external paging for an extension, be sure external paging
(see“Assigning External Page” on page 77) has already been set up and
assigned to the paging group you want to use.

SETTING UP PAGING PRIVILEGES VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Setting Up Paging Privileges via PC-DBA (continued on next page)
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Setting Up Paging Privileges via PC-DBA (continued on next page)

1) Go to ProgrammingP>Extension to display the Extensions screen.
|
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl

1:800:% - 1:800:% - [~ Drop Call Out Eve Class: m
2801y 2801 : :
3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation U R |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

3) Make sure there is a checkbox (¥ ) next to Paging Allow to enable the Paging Allow option.
« Clicking on this box toggles the setting between yes/enable (a checkmark ) and no/disable (no

checkmark 7).
+ The default is yes (checkmark ¥ )

In the Paging Group field on the right side of the screen:

Paging Group: |1 5
Fort Type:

DIR Mo,
Swapping:

ECF CO Group

Fredefined Call F

hironodt Dg ot

=R T )

4) Select the paging group for this extension.
« Valid choices are paging groups 1 through 8.

¢ The default is 1.

Setting Up Paging Privileges via PC-DBA (continued on next page)
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Setting Up Paging Privileges via PC-DBA (continued on next page)

5) Click the Update button to store the settings into the database on the local disk.
< Enable/disable paging privileges for other extensions (as needed) using the steps above.
When you are finished:

6) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
7) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP PAGING PRIVILEGES VIA THE DET

$~ NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Setting the Paging Active option:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-17 (where XXX is the extension: 101~204).
5) Press save to display the Paging Allow screen.

6) Press chg to specify whether or not you want to this extension to be able to page to paging groups.
« Valid options are Y or N.

e The defaultis Y (yes) - allow paging from this extension.

HINT
@ Set the Paging Active option for other extensions (as needed) using the steps above.
7) Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).

Setting Up Paging Privileges via the DET (continued on next page)
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Setting Up Paging Privileges via the DET (continued on next page)

Assign paging aroups to extensions:

From the DB Item Select screen (see steps 1 through 3 on page 421):
8) Enter 01-XXX-04 (where XXX is the extension: 101~204).
9) Press save to display the Paging Group screen for the extension you specified.

10) Press chg until you see the appropriate paging group for this extension.
 Valid choices are paging groups 1 through 8.

e The default is paging group 1.

HINT
@ Set the Paging Groups for other extensions (as needed) using the steps above.

11) Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Call Forward — Extension Predefined

The Call Forward -- Extension Predefined feature allows you to control where the system forwards a call when an
extension does not answer. You may want the system to forward these calls to the attendant extension, a
departmental secretary, another department, etc. This feature is extension specific (i.e., the system forwards all
unanswered calls to a specific extension).

= Extension Predefined Call Forward affects ringing intercom calls and transferred calls.

The programmed Extension Predefined Forward is a single step only forward destination (you cannot assign a
second or third step).

e You can assign two destinations based on station status: Busy and No Answer.
You can use different destinations for busy calls than for calls that go unanswered.
* The following conditions apply to setting pre-defined call forwards.

- Calls that are forwarded to the DX-120 voice mail system via any extension call forward include special
handling. The extension directory number is sent to the VM system with the call to identify the mailbox where
this call should be routed.

- The extension settings that extension owners have set for call forward supersede the settings you make here.

e The CO Line Predefined feature’s programming may affect the operation of the Call Forward--Extension feature
(see “Setting the Pre-Defined Call Forward No Answer” on page 144).

e The call forwarding of unanswered extensions is dependant upon the settings of the Predefined Forward Time,
which you set during programming of call handling (see “Setting Predefined Call Forward Time” on page 282).

NOTE
If you want to forward unanswered calls for all calls coming in on a CO line,
set that up instead in the CO line programming.

SETTING UP CALL FORWARD — EXTENSION PREDEFINED VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling
Syskem Resource
Restriction

C.0, Line Application
System Application
Feature Key Programming
K5U DE Password

3
3
3
Extension Application 3
13
3
3

Setting Up Call Forward — Extension Predefined via PC-DBA (continued on next)
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Setting Up Call Forward — Extension Predefined via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

Rrierson
‘ Extension |_v[ ‘ Update |Initia|ize(F8)| Close

Receive Assion Line Access Assign [~ Warnhing Tone
1800 - 1800 - [~ Drop Call Out
2801y 2801

3B02Y 3E02Y [~ Drap CallIn
4:803 4:803 :
8043 8043 I i
6805 B:805Y % SMDR Output
Te0enY Te0eY

8807y 8807y [ Intrusion Active
9:808Y 9:808Y

10809y 10809y Jv Intrusion Accept
11y 11810y .
12811 12811 /R
13812 13812 [~ Fir BTM Disable
14813 14813

15814 15:814% v Paging Allow
16818 16:818Y

178167 178167 ™ Record Allow
1887y 1887y 2
19818 19:818 il
20:819Y [d I DR =l || 7 oHvaAccept

Double Clicking Listed lterm to change State

Day Class:
Eve Class:
Monitor Class:
Tenant Group:
Pickup Group:
Faging Group:
Fort Type:

DIR Mo,
Swapping:

ECF CO Graup

I ]v
—

—Predefined Call Forward

Wirang# Dest: I 'I
Busy Dest: I vl
MNoAns Dest: | vl

Alternate Line |D
Indes:{1-100)

—

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: I

2) Select the extension number you want to program.

3) Set up information in the fields (in the "Predefined Call Forward" in lower right corner of the screen) as

shown below:

In this field... SELECT...

Wrong # Dest

» The default is blank (none).

The extension number to which you want "wrong number calls" forwarded.

« This can be an extension humber or a UCD group number.

» The default is blank (none).

The extension number to which you want "busy number calls" forwarded.
Busy Dest * This can be an extension number or a UCD group number.

NoAns Dest. time specified in call handling.

* The default is blank (none).

The extension number to which you want "unanswered calls" forwarded.
» The system considers a call unanswered when it rings for the amount of

« This can be an extension nhumber or a UCD group number.

Setting Up Call Forward — Extension Predefined via PC-DBA (continued on next)
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Setting Up Call Forward — Extension Predefined via PC-DBA (continued)

When you are finished:

4) Click the Update button to store the settings into the database on the local disk.
« Use the procedure shown above to set call forwarding parameters for other extensions

When you are finished:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP CALL FORWARD — EXTENSION PREDEFINED VIA THE DET

Qh-\'- NOTE

.é « chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

Specifying forwarding destination for a Wrong Number Condition:

From the DB Item Select screen (see steps 1 through 3 above):
4) Enter 01-XXX-29 (where XXX is the extension: 101~204).
5) Press save to display the Wrong Number screen for the extension you specified.

6) Press chg.

7) Enter the extension number or UCD group number to which you want to forward wrong number calls from
this extension.

¢ The default is none.
8) Press save.

9) Press next to display the Busy Destination screen.
OR

HINT
@ Set the Wrong Number option for other extensions (as needed) using the steps
above.

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB ltem Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
Setting Up Call Forward — Extension Predefined via PC-DBA (continued on next)
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Setting Up Call Forward — Extension Predefined via PC-DBA (continued)

Specify the forwarding destination for a Busy Destination Condition:

From the DB Item Select screen (see steps 1 through 3 on page 425):
4) Enter 01-XXX-30 (where XXX is the extension: 101~204).
5) Press save to display the Busy Destination screen for the extension you specified.

6) Press chg to enter the extension number where you want to forward busy calls from this extension.
¢ The default is none.

7) Press save.
8) Press next to display the No Ans screen.
OR

@ glelzrtrhe Busy Destination option for other extensions (as needed) using the steps
above.
Press the Hold button to return to the previous menu level.
OR
Press the volume UP button to return to the DB Item Selection screen.
OR
Exit programming (see “Exiting Database Administration” on page 27).

Specifying the forwarding destination for a No Answer Condition:

From the DB Item Select screen (see steps 1 through 3 on page 425):
4) Enter 01-XXX-31 (where XXX represents the extension: 101~204).
5) Press save to display the No Ans Destination field for the extension you specified.

6) Press chg to enter the extension humber where you want to forward unanswered calls from this
extension.
e The default is none.

7) Press save.
OR

HINT
@ Set the No Ans option for other extensions (as needed) using the steps above.

Press the Hold button to return to the previous menu level.
OR

Press the volume UP button to return to the DB Item Selection screen.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Programming Extensions for SMDR OQutput
SMDR allows the system administrator to track all incoming and outgoing CO line traffic, chronologically by extension
number. The system outputs account code data for each call record.

You have already set up SMDR during call handling programming (see page 274). When programming individual
extensions, you have the option to include that extension’s data in SMDR.

PROGRAMMING EXTENSIONS FOR SMDR OuTPUT VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling »
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.
E
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20819y LI 20819y LI v OHVA Accept MoAns Dest; | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

3) Make sure there is a checkbox (¥ ) next to SMDR Output to include information about this extension in
the system’s SMDR output.

« Clicking on this box toggles the setting between yes/enable (a checkmark ) and no/disable (no
checkmark 7).
+ The default is yes (checkmark v ).

Programming Extensions for SMDR Output via PC-DBA (continued on next page)
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Programming Extensions for SMDR Output via PC-DBA (continued)

When you are finished:

4) Click the Update button to store the settings into the database on the local disk.
¢ Use the procedure shown above to include information about other extensions’ in the SMDR output.

When you are finished:
5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

PROGRAMMING EXTENSIONS FOR SMDR OUTPUT VIA THE DET

NOTE
¢ chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

* You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-19 (where XXX is the extension: 101~204).

5) Press save to display the SMDR Output programming screen for the extension you specified.

6) Press chg to specify whether or not you want information about this extension included in the system
SMDR output.
« Valid options are Y to include this extension in SMDR, or N to exclude it.

e The default is yes (Y) - include this information in the SMDR.

7) Press the volume UP button to return to the DB Item Selection screen.
¢ Use the procedure shown above to include information about other extensions’ in the SMDR output.

OR
Press the Hold button to return to the previous menu level.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Recording Announcement Devices

Recorded Announcement Devices (RADSs) are third-party ancillary analog message devices connected to specially
programmed analog ports, for the purpose of playing announcements while callers wait for their call to be answered.
This feature is part of the UCD group call distribution process.

HINT
Q Also see...

e Programming Uniform Call distribution (UCD) Groups

e Atypical RAD message is, “Please continue to hold. Your call will be handled in the order in which it was
received.” The significant advantage of these announcements is the software control of callers waiting in queue
for a UCD agent to become available.

= A caller can be played messages to assure them that they are still in queue and not forgotten while the system
maintains the queue priority.

e The following conditions apply to setting up Recording Devices.

- When analog RAD devices are used, the system stacks multiple queued callers in queue for message
playback. When the analog port is available to handle another call the next call in RAD queue hears the
recorded message. (This does not affect DX-120 Voice Integrated RAD.)

- When multiple analog RAD devices are required to handle high call traffic, these RAD devices (with the same
recording) can be placed into a UCD group set for attribute “V.A.”

- When this is done, the Overflow Destinations and Reroute Destinations are programmed for that UCD group
number (not the individual analog port numbers connected to the RAD devices).

- UCD queued callers who are routed to Overflow Destination — RAD devices remain in UCD queue. When a
UCD agent answers the queued ringing call, the system removes the call from the UCD queue and connects
it to the UCD agent.

- If a UCD queued caller is listening to a RAD message when the agent answers the UCD call, the system
immediately delivers that call to the UCD agent and releases the RAD device port.

e The DX-120 enhances this function significantly through the use of integrated RAD messages as part of the voice
mail implementation. When you install the optional DX-120 Voice Mail into the DX-120 system platform, RAD
announcement space is allocated for each of the UCD Group Overflow and Re-route Destinations. This
significantly reduces the cost and complexity of applying this function to UCD operation.

REVIEW THE SITUATIONS BELOW AS WELL AS THE PROCEDURES SHOWN FOR EACH:

Using Third Party RADs Connected to VA Type Analog Ports...
1) Program the analog ports connected to the RAD devices as port type VA.
2) Program the VA type analog port directory (extension) number as the Overflow (1 and/or 2) for the UCD
Group.
High Traffic is Expected for the UCD Group RAD Destination...

1) Program the VA type analog port directory numbers in a specific VA UCD group (see “Setting Up UCD
Voice Announce (VA) Groups” on page 358).

2) Program the selected VA UCD group as attribute VA.

(continued on next page)
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(continued)

Using the Built-In DX-120 Voice System...

1) Program each overflow destination for all necessary UCD Groups for directory number 433 (default for
the DX-120 Voice UCD VM group).

2) Program each reroute destination for all necessary UCD Groups for directory number 433 (default for the
DX-120 Voice UCD VM group).

3) Program messages into the UCD Overflow mailboxes as required.
* See the DX-120 Hard Drive Voice Malil Installation and Supervisor Guide for details.

Assigning a Port Type

You can assign directory numbers to one of three port types:

e Extension (EXT) if the directory number is connected to an extension,
= Voice Announce (VA) if the directory humber is connected to a recording device, or
* Voice Mail (VM) if the directory number is connected to voice mail.

]

.é When programming extensions, be sure to set the port type for any given extension to
EXT.

HINT

Q Also see...
e “Setting Up UCD Voice Announce (VA) Groups” on page 358.
e “Section 9 - Programming Voice Mail” on page 361.

ASSIGNING A PORT TYPE vIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Assigning a Port Type via PC-DBA (continued on next page)
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Assigning a Port Type via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

T
‘ Extension |_ -] ‘ Update | Initialize(F &) | Close | Help |
Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :
3802 3802 I~ Drop Callin Manitor Class: |5 'l
4:803 4:803 : Tenant Group: -
5804 58047 i _ [1 i
63057 f:305Y [ SMDR Output Pickup Group: |1 vl
Te0enY Te0eY ) )
a:807 a:807:y [~ Intrusion Active Paging Group: |1 vl
9808y 9808y .
10:808Y 10:808Y Jv Intrusion Accept R EXT =
11:810:7 11:810:7 I Intrusion T DIR Ma. |
1281157 128115 EIIUSIRRAONE Swapping:
1aszy Tamzy [~ Fir BT Disable ECF CO Group |1 vl
14:8137% 14:8137%
15:8147% 15:814% I Paging Allow —Predefined Call Forward
16:8157% 16:8157%
17816 17816 [ Record Allow Wrong# Dest: I vl
188177 188177 - : I—L,
198185 19:81 85 B S SRl
2008195 [d I DR =l || 7 oHvaAccept MoAns Dest: |—_,,
Diouble Clicking Listed Iter to ch Stat
ouple Clcking Liste BIM 10 change olate Alternate Line 1D
Indes:{1-100) I
D88 Unit1: | D85 Unit 2: | D83 Unit 3: | 0SS Unit 4: |

2) Select the extension number you want to program.

3) Select EXT., V.A., or V.M in the Port Type field.
¢ Use Voice Announce (VA) if this directory number is connected to a recording device, Voice Mail (VM) if
this directory number is connected to voice mail, or extension (EXT) if this directory number is
connected to an extension.

¢ The default is EXT.

¢ The default for extensions 157 through 164 is VM, since these extensions are reserved for the in-skin
voice mail.

4) Click the Update button to enter and save your settings into the database on your local disk.
« Program other port types as needed using the steps above.

When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Assigning a Port Type (continued on next page)
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Assigning a Port Type (continued)

ASSIGNING PORT TYPE VIA THE DET

=y NOTE
.é » chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-21 (where XXX is the extension: 101~204).

5) Press save to display the Extension — Port Type field for the extension you specified.

6) Press chg until the appropriate port type appears.
 Valid selections are: EXT., V.A., or V.M.

¢ Use Voice Announce (VA) if this directory number is connected to a recording device, Voice Mail (VM) if
this directory number is connected to voice mail, or extension (EXT) if this directory number is
connected to an extension.

¢ The default is EXT.

7) Press the volume UP button to return to the DB Item Selection screen.
« Use the procedure shown above to assign port types to other extensions, as needed.

OR
Press the Hold button to return to the previous menu level.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Extensions to CO Lines

You must assign extensions to CO lines for out-dialing access. The following conditions apply to assigning CO lines.

= An extension that attempts access to a CO line to which it is not assigned will hear error tone and the display will
show: CO LN UNAVAIL.

e Extensions that are not assigned access to a CO line may receive that CO line via a transfer. However, once the
transferred call is disconnected, that extension cannot re-access the same CO line for use.

e Tenant Group programming of extensions and CO lines also dictates which CO lines an extension can access.

= To access a particular CO line, extension users press an available (idle) CO line button or dial a CO line group
access code (9, 740-746).

HINT
@ Also see “Assigning Extensions to Tenant Groups” on page 391.
ASSIGNING EXTENSIONS TO CO LINES viA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.
E
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: |D vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: |4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. |—L|
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20819y LI 20819y LI v OHVA Accept MoAns Dest; | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

Assigning Extensions to CO Lines via PC-DBA (continued on next page)
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Assigning Extensions to CO Lines via PC-DBA (continued)

2) Select the extension number you want to program.

In the Line Access Assign field just below the Extension field where all of the CO lines are listed and set as
assigned to the extension(s):

3) Select the appropriate CO line number(s).
¢ For each directory number, you can assign all valid CO line numbers.

¢ All of the CO lines are listed and each has a Y or N following it.

e The default is "Y" (i.e., Yes) for all directory numbers on all lines.

¢ To unassign a CO line from the extension, highlight the line number and double-click. This toggles the
Y to N.

4) Click the Update button to enter and save your settings into the database on your local disk.
« Program other lines as needed using the steps above.

When all assignments have been made:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

Once all database changes have been completed:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ASSIGNING EXTENSIONS TO CO LINES VIA THE DET

NOTE
» chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

« You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-23-NN (where XXX is the extension: 101~204; and NN represents the CO line 01~40
access).

5) Press save to display the CO line access for extension and CO you specified.

6) Press chg to select if you want the to assign the current CO line to the currently selected extension.
 Valid selections are Y or N for each CO line.

e The default is yes.

7) Press the volume UP button to return to the DB Item Selection screen.
¢ Use the procedure shown above to assign other extensions to other CO lines, as needed.

OR
Press the Hold button to return to the previous menu level.
OR
Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Receive Assignments

For each extension, you can assign receive privileges from each of the CO line numbers. As a default each CO lines
have the receive privileges setting enabled. So you will need to remove these privileges for any C.O. lines that should
not have this setting enabled.

SETTING UP RECEIVE ASSIGNMENTS VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 2
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

1) Go to ProgrammingP>Extension to display the Extensions screen.
E
‘ Extension |_v[ ‘ Update | Initialize(F &) | Close | Help |

Receive Assign Line Access Assign [~ Warning Tone Day Class: IU vl
1:800:% - 1:800:% - [~ Drop Call Out Eve Class: |D vl
2801y 2801 : :

3|02y Je0zy [~ Drop Callln Monitor Class: |5 vl

4:803Y 4:803Y : 5

58047 58047 I™ ECF Operation Sehaniotid |
B:805:Y B:805:7 % SMDR Output Pickup Group: 4 -]
Te0enY Te0eY )

8:807: 8807 [ Intrusion Active Paging Group: |1 vl
?naggg\(\f ?naggg\(\f [ Intrusion Accept R ExT -

11:810° 11:8107 : DIR MNo. I—LI
1281157 1281157 7 Intrusion Tane Swapping:

138127 138127 i EcFcocroup [1 =
14813 14813

158145 15:814% Iv Paging Allow ~Predefined Call Forward

16818 16:818Y
17818 17816 [ Record Allow Wrong# Dest: I vl
1887y 1887y 2 3

B Dest: -
19818 19:818 il usy Dest. | |
20:819Y x| |zoB1Ey hd| v OHVA Accept MoAns Dest: | vl

Double Clicking Listed lterm to change State .
Alternate Line |D Ii
Indes:{1-100)

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to program.

Setting Up Receive Assignments via PC-DBA (continued on next page)
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Setting Up Receive Assignments via PC-DBA (continued)

In the Assign Receive column on the left side of the screen where all of the CO lines
are listed and set to enable receive capabilities:

3) Double click any C.O. line to change its setting from Y (enable receive privileges) to N (disable receive
privileges).
¢ Use this method to reverse this setting (i.e., change disable to enabled).

4) Click the Update button to store the settings into the database on the local disk.
¢ Use the method shown above to assign (or unassign/disable) receiving privileges to other directory
numbers as appropriate.

When you are finished:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:

6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SETTING UP RECEIVE ASSIGNMENTS VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).
3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-24-NN (where XXX is the extension: 101~204; and NN represents the CO line 01~40
access).

5) Press save to display the Receive Assignment selection for the extension you specified.

6) Press chg to select whether or not the current extension should have receive the assignment.
« Valid selections are Y or N, per port and tenant number.

e The default for all receive assignments is yes.

7) Press the volume UP button to return to the DB Item Selection screen.
¢ Use the procedure shown above to set receive assignments to other extensions, as needed.

OR

Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Setting Up Extension Ring Level
= You can adjust the ringing level and ringing volume at each digital speakerphone. There are five levels of ringing
available (0-4).

e When an extension is busy on a call, the system automatically rings incoming intercom and CO line calls at the
lowest ring volume setting regardless of the level set at the extension. When the extension is idle, incoming calls
ring at the loudness level set by the user.

e The following conditions apply to assigning ring levels.

You can adjust ringing levels from the lowest level (0) to the highest level (4).
The CO line ringing settings overrides settings set at the extension.
The system displays the current setting on the LCD as you adjust ringing levels.

The system plays the highest setting and lowest ringing levels as an indication that you cannot further adjust
this volume level.

= While the extension is idle, extension users can press the Volume button (up or down) to adjust the ringing level.

The default ringer volume setting is level 2.

HINT
@ Also see “Assigning Ring Type for the CO Line” on page 134.
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Configuring Single Line Telephones

(Analog Device Support)

e Analog extension ports are provided for connection of standard, two-wire, analog telephone equipment to the
digital network of the DX-120.

- Common uses of the analog extension ports are facsimile machines, modems, and wireless and wired single
line analog telephones.

The DX-120 system basic configuration has four standard analog extension ports available.
- As the system expands, you can install a second APM4 (Analog Port Module-4 port) to KSU2.

- Each APMA4 provides four dedicated DTMF receivers for decoding the dialed digits from the connected device
(each analog port has a dedicated DTMF receiver).

To place calls, the analog device must provide DTMF tone signaling, which is decoded by the APM4 for call
processing instructions.

- Each analog port provides 25 — cycle, (frequency) ringing for the attached analog device.

Since each APM4 provides dedicated DTMF receivers and ringing generators, and because the system has a
non-blocking digital ICM bus, the Single Line Telephones/Analog Devices are not traffic sensitive and do not
require special traffic balancing.

Conditions for Setting Up Single Line Telephones.

- You can connect any single line (2500 type) telephone equipment to the system using one of the standard
analog ports available on the Analog Port Module (APM4).

- Analog ports are dedicated to the extension directory numbers system resource. You can assign these
directory numbers while programming the system.

- The allocation of DTMF Receivers (required resource to receive dialed digits from analog devices) is one to
one in the DX-120 system. That is, the system provides one DTMF receiver per analog port for decoding
DTMF signals dialed by analog devices/SLT users.

_ NOTE
Whenever extension users want to invoke a system feature at a single line telephone,
they must operate the hook-switch in a fashion that is distinguishable from an on-hook
(hang up) request. Considering this, the DX-120 system allows you to customize the
hook-switch command monitoring.

HINT
Q Also see “Establishing Start and End of SLT Hook Flash” on page 228.
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Set Up Directory/Extension Swapping

As part of the Flexible Numbering Plan in the DX-120 system, you can exchange extension directory numbers from one
port to another. Use this feature to simplify moves and changes of extensions at any specific location. When you swap
extension directory numbers from one port to another, the system moves the associated programming along with the
extension number.

EXAMPLE

Suppose the employee at port 011, extension 111 has to work out of another office for
the day—and the other office contains port 004, extension 104. Using the extension
swapping features, you can switch the two extension numbers for the day without
having to re-program both ports.

Extension 111 would then ring at port 004 (in the second office) while extension 104
would ring at port 011 (in the first office). You could keep the port assignments this
way indefinitely, or you could switch it back the following morning.

=3 NOTE
You can only swap extension directory numbers with valid extension directory
numbers (already defined in the numbering plan).

SETTING UP DIRECTORY/EXTENSION SWAPPING VIA PC-DBA

From the PC-DBA main screen:

|Pr0gramming Maintenance He|

C.0, Line %

Call Handling 13
Syskem Resource 13
Restriction 3
Extension Application 3
C.0, Line Application »
System Application 2
Feature Key Programming  #
K5U DE Password

Setting Up Directory/Extension Swapping via PC-DBA (continued on next page)
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Setting Up Directory/Extension Swapping via PC-DBA (continued)

1) Go to ProgrammingP>Extension to display the Extensions screen.

RP: Extension
oo TN

Receive Assign

Line Access Assign

1:800%
2801y
3|0y
4:803
5804
6805
Te0enY
8807y
9:808Y
10:809Y
11810
12811
13812
14:813Y
15814
16:815Y
17816
18817
19:818Y
20:819Y

-

|

1:800%
2801
3|0y
4:803
5804
B:805Y
Te0eY
8807y
9:808Y
10:809Y
11810
12811
13812
14:813Y
15814
16:815Y
17816
18817
19:818Y
20:819Y

Double Clicking Listed lterm to change State

-

sl

=
=
5
-
=
I_
o
g
=
5
.
2
=

Update | Initialize(F &) | Close
Warning Tone Day Class:
Dirop Call Out Eve Class:
Drop Call In Manitor Class:
ECF Operation Tenant Group:

SMDR Output Pickup Group:

Irtrusion Active Paging Group: |1 vl

Intrusion Accept FEE EXT -
DIR Mo.

Intrusion Tane Swapping: | vl

Fir BTN Disable ECF CO Group |1 vl

Paging Allaws ~Predefined Call Forward

Record Allow Wrong# Dest: I vl
OHWVA Active Busy Dest: I vl
OHYA Accept MNoAns Dest: | vl

Alternate Line |D
Indes:{1-100)

—

DES Unit 1: | DES Unit 2: I DES Unit 3: | DES Unit 4: |

2) Select the extension number you want to swap with another extension on another port in the Extension

field.

In the DIR Number Swapping field on the middle right side of the screen.

DIR Mo.
Swapping: I ﬁg
FCF CO Group 1101
2102
Fredefined Call F 3103 b
Wrang# Dest. (4104
5105
Busy Dest: 5106
707
MNoAns Dest: 5108
9:109

Iternate Line 1D [10:110

noex:(1-100)

1111
121112

0S5 Unil14:114 -

13113

3) Select the port number and directory number at which you want the original extension's calls to ring.
« The system swaps the previous directory number with the new directory number and reassigns the
directory number to the other port.

Setting Up Directory/Extension Swapping via PC-DBA (continued on next page)
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Setting Up Directory/Extension Swapping via PC-DBA (continued)

4) Click the Update button to store the settings into the database on the local disk.
« Use the method shown in the above steps to continue swapping extension directory numbers as
needed.

When you are finished:

5) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
6) Perform a SEND to copy the database changes to the DX-120 switch system memory.

SET UP DIRECTORY/EXTENSION SWAPPING VIA THE DET

NOTE
« chg, bksp, save, one, always, del, and ack are interactive LCD button operations.
Use the three buttons below the LCD display to activate the associated operation.

¢ You can press Hold at any time to return to the previous level or press the volume
buttons to return to the main DB selection screen.

1) Enter Database Administration (see page 26) using the feature code Feature # * to display the password
prompt.

2) Enter the DB Admin password (see page 27).

3) Press show to display the DB Item Select screen.

4) Enter 01-XXX-22 (where XXX is the extension: 101~204).

5) Press save to display the Directory Number Swapping screen.

6) Press show.

7) Enter the extension directory number that you want to assign this extension.

8) Press save to enable the directory number on this port.
¢ The system moves the old directory number to the port where the new number came from.

9) Press the volume UP button to return to the DB Item Selection screen.
« Use the procedure shown above to swap other directories/extensions, as needed.

OR
Press the Hold button to return to the previous menu level.
OR

Exit programming (see “Exiting Database Administration” on page 27).
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Assigning Feature Keys

After you are finished setting up the programming for the extensions, go to the individual phone and program its feature
keys (buttons). In addition to the buttons on each telephone, DX-120 console (DSS) has 64 programmable buttons.
All sixty-four buttons can be set up with their own directory types as well as directory numbers.

Although usually considered to be an attendant feature benefit, the DSS console can be assigned to any DX-120 DET.
You can add a maximum of 12 sixty-button Attendant/Extension consoles to the system. Each requires its own
dedicated digital port, and therefore reduces the number of DETs that you can connect to the system on a one-to-one
basis.

e The following conditions apply when assigning DSS port owners.
- Each DSS console has 64 dual-color LED buttons.
- Each DSS console requires its own dedicated cable pair from the KSU.
- You can assign up to 12 DSS consoles in the DX-120 system.
- You can assign to any DET a maximum of four Attendant/extension DSS consoles.

NOTE
Each extension and DSS are “mapped” with a default button arrangement.

DEFAULT BUTTON ARRANGEMENT - EXTENSION

25 101 26 102 27 103 28 104 29 104 30 106
19 107 20 108 21 109 22 110 23 111 24 112
13 Fo# 14 |F3 15 FG# 16 771 17 Fag 18 FG&Y
7 F73 g 400 9 F4 10 |F2 11 F&* 12 |FG4
1 m 2 801 3 80z 4 803 5 804 6 804

DEFAULT BUTTON ARRANGEMENT - DSS

Tm 2 {102 3103 4 1104 o105 6 106 7107 g | 108

9 /109 10 110 11111 12 112 13 113 14 114 15 115 16 116

17 117 18 118 19118 20120 210121 221122 23]123 240124
251125 26 126 27127 28 128 291129 30 130 31 131 32132
33| 133 34 134 35135 36 136 37| 137 38 138 39 139 40/ 140
41141 421142 43143 441144 45145 46146 471147 48148
49500 a0 a01 81|802 52503 83 504 54 505 55 506 86 507
a7 400 o8 401 29 402 60| 777 61771 62| 772 63 440 B4 441

Assigning Feature Keys (continued on next page)

- 442 -



DX-120 Programming Manual BASIC EXTENSION PROGRAMMING TASKS

Assigning Feature Keys (continued)

PROGRAMMING DSS CONSOLE FEATURE KEYS VIA PC-DBA

From the PC-DBA main screen:

Programming  Maintenance  Help

Extension

.00, Line

Zall Handling
Swskern Resource
Reskrickion
Extension application
Z.2, Line Application
System Application
Feature Key Programming
k5L DB Password

'DX-12

2
2
b
2
k
k
bk

Extension

1) Go to ProgrammingP> Feature Key ProgrammingPDSS to display the Feature Key Programming -DSS
screen.

THIS SCREEN IS COMPOSED OF TWO MAJOR PARTS:

a scrolling table of shows the feature keys currently assigned

RP: Feature Key Programming-DSS

OS5 Unit Mo I_ vl
—Feature Keys

Key Mo, Key Mo, Key Mo, Key Mo, Key Mo, Key Mo, Key Mo, Key Mo.

Tm 2102 3 103 4 1104 5 105 6 106 7107 g 108

9 109 10 110 11111 12{112 13 113 14114 158|115 16 116

17117 18 118 19 119 200120 21121 22122 23(123 241124
25128 26 126 27127 28(128 .29 129 30130 31.131 32(132
33/133 34 134 35135 36 136 37137 .38 138 39139 40.140
41141 42142 43 143 44 144 .45 145 46 146 4?.14? 45 148
49 3500 50801 51502 52803 53 504 .54 305 55 506 56.50?
57400 58 401 59 402 60| 777 .61 771 62|772 63.440 64 441

1|

Key Mo, DIR Type Dir Mo,
/__—> 1 | Extension x| 1o |
/ Update | Initialize{F &) | Close | Help |

/

an entry line you use to input new feature key assignments.

2) Select the DSS unit you want to program to display the corresponding feature key assignments.

Programming DSS Console Feature Keys via PC-DBA (continued on next page)
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Programming DSS Console Feature Keys via PC-DBA (continued)
3) Click on the feature key you want to program to highlight it.
« The corresponding Key No. will be displayed to the left of the entry line at the bottom of the screen,
together with any definition currently assigned to the key.

In the DIR Type field:

DIR Type

Extension
| Extension

Fage Group

Hunt Group

Pick Up J
Indiv. SPD.

Systemn SPD.

GO Line

BGM ¥,

4) Select the type of directory you want to apply to the currently highlighted key from the DIR Type field.
e The choices are blank, CO Group, Operator, Extension, Page Group, Hunt Group, Pickup, Indiv SPD.,
System SPD., CO Line, BGM, External Pager, Loud Bell, Vir. Number, Account, and MMC.

* The default is “extension”.
« To disable the key operation, select the blank space.

In the DIR No field:

Diir Mo,

110 %

2102
3103
4:104
5:105
6:106
7107 2

5) Select a directory number for this key from the DIR No.

HINT

The choices available for DIR No. will vary depending upon the selection you made
under DIR Type.

n:lf

6) Click III to move your settings to the corresponding location in the scrolling table.

7) Click the Update button to store the settings into the database on the local disk.

« Use the steps above to assign other directory number keys as needed for this DSS unit. In addition, you
can program features keys for other DSS Units by selecting another unit number (see step 2), then
follow the steps for making the settings as shown above.

When you are finished:

8) Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
9) Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming DSS Console Feature Keys (continued on next page)
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Programming DSS Console Feature Keys (continued)

PROGRAMMING DSS CONSOLE FEATURE KEYS VIA THE DET
To program the DSS Console without the PC-DBA, you need to make the settings using a DET to which the console is
assigned.

From an associated DET display:
1) Press Feature # 4 to display: FRESS D55 KEY.

2) Press the DSS button or the console that you want to program to display the current directory setting.
« The corresponding button on the console will be flashing red.

3) Press show to display the Dir No screen.

=y NOTE
To program the keys, you must know the code type(s) you want to use. The codes
= will either be a directory number or a feature code. In general, directory numbers are
resources that are designated dialing codes in the system such as extensions and
page zones.

Feature codes being those features that an extension might invoke. If you are unsure
what type of code is to be programmed review “Appendix C - Feature Directory and
Code Lists” on page 471.

4) Enter the appropriate directory number.

5) Press save.
« If you inadvertently enter the wrong number, use bksp, then chg, then re-enter the number.

* Repeat steps 2 through 5 for each key you want to program.

When all feature keys are programmed, as needed.
6) Press the SPK button twice to exit the DSS console programming mode.
OR
Lift and replace the handset to exit the DSS console programming mode.

Assigning Feature Keys (continued on next page)
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Assigning Feature Keys (continued)

PROGRAMMING DSS DET FEATURE KEYS viA PC-DBA

From the PC-DBA main screen:

Programming  Maintenance  Help

Extensian

Z,3, Line

Call Handling
System Resource
Restrickion

1.2
DX-12

Extension Spplication

.0, Line Application

Swstem Application
Feature Key Programming

kSl DB Password 0S5 | !

1) Go to ProgrammingP Feature Key ProgrammingPExtension to display the Feature Key Programming -
Extension screen.

THIS SCREEN IS COMPOSED OF TWO MAJOR PARTS:

4
4
4
b
b
b
4

a scrolling table of shows the feature keys currently assigned
I

RP : Feature Key - Extension il

Edension |G~

key Mo, key Mo, key Mo, key Mo, Key Mo, key Mo,
25 10 26 102 27 103 28 104 29 104 a0 106
19 107 20-108 21 109 22 110 23111 24 112
13 Fu# 14 |F8 14 Fo# 16 771 17 |F98 18 FBT
7 |F73 & 400 9 |F4 10 F2 11 |F5* 12 |FB4

1 m 2 8Mm 3 802 4 803 5 804 6 805

Key Mo, Type DIR Type DIR Mo
&+ Dial Key ----meeev oL ~| |1:800 -
1 y [Co Line & B
€ FUnE Key --------------- Func. Access |
" Maone
Update |Ini1ia|ize(F8)| Close | Help |
7
/

Entry lines you use to input new feature key assignments.

2) Select the extension you want to program to display the corresponding feature key assignments.

Programming DSS DET Feature Keys via PC-DBA (continued on next page)
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Programming DSS DET Feature Keys via PC-DBA (continued)

3) Click on the feature key you want to program to highlight it.

« The corresponding Key No. will be displayed to in the lower right portion of the screen, together with any
definition currently assigned to the key.

4) Select the key type you want to assign to this feature key (e.g, a dialing key, function key, or neither - see
the information below for more information about setting each of these key types).

Setting this Key as a Dialing Key (default):

=y NOTE
.E When/if you choose “Func Key” the Func Access field will be come available, and the Dial Key fields
will be come unavailable. Similarly, if/when you choose “None”, both the Dial and Func Key fields will

become unavailable. If the Dial Key fields are unavailable, click on the Dial Key option to make them
active.

5) Click on the Dial Key (default) option (if it is not already selected.

In the DIR Type field:

DIR Type

Extension

| Extension
Fage Group

Hunt Group

Pick Up

Indiv. SPD. —
Systemn SPD.

GO Line

BGM ¥,

6) Select the type of directory you want to apply to the currently highlighted key from the DIR Type field.
« The choices are blank, CO Group, Operator, Extension, Page Group, Hunt Group, Pickup, Indiv SPD.,
System SPD., CO Line, BGM, External Pager, Loud Bell, Vir. Number, Account, and MMC.
* The default is “extension”.

« To disable the key operation, select the blank space.

In the DIR No field:

Diir Mo,

110 %

2102
3103
4:104
5:105
6:106
7107 2

7) Select a directory number for this key from the DIR No.

HINT
@ The choices available for DIR No. will vary depending upon the selection you made
under DIR Type.

Programming DSS DET Feature Keys via PC-DBA (continued on next page)
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Programming DSS DET Feature Keys via PC-DBA (continued)

Once the DIR settings are made:
Go to step 8 on page 448.

OR

Setting this Key as a Function Key:

=3 NOTE
When/if you choose “Func Key” the Func Access field will be come available, and the

Dial Key fields will be come unavailable. Similarly, ifiwhen you choose “None”, both
the Dial and Func Key fields will become unavailable.

5) Click on the Func Key option to make the Func Access field active.
6) Enter a description for the Function key assignment.

EXAMPLE:
If you are programming a Call Key for Function 66, then you would enter “66”

into this field.

Once the settings are made for the Func key:
Go to step 8 below.
OR

If Don’'t Want to Set this Key as a Dial or Function Key:

=3 NOTE
When/if you choose “Func Key” the Func Access field will be come available, and the

Dial Key fields will be come unavailable. Similarly, ifiwhen you choose “None”, both
the Dial and Func Key fields will become unavailable.

5) Click on the None option to make the Dial and Func fields unavailable.

Once the settings is made for None:
Go to step 8 below.

Once all key settings are made:

8) Click |1I to move your settings to the corresponding location in the scrolling table.

9) Click the Update button to store the settings into the database on the local disk.
¢ Use the steps above to assign other directory number keys as needed for this extension. In addition,
you can program features keys for other extensions by selecting another unit number (see step 2), then

follow the steps for making the settings as shown above.

When you are finished:
10)Click the Close button to exit the current screen and return to the PC-DBA main screen.

When you have finished all programming changes:
11)Perform a SEND to copy the database changes to the DX-120 switch system memory.

Programming DSS DET Feature Keys(continued on next page)
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Programming DSS DET Feature Keys (continued)

PROGRAMMING DSS DET FEATURE KEYS VIA THE DET

While the extension is idle:

1) Press Feature # 3 to display: FFESS FTR KEY.

2) Press the flexible feature button that you wish to program and display:
FIa___
show  chd

3) Press chg to display
SELECTION FUHCTION
dir ftr

NOTE

To program the keys, you must know the code type(s) you want to use. The codes will either
be a directory number or a feature code. In general, directory numbers are resources that are
designated dialing codes in the system such as extensions and page zones.

Feature codes being those features that an extension might invoke. If you are unsure what
type of code is to be programmed review “Appendix C - Feature Directory and Code Lists” on
page 471.

To program a directory number press dir.

DIR HUMBER:_
bkzr  zave chd

4) Enter the a appropriate directory number.
5) Press save.
« If you inadvertently enter the wrong number, use bksp, then chg, then re-enter the number.

To program a feature code press ftr.

FTR COCE:_
bksr  =save chd

6) Enter the feature code (e.g., Feature 6 # for CID Table Review - see 472).
7) Press save.
e Continue programming other feature keys.
When all feature keys are programmed, as needed.
8) Lift/replace handset to exit this programming.

- 449 -



BASIC EXTENSION PROGRAMMING TASKS DX-120 Programming Manual

Programming a Release Key

DET speakerphone users may want a release key they can use to cancel or complete any current action. The release
key function can speed call processing by allowing the user to eliminate the use of the hook-switch, when call
processing is encumbered by this operation.

Extension users can use the release key to complete a call transfer (rather than going back on-hook). They can also
use it to force the telephone into an idle mode regardless of the condition of the hook-switch.

e You must program the release key onto an available feature button.
= When users press the release key the system disconnects the call in progress.

PROGRAMMING A RELEASE KEY VIA THE DET

=S NOTE
.é This operation cannot be performed using the PC-DBA.

While the extension is idle.
1) Press Feature # 3 to display: PRESS FTR KEY,
2) Press the flexible feature button that you want to use as the release key.
3) Press chg.
4) Press Feat.
5) Enter the feature code Feature 5 2.
6) Press save.

7) Lift/replace handset to exit this programming.

Flexible Feature Button Inquir

You may review the programming for flexible feature buttons at an idle DET. In order to review the programming, you
must dial the flexible button programming mode.

Buttons without feature programming will display AVAILABLE KEY.

LOOKING UP CODES USING THE DET

Q'\ NOTE
.é This operation cannot be performed using the PC-DBA.

While the extension is idle.
Press Feature # 3 to display: FRESS FTR KEY,
1) Press the flexible feature button to view its programming (e.g., press button 1- lower left).

aa0
show  cha
2) Press show to display the name/designation of the feature/directory number.
COLW 200
* Use the steps above to continue checking other buttons for their programmed content

3) Lift/replace handset to exit this programming.
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Feature Key Reset

You can clear all the feature key custom settings and reset all buttons to the default settings. See Appendix B, Button
Labeling for the default feature key configuration.

LOOKING UP CODES USING THE DET

=y NOTE
.é This operation cannot be performed using the PC-DBA.

While the extension is idle (no call activity).
1) Press Feature 5 8 to display the prompt for the password.

FEll o+
bksr show chd

2) Enter the extension password.

3) Press show to display the prompt for confirmation:
FTR KEY RESET

a0

4) Press go to resets all the feature keys to the default settings (see 442).
< You will hear a confirmation tone to let you know the reset has been successful.
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APPENDICES
APPENDIX A - WORKSHEETS
Extension Data Programming

New Values & 101 102 103 104 1085 106 107 108

Programming Par - :
Default | Range

Tenant Group 11213

Pickup Group 1-8

Paging Group

Day Class

Eve Class

Monitor Class

Warning Tone

Drop Call Out
Drop Call In
Intrusion Active
Intrusion Accept

Intrusion Tone

Off Hook Vioice Announce Active

Off Hook Voice Announce Accept

Feature Button Disable

Paging Allow

External Call Forward Operation

SMDR Output

Record Allow

Port Type

Directory Number Swapping

Line 1

Line 2

Line 3

. Line 4
Lme, Tenant 1
Assignment Line §

Line 6

Line 7

Line 8

Line 1

Line 2

Receive

. Te t1 i
Assignment enan Line 3

tred | Y | vIN

funes [Er vt e

Extension Data Programming Worksheet (continued on next page)
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Extension Data Programming Worksheet (continued)

Linz s ¥ ¥IN
Facdwu
e Pl [T ¥ YIK
oot e
Lines ¥ ¥IN
. HOKE !
fhang Desfi nafion RONE s
HOKE !
F Fonar Busy KOME sy
HOKE !
F Fonar K Answer HOME vt
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CO Line Data Programming

Programming NewValues 3 | 600 | 51 | 502 | a0a | a04 | 505 | 306  o07
Parameters
Default Range
Tenant Group 1 1/2/3
CO Group 1 1-8
Day Class 0 0-7
Eve Class 0 0-7
MOH Source MC1 MC1/MC2
Dialing Tone Tone/Pulse
CO Line Type co Cfg;z:%g{f;&w
Call Abandon Y YIN
Private To Null Null/Ext #
CO Ring Type 1 1-8
Privacy Release N YIN
Answer Position
Day

Member 1 101 Null/Ext #

Member 2 Null Null/Ext #

Member 3 Null Null/Ext #

Member 4 Null Null/Ext #

Member 5 Null Null/Ext #

Member 6 Null Null/Ext #
Answer Position

Eve

Member 1 101 Null/Ext #

Member 2 Null Null/Ext #

Member 3 Null Null/Ext #

Member 4 Null Null/Ext #

Member 5 Null Null/Ext #

Member 6 Null Null/Ext #
P Forward No Answer None None/Ext #

CO Line Data Programming Worksheet (continued on next page)
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CO Line Data Programming Worksheet (continued

Programming New Values 3 | g | soo | ato | 11 | o12 | 313 | 314 | a15
Parameters
Default Range
Tenant Group 1 11213
CO Group 1 1-8
Day Class 0 0-7
Eve Class 0 0-7
MOH Source MC1 MC1/MC2
Dialing Tone Tone/Pulse
CO Line Type co %g;zzggggy
Call Abandon Y YIN
Private To Null Null/Ext #
CO Ring Type 1 1-8
Privacy Release N YIN
Answer Position
Day

Member 1 101 Null/Ext #

Member 2 Null Null/Ext #

Member 3 Null Null/Ext #

Member 4 Null Null/Ext #

Member 5 Null Null/Ext #

Member 6 Null Null/Ext #
Answer Position _

Eve

Member 1 101 Null/Ext #

Member 2 Null Null/Ext #

Member 3 Null Null/Ext #

Member 4 Null Null/Ext #

Member 5 Null Null/Ext #

Member 6 Null Null/Ext #
P Forward No Answer None None/Ext #
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Call Handling

NO / 3LNS [ 2LNS

CO Line Conference 3LNS
CO Flash Time 0.8 -0.4:- 3.0 (0 4:int) =
PBX Flash Time : 01-30(01inY
Pause Time 20 0.5 -7.040:5 ii_1t}
Break Time 80 S
Inter Digit 800  400-800(501nt)
Dialing Ratio e
Tone Time 120 70/90/120
Ring Abandon 6 R
Hold Remind 60 ; 0/10/30/60/90
External Hold Time 3 gy
Outgoing Call 5 1.3
Waming Time
Incoming Call 1-30 ;
Transfer Intercom Recall 30- 16 /30160190 /120
Transfer Busy Recall 60 16730/ 60190/ 12.&!.
SLT Hold Recal 05 0050051t =
EKT Hold Recall 00-50(05int)
Start 60/ 1001400 (100nt)
SLT Hook Flash e
End 100-1500 (100 int)
PBX A Pause 10 05-70051)
Dial Wait Time 0 : 0-8
Dial Delay 100 1bo_r 50071000/ 1500/ 2000
Camp On Time | 0- 60_(1ﬁ int) s
Alarm Play 30 - 10/30/60-600 (60int) -
Hotel Enable N YIN -
System Speed Check N YIN
TSI Connect Y, YIN
Conference Tone i YN
Call Duration 10 e :
Intercom Prefix NULL © NULL/4DIGITS
Country Code : NULL NULL /4 DIGITS
Long Distince Prefix L  NULL/3DIGITS
Area Code 1 - NULL ~ NULL/5DIGITS
Prefix 1 NULL NULL /5 DIGITS
Local Area Code NULL _NULL/5DIGITS
Area Code 8 NULL * NULL/5DIGITS
Prefix 8 NULL NULL /5 DIGITS

Call Handling Worksheet (continued on next page)
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Call Handling Worksheet (continued)

To Tenant 1
Tenant 1 To Tenant 2
To Tenant 3
To Tenant 1
Tenant Calling Tenant 2 To Tenant 2
To Tenant 3
To Tenant 1
Tenant 3 To Tenant 2
To Tenant 3
) Qutgoing Call
SMDR Call Output
Incoming Call
Attempts
Auto Redial Interval
Waiting Time
Service
External Forward
' Talk Time
Tone Time
VM Dialing Ratio
Int. Digit Time
WM Monitor Time
VM Reserve Port
Fax Ring Time
Conference Talk Time
Unsupervised Conference Time
Pre-defined Forward Time
Ring Recognition Time
Talk Abandon Time
Hold Abandon Time
Ring Time to Answer
Ring No Answer
Drop No Ext #
Auto Attendant Transfer Mode
Waiting Code
Inquiry Code
DISA Code

Call Handling Worksheet (continued on

next page)
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Call Handling Worksheet (continued)

Day Mode
Tenant 1 Alt Mode
Eve Mode
Day Mode
Answer Position Tenant 2 Alt Mode
Eve Mode
e Day Mode
Auto Attendant
(continued) Tenant 3 Alt Mode
Eve Mode
Auto Attendant Line
€O 800 (Line 1)
Service
Auto Attendant Line
CO 815 (Line 16)
) Service
Ring Time to Answer
_ Extension COS 0
Allowed Extension COS
Extension COS 1-7
DISA CO Line
DISA Day COS
€O 800 (Line 1) DISA Eve COS
DISA Service
Talk Time
DISA CO Line
DISA Day COS
coss (Linets) | DSAEVeCOS
Senvice
Talk Time
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System Resources

DB Password g s 8DIGITS
Attendant o NULL / EXT#
Attendant Tenant 1,2, or 3
Alternate NULL : NULL [ EXT#
Playtime e
Reminder 1 NULL : NULL / TIME
System Reminder Tenant 1,2, or 3 - -
Reminder 8 ' ' SN NULL/TIME
Length % A
Extension 101 o099 | ~ 4piorTs
User Passwords Extension 102 o0 | apieTs
Password : S B T
Extension 108 4 DIGITS
Extension 101  NULL/BLETTERS
User Names ; : :
Extension 108 NULL/8 LETTERS
800 (Line 1) et . | NULL/BLETTERS
CO Line Names e R
‘ 807 (Line 8) St thes NULL/8LETTERS
Message 1 o =i : NULLHSLETFERS :
bronro ) Message 6 NULL /16 LETTERS
Messages Message 1  NULL/16LETTERS
. - -
Message 6 T
Extension 101 o0 0-50(10ing)
Individual ' el s
Spoed Number Extension 108 20 0-50(10 inc)
Assignments Tenant 1 20 | . 0-2000inc)
Common Tenant 2 025 ki ] 0-200 (20'inc}
Tenant 3 [i] . ; c 0.- 200 (20inc)
500 NULL NULLf 16 DIGITS
E:S:I:: poad Diel Tenant1-3
699 . NULL | NULL/16DIGTS
Tenant 1 00 e 0-100(10ine)
(aller D Name Tenant 2 0| o-to0p0ing
Tenant 3 Ens 0-100 (10/nc)

System Resources (continued on next page)
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System Resources (continued)

Name
Tenant 1 CID Entry 1-100 1
Phone Number
Name
| Caller ID Name
! Tenant 2 CID Entry 1- 100
Programming Phone Number
Name
Tenant 3 CID Entry 1 - 100
Phone Number
Application
' Tenant Group 1
Source ID 1
Tenant Group 2
Tenant Group 3
Music Source i
Application
Tenant Group 1
Source ID 2 )
Tenant Group 2
Tenant Group 3
Tenant Group
Page Group 1
External Pager ID 1
Page Group 8
Type
LoudBell ID 1 €O Group 1
CO Group 8
Owner
Unit 1
Directory Number
DSS Allocation
COwner
Unit 12
Directory #
Directory Number
Built-in Modem
BAUD Rate
Remote Programming Transmit Rate
Caller ID Logging Transmit Rate
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Toll Restrictions

From
To
Class 0
Day Allowed
Digit Interval 1
Class 7
Extension COS
Class 0
Eve Allowed
Class 7
Toll Restriction Tenant1-3
From
To
Class 0
Day Allowed
Digit Interval 100
Class 7
Extension COS
Class 0
Eve Allowed
Class 7
Length
Password
Password 1 Class Of Service
Disabled
Code
Password
Password 600 | Class Of Service
Disabled
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Extension Applications

Tenant 1 - 1-3
UCD Attribute ueD" UCD VA
UCD Group Member 1 NULL NULL T EXT#
UCD Group Member 24 NULL NULL / EXT#
Hunt Method LINE LINE/DIST /ALL
Uniform Call ~ Bl .
Distribution UCD Group 1 - 24 No Answer Time 10 5-60
Programming. . : :
Timer 0 0-255
Overflow 1 — — -
Destination NULL NULL / EXT#
Timer 0 0255
Overflow 2 e
Destination NULL - NULL / EXT#
Overflow Count 2 1-128 2
Reroute Destination NULL NULL/EXT#
VM Hunt Group 0 Stiotoases
Intercom / VM #2 4DIGITS.
Transfer o sDiGTS
Busy Forward 3 4DIGITS
No Answer Forward TR g DI_GITS-' i
Prefix Digits e e
Direct Forward # . 4DIGITS
Voice Mail Tenant 1-3 CO Greeting ; w6 el gmﬁs 1
CO Recall # ~ 4DIGITS
UCD Overflow 300 - 4DIGITS
Sufix Digit NULL 2DIGITS
Record Digit S ADIGITS' ¢
Delete Digit NULL * 4DIGITS
Disconnect Digi T 8DIGTS
Member 1 NULL NULL/EXT#
Auto Recording S ]
Member
Member 8 NULL  NULLJEXT#
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CO Applications

PEX Code
Hunt Method
Group Number
CO Group 1-8
Delete Digits
Altemate CO Group 1-8 -
Insert Digits
Swap with
803 (CO Line 4) Destination on detection
807 (CO Line 8) Destination on detection
Fax Datection

811 (CO Line 12) Destination on detection

815 (CO Line 16) Destination on detection
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System Applications

Ring Scheme
Letter Type
Hour Mode
Positionto Dir | Cabinet(1-2) | Board(1-4)
Numbering Plan | CO Group Length 1
Length 5
o Leading 1
Leading 5
Extension Dir
Nurnt Length
Leading 1
Leading 8
- Extension Page
Group Length
Leading 1
Leading 2
Leading 3
Extension Hunt
Group Length
Leading 1
Leading 2
Leading 3
Extension
L
Pickup Group ength
Leading 1
Leading 2
Leading 3
Individual Speed
Dial Numbers Length
Leading 1
Leading2
Leading 3
Common Speed
Dial Numbers | 6"
Leading 1
Leading 2
Leading 3

System Resources (continued on next page)
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System Applications (continued)
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e
Leading 1
Leading 2
Leading 3
Music Source Length
Leading 1
Leading 2
Leading 3
Loudbell Length
Leading 1
Leading 2
Leading 3
External Pager Length
Leading 1
Leading 2
Leading 3
Virtual Number Length
Leading 1
Leading 2
Leading 3
cotrores | L
Leading 1
Leading 2
Leading 3
Operator Code | Length o
Leading
Account Code Length
Leading
Suffix Code ICM Ring / Voice | ICM Ring/Voice
DND Override DND Override
Camp On Camp On
Callback Callback =
Call Pickup Call Pickup
Intrusion Intrusion
Message
Waiting
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APPENDIX B - BUTTON LABELING

Cut dlong
all dotted
lines
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r — — - - - - - — — — — 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL All Do Not CALL MEMO \Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
L o e e e e e e e
r — — - - - - - — — — — 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL All Do Not CALL MEMO Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
L o e e e e e e e
r — - — - - - - - - 0 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL All Do Not CALL MEMO \Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
L o e e e e e e e
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r — — - - - - - - — — — — 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL All Do Not CALL MEMO Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
S |
r —. — — — — — - - — — — — 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL Al Do Not CALL MEMO Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
S |
r — - - - - - - - - — /— — 1
| EXTENSION |
| Extension Extension Extension Exten- Extension Extension |
101 102 103 sion 104 105 106
| Exten- Extension Extension Extension Extension Extension |
sion 107 108 109 110 111 112
| HEADSET REDIAL Caller MUSIC ICM Mode Voice |
MODE ID HF-PR-TN Record
| CALL Al Do Not CALL MEMO Voice |
PARK Page Disturb FWD PAD Mail
| Line Line Line Line Line Line |
1 2 3 4 5 6
|
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APPENDIX C - FEATURE DIRECTORY AND CODE LISTS

Review the lists below to find features, director numbers, and access codes when you need them (see “Feature /
Directory Number Lookup” on page 36 for information about how to use these lists).

Feature Directory Numbers List

FEATURE DIRECTORY NUMBERS

Cogp 1 9
(COline group) o8 740~746
Tenant 400
Page Groupl-~8 401~408
(Paging) All Paging 409
EXTPAGE (External) 777
Hunt Hunt/UCD Groupl~24 410~433
Pickup Pickup Group1~8 440~447
Music Music Channel 1,2 771,772
Bell Loud Bell/E.P./M.S. 779
Mm cnf Meet Me Conf.1~8 390~397
Vir Virtual Numbers 1-30 700~729
Speed Dial-Individual 470~499
Spd
Speed Dial-System (common) 500~699

=y NOTE
This list shows the defaults, which can be changed by modifying the Numbering Plan
(see page 103).

- 471 -



APPENDIX C - FEATURE DIRECTORY AND CODE LISTS

Feature Access Codes List

FEATURE ENABLE CODE DISABLE CODE

Agent Log Off Feature 91 Feature *91

Alarm Clock Feature 92 Feature *92

Alarm Key Feature 62 N/A

All Forward Feature 22 Feature 22

Attendant Administration Feature #0 Password: 9999 (Xlo?)
0000 (all other extensions)

Auto Hold Feature 94 Feature *94

Auto Line Select Feature 95 Feature *95

Auto Redial Feature 78 N/A

Busy Forward Feature 21 Feature 21

Busy Ring Allow Feature #2 Feature #2

Call Forward Feature 2 Feature 2

Call Key Feature 66 n/a

CBCK (Callback) Delete Feature ## Feature ##

CID Table Feature 6# Password: 9999 (xlO%)
0000 (all other extensions)

Conference Feature 60 Feature 60

DB (Database) Programming Feature #* N/A

Default Set Feature 69 N/A

Distinctive Ringing Feature #7 N/A

Do Not Disturb Feature 4 Feature 4

DSS Key Programming Feature #4 N/A

External Call Forward Feature 26 Feature 26

Feature Status Feature #8 N/A

Flash Feature 3 N/A

Feature Access Codes (continued on next page)
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FEATURE ENABLE CODE DISABLE CODE

Follow Call Forward From Feature 23 Feature 23

Follow Call Forward To Feature 25 N/A

Forced Release (Conference) Feature 74 N/A

Feature Code Lookup Feature #5 N/A

Feature Key Programming Feature #3 N/A

Feature Key Reset Feature 58 Password: 9999 (Xlo})
0000 (all other extensions)

Get Held CO Line Feature 7* N/A

Headset Mode Feature 9# Feature *9#

Hidden Code Feature 61 N/A

Hot Key Feature #6 Feature #6

Hotline Feature 9* Feature *9*

ICM (Intercom) Key Feature 65 N/A

ICM Mode (HF/Private/Ring) Feature 98 Feature 98

Last # Redial Feature 8 N/A

Lock Phone Feature 97 Password: 9999 (Xlo?)
0000 (all other extensions)

Memo Pad Feature 5* N/A

MSG (Message) Waiting Feature 96 N/A

Mute Key Feature 76 N/A

No Answer Call Forward Feature 24 Feature 24

Paging Answer Feature 59 N/A

Paging Receive Feature #9 Feature #9

Park Call Feature 73 N/A

Pause Feature 70 N/A

Private Talk (Conference) Feature 57 N/A

Feature Access Codes (continued on next page)
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FEATURE ENABLE CODE DISABLE CODE
Release Key Feature 52 N/A

Ring Mode (Attendant station only) Feature 63 Password: 9999 (x101)
Room Status Feature 7# N/A

Saved # Redial Feature 51 N/A

Speed Dialing Feature 1 N/A

Status MSG (Message) Feature 90 Feature *90

Touch Tone Feature #1 Feature #1
Unsupervised Conference Feature 77 N/A

Voice MW Key Feature 64 N/A

Voice Record Feature 67 N/A

Xfer and Answer Feature 68 Feature 68

Xfer Beep Enable Feature 56 Feature 56

Suffix Codes List

SUFFIX
FEATURE CODE
ICM Voice/Ring *
DND Override 3
Camp On 4
Callback #
Call Pickup 6
Intrusion 8
MSG (Message) Waiting 9
ICM (Intercom) OHVA 0
Monitor 1

=y NOTE
This list shows the defaults, which can be changed by modifying the Numbering Plan (see page 103).
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APPENDIX D - TRUNK DIRECTORY NUMBERS

The DX-120 system supports one ISDN (T1/PRI) Board (PRI/B) and provides 23B channels (data transmitting) plus 1D
channel (control of data transmitting).

The default Trunk Directory Numbers for the DX-120 are assigned as follows:

Trunk Directory Number Cabinet / Slot / Port Trunk Type
800 ~ 803 1/1/1~4 4CO
804 ~ 807 1/5/1~4 4CO
808 ~ 811 2/1/1~4 4CO
812 ~ 815 2/5/1~4 4CO
816 ~ 838 1/7/1-~23 ISDN (T1/PRI)
816 ~ 839 1/7/11-~24 T1

FOR FUTURE USE ONLY

840 ~ 843 1/4/1~4 VOIP
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APPENDIX E - SETTING UP LETTER TYPE
FOR USING SPECIAL CHARACTERS

You can use special characters (e.g., those used in languages other than English such as &, C, and é) when
programming text for the telephone display (i.e., extension names, CO line names, pre-programmed messages, and
UCD names for special requirements. Each set of characters is assigned to a letter type. In order to use a specific set
of these special characters you must change the Letter type to the appropriate number.

SETTING UP LETTER TYPE FOR USING SPECIAL CHARACTERS - VIA PC-DBA

From the PC-DBA main screen:

1) Go to Programming P System Application® General Settings to display the Application—General Settings
screen.

In the Letter Type field:

2) Select the letter type that corresponds to the special character set you want to use.
« Valid entries are 0 through 7.

¢ The default is 0.

for this character set...

CHOOSE
THIS
Press 1
LETTER one Press 1 Press 1 Press 1 Press 1 Press 1 Press 1 Press 1
TYPE... time 2times 3times 4 times 5 times 6 times 7 times 8 times
0 IE fE 2 5 a A & i
1 G A =] H A = ¢ i
2 & & & & Y ¥ - F
3 & g & M o R £ ¥
4 £ & u] i U
5 t = A S
6 3 A 3 A o Cul
7 ¥ i ] A o u)

When you are finished:
3) Click the Update button to store the settings into the database on the local disk.
4) Click the Close button to exit the current screen and return to the PC-DBA main screen.
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When you have finished all programming changes:
5) Perform a SEND to copy the database changes to the DX-120 switch system memory.

ENTERING LOWERCASE LETTERS
Use the letters associated with the number keys (as shown below) to spell out a name or word using lower case letters.

IMPORTANT!
The # button acts as an enter key. You must press it after each character you enter to
save that character in the position. You can also use # to enter a space.

EXAMPLE
To enter “mary” as an extension user’s name, enter the following keystrokes:

O*H2*HTTT*HI99*#

NUMBER PRESS_. THEN THEN
15 1% 2% 4x PRESS PRESS

#

(Also sop
IMAPORTANT
note

abova)
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ENTERING UPPERCASE LETTERS
You can also use capital letters if you wish. Use the following table when entering a capital letter.
IMPORTANT!

The # button acts as an enter key. You must press it after each character you enter to
save that character in the position. You can also use # to enter a space.

EXAMPLE
To enter “MARY” as an extension user’s name, enter the following keystrokes:

OH2H [T THI99#

NUHBER PRESS..
KEY 1X

||| Z (=] |m|m
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ENTERING NUMBERS
If you wish to use numerals, refer to the following table.
IMPORTANT!

The # button acts as an enter key. You must press it after each character you enter to
save that character in the position. You can also use # to enter a space.

EXAMPLE
So for example to enter “1846” as password, enter the following keystrokes:

*1#*8H*AH*O#

FIRST THEN NUMBER  THEN TO GET THIS
PRESS KEY PRESS RESULT:

=

W oo (| S| B W k|
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APPENDIX F - T1 MAINTENANCE

The DX-120 provides an easy and efficient way to track and report errors that may occur during its operation. The T1
Maintenance module consists of:

IMPORTANT!
The PC-DBA and the switch MUST BE CONNECTED before you can complete any
of the maintenance tasks listed above.
e T1 Alarms and Error Parameters
e Three tools that allow for tracking and clearing of errors:
- T1 Error Threshold
- Error Seconds Total
- Clear T1 Error

T1 ALARM AND ERROR PARAMETERS
The following is a list of the various alarms and errors that can occur when the T1 card is installed.

IMPORTANT!

Be sure to contact Vertical Technical Support with any questions regarding alarms
and errors.

T1 ALARM AND ERROR PARAMETERS

Parameter Description

* This indication defines the minimum number of errors per second that must occur
before the T1 board will forward one error count to the system.

* Bipolar errors indicate that the system has detected electrical noise on the receive

Bipolar Error Alarm Trigger pair from the network.
* Bipolar errors can occur frequently, even on a properly functioning system and can
occur if the network is using B8ZS and the T1 board is not.

» The BIPOLAR indicator on the T1 board also indicates this condition.

* This indication is the minimum number of error counts per second, as reported by

the T1 board that must occur before the system logs the error.

Bipolar Error Logging » The actual number of bipolar errors is the logged number multiplied by the number

you enter for the Bipolar Error Alarm Trigger.

« This indication is active in only the ESF mode, and is the minimum number of
errors per second that must occur before the T1 board forwards one error count to
the system.

» CRC errors indicate corruption of A, B, C, and D bits for only the ESF mode.
* The CRC indicator on the T1 board also indicates this condition.

CRC Error Alarm Trigger

* This indication only occurs in the ESF mode.

» The T1 board must report the occurrence of a minimum number of error counts per
CRC Error Log Trigger second before the system logs the error.

» The actual number of CRC errors will be the logged number multiplied by the
number that you entered for the CRC Error Alarm Trigger.

T1 Alarm and Error Parameters (continued on next page)
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T1 ALARM AND ERROR PARAMETERS (continued)

« Slip errors indicate that the T1 board has discarded or duplicated a received frame
and the receive signal from the network is not properly synchronized to the system.

Slip Errors

If you receive a slip error, the SLIP indicator on the T1 board provides information
about this condition.

This T1 only error indicates that the T1 board has discarded or duplicated a
o transmitted frame and the transmit signal to the network is not properly
Transmit Slip Errors synchronized to the system.

If you see this error, check the DXPOPT-SYN card for proper installation.

The loss of sync indication means the T1 framer is unable to synchronize with the
received signal.

This condition will cause the system to send a yellow alarm to the network, but will

Loss Of Sync not cause a yellow alarm indication at the T1 board.

* When a loss of sync condition exists, check the received signal and wiring. The
SYNC indicator on the T1 board also indicates this condition.

The network sends a blue alarm (also known as an Alarm Indication Signal or AIS)
for detection by the T1 framer.

This alarm signal consists of all ones on all channels and is an indication that the
network is unable to detect any signal being transmitted from the T1 board.

This condition will immediately cause a red alarm. When you see a blue alarm,
check the transmit signal.

Blue Alarms

Loss of signal is an indication that the T1 framer is unable to detect a received
signal.

This condition causes the system to send a blue alarm to the network, but will not
Loss Of Signal cause a blue alarm indication at the T1 board.

This condition will immediately cause a red alarm. When you get this indication,
check the receive signal and wiring.

» The SIG indicator on the T1 board also indicates this condition.

The DXPOPT-SYN card sends this status information to cause the error log to
display a message that indicates that the primary or secondary reference has
become activated or deactivated.

This condition is usually associated with other synchronization type errors.
Primary/Sec Sync Ref Switch

If an error occurs, be sure that the DXPOPT-SYN card is installed properly and the
T1 lines are wired correctly and have the proper signaling.

The PRI and SEC indicators on the DXPOPT-SYN board also indicate these
conditions.

The DXPOPT-SYN Card sends this alarm to indicate that it is unable to
synchronize the DXP clock to the T1 signal.

Sync Phase Lock Error » When this alarm is active, it is a good practice to check the DXPOPT-SYN card for
proper installation and strapping.

» The UNLOCKED indicator on the DXPOPT-SYN card also indicates this condition.

T1 Alarm and Error Parameters (continued on next page)

- 481 -



APPENDIX F - T1 MAINTENANCE

T1 ALARM AND ERROR PARAMETERS (continued)

» The network sends a yellow alarm to the T1 framer for detection.

* This alarm indicates that the network has detected a transmit signal from the T1
board but cannot synchronize to the transmit frame.

* If a yellow alarm is in effect for more than 2.5 seconds, the system activates a red

Yellow Alarms alarm.

« If the network removes a yellow alarm within the 2.5 seconds, the system will
return to normal. When a yellow alarm occurs, it is a good practice to check the
network wiring.

* The YELLOW indicator on the T1 board also indicates this condition.

» The T1 card issues a red alarm for the following conditions:

« at startup until the system establishes synchronization with a good link

» whenever a receive signal is not present

» when the system receives a blue alarm from the network

Red Alarms » whenever a yellow alarm, sent from the network, is active for more than 2.5
seconds.

K NOTE

'. When the above conditions terminate, the red alarm will terminate. The
RED indicator on the T1 board also indicates this condition.
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T1 ERROR THRESHOLD

You can set the number of errors (for each error type) per second that you will allow to occur before registering an error
in the total count. The total number of actual errors is the number that you can see on the Error Seconds Total screen
(see page 484) multiplied by the number that is entered on the T1 Error Threshold screen.

IMPORTANT!
A e The PC-DBA and the switch MUST BE CONNECTED before you can complete
this task.

e Itis recommended that you leave the threshold settings as is (i.e., keep the default
settings). Please contact Vertical Technical support with any questions prior to
changing this setting.

1) Connect PC-DBA to the switch.

From the PC-DBA main screen:
2) Go to Maintenance® T1 MaintenanceP T1 Error Threshold to initiate the report.

3) Enter the number of totals to be tracked before a total is registered.

ERROR TYPE Description

« Bipolar errors indicate that the system has detected

electrical noise on the receive pair from the network.
BPV (Bipolar Viola-

tion)

Bipolar errors can occur frequently, even on a properly
functioning system and can occur if the network is
using B8ZS and the T1 board is not.

Loss of signal is an indication that the T1 framer is
unable to detect a received signal.

This condition causes the system to send a blue alarm
to the network, but will not cause a blue alarm

OOF (Out of Frame) indication at the T1 board. However, this condition will
immediately cause a red alarm.

When you get this indication, check the receive signal
and wiring. The NO SIG indicator on the T1 board also
indicates this condition.

CRC Error Alarm CRC errors indicate corruption of A, B, C, and D bits for
Trigger only the ESF mode.

Slip errors indicate that the T1 board has discarded or
duplicated a received frame and the receive signal
from the network is not properly synchronized to the
system.

Slip Errors

4) Click Send to complete the setting.

- 483 -



APPENDIX F - T1 MAINTENANCE

T1 ERROR SECONDS TOTAL
This feature generates a report which allows you to review any errors registered as per the T1 Error Threshold setting.

IMPORTANT!
A e The PC-DBA and the switch MUST BE CONNECTED before you can complete
this task.

« Contact Vertical Technical Support for assistance with understanding and clearing
errors.

1) Connect PC-DBA to the switch.

From the PC-DBA main screen:
2) Go to MaintenanceP T1 Maintenancel>Error Seconds Total to initiate the report.

IMPORTANT!

A * Please be patient. Depending upon the size of your system, as well as the way the
Error Thresholds (see page 483) are set, this process could take several seconds
to several minutes.

e Contact Vertical Technical Support for assistance with understanding and
correcting errors.

HINT
@ You can click Refresh to get a real time listing of errors (registered since you
previously ran the report).

3) Click Close to close the Error Seconds Totals feature.
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CLEAR T1 ERRORS

This tool allows you to clear any errors (i.e., for Hour Count only) that have been registered as described in “T1 Error
Threshold” (see page 483) and “T1 Error Seconds Total” (see page 484). After using the Clear T1 Error tool, the
contents (errors) will automatically be sent to KSU. The KSU will then clear the T1 Error Count for the specified error.

IMPORTANT!
A e The PC-DBA and the switch MUST BE CONNECTED before you can complete
this task.

e Itis recommended that you leave the threshold settings as is (i.e., keep the default
settings). Please contact Vertical Technical support with any questions prior to
changing this setting.

1) Connect PC-DBA to the switch.

From the PC-DBA main screen:
1) Go to Maintenance T1 Maintenancel>Clear T1 Error to display the Clear T1 Error screen.

2) Select the appropriate errors for clearing (you can select one, several, or all of the errors in the list).
e The default is for ALL to be selected.

« The table below provides a definition for each of the possible error types.

T1 ERROR TYPES

ERROR TYPE Description

« Bipolar errors indicate that the system has detected electrical
noise on the receive pair from the network.
BPV (Bipolar Violation) « Bipolar errors can occur frequently, even on a properly

functioning system and can occur if the network is using
B8ZS and the T1 board is not.

. * CRC errors indicate corruption of A, B, C, and D bits for only
CRC Error Alarm Trigger the ESF mode.

« Slip errors indicate that the T1 board has discarded or
Slip Errors duplicated a received frame and the receive signal from the
network is not properly synchronized to the system.

« Loss of signal is an indication that the T1 framer is unable to
detect a received signal.

 This condition causes the system to send a blue alarm to the

network, but will not cause a blue alarm indication at the T1
OOF (Out of Frame) board. However, this condition will immediately cause a red
alarm.

« When you see this indication, check the receive signal and
wiring. The NO SIG indicator on the T1 board also indicates
this condition.

T1 Error Types (continued on next page)
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T1 ERROR TYPES (continued)

A Red Alarm occurs in the following situations:

« at startup until the system establishes synchronization with a
good link

Red Alarm « whenever a receive signal is not present
» when the system receives a blue alarm from the network

« whenever a yellow alarm, sent from the network, is active for
more than 2.5 seconds.

« The network sends a yellow alarm to the T1 framer for
detection.

¢ This alarm indicates that the network has detected a transmit
signal from the T1 board but cannot synchronize to the
transmit frame.

« If a yellow alarm is in effect for more than 2.5 seconds, the
Yellow Alarm system activates a red alarm.

« If the network removes a yellow alarm within the 2.5 seconds,
the system will return to normal.

* When a yellow alarm occurs, it is a good practice to check the
network wiring.

» The yellow indicator on the T1 board also indicates this
condition.

« The network sends a blue alarm (also known as an Alarm
Indication Signal or AIS) for detection by the T1 framer.

« This alarm signal consists of all ones on all channels and is
Blue Alarm an indication that the network is unable to detect any signal
being transmitted from the T1 board.

« This condition will immediately cause a red alarm. When you
see a blue (AIS) alarm, check the transmit signal.

3) Click Clear T1 Error to clear the errors as specified in step 3.
* A message will appear to let you know whether or not the request was successful.

4) Click OK to close the Send success screen.
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A

AAM 298, 300
Abandon call on hold 129, 291
Account Code Length and Password 336, 337, 338, 339, 340
Agent, UCD 344
AIS 480
Alarm 480
alarm clock, hotel mode 249
Alarm indication 480
Alarm Indication Signal 480
alarm play intervals 247
Alarm signal consists 480
Alarm Trigger 480
Alarms 480
All ring 341
Allows 4
Alternate CO line group 150
Analog device support (SLT) 442
Ancillary devices 77, 327
AR 232
Areas, local calling 264
Assigning
CO group 119, 120
DSS port/owner 93
extensions to a class of service 400
extensions to CO lines 433, 434
extensions to paging groups 397
extensions to pickup groups 394
extensions to tenant groups 391, 392, 393
feature buttons 442
recording announcement devices 429
ring type for the CO Line 134
tenant group 116
Attendant extension
forwarding unanswered calls on CO line to 144
Attendant, assigning DDS port/owner 89, 93
Attendant/Extension DSS Console 89
Auto
attendant, AAM 298, 300
hold 324
redial 232
Automatic
CO line time switching 140, 141, 142, 143, 144
dialing 64
Automatic
disconnection 21
pause insertion 199
auxiliary ringer interface 77, 327

B
B8ZS 480
Background music source 77, 121, 327
baseline

CO line copy 30
extension copy 33
Baud 13, 14
Bipolar 480
errors 480
indicator 480
Bits 480
Blue Alarm 480
Busy 323
extensions, transfer recalls 213
Button labels 29, 468

C

Cable 21
Call duration 258
Call forward
extension predefined 423
external 237
no answer 144
predefined 282
Call handling 322
Call holding 325
Call Key 322, 323, 324, 325, 327
lamp indicator 322, 323, 325
Call limiter 411
Call output, SMDR 274
Caller ID
codes 264
table 72
Calling areas, local 264
Camp on interval 245
Changing database administration password 27
Channels 480
Checked
IN 249
OUT 249
CID table, controlling number of entries 72
Class of Service
assigning passwords for toll restrictions 336, 337, 338,
339, 340
extensions 400
program printout 9
programming via any digital extension 26
programming via Video Display Terminal 9
Class of Service and Digit Intervals 329
Clean 249
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Clearing
all the feature keys 451
features at an extension 37
CO 322, 323, 325, 327
flash time 193
group assignment 119, 120
CO line 322, 327
assigning extensions to 433, 434
assigning tenant groups to 116
copy 29, 30
dial type 124
line group, alternate 150
key 325
loop supervision 129
naming 49, 50, 51, 52, 53, 54
names 49, 50, 51, 52, 53, 54
programming 115
ring type assignment 134
ringing 327
signaling 124
time switching 140, 141, 142, 143, 144
type assignment 126, 127, 128
Code account, length 336, 337, 338, 339, 340
Cold start 21
COM Port settings 13, 14
Condition causes 480
Conference 322, 325
call assuming 325
calls 189, 325
meet me 241
talk time intervals 241
tones 241, 256, 257
Configuring Single Line Telephones
(Analog Device Support) 442
Connect 13, 14, 21
Connecting PC-DBA 13, 14
Connection 13, 14, 21
settings 13, 14
TSI 254
Controller 325
Controlling
Number of Caller ID Entries in the CID Table 72
Overflow and Reroute Situations 343
Convert DX-80 database 4
Convert
FO3 DB File 4
F39 DB File 4
Copy
CO line 29
extension 29
Copying Baseline
CO Line Setups 30
Extension Setups 33
Corruption 480
COS 329
CPM 13, 14
PC serial port 13, 14
CRC
errors 480
indicator 480

D
Database 4, 18, 19, 21
item select screen 27
memory 13, 14
programming templates 29
reloading 21
restore 12
save 12, 13, 14, 19
Database administration
administration
digital extension 26
exiting 27
mode 26
password 27
PC-DBA 9, 12, 17, 20
Day and evening class of services 121
DDS port/owner, assigning 93
Deactivated 480
Default 21
extension reset 29, 37
Delay in dialing 199, 220
DET
button labels 468
database screen 27
Detected electrical noise 480
Detecting fax tone 153
Diagnostics 13, 14
Dial delay 220
Dial type, CO line 124
Dial wait time 220
Dialing ratio 223
Digit intervals 329
Digital
extension telephone, programming via 26
voice mail 380
Direct inward system access 312, 313, 315
Directory 13, 14, 18, 19
extension swapping 439, 441
number lookup 36, 37
number/feature number lookup 29
numbers 37, 89, 323, 327
DISA 312, 313, 315
Disable
conference tones 256, 257
hotel feature 249
system speed toll check 252
TSI connection 254
Discarded 480
Disconnecting PC-DBA 21
Disconnects, CO line 129
Distant-end party disconnects 129
Download 13, 14, 18, 19, 21
Dropped calls 202
DSS Console 89
DTMF tone delay 220
Duplicated 480
Duration, call 258
DX-80 Database 4
DX-80 DB Converter 4
DXP clock 480
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E E
Edge 120 phone 325 FO3 DB File 4
Enable Convert F39 DB File 4
tenant group calling 271 F321
conference tone 256, 257 F4-Send 21
hotel feature 249 F8 21
system speed toll check 252 initialize 21
TSI connection 254 Fast shortcuts 29
Entering the Database Administration Mode 26 Fax detection 153
Error Feature 322, 324, 325
count 480 access codes 322
parameters 480 button lookup 450
system logs 480 directory number lookup 36, 37
ESF mode 480 key reset 451
Establishing number lookup 29
dialing ratio 223 system 8
music sources 77, 327 Flash time
start and end of slt hook flash 228 CO 193
warning time for limited call lengths 210 PBX 196
Exchanged 18, 19 Flash, SLT hook 228
Exclusive hold 207, 324, 325 Flexible feature button inquiry 450
remind 205, 206 Forced account code
Exit PC-DBA 21 o assigning length of 336, 337, 338, 339, 340
Exiting Database Administration 27 Forward, external call 237
Extension Frame 480
assigning class of service to 400 G
assigning feature buttons to 442 A=
assigning paging groups to 397 Group
assigning to CO lines 433, 434 CO assignments 119, 120
assigning to pickup groups 394 tenant 271
assigning to tenant groups 391, 392, 393 H
SOCF)))Illr;eg monitoring 404 Held 324, 325
copy baseline setup 33 H_elp 24_ ) o
directory swapping 439, 441 Higher indicator priority 325
feature key |ookup 450 Hold 322, 323, 324, 325, 326
feature key reset 451 exclusive 207
monitoring 404 recall 217
predefined call forward 423 remind 205, 206
programming 385 retrieve 325
reset defaults 29, 37 setting 324
ring level 437 Hold abandon 129
SLTs 442 time interval 291
SMDR 427, 428 Hold Key 324, 325, 326
transfer recalls 213 lamp 325, 326
External lamp Indicator 324, 325, 326
call forward 237 Hook flash, ST 228
music source 77, 327 Hotel feature 249

Hunt method 146
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1 M
ID, caller ID 264 Manual disconnection 21
Idle 323 Messages 323, 480
Idle extensions, transfer recalls 213 pre-programmed 60
Incoming Modem 13, 14, 21
calls 322, 323 internal 93
trunk 323 settings 13, 14
Init string 13, 14 Module 4
Initialize 13, 14, 21 MOH, CO lines 121
F8 21 Monitoring extension/CO Line 404
Inserting pause on outgoing CO line calls 199 Multiple Call Handling 322, 323, 325, 326, 327
Intentional delay 199 Music 77, 327
Interactive buttons 26 on hold source 121
Intercom 323, 325 Music source, external 77
Internal modem, setting up optional 93
Interval N
alarm play 247 Naming CO Lines 49, 50, 51, 52, 53, 54
campon245 Network wiring 480
conference talk time 241 New system programming 7
?alﬁ(lttigﬁg ” No answer, predefined call forward 144
Invoked 323 number lookup, feature/directory number 36, 37
Item select screen 27 @)
K Occurrence report 480
KSU 4 - Off hook voice announce 415, 416, 417
OHVA 415, 416, 417
L On-site 13, 14
- Optional
Labels, DET buttons 468 Automated attendant 303
Lamp 325, 326 Internal modem 13, 14
Lamp indicator 322, 323, 325, 326, 327 voice mail 380
after operation 325 Outdated PC-DBA laptop database 19
before operation 325 Outgoing calls 322, 323
LCD Interactive buttons 26 Output, SMDR 427, 428
Length of account code 336, 337, 338, 339, 340 Overflow 343
Lights 323, 324 Overwritten 18, 19
Limited calls 258, 411 Owner, DSS 93

waiting time 210
Limiting unsupervised talk time 294, 295
Line Key 322, 323, 324, 325, 327
CO 325
Line type assignment, CO 126, 127, 128
Loading PC-DBA software 9
Local
calling areas 264
settings 13, 14
Log 480
on/off as UCD agent 344
Lookup
feature number 29
feature/directory number 36, 37
Loss Of
signal 480
sync 480
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P

Paging groups, assigning extensions to 397
Paging privileges 419
Parameter 480
Password
account code 336, 337, 338, 339, 340
changing database admin 27
creating for toll restrictions 336, 337, 338, 339, 340
protection 9, 26
Pause time 199
PBX
code 146
compatibility 147
flash time 196
PC 13, 14
connect 13, 14
exchanged between 13, 14
serial port 13, 14
PC-DBA
control options 13, 14
loading 9
parameters 21
port 13, 14
transmit rate 13, 14, 94, 96, 100, 110, 111, 112
Performing 21
cold start 21
directory/extension swapping 439, 441
restore 12
save 12
warm start 21
Phantom lines / virtual numbers 116
Physical connection 13, 14, 21
Pickup groups, assigning extensions to 394
Pool 322
Predefined
call forward 282
call forward no answer 144
Pre-programmed messages 60
Preserve 18
PRI 480
Primary 480
Sec Sync Ref Switch 480
Privacy 131
release 131
Privileges, paging 419
Processor 13, 14

Programming 21
auto attendant module (aam) 298, 300
auto redial 232
caller id codes and local calling areas 264
co lines 115
conference calls 189
extensions 385
extensions for smdr output 427, 428
external call forward 237
methods 1
multiple call keys 322, 323
new system 7
optional internal vm, digital 380
options 1
release key 450
speed dial numbers 64
templates 29
tenant groups 271
uniform call distribution (ucd) groups 341
using any digital extension terminal (det) phone 26
voice mail 280
worksheets 453
Proper
installation 480
signaling 480
Properly functioning system 480
Pulse
dial 220
tone dial type, CO line 124

R

RAD 429
Rate

transmit SMDR 97

transmit to PC-DBA 94, 96, 100, 110, 111, 112
Recall

hold 217

transfer 213
Receive 4, 13, 14, 18, 21, 480

all 18, 21

data 4, 18

pair 480

programming 18
Recognition, ring on time 285
Recorded announcement device 429
Red

alarm 480

indicator 480
Rejoins 325
Release key, programming 450
Reloading database 21
Remind 324

system and exclusive hold 205, 206
Reminder 325
Remote

programming and administration 9

settings 13, 14
Reported occurrence 480
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Reroute 343
Reset 21
extension to its default settings 29, 37
feature keys 451
Restored 21
system saves 21
Retrieve 324, 325
hold 325
Retrieved 325
Retrieved independent 325
Revert 21
desirable 21
Reverting 21
ring abandon 202
ring level, extensions 437
ring on recognition time 285
ring scheme 103
ring type assignment, CO line 134
room status, hotel mode 249
RS-232 13, 14

S

schedule, time 140, 141, 142, 143, 144
SEC indicators 480
Secondary reference 480
Seized 323
Seized Trunk 323
Selecting Exclusive Hold Time 207
Selecting SMDR Transmit Rate 97
Send All 19
Sending 13, 14
Sending Data 19
Switch 19
Serial 13, 14
Service Observing 404

Set CO Line Time Switching 140, 141, 142, 143, 144

Setting
alarm play intervals 247
alternate co group 150
co line type 126, 127, 128
call abandon 129
call forward -- extension predefined 423
camp on interval 245

conference talk time intervals and conference tones 241

day and evening class of services
and music on hold (moh) source 121
dial type 124
dial wait time and dial delay 220
direct inward system access (disa) 312, 313, 315
extension ring level 437
fax detection 153
hold abandon time interval 291
hold recall 217
hold remind 205, 206
off hook voice announce 415, 416, 417
optional internal modem 93
paging privileges 419
pbx code and hunt method 146
pre-defined call forward no answer 144
predefined call forward time 282
pre-programmed messages 60
privacy and privacy release 131
ring on recognition time interval 285
ring scheme 103
smdr call output 274
system features 8
talk abandon time interval 287
transfer recalls for idle and busy extensions 213
ucd voice announce (va) groups 358
unsupervised talk time 294, 295
Settings 13, 14
connections 13, 14
Setups, baseline extension copy 33
Shortcuts to help you work faster 29
SIG indicator 480
Signal 480
Slip 480
errors 480
indicator 480
Slow flashing 324, 325, 327
SLT 442
hook flash 228
SMDR 274, 427, 428
setting up 274
transmit rate 13, 14, 97
Solid 324
Source for external music 77
Specifying
Call Duration 258
CO Flash Time 193
Pause Time 199
PBX Flash Time 196
PC-DBA Transmit Rate 94, 96, 100, 110, 111, 112
Ring Abandon 202
Speed Dial 18, 19, 323
numbers 64
toll check, system 252
Standard RS-232C 13, 14
Startup 480
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Status 322, 323, 324, 325, 327, 480
Straight-through

9-pin 13, 14

cable 13, 14
Strapping 480
Successful connection 13, 14
Supervised/screened transfer 327
Swapping, extensions, directories 439, 441
Switch 13, 14, 21
Switching, time 140, 141, 142, 143, 144
Sync

condition exists 480

indicator 480

phase lock error 480
Synchronize 480
System 13, 14, 480

activates 480

condition causes 480

disconnects automatically 21

errors 480

establishes synchronization 480

features, setting up 8

hold 324, 325

hold remind 205, 206

initializing 13, 14

logs 480

overwrites 18, 19

programming task list 7

reminders 45

saves 21

restore 21

speed toll check 252

upgrade 3

-

T1 322, 325, 480
framer 480
maintenance 480
PRI 322, 325
Talk abandon time interval 287
Talk time
intervals 241
unsupervised 294, 295
Talk/hold abandon 129
Telephones, single line 442
Templates, database programming 29
Tenant group 45, 271
assigning extensions to 391, 392, 393
assignment of CO lines 116
Time interval
hold abandon 291
ring on recognition 285
talk abandon 287
Time Switching 140, 141, 142, 143, 144
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